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网络中管理工具的
1 网络中管理工具的

无论整个系统的单个网络组件是任何组合到一起的，Industrial HiVision 8.1
都是对可管理的 Hirschmann- 设备 （包括交换机、路由器、EAGLE20 防火
墙、无线 BAT 单元以及来自不同制造商的产品）进行配置与监测的理想解决
方案。
专为高效的工业监测而开发，可以 Industrial HiVision 轻松地与 SCADA 应用
相结合。该解决方案为 OPC 服务器提供了一个集成的 SNMP 服务。 
User Manual Industrial HiVision
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网络中管理工具的
1.1 整合异类设备

使用特定制造商的网络管理软件当然可以优化其网络组件的运行过程。相比
之下，独立制造商的通用网络监控系统只能提供简简单单的产品集成。
但实际上，不同制造商的设备也会构成异类网络。
Industrial HiVision 使得网络管理员的工作变得轻松：只要设备是可以管理
的，它们便可以和来自 Hirschmann 其他制造商的设备整合到一起。这适用
于网络基础设施的组件以及现场设备。“ 管理型 ” 产品具有一系列可以监测的
标准特征，例如设备状态。此外还可以通过直接的标准接口收集更多的设备
特定信息，如很长时间的历史记录和状态消息。您可以自行决定对您的应用
程序进行监测的细致程度。
优势：
 可对任意制造商的管理型设备进行监测和趋势设置
 显示您整个系统的状态
 使用单独的网络管理系统进行全面的网络监测。
16
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网络中管理工具的
1.2 优化的自动拓扑识别

为了可靠监测工业网络，精确的网络拓扑结构知识是必不可少的。网络管理
员需要知道设备联网的方式、位置以及设备类型，以便有效地管理复杂的网
络，并执行任何所需的维护措施。
现有客户对 Industrial HiVision 的直观用户界面已经非常熟悉。 
它的典型特征是快速的网络拓扑结构可视化。通过标准 LLDP 协议规定网络
基础设施的组成部分，Industrial HiVision 将由此创建一个联网图。也可以识
别可编程控制器、E/A 组件和 HMI 面板等终端设备，并在拓扑结构中进行图
形化精确定位。
Industrial HiVision 您可以识别网络中的非管理型交换机和集线器，并可在网
络图中标明其位置。该软件还可以识别路由器后面设备的网络拓扑结构。由
此开辟出更高一层的拓扑结构。
工业网络随着时间的推移而不断发展，相关文件很容易过时。自动拓扑识别
功能可帮助您了解每个组件在网络中的位置。
密钥编号
 自动创建网络图，无需人工干预
 极为详尽的拓扑图
 最新的网络文件
User Manual Industrial HiVision
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网络中管理工具的
1.3 MultiConfig ™用于网络安装

网络基础设施的许多设备都需要相同的配置参数。根据网络的不同也会有所
变化。
哪些冗余协议是必需的？
设备边界温度是多少？
时间服务器在哪里？
需要锁定运行程序的网络界面？
警报应发送给哪些管理站？
要禁用未使用的端口？
这份名单可以随意延伸。
单独配置每个设备是一项单调乏味的任务。分散于各处的错误配置很难进行
定位。其结果是导致十分耗时的复杂现场验收试验，并存在着网络运行失败
的危险。MultiConfig ™ 帮助您避免这些情况出现。
配置工具可以帮助您同时为多台设备设定相同的参数，也可以显示不一致的
参数设置。该工具也适用于不同类型的设备，只要这些设备参数相同。
您还可以把一些 MultiConfig ™设备配置储存在本地服务器或是某个服务器
上，省去单独访问每个设备的麻烦。
密钥编号
 节省网络安装的时间
 网络基础设施的通用配置
18
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网络中管理工具的
1.4 MultiConfig™适用于正在运行的操作

在网络的使用期间必须重复执行基本的维护措施。为应对网络攻击的威胁，
网络管理员需要负责定期更改设备的密码。技术创新对您的网络和公司来说
大有裨益，但需要对设备的固件进行相应的升级。而在最坏的情况下，如网
络故障时，您的维修技术人员可以立即访问当前的配置文件和网络中设备的
事件日志。
在小型网络中，甚至可以单独访问每个设备。然而，无论网络是大还是小，
数据安全和数据可用性都各个工业网络的首要目标。通过使
用 MultiConfig ™，轻点几下鼠标即可满足这些要求。这大大减少了网络管理
员每天的工作量和工作间断次数。
密钥编号
 最高的网络可用性
 网络管理和网络维护的最低成本
 减少工作中断次数

提示 : 如果在某个对 SNMP、WEB 和 CLI 模块配置了同一访问参数的设备上
改动了用户访问参数，那么在以上 3 个访问模块中的参数同时也会发生改
变。
User Manual Industrial HiVision
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网络中管理工具的 1.5 根据丰富经验开发
1.5 根据丰富经验开发

Industrial HiVision 8.1 是第四代 Hirschmann 网络管理软件。基于以往版本的
经验，这款软件的研发力求能够实现工业环境中的平衡。Industrial 
HiVision 8.1 包括了以往版本中证明有用的特点和优点。包括：
密钥编号
 客户端 / 服务器的结构
 网络浏览器客户端
 编辑模式和正常模式 (Edit/run)
 分级电源指示灯
 全局和单独的状态显示，以及状态信息监控
 灵活的事件处理
 用户可配置的数据采集
 趋势识别
 全面的导出功能
 生产资料管理
20
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网络中管理工具的 1.6 免费的 30 日测试版
1.6 免费的 30 日测试版

作为网络管理员，您需要指导性的工具来实现自己的目标。Hirschmann 创新
无止尽。我们坚定致力于不断发展 Industrial HiVision，以使得我们的系统可
以匹配新型硬件的功能。它大大满足了客户和工业以太网市场的需求。
人人皆知：眼见为实！文字并不能证明我们在网络管理软件领域的投资。因
此建议您下载 Industrial HiVision，并根据您的喜好，在 30 天内对系统进行
测试。若需要更长的测试时间，欢迎提出咨询。
最新 8.1 版本 Industrial HiVision 请前往 www.beldensolutions.com 下载。
User Manual Industrial HiVision
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网络中管理工具的 1.7 Third Party Libraries
1.7 Third Party Libraries

Copyright (c) 2007-2008 Trilead AG (http://www.trilead.com)
All rights reserved.
Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:
a.) Redistributions of source code must retain the above copyright notice, this 
list of conditions and the following disclaimer.
b.) Redistributions in binary form must reproduce the above copyright notice, 
this list of conditions and the following disclaimer in the documentation and/or 
other materials provided with the distribution.
c.) Neither the name of Trilead nor the names of its contributors may be used 
to endorse or promote products derived from this software without specific 
prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.
Trilead SSH-2 for Java includes code that was written by Dr. Christian 
Plattner during his PhD at ETH Zurich. The license states the following:
Copyright (c) 2005 - 2006 Swiss Federal Institute of Technology (ETH 
Zurich), Department of Computer Science (http://www.inf.ethz.ch), Christian 
Plattner.
All rights reserved.
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Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:
a.) Redistributions of source code must retain the above copyright notice, this 
list of conditions and the following disclaimer.
b.) Redistributions in binary form must reproduce the above copyright notice, 
this list of conditions and the following disclaimer in the documentation and/or 
other materials provided with the distribution.
c.) Neither the name of ETH Zurich nor the names of its contributors may be 
used to endorse or promote products derived from this software without 
specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.
The Java implementations of the AES, Blowfish and 3DES ciphers have 
been taken (and slightly modified) from the cryptography package released 
by “The Legion Of The Bouncy Castle”.
Their license states the following:
Copyright (c) 2000 - 2004 The Legion Of The Bouncy Castle 
(http://www.bouncycastle.org)
Permission is hereby granted, free of charge, to any person obtaining a copy 
of this software and associated documentation files (the “Software”), to deal 
In the Software without restriction, including without limitation the rights to 
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies 
of the Software, and to permit persons to whom the Software is furnished to 
do so, subject to the following conditions:
User Manual Industrial HiVision
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The above copyright notice and this permission notice shall be included in all 
copies or substantial portions of the Software.
THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY 
KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER 
DEALINGS IN THE SOFTWARE.
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软件一览表
2 软件一览表

本章包含以下主题：
 软件安装和运行的前提条件，
 软件的安装，
 软件更新
 软件的维护，
 程序的启动以及 
 软件的卸载。

软件运行要求请参见附录 ( 参阅页 30 “ 系统要求 ”)。

提示 : 相关安全：
Industrial HiVision 使用密码保护用户界面的编辑模式。
如果您以管理员身份在您的网络管理站登录并启动 Industrial HiVision 的用户
界面，那么 Industrial HiVision 将会允许直接切换到 “Edit Mode“。这样可以
避开密码提示。

提示 : 相关安全：
Industrial HiVision 数据库内含有您的 Industrial HiVision 项目的信息。
如果您设置了目录 <installation directory>\database 的访问权限，那
么访问该文件就会受限。
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2.1 系统要求 

为了安装和运行 Industrial HiVision，需要：

 硬件要求
 处理器

x86 架构兼容处理器，最小 1GHz
 随机存储内存：

32 位处理器，至少 2GB
64 位处理器，至少 4 GB
Industrial HiVision 大约需要 500 MB 的存储空间。每个已知代理都另
外需要 500 KB 的系统内存。此外网络管理站还需要用于操作系统和
其他应用程序的系统内存。

 存储空间
2GB 空闲空间

 屏幕分辨率：
不低于 1024x768 像素。

 操作系统
 Windows 7 （64 位）
 Windows 8.1 专业版 （64 位）
 Windows 10 版本 1803 （64 位）
 Windows Server 2008 R2:

不能作为 Windows 服务器使用。请确保 Sharepoint Services、
Exchange Server 和 Active Directory 都已卸载。

 Windows Server 2012 R2:
不能作为 Windows 服务器使用。请确保 Sharepoint Services、
Exchange Server 和 Active Directory 都已卸载。

 Windows Server 2016:
不能作为 Windows 服务器使用。请确保 Sharepoint Services、
Exchange Server 和 Active Directory 都已卸载。
30
User Manual Industrial HiVision

Release 8.1 12/19



软件一览表 2.1 系统要求
 Windows Server 2019:
不能作为 Windows 服务器使用。请确保 Sharepoint Services、
Exchange Server 和 Active Directory 都已卸载。

 PC Linux （64 位：3.10 核，libc 6）:
Debian 8
Debian 9
Debian 10
Red Hat 7
Red Hat 8

提示 : 为 Debian 安装 libmono2.0-cil 和 libmono-winforms2.0-cil 软件
包。

 许可证
Industrial HiVision 的许可证密钥取决于待监测设备的数量。
您获得 16、32、64、128、256、512、1024、2048 和 4096 台设备的许
可证密钥。
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2.2 安装

Industrial HiVision 由多个组件组成。大部分的工作由后台服务完成。

该项服务与含有和待监测的 Industrial HiVision 设备有关的重要数据的 数据库
有着密切关联。Industrial HiVision 重启时，Industrial HiVision 将从数据库中
提取最近一次运行中所使用的配置数据。

图 1: 架构
1 - SNMP-Get/Set/Trap, HiDiscovery, Ethernet/IP, Modbus/TCP, Ping, 
HTTP, HTTPS, 
2 - HTTP, HTTPS

User interfaceServices

read/write

Network
Management Station

Configuration
daten

Display-
data

Database

Notification 
Server

IP211
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软件一览表 2.2 安装
可直接在屏幕上调用的 Industrial HiVision 程序与后台服务有关，并可以从其
中获得必要的数据。

您也可以安装 Industrial HiVision 作为 Industrial HiVision 早期版本的辅助。
如果您同时运行了不同的版本，则每个版本都将与自己的后台服务相关联。

Industrial HiVision 可以在不同的电脑上安装以下特性：
 用户界面 （Industrial HiVision 客户端）
 数据库服务 （Industrial HiVision 服务器）
所以，您可以从不同地点通过多个用户界面访问中央网络管理站。可以访问
中央网络管理站的用户界面数量取决于网络管理站的性能。为了避免访问冲
突，在 “Edit Mode“ 最多只能有一个用户界面可以访问网络管理站 ( 参阅
页 371 “ 高级 ”)。
相反，您可以使用一个用户界面对多个分散的 Industrial HiVision 服务器进行
访问。

提示 : 在服务和用户界面之间安装带 NAT 的外部防火墙
在服务方向连接端口的外部防火墙中为以下端口激活端口转发：
 11188, Industrial HiVision 连接服务与用户界面的代理服务器
 11187, Industrial HiVision 使得在浏览器中也能打开用户界面的 Web 服务

器。
( 参阅页 373 “ 服务访问 ”)

提示 : 提示 : Industrial HiVision 将标有日期和时间的事件 ( 参阅页 119 “ 事件
列表 ”) 保存在数据库中。保存的时间是指系统中服务所运行的时间。当您在
不同的时区启动计算机上的用户界面时，Industrial HiVision 将显示本台运行
着服务的计算机所处时区的事件时间。
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2.2.1 下载 Industrial HiVision 软件

要在您的电脑上安装 Industrial HiVision ，首先需要注册。注册完成后，您可
以下载应用程序。
要在 Industrial HiVision 下载 Hirschmann 应用程序前注册，按以下操作：
 请打开 Hirschmann Industrial HiVision 网址： http://www.hivision.de
 点击 “ 下载 ” 链接。
 点击 Industrial HiVision“ 软件下载 ” 链接。
 点击满足您要求的软件链接。
 打开 “ 下载 ” 选项卡。
 从列表中选择 “ 软件 ” 选项。
 选择满足您要求的软件。
 在 “ 登陆 ” 对话框中输入您的电子邮件地址，并在对话框的下方点击 “ 注

册 ” 链接。
 在 “ 注册 ” 对话框中输入相应的信息并点击 “ 注册 ” 链接。百通服务部将向

您的电子邮箱发送一封包含链接的电子邮件，用于验证您的帐户
（belden-service@salient.de）。

 要激活您的账户，请点击电子邮件中显示的链接。
 在 “ 首选合作伙伴网站 ” 对话框中输入新密码，并点击 “ 提交 ”。
要在您的电脑上安装 Industrial HiVision，按以下操作：
 如果您的电脑上正在运行 Industrial HiVision，停止运行当前该核心服务。
 请打开 Hirschmann Industrial HiVision 网址： http://www.hivision.de
 点击 “ 下载 ” 链接。
 要下载 Industrial HiVision 应用程序，请点击 “Industrial HiVision 软件下

载 ” 链接
 点击满足您要求的软件链接。
 打开 “ 下载 ” 选项卡。
 从列表中选择 “ 软件 ” 选项。
 选择满足您要求的软件。
 点击 “ 下载选好的软件 ” 链接。
 阅读许可协议并点击 “ 同意 ” 按钮。
 运行您下载的软件。
 浏览程序关闭下载页面后，文件浏览器会显示 Industrial HiVisionZIP 文

件。
 请确保您具有管理员权限。
 如果您使用的是 Windows 电脑，您可以把 ZIP 文件中包含的文件存放到

您的本地磁盘上。请留意您保存文件的位置，该位置会在文本框中显示。
 如果您操作的是 Linux 系统，请按照以下指示解压 ihivision08100 linux.tar 

文件：
tar -xf ihivision08100.tar -C /path/to/directory
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软件一览表 2.2 安装
2.2.2 在 Windows 系统下安装

 下载 Industrial HiVision 文件，并如 “ 下载 Industrial HiVision 软件 ” on 
page 34 所述，将文件提取出来。

 前往提取出的 Industrial HiVision 文件保存的位置。
 在 Windows 系统下，请双击 ihivision08100windows.exe 文件。
 在 Open File - Security Warning 对话框点击 Run 按钮。
 回答安装脚本的问题，并按照安装脚本的提示进行安装。 

如果您没有回答安装脚本的问题，则安装脚本选择默认答案。

提示 : 如果您收到 Error during installation of ikernel.exe 消息，这
意味着该用户并不具有管理权限。

安装向导将根据您的选择进行如下安装：
 带有集成数据库的 Hirschmann Industrial HiVision 08.1.00 Service 服务

（Industrial HiVision 服务器）
 OPC 服务
 Industrial HiVision 程序的客户端 （用户界面）

如果您想要连入一个 SCADA 系统，则需要在 Industrial HiVision 服务器上安
装 OPC 服务。
可以将 OPC 服务当作 SCADA 系统的数据源。

为执行 HiDiscovery 扫描，Industrial HiVision 需要使用 WinPcap 程序。
在 Industrial HiVision 安装期间，Industrial HiVision 将会检查，可能已安装在
您电脑上的 WinPcap 版本是否满足 Industrial HiVision 的要求。如果不满
足，则应允许安装向导进行 WinPcap 安装。

安装过程中，您可以选择是否在程序启动后启动如下 Hirschmann Industrial 
HiVision 08.1.00 Service 服务：
 每次启动电脑时自动启动该项服务
 程序启动时自动启动该项服务
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提示 : 您可以在 Windows 2008 R2, Windows Server 2012 R2 下的
Start:Control Panel:Administration Tools:Computer 
Management:Services and Applications:Services. 操作系统中找到该
服务的状态。
也可以结束或重启服务。
如果您正在计算机上运行其他的密集计算型程序，则需要结束 Industrial 
HiVision 程序和 “Hirschmann Industrial HiVision 08.1.00 Service” 服务。此
项服务需要巨大的计算机处理性能。启动 Industrial HiVision 程序时，该程序
会询问您是否需要启动该项服务。如果您选择 File > Exit and Stop Service 以退
出该程 Industrial HiVision，该程序会询问您是否需要关闭该项服务。
请注意，该项服务在未激活状态不会对您的网络进行监测，因此也不会记下
事件。

提示 : 默认情况下，“ 登录 ” 选项卡上的服务设置不允许在服务和本地系统帐
户桌面之间进行通信 （在 Start:Control Panel:Administration 
Tools:Computer Management:Services and Applications:Services 处
右键单击 Hirschmann Industrial HiVision 08.1.00 Service 并选择
Properties）。这意味着，您可以通过 #Industrial HiVision   ( 参阅页 339 
“Event Actions”) 启动一个程序，这一进程将在后台运行，而不会在屏幕上显
示。允许该项服务与图形用户界面之间进行数据交换，会产生安全隐患 ，因
为在这种情况下，未注册用户也可以独立启动该程序。所谓的木马攻击会利
用这些安全漏洞。要在事件出现时自动发送短消息 （SMS）或电子邮件，并
不需要在该项服务与图形用户界面之间进行数据交换。

2.2.3 在 Linux 下安装

 请您通过指令 su 登陆，以获得 Root 访问权限。
 停止运行当前该核心服务。
 根据指令启动安装脚本。

sh /mnt/cdrom/Software/industrialhivision/linux/install.sh

 回答安装脚本的问题，并按照安装脚本的提示进行安装。 
如果您没有回答安装脚本的问题，则安装脚本选择默认答案。
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运行安装脚本的示例：

Welcome to Industrial HiVision

This script will install Industrial HiVision on your system.
You can abort the setup process anytime by pressing ctrl-c.

Do you wish to continue? [y]es, [n]o (default=no)
y

Please specify a destination directory for the installation
(default=/opt/ihivision08100)

The directory /opt/ihivision08100 does not exist.
Do you wish to create it? [y]es, [n]o (default=no)
y

Unpacking Industrial HiVision...

Running setup script...
*** Checking database user ***
*** Initialising installation directory ***
*** Initialising log directory ***
*** Configuring Services ***
*** Configuring Executables ***
*** Preparing Init Script ***
*** Industrial HiVision successfully installed ***

Industrial HiVision is now installed and ready for use.

 使用以下命令启动 Industrial HiVision：服务：
/etc/init.d/ihivision08.1.00 start。
Industrial HiVision 您需要先用 su 登陆。

 使用以下命令停止服务：/etc/init.d/ihivision08.1.00 stop。

 使用以下命令重新启动服务：/etc/init.d/ihivision08.1.00 
restart

 您可以使用以下指令检查服务是否正在运行：
/etc/init.d/ihivision08.1.00 status

要在启动操作系统的同时启动该项服务，请将启动该项服务加入到您系统的
初始化序列中去。
对此，根据 Linux 版本的不同，有不同的操作方法。
在某些系统中，兼容的启动序列把脚本 ihivision08.1.00 启动复制到系统
的 init.d 目录下。
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根据需要，提供以下几种选择：
 在不同运行级别中进行集成
 如有需要，手动启动给定的指令
Linux 的 Red Hat、Ubuntu/Kubuntu 和 Mandriva 版本都对初始化脚本进行了
开发和测试。其他发行版 （例如 Gentoo）使用了不同的脚本格式，因此其
他脚本也是必需的。

 Syslog 服务器的配置
Linux 应用程序把生成的事件保存在日志文件中。通过使用系统实用工具 
Rsyslogd，可以在 Linux 系统中记录事件。请使用 rsyslog.conf 文件对实
用工具 Rsyslogd 进行配置。您可以对 rsyslog.conf 文件进行配置，以便
将 Industrial HiVision 事件保存到某个系统日志服务器中。
Linux 系统日志包含以下事件：
 登陆 / 退出 Industrial HiVision 应用程序，
 向某个设备发送 SNMP 设置询问的动作；这包括设定的 MIB 变量和一

个新值，
 Industrial HiVision 中 HiDiscovery 的动作
 启动外部应用程序，
 “Edit Mode“ 需要的动作。

要配置 rsyslog.conf 文件，以令其在系统日志服务器中储存事件，按以下
操作：
 请前往安装目录下的文件夹 /__ 等。
 打开 rsyslog.conf 文件。
 对以下行进行注释：

– $ModLoad imudp,
– $UDPServerRun 514.
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rsyslog.conf 文件示例：
#/etc/rsyslog.conf     Configuration file for rsyslog
#                      For more information see
#                      /user/share/doc/rsyslog-doc/html
                       /rsyslog_conf.html

#################
#### MODULES ####
#################

$ModLoad imuxsock # provides support for local system logging
$ModLoad imklog   # provides kernel logging support
$ModLoad immark   # provides --MARK-- message capability
|
# provides UDP syslog reception
|$ModLoad imudp
|$UDPServerRun 514
|
|
|# provides TCP syslog reception
|$ModLoad imudp
|$UDPServerRun 514
|
|
|"/ect/rsyslog.conf" 121 lines, 2630 characters
|
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2.3 升级

2.3.1 在 Windows 下升级

为了对已安装的 Industrial HiVision 版本进行升级，请按照 “ 在 Windows 系
统下安装 ” 页 29 所述安装新版本。
在安装过程中，您可以选择是否将前一版本的数据库内容应用到新版本中。
如果您需要接收旧版本的数据库内容，请在升级后再卸载以前的版
本。Industrial HiVision 允许在电脑上安装不同的版本。

提示 : 为了正确接收旧版本的数据，请在确认使用旧版本的服务之后结束安
装过程 （如果其仍在运行）。在升级过程中，不对网络进行监控。

提示 : 提示 : 对 Industrial HiVision 的备份支持，因版本的不同而有所区别。
在软件更新 后创建一个备份文件 ( 参阅页 222 “ 保存备份 ”)。

2.3.2 在 Linux 下升级

为了对已安装的 Industrial HiVision 版本进行升级，请按照 “ 在 Linux 下安装
” on page 36 所述安装新版本。
在安装过程中，您可以选择是否将前一版本的数据库内容应用到新版本中。
如果您需要接收旧版本的数据库内容，请在升级后再卸载以前的版
本。Industrial HiVision 允许在电脑上安装不同的版本。
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提示 : 为了正确接收旧版本的数据，请在安装之前结束旧版本 （如果其仍在
运行）。在升级过程中，不对网络进行监控。
如果安装了多个旧版本，那么 Industrial HiVision 会采纳最近一个旧版本的数
据。

提示 : 升级时，如果旧版本仍位于安装目录中指定的位置，Industrial HiVision 
将从旧版本的数据库中接收数据。
否则可以使用接口功能 ( 参阅页 269 “Save”) 和 ( 参阅页 269 “Open...”) 接收
数据。

提示 : 提示 : 对 Industrial HiVision 的备份，因版本的不同而有所区别。在软
件更新 后创建一个备份文件。在软件更新 后创建一个备份文件 ( 参阅页 371 
“ 高级 ”)。
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2.4 维护

Hirschmann 不断致力于软件的完善和开发。请定期检查软件更新是否能为
您带来更多益处。
可从 Hirschmann Automation and Control GmbH. 网页中获得有关升级和更
新的相关信息。

www.hivision.de
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2.5 启动

2.5.1 在 Windows 下启动

在安装过程中，预置程序 Industrial HiVision 将在以下各个位置都放置一个可
以连接到该程序的图标：
 在桌面上和
 在 Start:Programs:Hirschmann:Industrial HiVision 8.1

 双击桌面上的图标或选择启动目录中的图标来启动 Industrial HiVision。
启动时 Industrial HiVision 将搜索服务器。如果 Industrial HiVision 未找到
服务器，Industrial HiVision 将打开一个对话框用于输入服务器 IP 地址或
服务器名称。如果在本地计算机上找到了服务器，请输入名称
localhost。 

提示 : 如果想使用其他计算机来连接 Industrial HiVision 服务器，那么您需要
事先在该服务器的设置中允许远程访问 ( 参阅页 373 “ 服务访问 ”)。

图 2: “ 输入服务器地址 ” 窗口
User Manual Industrial HiVision
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如果 Industrial HiVision 找到了 Industrial HiVision 上一次连接的服务
器，Industrial HiVision 将再一次与其进行连接。如果需要连接到另一台服务
器，请在 “ 连接到服务器 ...” 窗口中点击 “ 取消 ”。使用 File > Login 来打开输
入服务器 IP 地址的对话框。

图 3: “ 连接到服务器 ...” 窗口

 与多个服务器连接
 连接到多台服务器需要复制并添加快捷方式图标。
 使用鼠标右键点击新的程序图标并选择 Properties，即打开该图标的

属性。
 请在 “C:\Programs\Hirschmann\Industrial HiVision 

8.1\bin\HiVision.exe” 后面的 Destination 行中输入一个空格，然
后输入命令行参数 -kernelHost <server name>。使用 IP 地址或您
的服务器名称来替换 <server name>。

对每个需要连接的服务器重复这些步骤。 

2.5.2 在 Linux 下启动

 启动服务，然后启动图形界面 ( 参阅页 36 “ 在 Linux 下安装 ”)。

为了可以从图形界面中启动 Industrial HiVision，请在所使用的桌面上设置一
个图标 （KDE、Gnome 等）。
在 /opt/ihivision08100/lib 中找到合适的图片
(ihivision_op32x32.png)。
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每个用户均可通过双击图标或使用指令
/opt/ihivision08100/bin/HiVision Industrial HiVision 来启动。
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2.6 卸载

2.6.1 在 Windows 下卸载

 关闭 Industrial HiVision 程序。

 要卸载 Industrial HiVision，请选择 Start:Control Panel:Software
Start:Control Panel:Software

 选择程序 Industrial HiVision。

 单击更改 / 删除，并按照卸载提示进行卸载。

2.6.2 在 Linux 下卸载

 关闭 Industrial HiVision 程序。

 请您通过指令 su 登陆，以获得 Root 访问权限。

 使用以下命令启动 Industrial HiVision：服务：
/etc/init.d/ihivision08.1.00 stop。

 使用以下指令来删除目录 /opt/ihivision08100：rm -rf 
/opt/ihivision08100

 从初始化序列 ( 参阅页 36 “ 在 Linux 下安装 ”) 的运行级别中删除启动脚
本 ihivision。
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提示 : 卸载时丢失数据库内容和许可证。 
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准备
3 准备

在您开始检测和监控网络之前，需要创造必要的先决条件或实际应用条件。
 在各项条件中，尤为重要的是对网络管理站进行保护。
 必要的先决条件包括待监测设备的可达性和相关的访问权限。
 实际应用条件则包括相关显示设置，例如字体颜色和字体大小。
 请创建一个数据备份计划。定期从您的项目中导出数据。如果数据遭到破

坏，您可以随时重新创建项目。

随附的 “Demo Network“ （演示网络）程序让您有机会在您的计算机上模拟
该网络，以帮助您在未连接到网络时熟悉 Industrial HiVision。
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准备 3.1 优化 Industrial HiVision 的安全性
3.1 优化 Industrial HiVision 的安全性

对 IT 系统的大量攻击、破坏和间谍活动，要求操作人员对攻击目标受到的伤
害有深入的了解。以下列表列举了在网络管理系统管理的环境中，可能遭受
攻击的目标：
 物理访问网络管理站
 物理访问受管理的设备
 经过操作的安装文件
 以太网访问网络管理站
 以太网访问受管理的设备
 访问配置和日志文件
在本章中，您会找到帮助您防止 Industrial HiVision 和受管理的设备遭受非法
访问的相关说明。
在本手册中，“ 安全 ” 是指数据网络基础设施的安全和保护措施。 

3.1.1 物理保护

如果攻击者能够对需要保护的设备进行物理访问，在这种情况下，即便是最
好的 IT 安全系统和相关软件安全策略，也起不到任何作用。比如，攻击者可
以断开设备电源，拆下数据线，窃取数据线信息或者干脆对设备进行机械性
破坏。
 为此，请将需要保护的设备安装在密闭的柜子或者房间中。

3.1.2 Industrial HiVision 安装前和安装期间的措施

早在安装前和安装期间，您就应该采取第一步措施来保护网络管理系统的安
全。
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 检查安装环境
您在系统上安装的程序越多，就为攻击者提供了更多的潜在攻击漏洞。预
置的 Industrial HiVision 提供了多个程序扩展。
– OPC DA 服务
– OPC UA 服务
– GUI 安装
 请检查您需要哪些程序和补充程序来满足您的要求。
 请卸载系统中与您的需求没有直接关联的程序。
 请只安装那些您需要的程序和补充程序。

提示 :  即使您没有安装 OPC UA 服务，通信端口也是开放的。由此产生
了安全隐患。

为了消除开放的通讯端口造成的安全隐患，按以下操作：
 当打开 Industrial HiVision 程序时，请关闭程序和并中断程序进程。
 点击 File > Exit and Stop Service （写入）。
 在文本编辑器 （比如记事本 + +）中打开 "service.xml" 文

件。“service.xml” 文件的路径地址为 C:\Program 
Files\Hirschmann\Industrial HiVision8.1\config

 找出 OPC 服务行 <Service Name="OpcUaServer" Enabled="yes" 
Path="..." Foreign="yes"。该服务行位于文件的下部。

 为 OPC UA 服务器把 yes 改成 no，比如 <Service 
Name="OpcUaServer" Enabled="no" Path="..." Foreign="yes"。

 保存，并关闭 “service.xml” 文件。
 重新启动 Industrial HiVision 程序。

 检查安装文件的签名
攻击 IT 系统的一大可能是通过恶意软件污染安装文件。Hirschmann 以 
Industrial HiVision 给 *.exe、*.ocx、*.dll 和 *.jar 文件签名。签名可以供您
检查是否具有原始的 Hirschmann 安装文件。
在 Windows 下检查 *.exe、*.ocx 和 *.dll 文件的签名：
安装路径下的文件里包含一个签名。
 在文件资源管理器中打开想要检查的文件的 Properties （属性）对

话框。
 在 Properties（属性）对话框中切换到 Digital Signatures（数字

签名）选项卡。
 选中签名行，并点击 Details （详细信息）按钮。
 在 Details（详细信息）对话框中点击 View Certificate（“ 查看证

书 ”）选项。 
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请确保该证书是签发给 Hirschmann Automation and Control GmbH （赫
斯曼自动化和控制有限公司）的。
请确保该证书由某个值得信赖的机构所签发的，该证书上附有 CA 第 3 级
代码签名。
在 Windows 和 Linux 下检查 *.jar 文件的签名：
用户界面是一种 Java 应用。
如果在网络浏览器中启动用户界面，那么网络浏览器会组织 *.jar 文件签
名的显示内容。同样，网络浏览器将供您选择是信任签名，还是禁止执行 
*.jar 文件。
参考 “ 网络访问 Industrial HiVision” on page 245.

 限制安装文件的访问权限
任何拥有系统安装文件写入访问权限的人，都可以对文件进行操作。
 请提高 Industrial HiVision 安装目录的访问权限，只允许您信任的人访

问。

提示 : 相关安全：
任何拥有系统注册表写入访问权限的人员，都可以对注册条目进行操作。
只允许您信任的人拥有写入访问权限，以此来保护注册表的安全。

 安装冗余网络管理系统
网络管理系统 Industrial HiVision 让您可以在不同的位置安装该软件，从
而达到网络管理高可用性。多个安装程序可以访问同一数据库。 
这为您提供了下列冗余结构：
 网络管理站本身
 两个网络管理站之间的连接
您以增加攻击范围为代价换取冗余可用性的优势。
增加的攻击范围包括下列几项：
 冗余网络管理站自身
 两个网络管理站之间的冗余连接
 请对冗余部件和主要部件采用相同的安全预防措置。
在 “Industrial HiVision 冗余网络管理系统 ” 用户手册中，您可以找到关于
安装冗余系统的详细信息。
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准备 3.1 优化 Industrial HiVision 的安全性
 网络服务器证书
Industrial HiVision 使您可以通过网络浏览器与 Industrial HiVision 网络服
务器进行加密通信。为了进行加密通信，请选择 HTTPS 传输协
议。Industrial HiVision 为 HTTPS 使用 “ 自签 ” 证书。如果您的连接请求
面向 Industrial HiVision，请只信任该证书。 

3.1.3 配置 Industrial HiVision 时的措施

安装 Industrial HiVision 后，所有人都能广泛使用程序。安全起见，请进行相
关配置，对访问权限进行限制。

 为 Edit Mode （编辑模式）修改登录名和密码
在新安装状态下可以自由访问 Industrial HiVision。 
使用 Industrial HiVision 时，会在启动程序界面前首先要求登录。
启动程序界面后，Industrial HiVision 提供 “Edit Mode“ 和运行模式供选
择。 参考 “Edit Mode” on page 94.
 请设置登录要求。
 请设置访问 “Edit Mode“ 的密码。 参考 “User Management” on 

page 333.

 确定用户权限
保护 IT 系统的一个重要手段是通过带密码的用户权限进行访问限制。
为此，定义相应的权利角色和具有匹配权利角色的用户。 
 要限制对 Industrial HiVision 的访问，应在 “Local Users“ （本地用户）

中建立用户，并 / 或激活授权 “Policy“ （方法）。 参考 “User 
Management” on page 333.
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 建立 LDAP
其中轻型目录访问协议 (LDAP) 用于在数据网络中验证 （密码检查）和授
权 （权限检查）。例如，微软将 LDAP 安装在 Active-Directory-Service
（活动目录服务）中用于用户管理。 
其中中央服务器或多个分布式服务器管理用户名和用户角色。
如果 LDAP 激活，一旦用户登录，则 Industrial HiVision 会向 LDAP 服务
器提出请求。
Industrial HiVision 接受来自于 LDAP 服务器的用户名和权利角色，并将
其登记到本地用户目录中。 
 请询问您 LDAP 服务器的管理员，在 Industrial HiVision LDAP 对话框

中应输入哪些配置数据。
 给您的 LDAP 服务器管理员提供下列网络数据，用于输入到 LDAP 服

务器中：
– “User Name“
– “Password“
– “Access Roles“

参考 “User Management” on page 333.

 Radius 认证
远程认证拨号用户服务 (RADIUS) 是一项在数据网络中进行验证 （密码
检查）和授权 （权限检查）的服务。 
RADIUS 基于客户端服务器协议。
如果 RADIUS 激活，一旦用户登录，则 Industrial HiVision 向 RADIUS 服
务器提出请求。
Industrial HiVision 接受来自于 RADIUS 服务器的用户名和权利角色，并
将其登记到本地用户目录中。 
 请询问您 RADIUS 服务器的管理员，在 Industrial HiVision RADIUS 对

话框中应输入哪些配置数据。
 给您的 RADIUS 服务器管理员提供下列网络数据，用于输入到 LDAP 

服务器中：
– “User Name“
– “Password“
– “Access Roles“

参考 “User Management” on page 333.

 监控设备配置设置
设备配置是一个攻击目标。具备管理权限的攻击者可以更改设备的配置，
比如关闭某个端口。
56
User Manual Industrial HiVision

Release 8.1 12/19



准备 3.1 优化 Industrial HiVision 的安全性
Industrial HiVision 可以将设备配置保存为参考配置，定期与设备的当前
配置进行比较 （参见新章节）。
 请在详细显示中点击 “Properties“ （属性）选项卡。
 请在 “Property:“ 下拉列表中选择 “Configuration File“ 属性。
Industrial HiVision 列举出您网络中拥有 “Configuration File“ （配置文件）
属性的设备。
 请标记出需要监控配置的设备。
 使用鼠标右键点击选中的设备，并选择 MultiConfig ™。
Industrial HiVision 打开 MultiConfig ™对话框。
 在 “Status Config“ 对话框中点击 MultiConfig ™对话树。
 为了下载设备的参考配置数据，在 “Status Config“ （配置状态）对话

框的功能框架下选择 “Set current to reference“ （将当前配置作为参
考）。

 请为 “Value is Reference Value“ 选择状态，比如 “OK“。
 请为 “Other Value“ 选择状态，比如 “Warning“。
 点击 “Write“ （写入）。
 为了设置请求和状态转发，在 MultiConfig ™对话框的菜单树中选择

“Property Properties“ （属性）。请注意请求间歇时该功能导致的网络
负载。
尽管较大的请求间歇可能对当前事件作出反应，仍存在通过设备将陷
阱发送到网络中的可能性。为此将网络管理站作为陷阱目标记录到设
备中。

如需更改受监控设备的配置，Industrial HiVision 可以对 Industrial HiVision
中保存的配置和设备上的当前配置进行比较。
 为了进入 “Configuration File“ （配置文件）设备属性，请在详细显示

的列表视图中双击相关设备。
 为了显示差异，右键点击 （显示差异）设备属性 “Configuration File“

并选择 “Display differences“。
比较视图中的标记具有下列含义：
 浅灰色背景，绿色文本：更改
 浅灰色背景，红色文本：已删除
 浅灰色背景，蓝色文本：已粘贴

 追踪程序设置和设备配置的变化
“Audit Trail” （审计跟踪）和 “Audit Log” （审计日志）是按时间顺序记录
系统及其环境变化的数据。 
例如，该记录可用来检查之前谁更改了配置。
审计跟踪使用 Windows 事件查看器或 Linux 中的系统日志功能。
审计跟踪自动运行，不受用户干扰。
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Industrial HiVision 显示下列事件信息：
 MultiConfig ™

– 使用 MultiConfig ™ 成功或失败执行的写入操作。
 属性对话框

– 在属性的属性对话框中进行写入操作
 域 

– 租用许可证
– 撤销租用的许可证
– 添加子域
– 移除子域

 绑定日期的操作
– 执行任务
– 添加任务

 设备管理
– 将设备设为 “Managed” （受管理）
– 设备设为 “unmaged” （不受管理）
– 删除设备
– 设置陷阱目标地址

 更改 IP 配置 
 执行要求 “ 编辑模式 ” 的操作

– “ 审计跟踪 ” 记录那些开始执行前，Industrial HiVision 要求输入 “ 编
辑模式 ” 密码的操作。

 外部程序
– 打开或关闭受管理设备的网络界面
– 打开或关闭受管理设备的设备配置
– 打开或关闭受管理设备的命令行界面
– 打开或关闭用来查询受管理设备 SNMP-MIB 变量的 SNMP 浏览器
执行外部程序的操作，其记录对外部程序负责。Industrial HiVision 记
录外部程序的启动和结束。

 用户自定义操作
– 添加用户自定义操作
– 执行用户自定义操作

 限制远程 GUI 访问权限
Industrial HiVision 可以远程连接 Industrial HiVision 服务器和另外一台计
算机。 
 如果要禁止远程访问 Industrial HiVision 服务器，请禁用远程访问。

参考 “ 服务访问 ” on page 373.
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 限制网络服务器访问权限
Industrial HiVision 允许通过 HTTP 或 HTTPS 协议访问 Industrial HiVision
的网络服务器。这样，您可以在任何地方对网络进行监测。 
 为了提高网络服务器的访问安全性，请对用户权限进行分配。 

参考 “User Management” on page 333.
 如果要禁止通过浏览器访问 Industrial HiVision，请禁用网络服务器。

参考 “ 服务访问 ” on page 373.

 限制 OPC 服务器使用
使用 Industrial HiVision 可激活 / 禁用 OPC 服务器或激活 / 禁用通过 OPC 
写入命令将目标值写入 Industrial HiVision 的功能。在交付状态下，两者
都已禁用。 
 请只激活真正需要的对象。

参考 “ 服务访问 ” on page 373.
 请禁用 "service.xml" 文件中的功能。

参考 “ 服务访问 ” on page 373.

3.1.4 限制访问文件

通过限制 Industrial HiVision 用户数量和用户权限，以此保护您的系统安全。
为防止未授权的访问，请限制对 Industrial 
HiVision“config ”、“var\script ”、和 “var\report_files ” 文件夹的访
问。
Industrial HiVision 的 config 文件夹包含重要的信息安全文件
usermanagement.xml 和 service.xml。
Industrial HiVision 的脚本文件存储在 “var\script ” 文件夹中。如果使用的
脚本密码未经加密处理，则用户可以打开脚本文件并查看密码。文件夹
“var\report_files ” 中包含脚本结果。脚本结果中还可能包含未加密的密
码。
该文件夹的默认路径是 C:\Program Files\Hirschmann\Industrial 
HiVision <version number>。
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提示 : 提示 : 在您在 Industrial HiVision 对话框中添加了用户后， config 的
usermanagement.xml 文件夹内才会产生 Configuration > Preferences > User 
Management 文。
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3.2 程序之外

Industrial HiVision 需要对待监测设备进行访问。因此请注意以下内容：
 您的网络管理站具有每一台待监测设备的访问权限。当有人会在待监测设

备中将您网络管理站的 IP 地址设为具有访问权限的 IP 地址时，问题就出
现了。
配备了任何 IP 地址的设备都能对被配置为 “ 交付状态中 ” 的 Hirschmann
设备进行访问。

 您的网络管理站可通过物理连接直接连接到每台待监测的设备，或通过集
线器和交换机或路由器间接连接到设备。
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3.3 网络结构

大型数据网络都具有层级结构。Industrial HiVision 具有可扩展性，能适应层
级网络结构的要求。 
能适应层级网络结构的要求，意味着您的数据网络中的每一个子域都能创建
一个网络管理站 ( 参阅图 63 “ 域 ”)。

3.3.1 层级网络结构的优势

分级调整的优点如下：
 负载分配

如果具备全方位监控功能的数据网络非常大，则您将很容易达到系统资源
的极限状态 ( 参阅页 “ 对系统资源的影响 ” on page 230)。通过使用多个
网络管理站，您可以将数据网络和网络管理站的满载程度限制到域边界状
态。这可以大大提升运行性能。

 项目更小
项目更小，方便您进行概览。

 组织结构
根据组织结构调整网络管理项目，您可以创建并拷贝与个人需求相符的合
适的项目。

 集中管理 Industrial HiVision 许可证
 集中显示子域状态

3.3.2 应用示例

下图指出分层网络结构的应用示例。
网络由域 IT，以及从属域、A1、A11 和 B1 组成。
IT 网络管理站在 IT 网络中。
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A1 网络管理站在生产网络 1 中。
A11 网络管理站在生产子网 11 中。在这种情况下，A1 网络管理站是 A11 域
的超域。
B1 网络管理站在销售网络 1 中。
域 A1 和 B1 是域 IT 的子域。
Industrial HiVision 允许每个域有 4 级和 5 个子域的嵌套深度。

图 5: 域

IT

A1

B1

A11
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3.3.3 对应用程序范例的配置

分级布局的网络管理站按照以下步骤进行配置：
 启用子域
 将子域绑定到超级域
 从上往下租用许可证

 启用子域
首先在层次级中进行自下而上的操作。在 Industrial HiVision 中释放子域 
界面以及上一层超域对其的访问
这个过程描述了给子域 A11 的操作命令：
 在 Advanced > Services Access 对话框中点击 “Preferences“ 对话树。
 选中该复选框 Project Data Server > Remote Access，以允许远程访问。
 选中该复选框 Project Data Server > Subdomain interface，以允许该子域接

口。
 在 Project Data Server > Password (Global Settings:Subdomain 

Password) 下输入超域访问该子域时所需的密码。
密码要求：8 至 16 个字符。

 对子域 A1 和 B1 重复这些步骤。

 将子域绑定到超级域
 为了将子域 A11 连接在超域 A1 上，请在超域 A1 上通过 File > New > 

Subdomain 打开对话框 “Add New Subdomain“。
 请输入子域的 IP 地址。
 给定子域名称，Industrial HiVision 以该名称将子域显示在文件夹框架

中。
 输入超域访问该子域时所需的密码并确认密码。

Industrial HiVision 在文件夹框架的上部分显示子域。
 对带有子域 A1 和 B1 的超域 IT 重复这些步骤。
选择子域并按 Del 键可从文件夹中删除子域。

 从上往下租用许可证
只在层次级中自上而下地授予 Industrial HiVision 许可证。
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提示 : 超域本身需要自己的许可证。免费的 16 节点许可证不能应用超级
域。

 在超域 IT 中输入许可证密钥 ( 参阅页 “License” on page 350)。
 鼠标右键点击超域 IT 文件夹框架中的子域 A1，授予子域 A1 许可证。

在对话框 “Lease license nodes“ (Lease license nodes) 中输入为子域 
A11 授予的许可证数量。
子域 A1 的许可证数量包含子域 A1 下一步为子域 A11 授予的许可证数
量。

 鼠标右键点击超域 A1 文件夹框架中的子域 A11，授予子域 A11 许可
证。
在对话框 “Lease license nodes“ (Lease license nodes) 中输入为子域 
A11 授予的许可证数量。
超级域 A1 需要自己的许可证，以便向子域发放许可证。

或者可以通过 Industrial HiVision 在子域中直接输入许可证密钥。

提示 : 子域通过与超级域之间的循环连接，来维持其租用的许可证的时
限。如果这之间的连接断开超过一个小时，子域从超级域租用的许可证即
失效。失效的许可证再次归超级域所有。

租用给子域的许可证可在配置设置中的对话框 Basics > License (Basic 
Settings:License) 查看概览 ( 参阅页 “License” on page 350)。

3.3.4 子域的状态显示

这些超级域可以测定子域状态，并且能通过颜色表示其状态。

颜色 含义
深灰色 子域无法访问
灰色 状态测定失败
绿色，可在预设置中配置 OK ( 正常 )
黄色，可在预设置中配置 警告
红色，可在预设置中配置 错误

表格 1: 子域的状态颜色含义
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3.4 程序的预设置

考虑到用户每台计算机的特性，Industrial HiVision 可以预先设置显示、功能
和设备识别。

 IP 参数
在 Configuration > Preferences > Advanced > Management Station 
(Configuration:Preferences:Advanced:Management Station) ( 参阅
页 “Management Station” on page 379) 下输入您网络管理站的 IP 参数。

 设备访问
Industrial HiVision 独立检测 Hirschmann 设备用于 SNMP 访问的交付设
置。 
如果出于安全原因已经改变了待监测设备的 SNMP 预设置，则需要在 
Configuration > Preferences > Advanced > Device Credentials 
(Configuration:Preferences:Advanced:SNMP Configuration) 下输入用户
名和密码 ( 参阅页 “ 服务访问 ” on page 373)。

 设备识别
Industrial HiVision 提供三种在连接的网络中识别设备的方法：
 通过其发送的警报信息识别设备 （陷阱）。请确保已将您的网络管理

站作为陷阱目标地址输入了每台待监测的设备中 ( 参阅页 “ 触发事件
目标地址 ” on page 218)。 

 HiDiscovery：HiDiscovery 日志，通过询问识别设备。请从 ( 参阅
页 “Management Station” on page 379) 选择网络管理站的网络接口
卡。
在交付状态下，在这个新的 Hirschmann 设备上的 Hirschmann 记录为
激活状态。

 通过查询输入的 IP 地址范围(参阅页 “设备识别” on page 134)内的 IP 
来识别设备。

在 Configuration > Preferences > Basics > Discover Devices ( 参阅页 “Basics” on 
page 328) (Configuration:Preferences:Basics:Discover Devices) 下选择
所需的设备识别方法。
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 许可证
为了顺利使用 Industrial HiVision 的全部功能，请在 Configuration > 
Preferences > Basics > License 
(Configuration:Preferences:Basics:License) ( 参阅页 “License” on 
page 350) 下输入您的许可证密钥。
在新安装或升级之后，Industrial HiVision 将以全部功能范围启动，并将持
续免费的 30 天试用时间。
30 日免费测试期届满后，您运行的 Industrial HiVision 是免费版 ( 参阅页 “
切换为免费版本 ” on page 275)。 
只要您输入了一个许可证密匙Industrial HiVision 便将作为许可版本运行。

 字体大小
根据屏幕分辨率的设置，显示的文本过小或不完整。在 Configuration > 
Preferences > Display > 
Device(Configuration:Preferences:Display:Device)， Configuration > 
Preferences > Display > Device Appearance 
(Configuration:Preferences:Display:Appearance) 下调整字体大小 （参
见 “Appearance” on page 364 和 “Device” on page 361）。

 字体颜色
最佳的显示效果取决于您的色感。在 Configuration > Preferences > Display > 
Status Colors (Configuration:Preferences:Display:Status Colors) ( 参阅
页 “Status Colors” on page 366) 下选择颜色显示。 

 设备名称和端口名称
Industrial HiVision 可以选择在界面上显示哪个设备 / 端口的名称。在 
Configuration > Preferences > Advanced > Device/Port Names 
(Configuration:Preferences:Advanced:Device/Port Names) ( 参阅
页 “Device/Port Names” on page 388) 选择设备 / 端口名称。 
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 默认设备图标
Industrial HiVision 可以为不同的设备类型分配默认图标。在 
Configuration > Preferences > Display > Device Icon 
(Configuration:Preferences:Display:Device Icon) ( 参阅页 “Device Icon” 
on page 367) 下选择设备图标。
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3.5 使用带防火墙的 Industrial HiVision

Industrial HiVision 是一个管理系统，帮助您在多个客户端和 Industrial 
HiVision 服务之间建立连接。您可以在同一客户端网络或是同一远程网络中
安装能够提供 Industrial HiVision 服务的管理站。你可以通过防火墙断开网
络。如果某个防火墙断开了客户端 Industrial HiVision 服务，请添加防火墙规
则，以继续传输 Industrial HiVision 服务所需的数据。

提示 : 您可以限制对本地用户的 “Project Data Server“ 访问。为了限制对
“Project Data Server“ 的访问，请禁用 “Remote Access“ 功能。

以下列表包含不同类型的客户端：
 使用图形用户界面

图形用户界面客户端通过可执行的文件 Industrial HiVision 连接
到 Industrial HiVision 服务器。

 Industrial HiVision 超级域客户端
通过 Industrial HiVision 服务器，您可以为客户添加一个 Industrial 
HiVision 子域。

提示 : 请激活 “Subdomain interface“ 并将密码存放入 Industrial HiVision
子域中。

 Web-GUI
Web 图形用户界面客户端对所有的网络使用者开放。
要通过网站浏览器访问 Industrial HiVision 服务器，请输入管理站的 IP 地
址和 “Port“ 号码。举例： 
https://[IP address of the network management station]:11165

提示 : 相关安全：
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攻击者可以欺骗 Industrial HiVision Web 图形用户界面客户端和浏览器客户
端，从而对 Industrial HiVision 核心 / 网络服务器进行未经授权的访问。为了
保护您的网络免受攻击，请您确认每个需要进行访问的用户都拥有准确的用
户登录信息。限制您的管理员数量和用户数量 ( 参阅页 333 “User 
Management”)。

 HTML-GUI
HTML 图形用户界面对所有使用 Web 浏览器的人员开放。
要在 Industrial HiVision 索引上对某个网站浏览器进行访问，请输入管理
站的 IP 地址、“Port“ 号码以及索引。举例：
https://[IP address of the network management 
station]:11187/idx
要在网站浏览器上对 Industrial HiVision 事件进行访问，请输入管理站的
IP 地址、“Port“ 号码以及 “ 事件 ” 举例：
https://[IP address of the network management 
station]:11187/events

 HiMobile 图形用户界面 (GUI)
Industrial HiVision-HiMobile 用户界面为移动设备提供服务。

 OPC UA HTTP/HTTPS
您可以对任何适合的 OPC UA 客户端进行配置，以使得该客户可以
在 Industrial HiVision OPC UA 服务器上对相应的端口进行访问。

请在那些标有 "X" 的条目下激活 Industrial HiVision 服务。要转发端口数据，
请添加防火墙规则。要激活该项服务，请在列出了必要服务的对话框
Preferences > Advanced > Services Access 里勾选复选框。

提示 : 检查您的 “Project Data Server“ 条目，查看 Industrial HiVision 服务是
否正在运行以及是否能被访问 ( 参阅页 373 “ 服务访问 ”)。

Industrial HiVision 服务 / 客
户的类型

网络服务器 项目数据服务
器 

OPC UA 服务器 
(HTTP)

OPC UA 服务器 
(HTTPS)

端口，用于与服务之间建立
连接

11187
（可配置）

11188 11189 11190

使用图形用户界面 – X – –
Industrial HiVision 超级域客
户端

– X – –

表格 2: 服务 - 客户 - 设置
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Web-GUI X X – –
HTML-GUI X – – –
HiMobile 图形用户界面 
(GUI)

X – – –

OPC UA HTTP – – X –
OPC UA HTTPS – – – X

Industrial HiVision 服务 / 客
户的类型

网络服务器 项目数据服务
器 

OPC UA 服务器 
(HTTP)

OPC UA 服务器 
(HTTPS)

表格 2: 服务 - 客户 - 设置
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3.6 指纹验证

如 “ 物理保护 ” on page 52 中所述，请确保核心主机免受未经授权的物理访
问。也要保护远程图形用户界面客户端免受来自核心主机的欺诈性访问。使
用指纹认证，以确保远程图形用户界面客户端连接的是正确的核心主机服务
器。
首次安装时，Industrial HiVision 创建了一个证书并存放在重要的存储
区。Industrial HiVision 会从该证书中生成一个 SHA-256 指纹。在每
个 Industrial HiVision 应用程序中，用于验证的指纹是独一无二的。 
您可以在文本区 Help > About > Fingerprint > SHA-256 Fingerprint 找到指
纹。“Fingerprint“ 对话框还显示证书的附加信息。例如，该证书的制作着、
制作日期以及到期日期。

提示 : 无需任何通知，子域内的管理站即可接受核心主机的指纹信息。

为了确保远程图形用户界面客户端连接的是正确的核心主机服务器，按以下
操作：
 远程用户向管理员询问核心主机服务器的指纹信息。要找到指纹并发出，

管理员应按以下操作：
– 打开选项卡 Help > About > Fingerprint。
– 从 “SHA-256 Fingerprint“ 区域复制该指纹。
– 将该指纹插入一个文本文件中。
– 通过一个安全的通讯渠道，将该文本文件发送给远程用户。
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图 6: 选项卡 Help > About > Fingerprint

 要让远程图形用户界面客户端连上核心主机服务器，按以下操作：
– 在工具栏中点击选项 “File“。
– 请在下拉列表中选择 “Login“ 属性。
– 在 “Enter Server“ 对话框中输入该核心主机包含的服务器的 IP 地址。
– 点击按钮 “OK“。
Industrial HiVision 打开 “Confirm Server Certificate for Industrial HiVision 
Server“ （多重配置）对话框。
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提示 : 如果核心主机和远程图形用户界面客户端处于同一个私人网络中，让
文本框为空。点击按钮 “Accept“ 或 “Accept Permanently“。

 在文本框 “Fingerprint to verify“ 输入您从管理员处获取的指纹。
– 如果指纹不匹配，文本框会显示红色字母。此外该对话还显示消息

“The fingerprints do not match“。点击按钮 “Cancel“ 并联系您的管理
员。

– 如果指纹可匹配，则按钮 “Accept“ 和 “Accept Permanently“ 被激活。
此外该对话还显示消息 “The fingerprint matches this server's 
fingerprint“。

– 点击按钮 “Accept“，远程图形用户界面客户端即与核心主机连接。如
果连接到服务器失败，Industrial HiVision 需要再次验证指纹以建立连
接。

– 您点击按钮 “Accept Permanently“ 时，Industrial HiVision 会将指纹与
对应的 IP 地址一同储存。如果连接失败，Industrial HiVision 会重新建
立无指纹验证连接。 连接指纹验证了没有回来。

提示 : 每次指纹被接受时，Industrial HiVision 都会在日志文件中记入一项条
目。
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图 7: 对话框 “Confirm Server Certificate for Industrial HiVision Server“

Industrial HiVision 使您可以把远程图形用户界面客户端与各个核心主机服务
器连接到一起。如果某个一直以来都可信的服务器的指纹发生了改变，或是
该服务器已经不再可信，您可以对该证书进行 “ 不信任 ” 操作。
Industrial HiVision 使您可以对某个核心主机或是某个远程图形用户界面客户
端上的证书进行 “ 不信任 ” 操作。 
 当您删掉核心主机服务器上的 “corbas.jks” 文件并重新启动时，Industrial 

HiVision 会创建一个含有新证书的新的 “corbas.jks” 文件。每个远程图形
用户界面客户端都必须接受新证书的指纹。

 当您删掉远程图形用户界面客户端上的 “corbas.jks” 文件时，您也删掉了
每个可信的服务器上的指纹。重新启动 Industrial HiVision 后，Industrial 
HiVision 会创建一个新的 „corbas.jks“ 文件。为了重新建立 corbas.jks 文
件，请您再次接受可信的服务器的指纹。

要对某个核心主机或是某个远程图形用户界面客户端的服务器进行 “ 不信任 ”
操作，按以下操作：
 请确保您具有管理员权限。
 请前往安装目录下的 “ 配置 ” 文件夹。
 删除存放在重要的存储区中的 „corbas.jks“ 文件。
 重新启动 Industrial HiVision 程序。
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准备 3.6 指纹验证
要在远程图形用户界面客户端上再次创建 corbas.jks 文件，请为每个所需的
核心主机服务器执行以下操作步骤：
 重新连接上核心主机服务器。
 请确保在对话框中显示的指纹与您从管理员处获得的指纹相一致。
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程序的界面
4 程序的界面

本章将向您介绍程序界面的结构。您将对图形界面有概括性的了解。详细说
明请参见章节 “ 参考 ” on page 265。

使用 Industrial HiVision 并不需要专业的网络知识。在界面上可对程序进行直
观的操作。它包含了标准用户界面元素，经过短期培训即可进行操作。
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4.1 Industrial HiVision 的主窗口

启动 Industrial HiVision 后屏幕上即会显示主窗口。由以下部分组成： 主窗口
 菜单栏
 工具栏
 事件行
 文件夹列表
 导航区
 详细显示
 事件列表

将光标短暂停留在 Industrial HiVision 屏幕位置上，即可打开带有简要帮助文
本的信息窗口。

在事件列表区域中，Industrial HiVision 显示了与计算机系统时间相同步的时
间。Industrial HiVision 会每秒更新一次该时间。
若所显示的时间与计算机系统时间相一致，则可以推断 Industrial HiVision 所
呈现的内容是最新的。
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图 8: 主窗口
1 - 菜单栏
2 - 工具栏
3 - 事件行
4 - 文件夹列表
5 - 导航区
6 - 详细显示
7 - 事件列表
User Manual Industrial HiVision
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4.2 菜单栏

菜单栏位于程序主窗口的顶部。使用菜单栏可以进行导入、导出、创建新项
目、复制、粘贴和删除数据以及更改外观和配置。此外还有帮助菜单可供使
用。 参考 “Industrial HiVision 的主窗口 ” on page 82.

菜单栏包括以下选项：
 “File“
 “Edit“
 “View“
 “Configuration“
 “Tools“
 “Help“
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4.2.1 File

菜单栏中的菜单项 “File“ 包含以下选项框 :
 “New Project“
 “Run Setup Wizard“
 “New“
 “Login“
 “Logout“
 “Open...“ （打开）(Ctrl+O)
 “Save“ （保存）(Ctrl+S)
 “Save as...“
 “Save Backup“
 “Load Backup“
 “Export...“
 “Export Events...“
 “Print“ （打印）(Ctrl+P)
 “Print Events“
 “Exit and Stop Service“
 “Exit“ （退出）(Ctrl+Q)

使用括号中的快捷键，不用鼠标也可以启动菜单项。

图 9: 菜单栏 - 文件
User Manual Industrial HiVision
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4.2.2 Edit

菜单栏中的菜单项 “Edit“ 包含以下选项框 :
 “Undo“ （撤销）(Ctrl+Z)
 “Redo“ （恢复）(Ctrl+Y)
 “Edit Mode“
 切换到免费版本 （在 30 天测试时间期间可用）
 “Cut“ （剪切）(Ctrl+X)
 “Copy“ （复制）(Ctrl+C)
 “Paste“ （粘贴）(Ctrl+V)
 “Paste As Link“
 “Delete“ （删除）(Del)
 “Rename“ （重命名）(F2)
 “Select All“ （全部选中）(Ctrl+A)
 “Acknowledge Status Change“
 “Manage“
 “Unmanage“
 “Set Device and Port Names“
 “Set Default Device Icon“
 “Device Documentation“
 “Drawing Size“
 “Background Image“
 “Find...“ （查找）(Ctrl+F)
 “Auto Topology...“
 “Auto Layout“
 “Properties...“ （属性）(Alt+Enter)

使用括号中的快捷键，不用鼠标也可以启动菜单项。
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图 10: 菜单栏 - 编辑

4.2.3 View

菜单栏中的菜单项 “View“ 包含以下选项框 :
 “Select VLAN“
 “Refresh VLANs“
 “Protocol Statistics“
 “Filter Events for Object“
 “Back“
 “Forward“
 “Up“
 “Home View“
 “Set Home View Settings“
 “Geographical Location View“
 “Zoom“
User Manual Industrial HiVision
Release 8.1 12/19 87



程序的界面 4.2 菜单栏
图 11: 菜单栏 - 视图

4.2.4 Configuration

菜单栏中的菜单项 “Configuration“ 包含以下选项框 :
 “ 监视 M“

该对话框提供了监控组件设置一览表。( 参阅页 “Monitor” on page 313).
 “PSM Manager“

产品专用模块 (PSM) 描述可以读取 Industrial HiVision 用于监控或写入该
产品用于配置的设备属性。
通过 PSM 管理器可更新 PSM 或除交货状态下包含的 PSM 之外导入其他 
PSM，并重新删除这些 PSM。
参考 “PSM 管理器 ” on page 315.

 “ 生成报告 “
除了用于网络管理系统程序数据库，该报告功能还可用于长期数据统计。
参考 “ 报告 ” on page 224.

 “ 调度程序 “
通过时间安排可自动完成 Industrial HiVision 的重复任务。
参考 “Scheduling” on page 317.
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 “Preferences“ （设置）(Ctrl+E)
您可以使用此复选框设置 Industrial HiVision 的配置 ( 参阅页 “User 
Management” on page 333)。

 “ 更改密码。。。“
 “Status Configuration“

使用该对话框，您可以为同种类别的设备或跨类别的所有设备配置组件状
态。

 “Scan Ranges“
使用此对话框，您可以记录设备识别的扫描范围。

 “User defined Properties“:
Industrial HiVision 提供了 “User defined Properties“ (User defined 
Properties) 功能，允许 SNMP 设备将其 MIB 中的更多属性添加到管理之
中。

 MultiConfig ™
多配置功能 (MultiConfig ™ ) 可帮助您在设备上和 Industrial HiVision 中进
行配置： 
– 一台或多台设备
– 一种或多种设备属性，可用于所有设备
– 一种或多种设备详细设置，可用于所有设备

 “MAC/IP List“
已识别设备的 MAC-/IP 清单。

 “Refresh“ (F5)
可使用该选项 “Refresh“ 对属性或选定的设备进行更新。

 “IP Configuration“
此对话框可用于为由 HiDiscovery 识别的没有 IP 地址的设备配置 IP 参
数，或更改已配置的 IP 参数。

 “Trap Destination“
打开此对话框时，Industrial HiVision 将询问设备的触发事件设置，并显示
设备是否已为显示的 IP 地址发送触发事件。

使用括号中的快捷键，不用鼠标也可以启动菜单项。
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图 12: 菜单栏 - 配置
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4.2.5 Tools

菜单栏中的 “Tools“ 菜单项包含以下复选框：
 “ 仪表板 “
 “Web 界面 “
 “ 设备配置 e“
 “ 命令行界面 C“
 “ 操作 “
 “SNMP 浏览器 “
 “Ping“
 “HiDiscovery 扫描 “
 “ 扫描网络 a“
 “ 演示网络 D“
 “ 计算可用性 “

可以通过选择设备或支持该功能的属性激活灰色的菜单项。

图 13: 菜单栏 - 工具
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4.2.6 Help

菜单栏中的菜单项 “Help“ 包含以下选项框 :
 “Online Help“ （在线帮助），(F1)
 “Readme“
 “Release Notes“
 “Tutorial“
 “Online“
 “Kernel Info“
 “About“

F1 键可在不使用鼠标的情况下启动在线帮助。

 Online Help （在线帮助），(F1)
使用该选项，启动程序的在线帮助。

 About
选择此复选框，可打开相关程序的信息窗口。

图 14: 菜单栏 - 帮助
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4.3 工具栏

使用工具栏可以通过点击相应操作按钮快速访问经常使用的功能。 参
考 “Industrial HiVision 的主窗口 ” on page 82.
工具栏包含以下复选框：
 “Back“
 “Forward“
 “Up“
 “Home View“
 “Undo“
 “Find“
 “Edit Mode“
 “Properties“
 “WWW“
 “Scan Network“
 “HiDiscovery Scan“
 “Preferences“

灰色的复选框表示目前没有办法进行操作。例如，您已经处于最高层级，您
却还想进入 “Up““ 上一级 ”。
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4.3.1 Edit Mode

Industrial HiVision 提供两种运行模式。使用 “Edit Mode“ 操作按钮可在这两
种运行模式之间进行切换。您可以用密码保护 “Edit Mode“ 按钮。您可以使
用 “Edit Mode“ 密码或活动管理员的密码来对 “Edit Mode“ 按钮进行密码保
护。
限制 “Edit Mode“ 访问的另一种方法是使用到期时间。可在这里规定编辑模
式处于激活状态的持续时间 ( 参阅页 371 “ 高级 ”)。
 “Edit Mode“

“Edit Mode“ 为管理模式确定您已指定至少 1 位具有管理员访问权限的用
户。要将用户指定为管理员，请在 “User Management“ 对话框中标记
“Login“、“Edit Mode“、“User Management“ 和 “Web Access“ 复选框。 参
考 “User Management” on page 333.
以下列表包含了可以在 “Edit Mode“ 中配置的参数：
– 图形用户界面中的网络显示
– 监控参数
– 配置安全参数
– 复制网络以供重复使用，参考 “Paste as new Network” on page 146.
– 用户管理和授权角色，参考 “User Management” on page 333.
– 信令设备端口，参考 “ 设备和端口信号化 ” on page 304.
– 配置主视图参数，参考 “Set Home View Settings” on page 311.
– 安排任务，参考 “Scheduler” on page 319.
– 设备自动登录，参考 “Web Interface” on page 426.
– 配置 “Dashboard“ 功能，参考 “Dashboard” on page 411.
– 运行模式部分列出的功能

 Run Mode （运行模式）
运行模式仅用于监视网络。当您指定仅具有 “Login“ 授权的角色时，用户
只能在运行模式下操作 Industrial HiVision。 参考 “User Management” on 
page 333.
以下列表包含一些可以在运行模式下监视的功能：
– 打开各个选项卡以查看网络状态
– 启动 “Dashboard“ 来监视网络，参考 “Dashboard” on page 411.
– 使用 “Find“ 按钮来寻找设备，参考 “Find...” on page 281.
– 使用 “Home View“ 按钮恢复到主页设置，参考 “Home View” on 

page 311.
– 使用 “Forward“、“Back“ 和 “Up“ 导航按钮
– 退出 Industrial HiVision
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提示 : 运行模式用于避免无意间写入 Industrial HiVision 的参数。此外运行模
式还用于避免访问数据时出现冲突。例如，“Edit Mode“ 一次仅允许 1 个用户
编辑 Industrial HiVision 中的参数。运行模式不能保护系统免受未经授权用户
的访问。
为防止系统免受未经授权用户的访问，建议您使用带有角色访问权限的 “ 用
户管理 ”。

 配置示例
本示例说明如何使用密码保护 “Edit Mode“ 按钮。您可以使用 “Edit Mode“
或使用 “User Management“ 对按钮进行 “Edit Mode“ 密码保护。当您使用
“User Management“ 来保护 “Edit Mode“ 按钮时，只有活动的管理员才能
使用其用户密码访问 “Edit Mode“ 
要使用 “Edit Mode“ 密码对 “Edit Mode“ 按钮进行密码保护，请验证 “User 
Management“ 功能已禁用。要验证 “User Management“ 功能已禁用，请
按照下列步骤操作：
 请打开 Preferences > Basics > User Management 对话框
 确认 “Selected Order“ 列表为空。
要使用 “Edit Mode“ 密码对 “Edit Mode“ 按钮进行密码保护，请按照下列
步骤操作：
 确认您具有访问 “Edit Mode“ 权限。
 请打开 Preferences > Advanced > Program Access 对话框。
 在 Password for Edit Mode > Password 字段中输入 test1 作为密码。
 在 Password for Edit Mode > Retype Password 字段中验证您的密码。
 点击按钮 “OK“。
“Edit Mode“ 按钮此时受 “Edit Mode“ 密码保护。要验证密码，请单击两次
“Edit Mode“ 按钮。要访问 “Edit Mode“，现在需要输入 “Edit Mode“ 密
码。
用户管理的优先级高于 “Edit Mode“ 密码。用户管理功能处于活动状态
时，该 “Edit Mode“ 框架处于非活动状态。 
要使用 “User Management“ 功能对 “Edit Mode“ 按钮进行密码保护，请按
以下步骤操作：
 确认您具有访问 “Edit Mode“ 权限。
 请打开 Preferences > Basics > User Management 对话框。
 要将新角色添加到 “Access Roles“ 框架，请单击 “New“ 按钮。
 在 “Role Name“ 字段中，输入值 Admin。
 要授予 Admin 角色管理员授权，请标记 “Login“, “Edit Mode“, “User 

Management“, 和 “Web Access“ 复选框。
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 要关闭对话框并将角色添加到 “Access Roles“ 列表中，请单击按钮
“OK“。

 要为本地用户授 Admin 角色，请单击按钮 Local Users > Edit 。
 在 “Local Users Configuration“ 对话框中，点击 “New“ 复选框。“New 

Entry“ 对话框打开。
 在 “User Name“ 字段中，输入值 AdminUser。
 在 “Password“ 字段中，输入值 test2。
 在 “Confirm Password“ 字段中验证密码。
 选中 Admin 复选框。
 要关闭对话框并将角色添加到 “New Entry“ 对话框中，请单击按钮

“OK“。
 要关闭 “New Entry“ 对话框，请单击 “OK“ 按钮。
 要激活“local“策略，请从“Selectable Policies“列表中选择“local“选项。
 点击向左箭头按钮 。该 “local“ 策略将移至 “Selected Order“ 列表。
 点击按钮 “OK“。
“Edit Mode“ 按钮此时受 AdminUser 密码保护。要验证密码，请单击两次
“Edit Mode“ 按钮。要访问 “Edit Mode“，现在需要输入 AdminUser 密码。

提示 : 使用 “User Management“ 功能对该 “Edit Mode“ 按钮进行密码保护
后，“Edit Mode“ 密码将被禁用。
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4.3.2 Preferences

在工具栏中选择 “Preferences“ (Preferences) 工具，打开带有下列菜单项的
窗口：
 “Basics“

“Basics“
– Industrial HiVision 确定设备应如何进行识别，
– Industrial HiVision 确定设备应如何对事件进行回应，
– 输入设备访问密码并
– Industrial HiVision 管理您的许可证。

 “Display“
该选项框 “Display“ 提供事件、设备或文本的显示方式。 
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4.4 事件行

事件行提供保存 在事件日志中未经确认的事件信息。根据其类型的不同，事
件的数量被分列在三个区域内显示。此外您还将知悉这些事件的更详细的信
息，例如某一事件在何时登陆了哪项服务 ( 参阅页 119 “ 事件列表 ”)。
例如，如果某一类型的事件发生了错误，则在该事件行对应的区域中用不同
颜色对该错误进行标记。涉及到的设备会在细节窗格中闪红光，相应的事件
行在事件窗中以红色突出显示。
用户可以使用工具栏中的菜单项 “Preferences“ 调整默认的颜色设置和闪光
设置 ( 参阅页 93 “ 工具栏 ”)。 

提示 : 相关安全：
攻击者可以 Industrial HiVision 对浏览器客户端进行欺骗，由此导致在 Web
服务器的内核中 Industrial HiVision 出现未授权访问。如果你怀疑有未授权人
员试图访问，Industrial HiVision 查看主机里的事件日志条目。

4.4.1 事件数量

在事件行 “Events“ (Events) 选项下的三个信息栏中还包含未确认事件的数
量。
Industrial HiVision 可以为事件分派三种评估类型中的一种：
 错误：（红色标志）

Industrial HiVision 所出现的事件可能造成严重错误。
 警告：（黄色标志）

Industrial HiVision 所出现的事件可间接导致在您的网络中出现问题。
 信息：（蓝色标志）

Industrial HiVision 所出现的事件为正常运行状态。
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图 15: 事件行 - 事件

每出现一个新的事件，Industrial HiVision 对应的计数器计数加 1。用户响应
事件后，Industrial HiVision 对应的计数器计数减 1。
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4.4.2 事件的种类

在事件行 “Most Severe Recently“ (Most Severe Recently) 选项下的三个信息
栏中还包含相关事件的更多详细信息。

将始终显示最新、最重要的事件。如果只有信息，将显示相应事件的最新信
息。如果包括警报，将显示相应事件的最新警报。如果包括错误，将显示相
应事件的最新故障信息。

图 16: 事件行 - 事件 - 最后最重要

每个新出现的事件都将
 在 “Time“ (Time) 栏中显示相应的日期和时间
 在 “Source“ (Source) 栏中显示记录该事件的服务说明
 在 “Message“ (Message) 栏中显示事件种类的详细描述。

可以在 “ 事件列表 ” on page 119 中获得事件的完整列表。事件列表的各列中
也包括事件行的数据。

名称 含义
时间 （Time） 事件的日期与时间
源 服务，例如 Industrial HiVision 服务
消息 事件种类，例如 “ 通过 Ping 发现新设备 ”

表格 4: 事件行中的信息
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4.4.3 确认事件

使用事件行中的 “Acknowledge“ (Acknowledge) 应答显示的事件。还可以使
用事件行中的 “Ack.“ (Ack.) 栏确认事件。

图 17: 事件行 - 事件 - 确认

确认后，事件行 ( 参阅页 100 “ 事件的种类 ”) 中将显示事件日志中的下一个
事件。可以在 ( 参阅页 100 “ 事件的种类 ”) 中获得事件的完整列表。还可以
使用 “Ack.“ (Ack.) 列确认相应事件。

用户确认一个事件后，相应的计数器减 1 ( 参阅页 98 “ 事件数量 ”)。

“ 事件列表 ” on page 119 的 “Ack.“(Ack.) 列中在根据所选事件筛选器应答
后，标记绿色对勾或隐藏已确认的事件。
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4.4.4 事件的属性

使用鼠标右键点击事件行并选择 “Properties“... (Properties), 打开带有当前显
示事件文本的信息窗口。 

图 18: 事件行 - 事件 - 属性
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4.5 文件夹列表

Industrial HiVision 程序界面的文件夹列表中，您可以像在任何标准的用户界
面中一样随意移动。参考 “Industrial HiVision 的主窗口 ” on page 82. 您可以
创建新的文件夹，并利用工具栏中的操作按钮 “Back“、“Forward“ 或 “Up“ 在
层级结构中向上和向下移动 ( 参阅页 93 “ 工具栏 ”)。
 “Back“ (Back)，返回到最后的位置
 “Forward“ (Forward)，前进到下一个位置
 “Up“ (Up)，向上一个层级

使用菜单栏中的 “View“ (View) ( 参阅页 87 “View”) 菜单项也可以实现这些功
能。 

如果您将网络划分成子域，并在 Industrial HiVision 中对其进行了配置 ( 参阅
页 62 “ 网络结构 ”)，则 Industrial HiVision 将在文件夹列表上部显示域结构。

如果在其中还包括下级元素或文件夹，则用加号 “+” 标识在文件夹列表中列
出的文件夹和元素。点击加号显示下级文件夹和元素。下级元素 / 文件夹使
用减号 “-” 进行标识。

点击减号隐藏下级元素 / 文件夹。

交付状态的 Industrial HiVision 包含三个文件夹 :
 “New Devices“

在这个文件夹中，Industrial HiVision 是新发现的设备。它是此款软件的组
成部分，因此无法删除。Industrial HiVision 允许您重命名该文件夹。

 “Unused Devices“
Industrial HiVision 不监测此文件夹中的设备。此文件夹是此款软件的组
成部分，因此无法删除。Industrial HiVision 允许您重命名该文件夹。为了
降低网络负载，您可以将您认为无需进行监测的设备移入该文件夹
中。“Unused Devices“ 文件夹中的设备，Industrial HiVision 其设备状态
显示为 "Unmanage" （非托管设备）。将设备移入您想要存放的文件夹，
以便再次对该设备进行监测。

 “My Network“
Industrial HiVision 提供此文件夹用于创建您自己的网络规划。您可以保
留此文件夹，或删除后再创建一个新的文件夹用于您的网络规划。
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4.6 导航区

使用导航区您可以在拓扑显示 ( 参阅页 105 “ 详细显示 ”) 中移动。
点击导航矩形并将其拖动到导航区内所需的位置。它们在 “ 详细显示 ” 中的
位置，也会进行相应的改变。 参考 “Industrial HiVision 的主窗口 ” on 
page 82.
通过使用 View > Zoom 菜单栏上的菜单项或在导航区单击鼠标右键，可以将细
节框架内的显示放大到 10%。
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4.7 详细显示

在 Industrial HiVision 用户界面的详细显示区域会以拓扑结构或列表形式清晰
显示网络结构。 参考 “Industrial HiVision 的主窗口 ” on page 82.
Industrial HiVision 通过拖放标签 “Map“、“List“ 和 “Devices“，您可以把设备
移入其他的项目文件夹中。例如，在验证您的网络之后，Industrial HiVision
会在 “New Devices“ 文件夹中显示出一个设备。通过拖放动作，您可以把该
设备从文件夹 “New Devices“ 移入其他的文件夹 “My Network“ 中。通过使用
拖放功能，您可以同时移动一个或多个设备。
您可以隐藏列，以便在细节视图选项卡中只显示出您认为是重要的信息。隐
藏列时，Industrial HiVision 隐藏的列的名称会存入数据库中的用户设置中。
导出或打印选项卡时，只有可见的列才会导出或打印。

提示 : 隐藏的列有其特定的名称。如果改变了用户界面语言，存储在数据库
中的隐藏列可能会受到影响。

要显示列或隐藏列，按以下操作：
 右键点击列标题。Industrial HiVision 显示一个包含列名称的下拉列表。
 标记出您想要在选项卡中显示出来的列名称。
 将鼠标指针移出下拉列表，关闭菜单。
下拉列表中有一个选项 “Show all“。如果选择该选项，选项卡将显示出每一
列。
在 “Module / Port“ 模式下，Industrial HiVision“C0“ 至 “C4“ 列将在选项卡
“PoE“ 的预设内容中被隐藏。Industrial HiVision 每一列会在其他选项卡中显
示。要重新显示列，打开下拉列表并选择您想要显示的列。选项卡 “PoE“ 的
下拉列表还有一个选项 “Show default“。该选项将 “C0“ 至 “C4“ 列隐藏起来。
您可以在用户设置与 “Show all“- 或 “Show default“- 设置中进行选择： 
 点击选项 “Show all“，以显示全部列。点击选项 “Show all“ 后，不要关闭下

拉列表。
 再次点击该选项 “Show all“。

第一次点击会显示出 “Show all“ 设置。第二次点击会显示出所保存的列的
设置信息。
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提示 : 不仅在 MultiConfig ™对话中，您还可以在所有的对话中使用隐藏列这
项功能。如果您的设备配置了 MultiConfig ™，您应该可以看到所有列。

4.7.1 Map

点击详细显示中的选项卡 “Map“，进入详细显示的拓扑视图。
网络结构中的现有设备和连接都将按照在拓扑视图中的显示选项进行显示。
可以选中并用鼠标拖动设备。

图 19: 详细显示 - “Map“

双击设备 / 组件，进入下一级详细显示 ( 参阅图 47)。
下一级显示的是组件的详细信息。使用图表符号对其进行标识。
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图 20: 用于表示组件详细信息的图表符号

4.7.2 List

在详细显示的列表视图中，点击选项卡上的 “List“ （列表）图标进入详细显
示。
网络结构中此层级的现有设备和连接都将按照您选择的显示选项以列表的形
式显示。

双击设备 / 组件可以进入下一级详细显示。

图 21: 详细显示 - “List“
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4.7.3 Devices

点击详细显示中的索引卡 “Devices“，进入详细显示的设备视图。
Industrial HiVision 将文件夹列表内所选文件夹和子文件夹中的设备以列表的
形式显示。列表将显示每台设备的：

通过选择一个设备类别，可以在对某个类别的设备进行筛选的同时，对其进
行标记。通过使用 MultiConfig ™功能，可以对选择的设备进行统一配置。

Name[ 名称 ] 含义
Type 设备的符号
Status 设备状态的符号
Name 您在 Industrial HiVision 中输入的设备名称，否则将采用设备的 IP 地址
IP Address 管理 IP 地址
MAC Address 管理 MAC 地址
Product 产品系列名称
Chassis 产品名称
Serial Nr..(Serial Nr) 设备序列号
System Name 设备 MIB 中的系统名称
Location fA 在设备中输入的地点名称
Contact 在设备中输入的联系人姓名
Firmware Version 设备上的固件版本
Chassis Name 带有多个管理代理的设备机箱名称
Configuration 
Signature

支持该功能的设备会向已保存的配置分派一个签名。

PSM up to date 该列将显示，设备所读取的数据是否与 Industrial HiVision 中的当前 
PSM （产品特定模块）相一致。如果设备所读取的数据源自 Industrial 
HiVision 的早期版本，则 Industrial HiVision 将在进行下次扫描循环时重
新读取设备数据。

Revision“EtherNet/IP“ 如果设备中存在该属性，则此列包含 EtherNet/IP 应用程序的修订号。

表格 5: 端口详细显示视图中各列的含义 “Devices“
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图 22: 详细显示 - “Devices“

 高级 EtherNet/IP- 支持
“Devices“(Device) 和 “List“(List) 选项卡上，Industrial HiVision 显示在您网
络中通过 EtherNet/IP 协议进行通信的设备的附加信息。Industrial 
HiVision 显示以下 EtherNet/IP 设备：
 交换机
 PC
 Ping 设备
“List“(List) 选项卡中包含一个 EtherNet/IP 设备的
“EtherNet/IP“(EtherNet/IP) 文件夹。打开此文件夹，Industrial HiVision 将
显示以下信息：
 “Vendor ID“
 “Status“
 “State“
 “Serial Number“
 “Revision“
 “Product Name“
 “Product Code“
 “Device Type“
如果以下列表中各列为空或包含默认值，则 “Devices“(Device) 选项卡将
分配 EtherNet/IP 属性如下：
 “MAC Address“(MAC Adresse) 列

包含设备的 MAC 地址。
 “Chassis“(Chassis) 列

包含 EtherNet/IP 设备的产品名称。
 “Serial Nr.“(Serial Nr.) 列

包含 EtherNet/IP 设备的序列号。
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4.7.4 Ports

点击详细显示中的选项卡 “Ports“，进入详细显示的拓扑视图。
Industrial HiVision 将文件夹框架内所选文件夹 / 设备和子文件夹中的端口根
据所选的显示选项以列表的形式显示。

Name[ 名称 ] 含义
Type 端口插座的符号
Status 端口状态的符号
Device 端口所属设备的 IP 地址
Port 端口编号
Port Name 端口保存在设备中的名称
Media Type 所连接的传输介质类型，例如铜
Autoneg 自动协商功能的状态。显示为灰色，表示此端口的自动协商功能出现

错误。
Link 与该端口相连设备的连接状态
Port Enabled 端口设置：启用或停用。
Speed/Duplex 与端口相连的连接速度和双工传输
User 与该端口相连设备的 MAC 地址。该单元格显示与该端口相连设备的 

MCA 地址和组播地址的数量。
Load 收到的数据传输造成的网络负荷
SFP Power RX dBm 显示 SFP 收发器的接收功率 （RX 功率），单位：dBm。
SFP Power TX dBm 显示 SFP 收发器的发送功率 （TX 功率），单位：dBm。
PVID 该端口的 VLAN-ID。连字符表示设备的端口 VLAN 功能出现错误。
Ingress 输入筛选器功能的状态。灰色图标表示设备的输入过滤器功能出现错

误。
VLANs 端口 VLAN 的从属性。

数字是指 VLAN ID，端口也是该 VLAN 的成员。
“ U ” 表示 VLAN 中的成员，无标签的数据包。
“ T ” 表示 VLAN 中的成员，带标签的数据包。

VLAN Consistency 
Check

VLAN 中所包含的 PVID

表格 6: 端口详细显示视图中各列的含义
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图 23: 详细显示 - “Ports“
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4.7.5 Connections

点击详细视图中的连接选项卡 “Connections“，可以显示详细的设备连接视
图。
Industrial HiVision 将文件夹列表内所选文件夹和子文件夹中的连接以列表的
形式显示。该列表为每个链接显示以下信息：

名称 含义
Status 根据监测的设置，用于表示连接状态的符号
Name 连接的名称，自己输入的连接名称或所连接设备的 IP 地址 / 端口号
Connection 连接状态 （激活、未激活）
Device A 连接中设备 A 的名称 /IP 地址
Port A 连接中设备 A 的端口号
Device B 连接中设备 B 的名称 /IP 地址
Port B 连接中设备 B 的端口号
Load A-B 从设备 A 到 B 的网络负荷数据流量
Load B-A 从设备 B 到 A 的网络负荷数据流量
Speed/Duplex 连接速度与双工传输
Media Type 连接的传输介质类型，例如铜
Link Changed 连接状态变化的最后日期（Date of the last status change for the link）
Config Check 连接中端口设置的差异

参见 表格 8
SFP Power RX dBm A 显示端口 A 的 SFP 收发器 RX 的功率，单位为 dBm。
SFP Power RX dBm B 显示端口 B 的 SFP 收发器 RX 的功率，单位为 dBm。
SFP Power TX dBm A 显示端口 A 的 SFP 收发器 TX 的功率，单位为 dBm。
SFP Power TX dBm B 显示端口 B 的 SFP 收发器 TX 的功率，单位为 dBm。
PVID Port A 端口 A 的端口 VLAN-ID。连字符表示设备 A 的端口 VLAN 功能出现错

误。
PVID Port B 端口 B 的端口 VLAN-ID。连字符表示设备 B 的端口 VLAN 功能出现错

误。
VLANs A
VLANs B

连接 VLAN 的从属性。
数字是指 VLAN ID，连接也是该 VLAN 的成员。
“U” 表示 VLAN 中的成员，无标签的数据包。
由数字单独代表的 VLAN 中的成员，发送带标签的数据包。

VLAN Check 若端口 A 和端口 B 所具备的 VLAN 列表相同，则说明检查结果 “OK“ 
(Ok)。
连字符表示某端口处的 VLAN 列表信息出现错误

MTBF 连接中相关组件的平均故障间隔时间
( 参阅页 432 “Calculate Availability”)。

MTTR 连接中相关组件的平均修复间隔时间 (MTTR)
( 参阅页 432 “Calculate Availability”)。

表格 7: 详细显示视图中选项卡各列的含义 “Connections“
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图 24: 详细显示 - “Connections“

4.7.6 Properties

在详细显示的列表视图中，点击选项卡上的 “Properties“ （属性）图标进入
详细显示。
Industrial HiVision 将文件夹列表内所选文件夹 / 设备和子文件夹中同一设备
类别的所选属性以列表的形式显示。 
 选择一种设备类别 （比如 Windows PC）。
 在同一设备类别中选择您想看到的设备的某种属性。

Value 说明
OK ( 正常 ) 连接中的两个端口具有相互匹配的双工设置。
双向 连接中的端口具有不同的双工设置。
Empty field [ 空白
框 ]

缺失信息

表格 8: 配置检查 - 显示的含义
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列表将显示同一设备类别中每台设备的：
 使用右列中的值测定的状态，
 设备的名称 /IP 地址，
 设备类别，
 所选属性的名称，
 属性的值，

如果您想了解以下内容，“Properties“ 视图可为您提供快速概览： 
 某种设备类别中设备的软件版本，
 某种设备类别中设备的所在位置，
 继电器统计，
 Windows PC 的端口属性
 依次类推。

图 25: 详细显示 - “Properties“
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4.7.7 Security Status

通过 “Security Status“(Security Status) 选项卡，您可以对所选取的文件夹中
的设备的安全属性有所了解。
参考 “ 安全性状态 ” on page 207.

图 26: 详细显示 - “Security Status“

4.7.8 PoE

在详细信息视图上，选项卡 “PoE“ 显示您网络上以太网供电设备的 PoE 参数
一览表。

提示 : “Device / Module“- 视图和 “Module / Port“- 视图中的列定义，取决于特
定设备所具有的 PoE 功能。

如果您在文件夹框架中选择了某个项目，选项卡 “PoE“ 会显示出该项目中每
个具有 PoE 功能的设备的参数。您还可以对您的选择进行筛选，只挑出某个
特定网络中具有 PoE 功能的设备。要显示每台设备的 PoE 参数，按以下操
作：
 在文件夹框架中找出一个具有 PoE 功能的设备。
 打开设备列表，显示其属性。
 点击该属性 “PoE“。
此外还要在选项卡 “List“ 中找出每台设备的 PoE 参数。
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如果该设备支持不同层级，MultiConfig ™那么您可以在整体层级、模块层级
和端口层级上使用这些 PoE 参数。
 要在整体层级或模块层级上显示 PoE 参数，按以下操作：

 选择您想要调整其参数的设备。
 右键单击选择的设备。
 在下拉列表中选择 MultiConfig ™。
 请打开对话框 Basic Settings > PoE > Global。

 要在端口层级对 PoE 参数进行详细说明，按以下操作：
 选择您想要调整其参数的设备。
 打开选项卡 “PoE“。
 选择您想要调整其参数的端口。
 右键单击选定的端口。
 请选择选项 MultiConfig ™。
 打开对话框 Basic Settings > PoE > Global。

使用按钮 “Reload“，对选定行的参数进行更新。使用按钮 “Reload“ 可启动一
项轮询任务，Industrial HiVision 检索出选定的参数。更新操作可能需要为完
成轮询任务留出少许时间，视网络负载而定。
通过使用 “View:“- 下拉列表，可以显示 “Device / Module“- 属性或是 “Module 
/ Port“- 属性。
列表 “Device / Module“ 引用了以下列中的模块参数：
名称 含义
Name 显示设备的 IP 地址。
Operation 显示设备的 PoE 功能是否已启用 / 禁用。
Budget 显示可用性能所需要的整体功率预算。
Remaining 显示剩余的性能。

 “Rem Pwr“= “Budget“ - “Reserved“
Reserved 显示整体的预留性能。
Delivered 显示实际向该模块输送的性能。
Global Threshold[%] 以百分比显示全部设备的电量消耗阙值
Device Limit 如果设备的电量消耗超出配置的阈值，显示警告
Module 显示设备上的模块数量。
Nominal Pwr 显示端口的模块可用分配功率。
Max Pwr 显示模块的最大可用功率。
Del Pwr 显示向连接到该端口的动力装置所输送的性能。
Res Pwr 显示根据检测到的相连的动力装置的类别而为模块预留的性能。
Pwr Source 显示设备的电源供应设备。
Threshold[%] 以百分比显示模块的电量消耗阙值
Module Limit 如果模块的电量消耗超出配置的阈值，显示警告图标
Trap Notif 显示 “ 发送 SNMP 触发事件 ” 功能是否已启用 / 禁用。如果启用了该功

能，当电量消耗超出阈值时，该设备将发送一个触发事件。

表格 9: 视图中列的含义 “Device / Module“
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图 27: 详细显示 - 选项卡 “PoE“，视图 “Device / Module“

视图 “Module / Port“ 在以下列中检索端口参数：

您可以在 “Device / Module“- 层级或是 “Module / Port“- 层级禁用特定的参
数。 
 要激活编辑模式，点击 “Configure Monitoring“。 
 启用 / 禁用所需的参数。 
 使用按钮“Activate all“和“Deactivate all“，以接受在所有具有“PoE“-功能的

设备、模块和端口上作出的改动。
参数被禁用后，应用程序不再显示与这些参数相关的警告。

名称 含义
Name 显示设备的 IP 地址。
Nominal Pwr 显示端口的模块可用分配功率。
Rem Pwr 显示剩余的性能。

 “Rem Pwr“= “Budget“ - “Reserved“
Res Pwr 显示根据检测到的相连的动力装置的类别而为模块预留的性能。
Del Pwr 显示向连接到该端口的动力装置所输送的性能。
Module 显示设备上的模块数量。
Port 显示设备端口号码。
Operation 显示设备的 PoE 功能是否已启用 / 禁用。
Fast Start 显示端口上是否已启用 / 禁用 PoE 快速启动功能。
Prio 显示端口优先级。
Status 显示端口供电设备识别的状态。
Det. Cl. 显示性能的动力装置连接到这些端口。
C0 Det. 当端口性能类别无法解析时，在端口显示警告图标。
 “C0“...“C4“ 在端口显示 0-4 类别的当前状态。
Cons 以瓦数显示端口当前电量消耗。
Pwr Limit 以瓦数显示可供端口使用的最大功率。
Port Limit 如果端口电量消耗超出配置的阈值，显示警告
Max Cons 以瓦数显示该设备自上次启动以来消耗的最大功率。
Enab ASDn 显示是否已在端口上启用 / 禁用自动关机功能。
Start 显示自动关机功能激活之后，该设备关闭端口电源的时间。
End 显示自动关机功能激活之后，该设备开启端口电源的时间。

表格 10: 视图中列的含义 “Module / Port“
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图 28: 详细显示 - 选项卡 “PoE“，视图 “Module / Port“
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4.8 事件列表

Industrial HiVision 记录与程序本身、与被监测设备相关的事件。( 参阅
页 354 “Event”)。两个 hauptszenarien 选择和显示在 ereignisliste 事件： 
 基于对象的筛选器
 面向所有对象的事件 / 按时间先后排序的筛选器。
在第一个场景中选择该范围内所需要的对象的数量。使用位于事件列表右上
方的按钮 “Filter Events for Object“。如果您在该范围内至少选择了一个对
象，按钮即被激活。然后使用事件列表右上角的选项框，Industrial HiVision 
以对显示出来的事件进行筛选。您可以从以下筛选器中进行选择：
 “All Events“,
 “Last 24 Hours Events“,
 “Last 12 Hours Events“ (System Name),
 “Unacknowledged Events“,
 “Warnings & Errors“ (System Name),
 “Unacknowledged Warnings & Errors“,
 “Link Events“ (System Name),
 “User Defined...“

对于自定义事件，打开 Industrial HiVision“User Defined...“Industrial 
HiVision 对话框，您可以在里面列出需要在事件列表内显示的事件。
输入符号时请将鼠标指针悬停在输入区。

点击按钮 “Filter Events for Object“，Industrial HiVision 在事件列表中显示标
记指定对象的事件。
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图 29: 对话框 “User Defined...“

提示 : 输入时间时，请使用 24 小时时间表示法。

事件的示例：
  “Application Info“,
  “Status Better“/“Status Worse“,
  “Event Acknowledge“,
  “SNMP Trap“ (System Name),
  “Device Discovered“,
  依此类推。

Industrial HiVision 可以将事件写入事件日志文件中。还可以在程序接口显示
事件。
在每个事件中 Industrial HiVision 记录以下信息：
 识别号码，
 事件是否已由用户进行确认，
 事件类型 （信息，警告，错误）
 事件类别，
 事件出现的时间，
 进行操作的用户，比如确认了事件的用户，
 条目的来源，比如切换为更佳状态的设备，
 引发此条目的组件，比如连接状态再次变回 “ok” （正常）的端口，
 消息，哪些事件引发了此条目。
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可在事件列表中单独确认事件，或一次性确认全部事件。 参阅图 8 on 
page 83.

在事件列表的某一行，右键单击鼠标，
 选择 “Acknowledge“，以确认事件
 选择 “Acknowledge All“，以确认该选项卡中的所有事件

如果该事件 Industrial HiVision 与某个设备或某个属性相关连，则双击事件列
表的某一行，在文件框架内选择事件源。

提示 : 链接的 “User Intervention“- 事件或含有 “ 关闭设备更新 （F5 键）” 通
知的事件，现在是带有同一通知的 “Application Info“- 事件。如果您已对这一
“User Intervention“- 事件配置了事件警报，请对事件警报进行改动，以适应
新的 “Application Info“。

4.8.1 Event History

该 “Event History“ 对话框显示与 Event List 中相同的事件，但在甘特图
中。该甘特图包含以下范围：
 一个级别树链接，

左边的树包括图表中的事件中涉及到的用户、设备、连接与相关组件。 
 右侧有一个图表。

为下方的下属组件配置的一行，位于右侧图表内。该行内含有该组件的事
件。
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“Event History“ 对话框显示以下事件：
 状态的时间间隔

状态的时间间隔是一个显示时间间隔的彩色条纹，显示某个设备属性、某
个设备或某个连接保持设定状态的某个时间段。
彩色条纹通过以下颜色显示事件的状态：
– 红色

红色条纹显示事件状态为 “ 错误 ”。
– 黄色

黄色条纹显示事件状态为 “ 警告 ”。
– 绿色

绿色条纹显示设备无误差运转时间。
– 银色

银色条纹仅供用户、设备和连接使用。该条纹显示隶属于同一设备或
同一连接的下属设备的概况。

 应用程序事件 
“Event History“ 对话框在应用程序行中显示应用程序事件。应用程序事件
是应用程序相关信息， Industrial HiVision 比如用户注册时间等。 

 陷阱事件 
“Event History“ 对话框在组件行中显示陷阱事件。陷阱事件是从设备发送
到 Industrial HiVision 的信息，例如，不可达的设备或协议的更改。

 用户事件 
“Event History“ 对话框在与用户相关的行中显示 “User Intervention“ 类别
中的事件。

“Event History“ 对话框在一个图标上显示在同一时间或大约同一时间发生的
事件数。将鼠标指针移到该图标上，可以文本方式显示事件。当图标上显示
的事件数大于 1 时，右键单击该图标并选择 “Details“ 选项。列表还显示事件
出现的时间。

要在 “Event History“ 对话框中显示事件，请按照下列步骤操作：
 在带有事件筛选器的下拉列表中选取一个您想要显示的事件筛选器。
 点击按钮 “Event History“。
要在 “Event History“ 对话框中显示仅与指定组件有关的事件，请按照下列步
骤操作：
 在 “Map“ 选项卡中选择组件。
 点击按钮 “Filter Events for Object“。
 点击按钮 “Event History“。
122
User Manual Industrial HiVision

Release 8.1 12/19



程序的界面 4.8 事件列表
如果事件图标显示了在同一时间或大约同一时间发生的许多事件，则可以使
用 “Zoom Time Scale“ 滑块延长时间线。如果拉伸时间线，则 “Event 
History“ 对话框将列出事件。“Zoom Row Height“ 滑块增加和减少行的高度。

提示 : 当您从 “Map“ 选项卡中删除组件时，该组件产生的事件将保留在事件
列表中。但是，Industrial HiVision 从 “Event History“ 对话框中删除事件。

以下列表包含 “Event History“ 对话框中复选框和按钮的描述：
 “Fit all Events“

使用该按钮可以调整行宽，以显示事件的开始时间与结束时间。
 “Export“

该按钮允许您将 “Export“ 对话框导出为 PDF 文件。
 “Export all Pages“

使用该复选框可以限制输出工作，即只能输出当前屏幕上显示的组件。

图 30: 对话框 “Event History“
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 举例
您会注意到该 “Map“ 选项卡向下显示了一些链接。要查明链接状态更改
的时间，可以在 “Event History“ 对话框中显示设备和连接。要过滤
“Event History“ 与设备和连接有关的事件，请按照下列步骤操作：
 在 “Event History“ 部分中，从下拉列表中选择 “User Defined...“ 功

能。Industrial HiVision 打开 “User Defined...“ 对话框。
 在 “User Defined...“ 对话框中输入设备信息。

提示 : 输入符号时请将鼠标指针悬停在输入区。

– 在 “ID“ 行中，从下拉列表中选择 “in“，然后在文本字段中输入一个
星号 (*)。

– 在 “Ack.“ 行中，从下拉列表中选择 “in“，然后在文本字段中输入一
个星号 (*)。

– 在 “Type“ 行中，从下拉列表中选择 “=“ 和 “Warning“。
– 在 “Category“ 行中，从下拉列表中选择 “=“ 和 “Status Worse“。
– 在 “Time“ 行中，从下拉列表中选择 “Before“ 并输入当前时间。
– 在 “User“ 行中，从下拉列表中选择 “=“ 和 “ * ” 。
– 在 “Source“ 行中，从下拉列表中选择 “=“ 和和设备的 IP 地址。
– 在 “Component“ 行中，从下拉列表中选择 “=“ 和 “ * ” 。
– 在 “Message“ 行中，从下拉列表中选择 “=“ 和 “ * ” 。

 要将过滤器应用于 “Event History“ 日志，请单击 “OK“ 按钮。Industrial 
HiVision 只显示符合筛选值的日志日志条目。

 要打开 “Event History“ 对话框，请单击 “Event History“ 按钮。
 “Event History“ 对话框显示状态恶化的时间。
现在既然您已知悉设备连接断开的时间，您便能查明原因了。
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4.9 使用键盘进行导航

4.9.1 在表格中进行导航

可以使用箭头键在表格内上、下、左、右移动表字段。 
使用 Tab 键可以移动到下一个表字段。
使用 Ctrl+Tab 可以切换到表格之外的下一个字段。

4.9.2 切换范围

使用 Tab 键可以切换到程序界面中的下一个框架。
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5 创建网络规划

网络监测开始时，将在网络管理界面上显示网络图像。Industrial HiVision 可
以根据不同的标准同时查看网络的不同显示变化。
例如可以根据如下标准创建网络规划：
 塑造实际的物理环境，
 显示最重要的连接节点， 
 遵循网络的拓扑结构，等等。
可以通过复制或快捷方式在多个网络规划中显示设备。

网络显示可以分为以下几个要素：
 设备识别
 设备分配
 设备显示，
 设备连接。

网络结构通常都在不断变化中。它包括以下活动：
 移除设备 
 添加新设备并随后
 创建新连接。
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5.1 设备识别

在设立网络规划的第一步中，#Industrial HiVision 可帮助您识别网络中安装
的以下设备 ( 参阅页 328 “Basics”)：
 Hirschmann BAT 系列
 Hirschmann OCTOPUS 系列
 Hirschmann 管理型 GECKO 系列
 Hirschmann 管理型导轨交换机
 Hirschmann MICE 系列
 Hirschmann Power MICE 系列
 Hirschmann MACH 系列
 Hirschmann GREYHOUND 系列
 Hirschmann GES-24TP Plus
 Hirschmann EAGLE 系列
 Hirschmann 导轨交换机系列
 Hirschmann 冗余开关系列
 Hirschmann LioN-P 系列
 Hirschmann LioN-R 系列
 Hirschmann LION 系列
 Hirschmann 嵌入式以太网系列
 Hirschmann OWL 系列 
 Hirschmann Dragon PTN 系列
 Hirschmann Dragon MACH 4000 和 4500
 Hirschmann Bobcat 系列
 Magnum 5RX
 Magnum 6K
 Magnum 10KT
 Magnum DX line
 Magnum 10ETS
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 Magnum 10RX
 Magnum 12KX
 Schneider Electric TCSESM、TCSESM-E、TCSESB 系列
 Schneider Electric TCSEFEC 系列
 Schneider Electric Nxx 系列
 Selectron Systems ESM 系列
 Selectron Systems ERT 系列
 ABB AFF、AFS、AFR 系列
 INSYS MoRoS Modem, ISDN, HSPA, UMTS, GPRS, LAN, MI
 Meinberg LANTIME GPS、M300、M600
 Advantech SNMP-1000
 打印机 EPSON FX-2190、ACULASER C100N
 支持 SNMP 功能的设备
 Windows PC
 带 ICMP 的设备 (Ping)

提示 : Industrial HiVision 基于标准 MIB II 并支持 SNMP 功能的第三方设备。
因此，可将 Industrial HiVision 的现有接口 ifTable （包括 VLAN 或路由器
接口）作为单独的端口显示。

 请在 Configuration > Preferences > Basics > Discover Devices 之中选出您最偏好
的一种设备识别方法。

Industrial HiVision 提供四种设备识别方法：
 通过触发事件识别设备

接通电源后设备将发送一个接通信息到设备内的网络管理站。该信息将提
取 Industrial HiVision 中有用的部分，并在已登陆的目标文件夹内显示设
备 ( 参阅页 328 “Basics”)。
该方法适用于对重要的网络进行不间断监测。

 借助 HiDiscovery 协议识别设备
HiDiscovery 协议可借助 MAC 地址与网络中 HiDiscovery 协议已激活的设
备进行通信。
此方法帮助识别网络中尚未分配有效 IP 地址的设备。
Industrial HiVision 在已登陆的目标文件夹内显示设备 ( 参阅页 328 
“Basics”)。
需要将新安装的网络投入运行，或为新设备分配 IP 地址时可选择这种方
法。
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 根据明确的 IP 地址范围识别设备
在明确的 IP 地址范围内，Industrial HiVision 通过网络扫描，定期向配有 
IP 地址的设备发送 Ping 请求和 SNMP 请求。Industrial HiVision 将在目标
文件夹内为此 IP 地址范围定位所识别的设备。确定 IP 地址范围时，可为
每个 IP 地址范围分配一个目标文件夹 ( 参阅页 328 “Basics”)。
此方法适用于监测正在运行的网络。请根据您的网络带宽调整询问频率。 

 识别新创建的设备
Industrial HiVision 使您能够可以手动创建某个设备，并为该设备分配一
个 IP 地址。添加设备后，Industrial HiVision 将向该 IP 地址发送一个请
求，以进行识别 ( 参阅页 142 “ 添加新设备 ”)。 

 识别 IP 地址列表中的设备
Industrial HiVision 可以通过文本文件或 Microsoft Excel 文件 （CSV），
对 IP 地址进行扫描。通过对话框 “Create Devices from List“，可以查找文
件并上传至 Industrial HiVision。如果在列表中查找不到某个设
备，Industrial HiVision 则该设备在拓扑图中作为通用设备显示。 ( 参阅
页 267 “Devices from List”)

5.1.1 设备图标

Industrial HiVision 扫描了您的网络之后，选项卡 “Map“ 会显示扫描结果。选
项卡用不同的图标来显示通过网络扫描识别出的各个设备。如果某个设备已
被分配了 PSM，则选项卡中会显示该设备的 PSM ；如若还未分配 
PSM，Industrial HiVision 则会显示该设备的状态。
以下列表包含对 Industrial HiVision 图标的描述：
 小黄箱 – 

该设备仅对 Ping 请求作出回应。
 小蓝箱 – 

该设备对 HiDiscovery 请求作出回应，不过该设备不是 Hirschmann-Gerät
设备。

 Hirschmann- 图标 – 
该设备对 HiDiscovery 请求作出回应。Industrial HiVision 根据 MAC 地址
查找到该设备，该设备是一个 Hirschmann 设备，不过它不具有 PSM 模
块。
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 “ 陌生绳结 ” 图标 – 
某个用户将该设备手动输入到 Industrial HiVision 中。不过与该设备无法
连接。

 PSM 开关 – 
该设备虽然对 SNMP 请求作出回应，Industrial HiVision 不过它不知道 
SNMP 对象的 ID。

 Windows 电脑 – 
该设备是一台以 Windows 操作系统运行的电脑

 Linux 电脑 – 
该设备是一台以 Linux 操作系统运行的电脑

5.1.2 HiProvision

HiProvision 可让您监视 Dragon PTN 设备，隧道和在隧道中运行的服
务。Industrial HiVision 中显示的 HiProvision 图标代表 Dragon PTN 设备，
隧道和服务。
您可以从 Hirschmann 文档网页上下载 HiProvision 手册：
www.doc.hirschmann.com

为了让您在 Industrial HiVision 中添加 HiProvision 图标，请按照以下步骤操
作：
在 HiProvision 中执行以下步骤：
 导航到 Dashboard> Tools> Add-ons> SNMP-Northbound> 

Configuration 选项卡。
 在 Agent 框架中，选中 Enabled 复选框。
 在Agent> IP Address & Port字段中，键入运行HiProvision的PC的IP地

址。
 您可以使用 Port 字段来设置用于 Industrial HiVision 通信的 SNMP 端口。

默认端口设置为 161。这也是 Industrial HiVision 的默认设置。
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 在 Agent 框架中，选中 SNMP v3 复选框。
 配置 admin 或 user 参数。配置设备管理的 admin 参数。user 参数仅允许

您监视设备。
– 在 Authentication Protocol 下拉列表中，选择所需的身份验证类

型。
Industrial HiVision 使用 Md5 或 sha。

– 在 Encryption Protocol 下拉列表中，选择所需的加密类型。 
Industrial HiVision 使用 None, Des, 或 Aes128。

在 Industrial HiVision 中执行以下步骤：
 打开 “Map“ 选项卡。
 要将新设备添加到拓扑，请右键单击 “Map“ 选项卡中的空白处。 

 在下拉列表中，选择 New > Device。
 在IP Address > Device > IP Address 字段中，键入运行HiProvision 的PC的

IP 地址。
 您可以使用 SNMP Port No 字段来设置用于 HiProvision 通信的 SNMP 端

口。默认端口设置为 161。这也是 HiProvision 的默认设置。
 在 Properties > Name 字段中，输入 HiProvision。
 点击按钮 “OK“。

Industrial HiVision 在 “Map“ 选项卡中显示 HiProvision 图标。 

以下工作步骤说明了如何监视 Industrial HiVision 中的 “Tunnel List“。您以相
同的方式监视 “Service List“。 
 在HiProvision中创建2个隧道，并将它们分别命名为 Tunnel 1和 Tunnel 

2。
 验证 “Edit Mode“ 是否处于活动状态。
 双击 “Map“ 选项卡中的 HiProvision 图标。
 双击 “List“ 选项卡中的 “Tunnel List“ 条目。
 在 “Properties“ 对话框中，点击 “Status Config“ 复选框。
 输入 ( 参阅图 32) 中显示的值。
 要添加其他行，请使用 “New“ 按钮。
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图 32: HiProvision 隧道的状态配置

只要条目仅包含 Tunnel 1 和 Tunnel 2，“List“ 选项卡中的 “Tunnel List“ 条
目就会显示一个绿色的选中标记。如果 Tunnel 1 或 Tunnel 2 出于任何原因
中断，则 Industrial HiVision 将显示带有错误的条目。如果条目包含另一个
值，则 Industrial HiVision 会将条目显示为警告。
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5.2 分配设备图标

为了在详细显示中更清楚地识别设备，Industrial HiVision 您可以为不同的设
备类型分配不同的图标，作为该设备类型的默认图标。

图 33: 设备图标

在交付状态中，Industrial HiVision 可以识别某些设备类型 （比
如 Hirschmann 设备）并为其分配合适的设备图标。
您可以向 “Preferences“- 对话框中更多的设备类型分配图标。在识别设备
时，Industrial HiVision 可借助以下分类标志来区分不同的设备类型 ( 参阅
页 367 “Device Icon”)：
 系统对象标识符 (SysOID)

SysOID 标明 MIB 变量。在 SysOID 中，每个制造商都有一个制造商 
MIB，您可以根据不同的图标来区分各个制造商的设备。在交付状态
下，Industrial HiVision 已经具有制造商 Hirschmann、施耐德、西门子、
罗克韦尔和思科的 SysOID。

 EtherNet/IP
与系统对象标识符类似，EtherNet/IP 设备也包含相应制造商和产品的信
息。您可以使用 Industrial HiVision 为设备层级分配图标。

 Modbus/TCP
与系统对象标识符类似，Modbus/TCP 设备也包含相应制造商和产品的
信息。您可以使用 Industrial HiVision 为设备层级分配图标。

 MAC 地址
MAC 地址中也包含相应制造商的信息。根据制造商的编码深度，您可以
为制造商层级直到设备类型层级分配图标。
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5.3 设备分配

5.3.1 创建网络规划

创建新的网络规划时，需要在文件夹列表中新建文件夹。

 使用鼠标右键点击地球图标，并在下拉菜单中选择 New > Folder。

 使用鼠标右键点击新建文件夹，并在下拉菜单中选择 “Properties...“。使
用您需要创建的网络规划的名称命名此文件夹。
双击此文件夹，或选中后按 F2 键即可重命名此文件夹。名称输入后按下
Enter 键。

 使用鼠标右键点击新建文件夹，并选择 “Scan Ranges“ （扫描范围）。在
“Scan Ranges“ （扫描范围）对话框中可以定义 IP 地址范围。Industrial 
HiVision 将在此文件夹中显示此 IP 地址范围中新识别出的设备及其 IP 地
址。

图 34: 网络规划的结构示例
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5.3.2 在网络规划中移动设备

将新识别出的设备移到网络规划文件夹中。 

 选中设备。

 点击选择的设备，并将其移到文件夹列表的网络规划文件夹中。 

5.3.3 添加新设备

如果您希望在网络中安装设备之前已输入网络规划，请先在详细显示中定位
新设备。

 使用鼠标右键点击新建文件夹，并在下拉菜单中选择 New > Device。

 在选项卡 “IP Address“ 中输入将放入的设备的 IP 地址。
如果选择了 Device > Scan，Industrial HiVision 将在点击 “OK“ 关闭此对话
框后自动扫描该设备的网络。
如果您选择 Device > Generate，Industrial HiVision 会将该对话框添加到设
备的模块和端口中去。
如果新设备已通过 NAT 路由器从网络管理站断开，则 Industrial HiVision 
可以通过 NAT 路由器的端口转发与新设备进行通信。
然后在选项卡 Industrial HiVision 中输入 与新设备进行通信的 NAT 路由器
的 “IP Address“ 和端口的 SNMP 端口编号。在 NAT 路由器的 NAT 列表
中输入端口的组合和新设备的 IP 地址。
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图 35: 输入新设备的 IP 地址

 在选项卡 “Properties“ 中输入
 您所需的名称以及 
 状态转发 / 状态测定 （如果需要） 

( 参阅页 285 “ 文件夹 / 设备的属性 ”)。

 选中设备，然后按下键盘上的 “F5” 键，或使用鼠标右键点击设备并选择 
“Refresh“ (Refresh)，Industrial HiVision 即可识别网络中的设备并检索数
据。
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5.3.4 在详细显示中排列设备

帮助您在详细显示中使设备对齐 Industrial HiVision

 使用鼠标右键点击详细信息列表并选择 “Auto Layout“ (Auto 
Layout)，Industrial HiVision 可在详细显示中根据其连接重新定位对象。

 使用鼠标右键点击详细信息列表并选择 Drawing > Line Up all Objects 
(Drawing:Line Up all Objects)，按行排列设备。

 在详细信息列表中选择多个对象，使用鼠标右键点击详细信息列表并选择
Drawing > Align Tops/Align Bottoms/Align Left/Align Right (Drawing:Align 
Tops/Align Bottoms/Align Left/Align Right)，按行或按列排列选中的对
象。
Industrial HiVision 在此选择最外侧的对象定位每行 / 每列的位置。 

 在详细信息列表中选择多个对象，使用鼠标右键点击详细信息列表并选择
Drawing > Center Horizontally/Center Vertically (Drawing:Center 
Horizontally/Center Vertically)，按行或按列排列选中的对象。
Industrial HiVision 在此选择最外侧的对象定位每行 / 每列的位置。 

提示 : 如果已通过移动对象组将单个对象从可见区域移出，但此对象依旧包
含在文件夹列表中，则可以使用鼠标右键点击详细信息窗口并选择 “Auto 
Layout“ (Auto Layout) 或 Drawing > Line Up all Objects(Drawing:Line Up all 
Objects) 再次出现在可见区域中的对象。

5.3.5 为设备和端口命名

在文件夹框架或是在详细显示中显示的设备 / 端口名称 Industrial HiVision，
取自该设备 / 端口自身的 Industrial HiVision“Properties“- 对话框。如果未输入
名称，则 Industrial HiVision 将在设备上显示管理 IP 地址并在一个端口上显
示模块 / 端口号。

 使用鼠标右键点击设备 / 端口，选择 “Properties“(Properties) 并输入名称。
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使用配置设置 ( 参阅页 388 “Device/Port Names”) 可以自动承接 
 设备名称 / 端口名称以及 
 域名服务器 (DNS) 或私人主机文件的设备名称。

5.3.6 设备复制

为了表示不同的监测方案，可以使用 Industrial HiVision 复制设备。为此，您
可以在对话框 “Properties“ 中为复制的设备输入不同的状态配置。Industrial 
HiVision 每个设备都有一份数据集。每个副本也都有自己的数据集。该数据
集的内容来自于原件的复制。 

两种监测方案的例子：
其中一个方案中只能显示您认为至关重要的事件。设备 A 上的端口 3 连接中
断即属于重要的事件。
在另外一种监测方案中您只希望显示与维护相关的事件。设备 A 的冗余电源
故障即属于与维护相关的事件。
 为了实现这个目标，您可以在文件夹列表内创建两个新的文件夹，并将它

们命名为 “ 重要 ” （Critical）和 “ 维护 ” （Maintenance）。 
 使用鼠标右键点击设备 A，并选择 “Copy“ (Copy)。 
 在 “ 维护 ”（Maintenance）和 “ 重要 ”（Critical）文件夹中添加设备 A 的副

本。
 双击 “ 重要 ” （Critical）文件夹进入组件层。 

双击端口 3 进入详细设置层。 
 在对话框(参阅页 293 “组件详细设置的属性”)中输入对详细信息“Link“的相

关设置。
 在 “ 维护 ” （Maintenance）文件夹中进行相同操作。
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5.3.7 Paste as new Network

如果使用 “Copy“(Copy)/“Paste“(Paste) 功能，Industrial HiVision 将添加原始
设备的副本至所选文件夹。原始设备和副本设备针对的是同一设备。
如果使用 “Copy“(Copy) 和 “Paste as new Network“(Paste as new network 
new network) 功能，Industrial HiVision 将复制设备并将新的设备添加至所选
文件夹。复制的设备是另一台设备。

提示 : “Paste as new Network“(Paste as new network new network) 功能不
适用于以下文件夹：
 “New Devices“
 “Rogue Devices“

“Paste as new Network“(Paste as new network new network) 功能能够在设
备和连接相同、而 IP 地址不同的相同网络下使用。
除了连接之外，“Paste as new Network“(Paste as new network new network) 
功能还可以复制设备参数。“Paste as new Network“(Paste as new network 
new network) 功能使您能够设定复制到新网络设备的参数。您可以通过以下
对话框键检查复制的参数：
 “Copy Device Credentials“

此功能复制对话框 Preferences > Device Credentials 参数。
 “Copy Event Forwarding“

此功能复制对话框 Preferences > Event Forwarding 参数。
 “Copy Event Actions: Alarms“

此功能复制表格 Preferences > Event Actions > Alarms 参数。
 “Copy Tasks and Schedules“

此功能复制对话框 Configuration > Scheduler 参数。
针对此功能存在以下前提条件：
 Industrial HiVision 处于 “Edit Mode“(Edit Mode) 中。
 Industrial HiVision 识别到您想要进行复制的设备。
 想要为新网络复制的设备位于同一文件夹中。
 您可以在原始设备上配置连接、轮询和状态配置。
 您只能将原始网络用于具有相同设备和连接的其他网络。
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 示例配置：
以列车网络为例。比较列车网络时，您会发现它们基本相同。复制列车网
络，更改 IP 地址，然后将该网络用于另一辆列车。
针对此示例存在以下前提条件：
 您已在 Industrial HiVision 识别到并配置了 ?? A 的设备。
 您想要复制的设备位于同一文件夹中。
 您已创建 ???? 文件夹。
 ?? A 文件夹是 ???? 文件夹的子文件夹。
在以下示例中，您复制了 ?? A 文件夹，想要将其用作 ?? B 的网络。要使
用 “Copy“ 和 “Paste as new Network“ 功能，请如下进行操作：
 在 ???? 文件夹中创建子文件夹 ?? B。

 打开 ???? 文件夹的选项卡 “Map“。
 请鼠标右键点击对话框中的空白区域。
 在下拉列表中选择选项 New > Folder。
 请在 ?? B 中输入新文件夹的名称。

 请复制 ?? A 文件夹中包含的、您想用于 ?? B 网络的设备。
 请打开 ?? A 文件夹的选项卡 “Map“。
 选择想要复制的设备。
 右键单击标记的设备。
 请在下拉列表 “Copy“ 中选择。

 将 ?? A 文件夹中的设备添加至 ?? B 文件夹。
 请打开 ?? B 文件夹的选项卡 “Map“。
 请鼠标右键点击对话框中的空白区域。
 在下拉列表中选择 “Paste as new Network“。

 为 ?? B 的设备分配新的 IP 地址。
 请双击对话框 “Copy Devices“ 第一行中的单元格 “Source IP 

Address“。
 在 Edit > IP Address of the Copy 栏中，输入 ?? B 网络的第一个 IP 地

址。
 请点击 “OK“ 按键。

对话框 “Copy Devices“ 现在显示 “IP Address of the Copy“ 列中
?? B 网络的第一个 IP 地址。

 为自动计算其他设备的 IP 地址，请点击 “Calc with Offset“ 按键。
Industrial HiVision 计算偏移量如下：
IP Address of the Copy = Source IP Address + ????????? IP ??

 为选择想要复制到新设备的参数，请选中对话框底部的复选框。
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 为确保Industrial HiVision 在关闭对话框 “Copy Devices“后会自动扫
描网络，请选中复选框 “Scan Devices after Copy“。

 请点击 “OK“ 按键。
Industrial HiVision 显示 ?? B 的设备以及您在对话框 “Copy 
Devices“ 中输入的 IP 地址。

提示 : 创建新的 IP 地址时，请确保它的唯一性。Industrial HiVision 显示带
有红色背景的重复 IP 地址。

以下是 “Type“(Type) 列中符号的定义：
 ：手动确定 IP 地址。
  ：计算 IP 地址。

5.3.8 带有多个 IP 地址的设备

Industrial HiVision 可以使用多个 IP 地址表示设备，比如一台路由器作为一
台设备显示。在设备属性对话框 “Properties“ 选项卡 “MAC/IP Addresses“ 中
选择为设备分配哪个 IP 地址。 
为了确保分配地址的唯一性，Industrial HiVision 为每台设备都定义了精确的 
IP 地址。如果您想为设备定义其他的 IP 地址，请在界面上删除设备，并使
用所需的 IP 地址再次创建设备。更新设备后，Industrial HiVision 将使用此 IP 
地址定义设备。
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5.3.9 创建快捷方式

为了能够在多个网络规划中显示同一设备，可以使用 Industrial HiVision 创建
设备的快捷方式。如果您想将网络分成几个文件夹，则这种快捷方式非常有
用。如果一台设备将两个网络规划彼此连接在一起，您就可以在两个网络规
划中显示该设备。相对于副本，快捷方式将访问原始的数据集。原件的每个
变化都将反映在快捷方式中。
除了设备的快捷方式，还可以为组件创建快捷方式。

 复制您需要创建快捷方式的对象。

 使用鼠标右键点击需要创建快捷方式的位置，并选择 “Paste As Link“ 
(Paste As Link)。
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5.4 设备连接。

5.4.1 自动显示拓扑

使用 “Auto Topology...“ 功能，是显示设备之间连接的最简单的办法 Industrial 
HiVision。

 请选择 Edit > Auto Topology... (Edit:Auto Topology)。

 如果您想要在自动拓扑识别对话框中对于 ( 参阅页 282 “Auto 
Topology...”)Industrial HiVision 作出选择，请点击 “Auto 
Topology...““OK“。

接着 Industrial HiVision 将会根据连接询问设备。Industrial HiVision 将在界面
上显示已识别的连接，并开始监测连接状态和网络负荷。 

Industrial HiVision 将在无线局域网 (WLAN) 中以虚线显示无线连接。由于接
入站可移动，因此从一个接入点漫游到另一个接入点是十分正常的过程。因
此 Industrial HiVision 未将连接状态包含在无线连接的状态配置中。 
对接入点的状态测定进行轮询之后，Industrial HiVision 断定通往毫无回应的
接入点的连接已中断。
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5.4.2 手动连接设备

根据您的需要排列好设备之后，即可在设备之间添加连接。

 点击设备图标的中心位置。再次点击并按住鼠标按钮，将光标移动到您需
要连接设备的图标上。

5.4.3 改变连接线的形状

Industrial HiVision 可以改变连接线的形状。比如可以将 HIPER 环真实显示
为环形。

 选择连接，折叠或弯曲连接线。根据连接的形状和所作标记，有下列选项
可供使用 （见气泡帮助）：
 单击一次句柄添加一个锚点。 
 通过重新选择连接在 “Add anchor point” （添加锚点）和 “Change 

shape of curve” （改变弯曲形状）之间切换。 
 双击删除锚点。 
 利用句柄改变弯曲形状。 
 单击锚点拉直连接件。 
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图 36: 改变连接的形状
– 左侧：改变弯曲形状
– 右侧：增加锚点

5.4.4 确定线条的粗细

根据所选择的背景图，连接线可能会融入背景。Industrial HiVision 允许您改
变连接线的粗细。这样就可以在背景中很好地突出连接线。
可以使用菜单 Preferences > Display > Device ( 参阅页 364 “Appearance”) 
(Preferences:Display:Device) 设置线条粗细。
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5.4.5 其他连接

与连接设备一样，使用 Industrial HiVision 还可以对文件夹和组件进行连接，
但图标与文本除外。下面的插图 ( 参阅图 37) 为连接一个文件夹的示例 。

图 37: 连接一个文件夹

5.4.6 识别与另一个文件夹的连接

Industrial HiVision 使用一面旗子来表示与设备或与当前文件夹之外的文件夹
之间的连接。旗子旁边有关于连接指向的提示。如果连接有多个目
标，Industrial HiVision 将汇总这些目标，气泡帮助将向您显示这些目标。

双击旗子
 直接进入目标端口 （如果只连接了一台设备）。
 打开下拉菜单 （如果旗子指向多个目标）。下拉列表显示连接目标。选择

您想要进入其端口的连接。
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图 38: 旗子作为连接标记

5.4.7 确定连接属性

请确定连接属性。

 使用鼠标右键点击地球图标，并在下拉菜单中选择 “Properties...“ ( 参阅
页 300 “ 连接的属性 ”)。

 在选项卡 “Connection“ 中输入某条线路连接的端口。 
点击树形结构，选择需要连接线的相应设备上的端口。

 同样，在选项卡 “Connection“ 中，在 “Monitor“ 下方，选择需要监测的属
性。在基本设置中 Industrial HiVision 自动监测连接中断、网络负荷和端
口冗余。

图 39: 连接的监控状态
N - 无连接监控
A - 连接监控激活
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5.4.8 连接类型

为了便于识别，Industrial HiVision 将根据其特性以不同方式显示连接：

5.4.9 连接介质的显示

Industrial HiVision 可以根据连接末端的图标来识别连接介质 ( 参阅页 300 
“Connection”)。

显示 含义
正常连接

待机连接

断开的连接

无线连接

待机无线连接

断开的无线连接

表格 11: 连接类型

显示 含义
铜
玻璃纤维
Wireless （无线），锯齿线
Unmanaged （未管理）
Unknown （未知）

表格 12: 连接介质的显示
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5.5 与时俱进的网络

您的网络基本不会处于静止状态。通常需要不时添加新设备，移除设备或在
其他位置重新插入设备。

5.5.1 添加设备 HiDiscovery

使用工具栏中的 HiDiscovery 按钮可以轻松添加设备。

 点击工具栏中的 HiDiscovery 按钮。
Industrial HiVision 启动一个网络查询。
新识别的、Industrial HiVision 已分配了 IP 地址的设备，Hirschmann 放在
该 IP 地址范围的目标文件夹中 “New Devices“。
新识别的、Industrial HiVision 已分配了 IP 地址的设备，Hirschmann 放在
该 IP 地址范围的目标文件夹中 ( 参阅页 328 “Basics”)。

如前所述将新设备移入网络规划文件夹，并建立连接。

 分配 IP 地址
使用 HiDiscovery 添加了新设备之后，可使用 Industrial HiVision 为设备
分配地址 ( 参阅页 407 “IP Configuration”)。
 使用鼠标右键点击设备，并选择 “IP Configuration“ (IP 

Configuration)。使用 “IP Configuration“- 对话框，输入下列参数
– 设备名称，
– IP 地址
– 网络掩码
– 网关 IP 地址。
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5.5.2 使用网络扫描添加设备

使用工具栏中的 “Scan Network“__ 按钮，添加已经配置了 IP 地址的设备。

 点击工具栏中的 “Scan Network“- 按键。
Industrial HiVision 根据设置，在 “Basics” on page 328 中间发出网络请
求。Industrial HiVision 将在相应地址范围的目标文件夹中显示新识别出的
设备 “Basics” on page 328。

如前所述将新设备移入网络规划文件夹，并建立连接。

5.5.3 手动添加设备

添加新设备的另一种方法是手动添加设备 ( 参阅页 142 “ 添加新设备 ”)。

如前所述将新设备移入网络规划文件夹，并建立连接。

5.5.4 Hirschmann 设备的调试

Industrial HiVision 帮助简化 Hirschmann 设备的调试工作。您可以在网络管
理站中为 Hirschmann 设备进行除安装外的所有调试工作：

 通过使用 Hirschmann 来对 HiDiscovery 设备进行确认 ( 参阅页 134 “ 设备
识别 ”)。

 请配置 IP 参数 ( 参阅页 407 “IP Configuration”)。

 请输入触发事件的目标地址 ( 参阅页 409 “Trap Destination”)。
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 使用网络界面更改新设备的 SNMP 密码。

 在 Industrial HiVision ( 参阅页 376 “ 高级 ”) 中输入新的 SNMP 密码。

5.5.5 设备监测中断

为降低网络负荷，Industrial HiVision 有两种方法可以中断单个设备和文件夹
的监测：
 将设备移入文件夹 “Unused Devices“。
 使用鼠标右键单击该设备图标，并从下拉列表 “Unmanage“ 中选择。

Industrial HiVision 将设备显示变为灰色。

5.5.6 移除设备

要移除设备，按以下操作：

 使用鼠标右键单击该设备图标，并从下拉列表中 (参阅页 103 “文件夹列表
”) 选择 “Delete“。
Industrial HiVision 使您可以删除设备或将其移入 “Unused Devices“ 文件
夹。
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5.5.7 设备更换

为了胜任时代要求，将逐渐用具有新功能的新设备替代数据网络中现有的设
备。
面对这种情况，Industrial HiVision 提供了一种能够将 Classic 设备的配置在
文件路径中另存为 XML 文件的转换工具。
支持该功能的设备列表请参见的 “ 问与答 ” 页面 Hirschmann：
https://hirschmann-support.belden.com/kb/articles/how-can-i-migrate-the-
configuration-of-a-powermice-to-msp
 标记 Classic 设备，即想用 HiOS 设备替换的设备。
 请选择 Configuration > MultiConfig ™。
 在 MultiConfig ™对话框中选择： 

Device Settings > Advanced > Configuration Saver
 检查路径、文件名，并点击 “Write“ （写入）。

Industrial HiVision 将配置保存在 XML 格式的文件中。
在下一个步骤中，将保存的 Classic 设备配置迁移到事先安装和在网络计划
中创建的 HiOS 设备上。
 标记 HiOS 设备，即想应用 Classic 设备配置的设备。
 请选择 Configuration > MultiConfig ™。
 在 MultiConfig ™对话框中选择： 

Device Settings > Advanced > Configuration Migrator
 请在文件选择对话框中选择事先保存的 XML 文件。 
 检查 Industrial HiVision 记录迁移结果的日志文件的路径和文件名，并点

击 “Write“ （写入）。
Industrial HiVision 将 Classic 设备的迁移配置传输到 HiOS 设备上。
如果对话框中的 “Status“ （状态）栏显示，HiOS 设备拒绝了配置数据，
则可以在日志文件中找到可能原因的提示。
日志文件的路径请参见 Configuration > Preferences > Advanced > Load/Save > 
Configuration Saver。
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5.6 网络文件

Industrial HiVision 准备了一系列功能，以支持您处理您的网络文件。

5.6.1 保存 Industrial HiVision 项目

通过 Industrial HiVision， 您可以将 Industrial HiVision 的当前网络数据和配置
保存到项目文件中 （参见 “Save” on page 269 和 “Save as...” on page 270）

5.6.2 保存报告数据

Industrial HiVision 将报告功能 ( 参阅页 316 “ 报告 ”) 的数据记录在项目以外
的一个单独的数据库中。您可以在安装目录的子目录 __ 中找到这个数据库
report_db。
该子目录中可为多个项目保存报告数据库，Industrial HiVision 会为每个项目
都创建一个子目录：
<INSTALL_DIR>/report_db/<UUID>/pm.h2.db

这些 UUID 位于核心信息的帮助菜单内。
160
User Manual Industrial HiVision

Release 8.1 12/19



创建网络规划 5.6 网络文件
5.6.3 导出详细显示的内容

Industrial HiVision 可以导出详细显示的内容 ( 参阅页 271 “Export...”)。

 请选择 File > Export... (File:Export...) 并在 “Save“ (Save) 窗口中选择文件类
型。

5.6.4 打印详细显示的内容

Industrial HiVision 可以打印详细显示的内容。

 请选择 File > Print。
Industrial HiVision 将生成一个包含列表内容的临时 PDF 文件，并使用安
装在管理站中的 PDF 显示程序 （如 Acrobat Reader）打开 PDF 文件。

5.6.5 导出事件列表 （Export Events）

Industrial HiVision 允许您完全导出事件列表 ( 参阅页 272 “Export 
Events...”)。

 请选择 File > Export Events... (File:Export Events...) 并在 “Save“ (Save) 窗口
中选择文件类型。
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5.6.6 打印事件列表 （Print Events）

Industrial HiVision 允许您完整打印事件列表。

 请选择 File > Print Events。
Industrial HiVision 将生成一个包含列表内容的临时 PDF 文件，并使用安
装在管理站中的 PDF 显示程序 （如 Acrobat Reader）打开 PDF 文件。

5.6.7 创建设备文件

Industrial HiVision 允许您创建设备文件。创建设备文件时，Industrial 
HiVision 可为选择的每台设备生成一个 PDF 文件。PDF 文件中包含设备及
其设置的说明。

 在详细信息窗口中选中需要创建文件的设备。

 在菜单栏中选择 Edit > Device Documentation > Document Selected Devices 
(Edit:Device Documentation:Document Selected Devices) 或使用鼠标右
键点击所选中的设备，并选择 “Document Selected Devices“(Document 
Selected Devices)。

 在窗口 “Choose a directory for placing device documentation files“ 中确定
您要存放 PDF 文件的文件夹，Industrial HiVision 并点击 “Select“。

在这一文件夹中，为每个选定的设备写一个名为 Industrial HiVision 的 PDF
文件 nventory_<IP address>.pdf。
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5.6.8 打印或导出状态配置

Industrial HiVision 可以打印或导出状态配置 ( 参阅页 396 “Status 
Configuration”)。 

 请选择 Configuration > Status Configuration。

 点击 “Print“ （写入）。
Industrial HiVision 将生成一个包含详细显示内容的临时 PDF 文件，并使
用安装在管理站中的 PDF 显示程序（如 Acrobat Reader）来打开该 PDF 
文件。

 点击 “Export“ （写入）。
Industrial HiVision 可以如下形式导出列表。
 PDF 文件
 HTML 文件
 CSV 文件 ( 参阅页 469 “CSV 导出 ”)

5.6.9 Agent

Der Ordner “Agent“ befindet sich im erweiterten Gerätebaum im 
Ordnerrahmen. Der Ordner “Agent“ enthält die folgenden Informationen über 
das von Industrial HiVision entdeckte PSM-Gerät:
 “GVRP“ - zeigt den Status des GVRP-Protokolls an.
 “VLANs“ - zeigt die konfigurierten VLANs an.
 “LLDP Chassis ID“ - zeigt die Chassis-ID an.
 “LLDP System Name“ - zeigt den Gerätenamen an.
 “Number of Users“ - zeigt die Anzahl der angeschlossenen Geräte am 

Port an.
 “Base MAC Address“ - zeigt die MAC-Adresse des Geräts an.
 “Firmware Version“ - zeigt die laufende Firmware-Version an.
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 “Other Firmware Info“ enthält die folgenden Informationen über das PSM-
Gerät:
 “Backup Firmware“- zeigt die gespeicherte Backup-Firmware an.
 “Stored Firmware“ - zeigt die aktuell gespeicherte Firmware an.
 “Boot Code Firmware“ - zeigt die gespeicherte Bootcode-Firmware an.

 “Interface“ enthält die folgenden Informationen über das PSM-Gerät:
 “Netmask“ - zeigt die konfigurierte Netzmaske an.
 “Default Gateway“ - zeigt das konfigurierte Standard-Gateway an.
 “MAC Address“ - zeigt die MAC-Adresse des Geräts an.
 “IP Address“ - zeigt die IP-Adresse des Gerätes an.

 “IP Address Conflict“ - zeigt den Status an, wenn ein IP-Adresskonflikt 
auftritt.
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6 配置网络

在 Industrial HiVision 中显示网络、设备和连接时，可以配置设备。
多配置功能 (MultiConfig™) 可帮助您在设备上和 Industrial HiVision 中进行配
置：
 台或多台设备
 种或多种设备属性，可用于所有设备
 种或多种设备详细设置，可用于所有设备

至少标记一台设备或一个属性，在菜单栏上选择 Configuration > MultiConfig ™，
进入 MultiConfig ™ 对话框。

提示 : 请注意对系统资源的影响 ( 参阅页 “ 对系统资源的影响 ” on 
page 230)。
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6.1 使用对话框

MultiConfig ™ 对话框包括三部分：
 基于 Web 的树形菜单界面
 对象区
 功能区

图 40: MultiConfig ™ 对话框概览 
1 – 菜单树 
2 – 对象区 
3 – 功能区 
4 – 操作元件
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6.1.1 菜单树的说明

在基于网络的界面风格的菜单树中，选择要配置的功能。在这里您可以找到
– 在设备上配置的功能
– 以及在 Industrial HiVision 中配置的检测属性

6.1.2 对象区的说明

对象区中包含为进行配置而在详细显示中选中的对象列表。
表格的第一行是表中对象状态的汇总。

对象后的状态图标含义如下：

符号 含义
Industrial HiVision 读取参数值，并在功能区中显示匹配性。

操作启动，但还没有开始。

Industrial HiVision 正在读取 / 传输参数值。

将鼠标指针移到图标上以获取异常信息。 
异常可能是指列表中包含隐藏项。写入数据时，这些隐藏项将丢失。
Industrial HiVision 可以访问设备。传输时缺失了一个或多个值。
将鼠标指针移到图标上以获取信息。
此对象不提供值。
与设备的连接中断。
将鼠标指针移到图标上，找出造成值读取 / 写入失败的原因。

表格 13: 状态图标的含义
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6.1.3 功能区的说明

Industrial HiVision 支持在功能区选择参数和操作。Industrial HiVision 选择可
配置的参数和由所选对象和所选功能形成交集的可执行操作。

由于参数的演示功能差异过大，请查看下面的应用示例 ( 参阅页 176 
“MultiConfig ™ 的应用示例 ”)。

您可以使用功能区左侧的选择框标记需要配置的参数。

选择框旁的图标 （如果有）具有下列含义 ( 参阅表格 14)。

为了简化重复设置的输入，Industrial HiVision 提供编辑预设置 （默认设置）
的功能 ( 参阅页 177 “ 使用预设置的联系人 ”)。

图 41: MultiConfig ™ 功能的预设置。

MultiConfig ™ 功能为各种不同类型的设备提供了多种输入方法，Industrial 
HiVision 允许在输入字段中输入任何值。

符号 含义
读取的对象具有与参数不同的值。

选中的对象无法提供此参数的值。

部分对象无法提供此参数的值。

表格 14: 选择框旁图标的含义 
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如果 Industrial HiVision 检测到输入不一致，Industrial HiVision 将以红色字体
显示。

为了加载或保存文件，请您在相应的对话框中输入一个路径来指示保存位
置。Industrial HiVision 识别绝对和相对路径。相对路径以 <Install-
Dir>/service 开始。

6.1.4 操作元件的说明

 “Write“
通过 “Write“(Write) 功能，Industrial HiVision 可以将选中参数的数据传输
至以下位置：
– 对象区列表中的任意对象。
– 对象区列表所包含的错误状态的对象中。
– 对象区列表所包含的任意错误状态的对象。
您可以在对象区下方以 “Write Mode“ (Write Mode) 选择您想要写入的对
象。
如果您使用这种方式将配置参数写入了设备，则它们将临时保存在设备
上。要存储设备的配置数据，请进行最后的配置步骤，将新配置保存在设
备上。

 “Reload“
使用 “Reload“ (Reload) Industrial HiVision 将列出对象区列表中所包含对
象选中参数的数据。
点击对象区中的对象，显示对象的参数值。

 “Cancel“
Industrial HiVision 可以使用 “Cancel“ (Cancel) 关闭对话框。无法保存最
后一个 “Write“(Write) 命令后写入的更改。
已经启动的操作  使 Industrial HiVision 至结束。

 “Help“
使用 “Help“ (Help) Industrial HiVision 将在相应页面打开在线帮助。
如果存在已打开对话框的示例 ( 参阅页 176 “MultiConfig ™ 的应用示例
”)，Industrial HiVision 将会打开示例页面上的在线帮助。
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6.2 MultiConfig ™ 的应用示例

根据您所选择的菜单项，在功能区中将有不同的显示。以下示例将为您介绍
不同的显示方式。

6.2.1 多个设备的相同联系人

您想在多台设备上输入相同的联系人，比如 Michael。
 请在详细显示中选择 “Map“(Map) 视图或设备显示的其他视图。
 选中您需要输入相同联系人的设备。
 使用鼠标右键点击选中的设备，并选择“MultiConfig™”打开 MultiConfig™ 

对话框。
 在 MultiConfig™-对话框中选择菜单树中的Device Settings > Basic Settings > 

System(Device Settings:Diagnostics:QR Code Generator).
然后，您将在对象区中发现相关设备的列表，并会在功能区中出现可配置
的参数。

 显示当前参数值
 在对象区中点击列表行显示设备参数值。
 在对象区列表中点击第一行 “All Objects“ (All Objects)，即可显示每个

设备上相同的参数值。

 在设备上写入联系人
 选中复选框 “Contact“(Contact)。
 在文本框 “Contact“(Contact) 中输入联系人的姓名，比如 Michael。
 点击 “Write“(Write) 按键，将更改传输和临时保存到设备。
 在菜单树中选择 Device Settings > Basic Settings > Load/Save，将更改永久

保存到设备。
176
User Manual Industrial HiVision

Release 8.1 12/19



配置网络 6.2 MultiConfig ™ 的应用示例
 在下拉列表 “Action“ 中选择 “Save to Device“。
 点击 “Write“ 按键。

 使用预设置的联系人
Industrial HiVision 支持将姓名设置为默认姓名，以便之后配置其他设备
时，不必重新输入姓名。
 选中复选框 “Contact“。
 在文本框 “Contact“(Contact) 中输入联系人的姓名，比如 Michael。
 选中复选框 “Edit Presets“。Industrial HiVision 将打开预设置列表。 
 点击预设置列表旁的 “New“(New) 按键，将所选参数设置为预设置。
 双击此条目的名称行给新的列表项输入有意义的名称，例如 “ 联系人 

Michael”。
 点击 “Write“(Write) 按键应用更改。
现在，您可以直接选择预设置的 “ 联系人 Michael”，而不用再输入姓名。
 选择所需的行，更改参数，并单击 “Set“ (Set) 来更改现有的表格项。
 取消功能区中的 “Edit Presets“ (Edit Presets) 以在对象区中选择一个对

象。

6.2.2 在同样的设备上进行软件升级

如果需要在多台同类设备上进行软件升级：
 请在详细显示中选择 “Devices“ 视图。
 请选择设备类别。
 请选中您需要升级的设备。
 使用鼠标右键点击选中的设备，并选择“MultiConfig™”打开 MultiConfig™ 

对话框。
 在 MultiConfig™-对话框中选择菜单树中的Device Settings > Basic Settings > 

Software(Device Settings:Diagnostics:QR Code Generator).
然后，您将在对象区中发现相关设备的列表，并会在功能区中出现用于升
级的设置。

 在功能区点击 “File“ > ...，打开文件选择窗口。选择软件更新文件，或将
文件拖放到行中。然后点击 Open 按键。

 选择 “Update“(Update) 和 “File“(File) 复选框。
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 点击 “Write“(Write)，将升级传输到设备。
在对象区的 “Status“ (Status) 列中，出现图标  即表示接受成功。

 冷启动设备，在设备上激活新软件 ( 参阅页 179 “ 重新启动多台设备 ”)。
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6.2.3 重新启动多台设备

MultiConfig ™ 的 Industrial HiVision 功能可以重启多台设备。
Industrial HiVision 将其分为 “Restart (consecutively)“ (Restart 
(consecutively)) 重启和 “Restart (simultaneously)“ (Restart (simultaneously)) 
重启。
 “Restart (consecutively)“

Industrial HiVision 发送重启命令到一台设备并等待该台设备完成重新启
动。之后 Industrial HiVision 向下一台设备发送重启命令。 
网络管理站中的设备采用串联时可以选择这种方法。

 “Restart (simultaneously)“
Industrial HiVision 几乎同时发送重启命令到需要重启的设备。设备直接
连接在网络管理站中时可以选择这种方法。

提示 : 重启时设备中断传输。这可能导致针对某些设备的重启命令丢失。

 在 MultiConfig™-对话框中选择菜单树中的Device Settings > Basic Settings > 
Restart (consecutively)(Device Settings:Basic Settings:Restart 
(consecutively)) 或 Device Settings > Basic Settings > Restart (simultaneously) 
(Device Settings:Basic Settings:Restart (simultaneously))。
现在对象区中将会出现对此设备进行重启的选项。

 软件升级后选中复选框，例如在 “Cold Start“(Cold Start) 行。
 点击 “Write“ 按键。
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6.2.4 为多台设备加载 / 保存配置

根据所选中的设备，Industrial HiVision 可以提供多种方法传输配置：

 请在详细显示中选择 “Map“(Map) 选项卡或设备显示的其他选项卡。
 选中您需要保存配置的设备或要加载配置的设备。

操作 加载 / 保存 通过 PC 加载 /
保存

保存到设备上
当前配置从设备的挥发性内存复制到设备的永久内存中。

X

保存到 TFTP 服务器上 （二进制）
当前配置从设备的挥发性内存中以二进制格式复制到指定的 
URL 中。

X

保存到 TFTP 服务器上 （脚本）
当前配置从设备的挥发性内存中作为可编辑和可读取的脚本复
制到指定的 URL 中。

X

从设备加载
从设备的永久内存复制配置到设备的非挥发性内存中。

X

从 TFTP 服务器加载
配置从指定的 URL 读入设备的非挥发性内存中。

X

从 TFTP 服务器加载并保存到设备上
配置从指定的 URL 读入到设备的非挥发性内存和永久内存中。

X

删除：当前配置
使用设备永久内存中的配置覆盖设备非挥发性内存中的配置。

X

删除：当前配置和从设备上删除
删除设备非挥发性内存和永久内存中的配置，并使用交付状态
中的配置进行替换。下次重启之后，IP 地址变为交付状态。

X

保存到 PC 上 （脚本）
设备非挥发性内存中的配置作为可编辑和可读取的脚本保存到 
PC 上的文件中。

X

保存到 PC 上 （二进制）
设备挥发性内存中的配置以二进制的格式保存到 PC 上的文件
中。

X

从 PC 加载 （脚本）
将 PC 中可编辑和可读取脚本文件的配置加载到设备的挥发性
内存中。

X

从 PC 加载 （二进制）
将 PC 中二进制格式文件的配置加载到设备的挥发性内存中。

X

表格 15: 配置的传输方法
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 使用鼠标右键点击选中的设备，并选择“MultiConfig™”打开 MultiConfig™ 
对话框。

 在菜单树中选择 Device Settings > Basic Settings > Load/Save。也可以选择
Device Settings > Basic Settings > Load/Save via PC。 
然后，您将在对象区中发现相关设备的列表，并会在功能区中出现用于传
输配置的选项。

 “Load/Save“
– 例如选择选项 “Load/Save via PC“(Load/Save via PC)。
– 在下拉列表 “Action“(Action) 中选择传输类型。
– 确定选中复选框。

 选择 “File“(File) 复选框，输入文件名称和完整的路径，例如
D:\Data\Network Management\Configurations/$CURRENT-
DATE/$IP_ADDRESS.$EXTENSION，或 
URLtftp://10.0.1.159/configs/2009_10_28/$IP_ADDRESS.cfg。
Industrial HiVision 支持在设置中输入文件名和 URL ( 参阅页 “Load/Save” 
on page 391)。 
写入时 Industrial HiVision 将创建缺失的子文件夹。

 点击 “Write“(Write) 按键传输数据。
在对象区的 “Status“ (Status) 列中，出现图标  即表示接受成功。

6.2.5 在多台设备上配置触发事件目标

如需在多台设备上配置相同的触发事件目标，
 请在详细显示中选择 “Map“(Map) 视图或设备显示的其他视图。
 请选中您需要配置相同触发事件目标的设备。
 使用鼠标右键点击选中的设备，并选择“MultiConfig™”打开 MultiConfig™ 

对话框。
 在 MultiConfig ™ - 对话框中选择菜单树中的 Device Settings > Diagnostics > 

Status Config > Trap Destinations (Device Settings:Diagnostics:Status 
Config:Trap Destinations)。
然后，您将在对象区中发现相关设备的列表，并会在功能区中出现用于触
发事件目标的表格。

 为了在表格中生成新的条目，
点击 “New“。
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 输入触发事件目标的 IP 地址，选择激活状态并 
点击 “OK“。
表格中将生成带有新触发事件目标的行

 为了使机器接收更改并临时保存，
点击 “Write“。

 在菜单树中选择 Device Settings > Basic Settings > Load/Save 和 “Save to 
Device“ 操作，将变更永久保存到设备。点击 “Write“ 按键。

6.2.6 在多台设备上创建防火墙规则

通过 MultiConfig™ 对话框可以创建防火墙规则。MultiConfig™ 对话框支持保
存防火墙规则预设置，将防火墙规则加载到其他 EagleOne 设备。

 MultiConfig ™ 防火墙规则列表
MultiConfig ™ 对话框显示索引列表，列表行显示在选择的 #EagleOne 设
备上保存的防火墙规则。
选择多个设备时，索引列表可以显示选择的 EagleOne 设备上保存的规则
的子集。索引列表以不等符号标记子集。不等符号表示选择的设备上的规
则有所不同。可以指规则中包含的信息不同，也可以指规则在各个设备上
的顺序不同。保存规则以不等符号标记的预设置时， MultiConfig ™ 将不
同的行保存为空行。可以移除空行，也可以在其中输入必要的信息。
防火墙对话框有一个向上的箭头和一个向下的箭头。操作箭头按键，可以
更改规则在索引列表中的顺序。

提示 : 无法更改有 “ 不等 ” 符号的行中的信息。但是可以从索引列表中移
除该行。

 举例
病毒更新文件服务器需要在企业防火墙中释放另一个端口。为此应为相应
的防火墙添加第 1 条新规则，激活该端口。
182
User Manual Industrial HiVision

Release 8.1 12/19



配置网络 6.2 MultiConfig ™ 的应用示例
 将新规则保存为预设置
 请在详细显示中选择 “Map“(Map) 选项卡或设备显示的其他选项卡。
 右键单击需要添加规则的 EagleOne 设备，在下拉列表中选择 

MultiConfig ™ 功能。
 在 MultiConfig ™ 对话框的菜单树中选择相应的数据包过滤器。
 在 MultiConfig ™ 对话框的功能区中选择复选框 “Edit Presets“(Edit 

Presets)。
 在 “Edit Presets“(Edit Presets) 框中点击 “New“(New) 按键，将规则预

设置保存到索引列表。

提示 : 需要将索引列表的完成内容保存为预设置时，取消标记索引列
表中的规则。想要保存 1 个或多个规则作为预设置时，在索引列表中
进行相应选择。

 在 “Edit Presets“(Edit Presets) 列表中双击名称单元格，为预设置输入
有意义的名称。

 输入名称，如 “ 当前规则 ” 后，点击 “Set“(Set) 按键。也可以按键盘上的
输入键。

 将规则保存为预设置后，删除索引列表中的规则。
 在索引列表 1 中创建新规则，需要时为端口启用创建多项规则。
 将新规则作为预设置保存到 Industrial HiVision 数据库时，点击 “Edit 

Presets“ (Edit Presets) 框中的 “New“(New) 按键。
– 在 “Edit Presets“(Edit Presets) 列表中双击名称单元格，为预设置

输入有意义的名称。
– 输入名称，如 “ 病毒更新 ” 后，点击 “Set“(Set) 按键。也可以按键

盘上的输入键。
 恢复初始规则时，在 “Edit Presets“(Edit Presets) 列表中选择预设置的

规则 “ 当前规则 ”。
 点击 “Write“(Write) 按键，将数据保存到设备。

在对象区，通过 “Status“(Status) 栏中的  符号识别，MultiConfig ™ 
已将规则保存到设备上。

进行这些操作后，防火墙设备将重新恢复至初始状态，并且 
MultiConfig ™ 将 “ 病毒更新 ” 预设置保存到 Industrial HiVision。
 关闭 MultiConfig ™ 对话框。

 为相关防火墙设备添加新规则
 请在详细显示中选择 “Map“(Map) 选项卡或设备显示的其他选项卡。
 选中想要为其添加规则的防火墙设备。
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 使用鼠标右键点击已选中的防火墙设备，并选择 “MultiConfig ™ ”。
 若要将端口激活的新规则添加为第一条规则，则需选中第一条规则。

取消选择 “Edit Presets“ 复选框后，在下拉列表中选择 “ 病毒更新 ” 预
设置。

Industrial HiVision 在选择的规则上方，添加 “ 病毒更新 ” 预设置规则。

提示 : 如果此对话框中的设备规则相同，Industrial HiVision 支持将新规则
添加到最后一条规则上方。

 点击 “Write“(Write) 按键，将数据保存到设备。
在对象区，通过 “Status“(Status) 栏中的  符号识别，MultiConfig ™ 
已将规则保存到设备上。

 关闭 MultiConfig ™ 对话框。

 Edit Presets(Edit Presets) 列表的常规信息
 “Edit Presets“ (Edit Presets) 已激活。

模式激活时，可以显示和编辑规则。 
– 选择相应的预设置，即可在下框中显示预设置。
– 若要将下框中的规则保存为预设置，则需点击按键 “New“(New)。
– 保存预设置时，在 “Edit Presets“(Edit Presets) 下拉列表中选择相

应的预设置。在下框中编辑规则。使用 “Set“ (Set) 关闭操作。
 “Edit Presets“ （编辑预设值）已禁用：

模式禁用时，可以添加规则。
– 若要将预设置规则添加到下框的规则中，则需选中想在其上方插入

规则的行，然后选择所需的预设置。
– 若要将预设置规则添加到下框规则结尾处，则需取消选中下框中的

行，然后选择所需的预设置。

6.2.7 Industrial HiVision-Eigenschaft konfigurieren

Die Verfügbarkeit Ihrer Vermittlungskomponenten hat höchste Priorität. 
Deshalb wollen Sie durch Industrial HiVision besonders informiert sein, wenn 
die Redundanz der Versorgungsspannung entfällt. 
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In der Standard-Statuskonfiguration des Netzteil-Status von Industrial 
HiVision
– ordnet Industrial HiVision dem Wert „Nicht installiert“ den Status „OK“ zu.
– ordnet Industrial HiVision dem Wert „Nicht verfügbar“ den Status „Kein 

Status“ zu.
In beiden Fällen möchten Sie aber den Status „Warnung“ erhalten.

 Öffnen Sie in der Detaildarstellung die Registerkarte “Properties“.
 Wählen Sie in der Dropdown-Liste “Property:“ die Eigenschaft “Status“ 

(“Power Supply“).
 Markieren Sie in der Tabelle die Netzteile, für die Sie die Konfiguration 

ändernwollen.
 Zum Öffnen des MultiConfig ™ -Dialoges klicken Sie mit der rechten 

Maustaste auf eine markierte Zeile, undwählen Sie MultiConfig ™ .
 Im MultiConfig ™ -Dialog wählen Sie im Menübaum “Status Config“.

Daraufhin finden Sie im Objekt-Rahmen die Tabelle mit den betroffenen 
Geräten und im Funktions-Rahmen die Möglichkeiten zur Einstellung der 
Statuskonfiguration.

 Markieren Sie folgenden Kontrollkästchen:
– “Value“ = “Not Installed“
– “Value“ = “Unavailable“

 Wählen Sie in der Dropdown-Liste der beiden Zeilen den Status 
“Warning“ aus.

 Um die Änderungen zu speichern, klicken Sie die Schaltfläche “Write“.

6.2.8 保存每台设备的参考值

MultiConfig ™ 功能除了在多台设备上编辑相同数值外，还支持编辑多台设备
上的个性化数值。示例请参见 “ 网络中设备的安全相关设置 ” on page 211。
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6.2.9 密码同步

Industrial HiVision 支持同步 SNMP-v1/v2 和 SNMP-v3 密码。此功能实现同
时更改多个对话框中的 SNMP-v1/v2 密码。除 SNMP v1/v2 外，同时应用其
他网络管理系统监控设备访问时，此功能也很有用。
此功能通过以下对话框更改 SNMP-V1/v2 密码：
 MultiConfig ™ > Device Security > SNMP V1/V2 > Stations
 MultiConfig ™ > Program Settings > Device Credentials，用于更改 “V1“ 设置。
同步密码的操作步骤如下：
 确定 Industrial HiVision 使用 SNMP v3 访问选择的设备。

 在 MultiConfig ™ 设备框中选择首个设备。
 打开对话框 MultiConfig ™ > Program Settings > Device Credentials。
 “SNMP Version“(SNMP Version) 栏显示设备使用的 SNMP 版本。
 检查 MultiConfig ™ 设备框中的每个设备。

 选择需要同步密码的设备。
 右键单击选择的设备。
 在下拉列表中选择  “MultiConfig ™ “。
 打开对话框 MultiConfig ™ > Device Security > SNMP V3 > Password/SNMP 

Access。
 在 “Read-only password (user)“(Read-only password (user)) 和 “Read-

write password (admin)“(Read-wrtie password (admin)) 中输入 SNMP-v3 
密码。您可以使用当前密码，也可以输入新的密码。

 选中复选框 “Synchronize password to v1/v2 community“。
 点击 “Write“ 按键。

提示 : SNMP-v1/v2 协议存在安全风险。

6.2.10 MultiConfig ™搜索功能

MultiConfig ™ 搜索功能根据搜索栏中输入的信息，扫描菜单树和对话框。帮
助您快速查找需要的功能。在搜索框中输入首字符时，Industrial HiVision 在
菜单树节点和对话框中搜索相应字符串。Industrial HiVision 只显示包含该字
符串的菜单树节点和对话框。
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搜索功能可能返回空对话框或搜索栏为空的对话框。这是因为 Industrial 
HiVision 在一个对话框中找到此功能，但并非所选设备全部具备此功能。选
择的设备组中，如果有一个设备不具备此功能，Industrial HiVision 将隐藏此
功能。

6.2.11 MultiConfig ™ User Management

MultiConfig ™ “User Management“(User Management) 功能支持同时在网络
中的多个设备上，设置用户登录信息。“User Management“ 功能只适用于 
HiOS 设备。
在 “User Management“(User Management) 对话框中编辑用户登录信息
时，Industrial HiVision 要求您输入 “Password“(Password)。这是出于安全考
虑。Industrial HiVision 不保存任何设备密码，也不检索保存在设备上的密
码。您在编辑时可以输入新密码，也可以输入其他用户已经保存在设备上的
密码。
更改用户登录信息时，首先选择用户，然后点击 “Edit“(Edit) 按键。可以应用
以下列表中的规则：
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参数 含义
Access 指定访问设备的用户。Industrial HiVision 只允许 1 名用户

访问设备。

提示 : 以下列表包含启用用户访问的前提条件：
• 选中复选框 “Active“。
• 确定密码。
• 取消选择复选框 “User locked“(User locked)。

Username 用户账户名。

提示 : 更改用户名前必须确定密码。
Active 激活 / 禁用用户账户。

可用的数值：
 ??

用户账户激活。Industrial HiVision 使用用户登录信息
登录设备。

 ????
用户账户禁用。

提示 : 禁用用户账户前，必须取消选择 “Access“(Access) 
复选框。

Password 确定 Industrial HiVision 登录设备的密码。

可用的数值：
 6 - 64 个字母数字字符
 包括以下特殊符号：

!#$%&'()*+,-./:;<=>?@[\\]^_`{}~

选择 “Policy Check“(Policy Check) 复选框时，设备检查密
码是否符合 Device Security > User Management > Global 对话框
中定义的规则。

提示 : Industrial HiVision 禁止使用 2 个连续的星号，例如 
”**”。

表格 16: MultiConfig ™ “User Management“
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Access Role 定义管理设备访问的各个功能的授权角色。

可用的数值：
 unauthorized

用户被锁定，设备拒绝注销用户。分配此值以临时锁
定用户帐户。

 guest
用户只有监控设备的权限。

 auditor
用户有权监控设备并将日志文件保存在 “ 诊断 > 报告
> 审计跟踪 ” 对话框中。

 operator
用户有权监控和配置设备，但无法访问设备的安全设
置。

 administrator
用户有权监控和配置设备。

User locked 显示用户账户是否因登录失败次数过多被禁用。

可用的数值：
 ??

设备因登录失败次数过多自动注销。
只有设备可以标记复选框。

 ????
允许用户访问设备。

提示 : 解锁用户账户需要联系 Industrial HiVision 管理员。
Policy Check 确定配置或更改密码时，Industrial HiVision 是否检查密码

是否符合规定。

可用的数值：
 ??

设备检查密码是否符合 User Management > Global 对话框
中的规定。

 ????
不经验证，设备直接接受密码。

参数 含义

表格 16: MultiConfig ™ “User Management“
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6.2.12 MultiConfig ™ Time Sensitive Networking

Hirschmann-Geräte unterstützen die zeitgesteuerte Kommunikation (bzw. 
„Time-aware queuing“) gemäß IEEE 802.1Qbv. Diese TSN-Funktion bietet 
den TSN-fähigen Ports die Möglichkeit, Datenpakete für jede zeitgesteuerte 
Datenverkehrsklasse im Verhältnis zu einem in der Gate Control List 
definierten Zyklus zu übertragen. Das VLAN-Tag eines Ethernet-Paketes – 
oder im Fall eines unmarkierten Paketes – enthält die Priorität.
Diese Funktion ermöglicht die Vermeidung von Latenzen und 
Datenverlusten aufgrund von Überlast für reservierte Datenströme. Die 
präzise Synchronisation von Zyklen und Gate-Status mittels IEEE 1588 
(PTP) ermöglicht eine überlastfreie Kommunikation mit geringer Latenz. Als 
Voraussetzung gilt, dass jedes Gerät im Netz IEEE 802.1Qbv unterstützt.
Um die Überwachung der TSN-Ports zu unterstützen, stellt Industrial 
HiVision ein TSN-Widget über das Dashboard bereit. Weitere Informationen 
zum TSN-Widget finden Sie in Kapitel “TSN Schedule 小部件 ” on page 425.
Weitere Informationen zu TSN-Netzen finden Sie im E-Book „TSN for 
Dummies“ unter: 

SNMP Auth Type 指定用户通过 SNMPv3 访问时设备使用的身份验证协议。

可用的数值：
 hmacmd5

设备为此用户账户使用 HMAC-MD5 协议。
 hmacsha

设备为此用户账户使用 HMAC-SHA 协议。
SNMP Encryption Type 指定用户通过 SNMPv3 访问时设备使用的加密协议。

可用的数值：
 none

无加密
 des

DES 加密
 aesCfb128

AES 128 加密

参数 含义

表格 16: MultiConfig ™ “User Management“
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https://www.belden.com/resources/knowledge/ebooks/time-sensitive-
networking-for-dummies-lp

 TSN-Beispielnetz
Vor der Konfiguration des TSN-Zeitplanes mithilfe von MultiConfig ™ ist 
die Konfiguration bestimmter Funktionen auf den Geräten erforderlich. 
Für die Konfiguration der in TSN-Netzen verwendeten Geräte mithilfe 
vonMultiConfig ™ gelten die folgenden Voraussetzungen:
 Konfiguration der VLANs und der VLAN-Portzugehörigkeit
 Konfiguration der Forwarding Database für den TSN-Datenstrom
Beispielsweise konfigurieren wir ein paralleles Netz dahingehend, dass 
ein kritischer Datenstrom zwischen den Endgeräten weitergegeben wird.

图 42: TSN-Netz mit TSN-fähigen Geräten

Die Zykluszeit ist anwendungsspezifisch. Im vorliegenden Beispiel 
kommt ein Zykluszeit-Wert von 1000000 ns zur Anwendung. Um die 
zeitspezifischen Einstellungen für die TSN-Funktion zu konfigurieren, 
bestimmen und berechnen Sie zunächst die folgenden Verzögerungen.
 Die Laufzeitverzögerung hängt von der Kabellänge ab (ca. 5 ns/m). 
 Bridge-Verzögerung = Empfangsverzögerung + Sendeverzögerung

– Empfangsverzögerung = unabhängige Verzögerung + abhängige 
Verzögerung des empfangenden Ports

– Sendeverzögerung = unabhängige Verzögerung + abhängige 
Verzögerung des sendenden Ports

 Gate-Offenhaltezeit = Laufzeitverzögerung + Bridge-Verzögerung

Talker ListenerDevice 1 Device 2

1/1 1/2 1/1 1/3
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 Die minimale Gate-Offenhaltezeit ist der Zeitraum, der für die 
Übertragung eines Paketes erforderlich ist, das aus der 
Dienstdateneinheit (SDU) + 36 Byte besteht, mit der maximal 
zulässigen Verzögerung.
Um die minimale Gate-Offenhaltezeit zu berechnen, multiplizieren Sie 
die Byte-Gesamtzahl mit einem Faktor, der von der TX-
Übertragungsrate abhängig ist (80 ns für 100 MBit/s und 8 ns für 
1 GBit/s).

 Bei der Zeitplanung für die Gates, die für die Weitergabe von 1 Paket 
vorgesehen sind, muss der interne Overhead berücksichtigt werden. 
Erwägen Sie die Verwendung der folgenden Overhead-Werte: 
1.400 ns für 100 MBit/s und 180 ns für 1 GBit/s.

提示 : Die Zeiten für die Empfangs- und die Sendeverzögerung für 
Hirschmann-Geräte finden Sie in der Gerätedokumentation.
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 TSN-Beispielberechnung
Im vorliegenden Beispiel kommen RSPE-Geräte mit der Software-
Version 07.3.00 zur Anwendung.
Sie berechnen die Verzögerungen für das TSN-Netz und die Geräte wie 
folgt:
 Die folgende Liste enthält die Merkmalswerte des Senders:

– Sendet 1 Datenpaket mit einer 300 Byte langen SDU im Zyklus mit 
Zeit t = 0.
12 MAC-Oktette + 4 VLAN-Oktette + 300 SDU-Oktette + 4 FCS-
Oktette = Ethernet-Datenpaket mit einer Länge von 320 Oktetten

 Die folgende Liste enthält die Merkmalswerte von Gerät 1:
– empfängt das Datenpaket über ein Twisted-Pair-Kupferkabel an 

Port 1/1; die Übertragungsrate beträgt 1 GBit/s
– Kabellänge zwischen Sender und Gerät 1: 10 m
– überträgt das Datenpaket über einen LWL an Port 1/2; die 

Übertragungsrate beträgt 1 GBit/s

 Die folgende Liste enthält die Merkmalswerte von Gerät 2.

Verzögerung Gerät 1
Laufzeitverzögerung 10 m × 5 ns/m 50 ns

Bridge-Verzögerung (RX) Unabhängige Verzögerung port 1/1 1094 ns
Abhängige Verzögerung 8 ns/Oktett 

× 300 Oktette
2400 ns

Bridge-Verzögerung (TX) Unabhängige Verzögerung port 1/2 530 ns
Bridge-Verzögerung 
(gesamt)

4024 ns

Gate-Offenhaltezeit Laufzeitverzögerung 50 ns
Bridge-Verzögerung 
(gesamt)

4024 ns

Gate-Offenhaltezeit (gesamt) ~4100 ns

Minimale Gate-
Offenhaltezeit

TX-Übertragungsrate 8 ns/Oktett 
× 340 Oktette

2720 ns

Interner Overhead Wert für 1 GBit/s 180 ns
PTP-Genauigkeitsmarge 1 µs 1000 ns
Minimale Gate-
Offenhaltezeit

~3900 ns

表格 17: Berechnungstabelle – Gerät 1
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– empfängt das Datenpaket über einen LWL an Port 1/1; die 
Übertragungsrate des Ports beträgt 1 GBit/s

– Kabellänge zwischen Gerät 1 und Gerät 2: 50 m
– überträgt das Datenpaket über ein Twisted-Pair-Kupferkabel an 

Port 1/3; die Übertragungsrate beträgt 100 MBit/s

 Die folgende Liste enthält die Merkmalswerte des Empfängers:
– empfängt das Datenpaket an einem Kupfer-Port; die 

Übertragungsrate des Ports beträgt 100 MBit/s

Verzögerung Gerät 2
Gate-Offenhaltezeit von 
Gerät 1

4100 ns

Bridge-Verzögerung von 
Gerät 1 (TX)

Abhängige Verzögerung 0 ns

Laufzeitverzögerung 50 m × 5 ns/m 250 ns

Bridge-Verzögerung (RX) Unabhängige Verzögerung port 1/1 954 ns
Abhängige Verzögerung 8 ns/Oktett 

× 300 Oktette
2400 ns

Bridge-Verzögerung (TX) Unabhängige Verzögerung port 1/31

1. Aufgrund der Gerätearchitektur weist Port 1/3 nach der Gate-Öffnung eine zusätzliche 
Verzögerung auf, die von der Datenpaketlänge abhängig ist.

9900 ns
Bridge-Verzögerung (gesamt) 5040 ns + 5200 ns 13254 ns

Gate-Offenhaltezeit Gate-Offenhaltezeit von 
Gerät 1

4100 ns

Bridge-Verzögerung von 
Gerät 1 (TX)

0 ns

Laufzeitverzögerung 250 ns
Bridge-Gesamtverzögerung 
von Gerät 2

13254 ns

Gate-Offenhaltezeit (gesamt) ~ 17.650 n
s

Minimale Gate-Offenhaltezeit TX-Übertragungsrate 80 ns/Oktett × 
340 Oktette

27200 ns

Interner Overhead Wert für 100 MBit/s 1400 ns
PTP-Genauigkeitsmarge 1 µs 1.000 ns
Minimale Gate-Offenhaltezeit ~29.600 n

s

表格 18: Berechnungstabelle – Gerät 2
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– Kabellänge zwischen Gerät 2 und dem Empfänger: 10 m

 Beispielkonfiguration
Der folgende Arbeitsschritt beschreibt die Konfiguration von Gerät 1. Die 
Konfiguration von Gerät 2 hat auf dieselbe Weise zu erfolgen.
Bei der globalen Aktivierung der TSN-Funktion weisen die TSN-fähigen 
Ports eine gemeinsame Forwarding Database (FDB) auf, die bis zu 
256 Einträge enthält.
Die Gate Control List (GCL) legt fest, wann das Übertragungs-Gate für 
den TSN-Datenstrom geöffnet werden soll. Die Gate Control List enthält 
bis zu 256 Einträge.

提示 : Dieses Beispiel geht davon aus, dass für die Geräte weiterhin TSN-
Standardeinstellungen und Zeitsynchronisierungseinstellungen 
konfiguriert sind.

Um die Zykluszeit zu konfigurieren, gehen Sie wie folgt vor:
 Öffnen Sie die Registerkarte “Devices“.
 Führen Sie einen Doppelklick auf das TSN-Gerät aus, das Sie als 

Gerät 1 verwenden möchten.

Empfänger-Verzögerung
Gate-Offenhaltezeit von 
Gerät 2

17650 ns

Bridge-Verzögerung von 
Gerät 2 (TX)

Abhängige Verzögerung 80 ns/Oktett 
× 300 Oktette

2400 ns

Laufzeitverzögerung 10 m × 5 ns/m 50 ns

Empfangszeit Gate-Offenhaltezeit von 
Gerät 2

17650 ns

Bridge-Verzögerung von 
Gerät 2 (TX)

24000 ns

Laufzeitverzögerung 50 ns
PTP-Genauigkeitsmarge 1 µs 1000 ns
Empfänger-Empfangszeit 
(gesamt)

~42700 ns

表格 19: Empfänger-Berechnungstabelle
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 Öffnen Sie die Registerkarte “List“.
 Führen Sie einen Rechtsklick auf Port 1 aus.
 Wählen Sie in der Dropdown-Liste die Option “MultiConfig ™ “.
 Öffnen Sie den Dialog TSN > Configuration.
 Geben Sie in das Feld  eine Zykluszeit von 1000000 ein.
 Um die Änderungen auf dem Gerät zu speichern, klicken Sie die 

Schaltfläche “Write“.
 Legen Sie die Parameter für Gerät 2 fest.

图 43: Geben Sie die Zykluszeit ein.

Die Arbeitsschritte zeigen die für Gerät 1 berechneten Werte an, die von 
参阅表格 17 on page 193 übernommen wurden. Um die Parameter für 
Gerät 2 zu konfigurieren, verwenden Sie die in 参阅表格 17 on page 193 
berechneten Werte. Sie weisen die kritischen Daten dem Datenstrom mit 
Priorität 5 zu. 
 Öffnen Sie den Dialog TSN > Gate Control List > Configured.
 Markieren Sie die Zeile 1, und klicken Sie die Schaltfläche “Edit“.
 Geben Sie in das Feld “Interval“ den Wert 4100 ns ein. Dies ist die 

Gate-Offenhaltezeit (gesamt) von Gerät 1.
 Markieren Sie die Kontrollkästchen für jedes Gate mit Ausnahme von 

“Gate“ 5.
 Klicken Sie die Schaltfläche “OK“.
 Um der Tabelle eine neue Zeile für die TSN-Daten mit Priorität 5 

hinzuzufügen, klicken Sie die Schaltfläche “New“.
 Geben Sie in das Feld “Interval“ den Wert 3900 ns ein. Dies ist die 

minimale Gate-Offenhaltezeit von Gerät 1.
 Markieren Sie ausschließlich das Kontrollkästchen für “Gate“ 5.
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 Klicken Sie die Schaltfläche “OK“.
  Um die verbleibende Zeit den Prioritäten 0, 1, 2, 3, 4, 6, und 7 

zuzuweisen, klicken Sie die Schaltfläche “New“. Verbleibende Zeit = 
Zykluszeit - (Bridge-Verzögerung (gesamt) + minimale Gate-
Offenhaltezeit).

 Geben Sie in das Feld “Interval“ den Wert 992000 ns ein.
 Markieren Sie die Kontrollkästchen für jedes Gate mit Ausnahme von 

“Gate“ 5.
 Klicken Sie die Schaltfläche “OK“.
 Um die Änderungen auf dem Gerät zu speichern, klicken Sie die 

Schaltfläche “Write“.
 Um den Dialog “Configured“ zu schließen, klicken Sie die Schaltfläche 

“Close“.
 Legen Sie die Parameter für Gerät 2 fest.

图 44: Gerät 1 TSN > Gate Control List > Configured

Aktivieren Sie nach der Festlegung der TSN-Gate-Zeiten die PTP- und 
TSN-Funktionen. Um die Funktionen zu aktivieren, führen Sie folgende 
Schritte aus:
 Führen Sie im Ordner-Rahmen einen Rechtsklick auf das Gerät aus, 

das Sie als Gerät 1 konfiguriert haben. Informationen zur Identifikation 
参考 “Industrial HiVision 的主窗口 ” on page 82..

 Wählen Sie in der Dropdown-Liste die Option “MultiConfig ™ “.
 Öffnen Sie den Dialog “TSN“.
 Wählen Sie in der Dropdown-Liste “Operation“ die Option “On“ aus.
 Um die Änderungen auf dem Gerät zu speichern, klicken Sie die 

Schaltfläche “Write“.
 Legen Sie die Parameter für Gerät 2 fest.
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图 45: Funktion aktivieren

Wenden Sie nach der Aktivierung der Funktionen die 
Konfigurationsänderungen an. Um die Änderungen zu übernehmen, 
gehen Sie wie folgt vor:
 Öffnen Sie die Registerkarte “Devices“.
 Führen Sie einen Doppelklick auf das TSN-Gerät aus, das Sie als 

Gerät 1 konfiguriert haben.
 Öffnen Sie die Registerkarte “List“.
 Führen Sie einen Rechtsklick auf Port 1 aus.
 Wählen Sie in der Dropdown-Liste die Option “MultiConfig ™ “.
 Öffnen Sie den Dialog TSN > Configuration.
 Wählen Sie in der Dropdown-Liste “Gate Control Active“ die Option 

“Enabled“ aus.
 Um die Änderungen auf dem Gerät zu speichern, klicken Sie die 

Schaltfläche “Write“.
 Klicken Sie die Schaltfläche “Close“.
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图 46: Port aktivieren und Konfigurationsänderungen übernehmen 

提示 : Sie verwenden den TSN > Gate Control List > Current-Dialog, um 
ausschließlich die Einstellungen des Gerätes anzuzeigen. Um die 
aktuellen Einstellungen anzuzeigen, klicken Sie die Schaltfläche 
“Refresh“.

 Reception delay

Port 
speed

RX 
port

Medium Independent 
delay [ns]

Dependent 
delay [ns]

Max. Reception delay [ns]
68 octets data 

packet
1522 octets data 

packet
(incl. 4 octets VLAN tag)1

1. These octets are included in the Independent delay, together with PREAMBLE, MAC 
addresses and FCS.

48 octets 
SDU2

2. The VLAN tag is not part of the SDU.

1502 octets SDU

100 Mbit/s 1/1
1/2

Twisted pair 3920 … 3940 80 × SDU 7780 123780
Optical 3830 … 3840 80 × SDU 7680 123680

1/3 Twisted pair 11480 … 11690 160 × SDU 27050 251370
Optical 11380 … 11600 160 × SDU 26960 251280

1 Gbit/s 1/1
1/2

Twisted pair 1064 … 1094 8 × SDU 1478 13078
Optical 924 … 954 8 × SDU 1338 12938

1/3 Twisted pair 3388 … 3538 16 × SDU 4306 27506
Optical 3238 … 3388 16 × SDU 4156 27356
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 Transmission delay

Port 
speed

TX 
port

Medium Independent 
delay [ns]

Dependent 
delay [ns]

Max. Transmission delay [ns]
68 octets data 

packet
1522 octets data 

packet
(incl. 4 octets VLAN tag)1

1. These octets are included in the Independent delay, together with PREAMBLE, MAC 
addresses and FCS.

48 octets 
SDU2

2. The VLAN tag is not part of the SDU.

1502 octets SDU

100 Mbit/s 1/1
1/2

Twisted pair 1660 … 1690 0 1690 1690
Optical 1720 … 1750 0 1750 1750

1/3 Twisted pair 9670 … 9900 8 × SDU 13740 129740
Optical 9730 … 9960 8 × SDU 13800 129800

1 Gbit/s 1/1
1/2

Twisted pair 530 … 550 0 550 550
Optical 510 … 530 0 530 530

1/3 Twisted pair 2904 … 3124 8 × SDU 3508 3892
Optical 2884 … 3104 8 × SDU 3488 3872
200
User Manual Industrial HiVision

Release 8.1 12/19



建立网络监测
7 建立网络监测

Industrial HiVision 基本设置支持创建网络计划后立即检测网络。
修改网络监测设置的关键信息包含在以下列表中：
 安全相关设置
 状态配置
 状态测定
 触发事件目标地址
 状态转发
 事件操作
 历史记录

受监测组件的概览信息请参阅 “Monitor” on page 313。

有关文件夹 / 设备、组件或连接的属性监测的设置请参见章节：
 “ 文件夹 / 设备的属性 ” on page 285
 “ 连接的属性 ” on page 300
 “ 组件详细设置的属性 ” on page 293
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7.1 优化网络安全

IT 网络为那些不请自来的入侵者提供了大量攻击目标。
意识到潜在的安全漏洞并将其修复，会提高您网络的安全性。
Industrial HiVision 可以轻松完成安全相关设置。 
下列执行过程会向您一步展示，Industrial HiVision 是如何为您提高网络安全
性提供支持的。

7.1.1 为网络中的设备设置密码

可配置的网络中继设备，例如集线器、交换器、路由器、防火墙和 WLAN 接
入点等，都是潜在的攻击目标，可能让您的网络遭受伤害。
 您可以通过给设备设置有效的密码来增大访问网络中继设备管理系统的难

度。
Industrial HiVision 可以通过多重配置功能，一步为多台设备设置同样的密
码。但是您要清楚，分别设置密码才能提高访问安全性。
 请定期给这些设备设置新密码。请您选择有效的密码。

7.1.2 首次登录时更改密码

为了帮助防止意外访问，至关重要的是在初始登录期间更改默认密码。
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从以下软件版本开始，有必要在初始登录期间更改默认密码：
 HiOS

07.1.00
08.1.00

 Classic
09.0.17
09.1.00 

 RSB
05.4.00

 HiSecOS
Eagle 20/30/40  03.3.00
EagleONe          05.4.00

 GarrettCom
DX
    DX940      4.2.0
    DX940e    1.0.3
    MN4         4.2.0
10RX
     XRX        5.0.0

Industrial HiVision 使您能够在初始登录期间更改默认密码。使用
MultiConfig ™ > Password Change 对话框时，可以同时在多个设备上更改默认密
码。

 配置示例
在此示例中，您使用 MultiConfig ™ 来更改在初始登录期间需要更改默认
密码的设备上的默认密码。
以下列表包含使用 MultiConfig ™更改默认密码的先决条件：
 设备已安装在您的网络中
 设备具有 IP 地址
 您使用 “HiDiscovery Scan“ 按钮发现了设备，或者使用 New > Device 手

动添加了设备。
要使用 “HiDiscovery Scan“ 按钮发现设备，请参阅 “HiDiscovery Scan” 
on page 429。
要手动添加设备，请参阅 “ 添加新设备 ” on page 142。
Industrial HiVision 发现设备后，Industrial HiVision 将设备显示为 ping 或
HiDiscovery 设备。
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以下步骤指导您完成密码更改：
 打开 “Map“ 选项卡。
 选择新添加的设备。
 右键单击标记的设备。
 在下拉列表中，选择 MultiConfig ™选项。
 在菜单树中，选择 Device Settings > Device Security > Management Access > 

Password Change。“Password Change“ 对话框打开。
 在 “New Password“ 字段中输入您希望将来用于访问的密码。

此字段的默认设置为空。
 在 “Repeat“ 字段中确认新密码。
 要将配置上传到设备，请单击 “Write“ 按钮。
标记该 “Advanced“ 复选框时，“Advanced“ 框架会展开，您可以在其中更
改其他值。单击 “Write“ 按钮后，“Advanced“ 框架中的设置生效。
  “User“ 字段包含设备的默认用户名。Industrial HiVision 使用该值登录

设备。
此字段的默认设置为 admin。

 “Old Password“字段包含设备的默认密码。Industrial HiVision使用该值
登录设备。
此字段的默认设置为 private。

提示 : 在 Hirschmann 和 GarrettCom 设备上，无需更改默认值 “User“
和 “Old Password“ 值。

 要验证 “Old Password“ 字段中的字符串，请使用该 “Repeat“ 字段。
此字段的默认设置为 private。

 选中 “Enable SNMP“ 复选框后，设备将激活 SNMP。SNMP 在新设备
上处于非活动状态。 
此复选框的默认设置已标记。

 标记时，“Add Password to SNMP guess list“复选框Industrial HiVision 
将 “User“ 和 “New Password“ 字段中的值添加到 Preferences > 
Advanced > Device Credentials > SNMP Guess List 中。 
此复选框的默认设置已标记。

 选中 “Refresh Device“ 复选框后，Industrial HiVision 将重新加载设备。
此复选框的默认设置已标记。

 标记后，“Hide Passwords“ 复选框 Industrial HiVision 隐藏或以纯文本
显示密码。此复选框仅在 “Password Change“ 对话框中隐藏或显示密
码。
此复选框的默认设置已标记。
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7.1.3 安全状态显示和配置

 安全性状态
在 “Security Status“(Security Status) 对话框中，Industrial HiVision 提供所
选文件夹中设备的安全属性概览。
“Status“ （状态）栏显示该行属性的临界状态。
符号具有下列含义：
  未查询该属性
  属性查询结果符合一般安全设置
 此属性的查询结果违反了一般的安全准则。根据一般的安全规定检

查设置。
 “-” 表示，设备不具备此功能。
为了设置要监控 Industrial HiVision 的哪些属性，请在表格 “Configure 
Monitoring“ （监控属性）中进行选择。
选择的属性在状态栏中显示。
下列栏的属性可根据设备在相应设备的设备子目录 “Security“ （安全）中
找到。
 “Tftp“
 “Profinet IO“
 “IEC61850“
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 “Inbound ANY Rule“
 “Outbound ANY Rule“
 “Time Synchronization“
 “Telnet“
 “HiDiscovery“
 “Http“
 “802.1X Port Access Control Enabled“
 “Restricted Management Access“
 “Ethernet/IP“
 “SNMP V1/V2“
 “Unused Active Ports“
 “Default Password“
Industrial HiVision 循环查询这些属性 （预设为 24 小时）。点击
“Refresh“(Refresh) 按键，立即将值导入 Industrial HiVision。
为提高网络的安全性，MultiConfig ™ 功能支持通过 1 次操作修改状态为
warning 的多个属性。
 请在表格中标记出您想要进行修改的设备行，并用鼠标右键选

择 MultiConfig ™。
您可利用 “Device Security“ （设备安全）下的 “Security Lockdown“
（安全锁定）对话框一次性进行多个安全设置。

 在 “Security Status“(Security Status) 对话框中检查相关设置时，点击 
“Refresh“(Refresh) 按键激活显示。更改后的属性显示 “ 安全 ” 状态

。

“Security Status“(Security Status) 选项卡仅显示设备安全功能的运行状
态。在设备上启用安全功能时，请使用可用的设备功能使网络尽可能安
全。网络设备上缺少安全功能或安全功能过于陈旧时，存在未经授权人员
访问您的网络的可能。确保您的网络设备是最新的，并根据您的安全定义
配置功能。
某些固件型号不支持表格中列出的每个安全功能。由于无法激活错误功
能，表格显示错误功能是不安全的。
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 Inbound ANY Rule (Connection) 和 Outbound ANY Rule (Properties)
设备上的 “ 数据包过滤器 ” 功能激活时，Industrial HiVision 检查规则内
容，并在 “ 安全性状态 “(Security Status) 对话框中显示结果。
通过检查接口上的角色分配实现输入和输出状态的分离。默认策略也被验
证。如果没有规则适用，则默认策略决定防火墙如何管理数据包。默认
“Action“(Action) 准则设置为为 “Accept“ (Accept) 时，状态为 Unsecure。
为确定 “Inbound ANY Rule“ 和 “Outbound ANY Rule“ 中显示的状
态，Industrial HiVision 在以下字段中搜索 ”any” 指令。
 Eagle 20/30 和 Eagle One：

Industrial HiVision 搜索以下 L3 防火墙规则中的 ”any” 指令：
“Source IP (CIDR)“ （源地址）= “any“
“Destination IP (CIDR)“ （目标地址）= “any“
“Source Port“ （源端口）= “any“
“Destination Port“ （目标端口）= “any“
“Protocol“ （协议）= “any“
Industrial HiVision 搜索以下 L3 防火墙规则中的 ”any” 指令：
“Source IP (CIDR)“ （源地址）= “any“
“Destination IP (CIDR)“ （目标地址）= “any“
“Protocol“ （协议）= “any“

Industrial HiVision 支持的其他产品系统，默认状态 “Inbound ANY Rule“ 
和 “Outbound ANY Rule“ 被认为是 SECURE。

 Time Synchronization
Industrial HiVision 检查网络中每个设备的时间同步状态。以下列表描述
使设备在 “Time Synchronization“ 栏中显示警告的配置。
SNTP 和 PTP 均不安全时， Classic 型号设备的 “Time Synchronization“ 
栏显示警告：
 设备如下配置时，SNTP 不安全：

– 运行关闭
– 运行启动 + 客户端关闭
– 运行启动 + 客户端启动 + 允许广播开启
– 运行启动 + 客户端启动 + 允许广播关闭 + 未同步

 设备如下配置时，PTP 不安全：
– 运行关闭
– 运行启动 + 未同步
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SNTP 和 PTP 均不安全时， HiOS 型号设备的 “Time Synchronization“ 栏
显示警告：
 设备如下配置时，SNTP 不安全：

– 客户端关闭
– 运行启动 + 客户端启动 + 广播模式
– 运行启动 + 客户端启动 + 单播模式 + 未同步

 设备如下配置时，PTP 不安全：
– 运行关闭
– 运行启动 + 未同步

SNTP 和 PTP 均不安全时， HiSecOS 型号设备的 “Time Synchronization“ 
栏显示警告：
 设备如下配置时，SNTP 不安全：

– 运行关闭
– 运行启动 + 允许广播开启
– 运行启动 + 允许广播关闭 + 未同步

 设备如下配置时，NTP 不安全：
– 运行关闭
– 运行启动 + 服务器模式
– 运行启动 + 客户端广播模式
– 运行启动 + 对称模式主动 + 未同步
– 运行启动 + 对称模式被动 + 未同步
– 运行启动 + 客户端启动 + 未同步
– 运行启动 + 客户端服务器模式 + 未同步

NTP 不安全时，HiSecOS 设备上的 “Time Synchronization“ 栏显示警告：
 设备如下配置时，NTP 不安全：

– 客户端关闭
– 客户端启动 + 广播模式
– 客户端启动 + 单播模式 + 未同步
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7.1.4 网络中设备的安全相关设置

 关闭 HiDiscovery
HiDiscovery 协议使用以太网，以支持为设备指定名称和 IP 参数。为了尽
量简化分配过程，HiDiscovery 放弃采用限制访问设备的机制。

提示 : 设备上的 HiDiscovery 功能激活时，“Security Status“(Security 
Status) 选项卡显示设备和功能是不安全的。

 为了对网络内的设备访问和 IP 参数以及名称变更进行限制，结束设备
配置后，请立即禁用设备上的 HiDiscovery。
MultiConfig ™ 功能支持一次操作禁用多个设备上的 HiDiscovery。
– 选择多个设备。
–  右键单击选择的设备，在下拉列表中选择 MultiConfig ™。
– 打开 Device Settings > Basic Settings > Network > Global 下的对话框。

需要禁用 Classic 设备上的 HiDiscovery 时，在 “HiDiscovery 
Access“(HiDiscovery Access) 下拉列表中选择 “Disable“(Disable)。
禁用 HiOS 设备上的 HiDiscovery 时，取消选择 “HiDiscovery 
Enable“(HiDiscovery Enable) 复选框。

提示 : 功能名称左侧的复选框仅显示功能的更改。

 配置签名检查
Classic 设备 (Hirschmann) 给设备配置设置个性化的配置签名。
HiOS 设备 (Hirschmann) 给设备配置设置个性化的指纹 (Fingerprint)。
将配置保存到设备上时，即使现有配置不变，每次配置签名也会改变。
将配置保存到设备上，并且现有配置更改时，配置签名改变。
设备将随机生成的配置签名 / 指纹与配置一起保存。
通过 Industrial HiVision 可监控配置签名 / 指纹。这样，如果有人更改设
备的配置，您就会知道。
 如需通过配置签名或指纹选择设备，请在详细显示中切换到

“Properties“(Properties) 选项卡。在 “Property:“(Property) 下拉列表中
选择 "Configuration Signature (Device)" 选项。

 在表格中选中需要监控配置签名 / 指纹的设备。
 右键单击设备，选择 MultiConfig ™。
 在 “Status Config“ 对话框中点击 MultiConfig ™对话树。
 在 MultiConfig ™ 菜单树中点击选择 “Set current to reference“(Status 

Config)。 
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 如果当前值与参考值不同，在 “Reference Value“ （参考值）框中选择
属性应用的状态。

 若要将当前配置签名 / 指纹作为参考应用到 Industrial HiVision 中，请
点击 “Write“(Write) 按键。

 端口安全性
通过端口安全性可以规定，允许向此端口发送哪些设备数据。从而能够封
锁接收其他设备的数据。 
Industrial HiVision 的 Industrial HiVision ™ 对话框帮助您配置 Classic 设
备的端口安全功能。

 加载设备证书 / 密钥
如果您想与设备通讯，可能想要知道，实际是否与真实的设备通讯。证书
用于验证设备的真实性。
认证机构 (Certification Authorities, CA) 提供此类证书，例如 Verisign，
Symantic。有些公司经营自己的机构，利用自己的服务器制作公司证书。
Industrial HiVision 支持通过 MultiConfig ™ 对话框将证书上传到设备。
每个设备使用一份自己的证书，比一份证书用于多个设备具有更高的安全
性。
 在 “Map“(Map) 选项卡上右键点击需要上传证书的设备。然后选择 

MultiConfig ™。
在MultiConfig™对话框的菜单树中，在 Device Settings > Device Security > 
Management Access > Server 下可找到证书 / 密匙上传的对话框。

7.1.5 配置网络中的安全相关设置

 Security Lockdown
“Security Lockdown“ 功能 （限制访问）实现通过单击受管理的设备或者
选中的设备，使用 Hirschmann 设备上已有的安全功能。
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限制程度以网络的当前状况为准。这表示保持当前的网络运行，但限制额
外的访问。
“Security Lockdown“ 功能包含以下安全功能 （只要设备支持）：
 受限的管理访问

Industrial HiVision 将设备的管理访问限制为网络管理站。出厂时任意 
IP 地址均可访问。

 端口安全
Industrial HiVision 激活端口的端口安全功能，它与一个 MAC 地址绑
定在一起。
例如，连接时如果由于超时导致 MAC 地址失效，设备会执行一个可
选，同时也可以设置的操作。这个操作可能是：向网络管理站发送触
发事件。
出厂时这种功能被禁用。

 端口安全操作
只要设备识别到未经授权的访问尝试，就会执行您之前配置好的操
作。
可能的操作：
– 无操作
– 禁用端口
– 发送触发事件
– 禁用端口并发送触发事件

 禁用未使用端口
Industrial HiVision 关闭无连接的设备端口。

 禁用未使用的插槽
Industrial HiVision 禁用设备未识别的模块设备的插槽。

 禁用不安全的协议
为了管理网络中的设备，设备通过不同的协议提供入口。Industrial 
HiVision 禁用被认为不安全的协议。被认为不安全的协议有：HTTP、
Telnet、SNMPv1、SNMPv2、HiDiscovery。保留 SNMPv3 的功能。

通过 MultiConfig ™ 功能，可通过一次操作同时为多个设备配置 “Security 
Lockdown“ 功能。
 打开详细显示中的 “Devices“(Devices) 选项卡，打开  “Security 

Lockdown“ 对话框。
 选择要配置的设备。
 使用鼠标右键点击选中的设备，并选择 “MultiConfig ™ ” 打开 

MultiConfig ™ 对话框。
 需要打开 “Security Lockdown“ 对话框时，在 MultiConfig ™ 对话框中

选择 Device Settings > Device Security > Security Lockdown。
“Security Lockdown“ 功能有以下限制：
 “Port Security“ 功能不适用于 EAGLE 和 BAT 设备。
 “Disable Unused Slots“ 功能只适用于模块化的 Classic 和 HiOS 设备。
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 “Disable Unused Slots“ 功能只适用于 GarrettCom-RX10 设备。
 “Restricted Management Access“(Restricted Management Access) 和 

“Disable HiDiscovery“(Disable HiDiscovery) 功能只适用于以下设备：
– 09.0.01. 以上版本的 Classic 设备
– 06.0.00. 以上版本的 HiOS 设备
– 03.0.00. 以上版本的 HiSecOS 设备

 比较 IP/MAC 地址对
攻击者经常使用其自己的设备来访问您的数据网络。此时攻击者会使用一
个刚关闭的现有设备的 IP 地址，或者一个子网空闲 IP 地址，从那里侵
入。
攻击者设备的 MAC 地址可能与其侵占的设备的 IP 地址不同。
Industrial HiVision 可以通过这项功能对侵入者进行追踪。
Industrial HiVision 为此会收集已连接设备的 IP/MAC 地址对。Industrial 
HiVision 将收集到的 IP/MAC 地址对列在表格中供您使用。您可以使用自
定义项来手动补充表格。
Industrial HiVision 自动定期对比表格的内容和实际网络中活动的 IP/MAC 
地址对。如果 Industrial HiVision 确定存在差异，Industrial HiVision 会按
照您定义的操作通知您。
 为监控 IP/MAC 地址对，请作出相应的设置。

参考 “MAC/IP 地址成对安全性 ” on page 405.

 识别非法设备
非法设备是指网络中处于别人位置上的设备。 
假设您完成了 Industrial HiVision 中的数据网络配置并且 Industrial 
HiVision 中包含您设备的有效拓扑结构和设备连接。此刻是冻结 Industrial 
HiVision 中该状态的正确时机。
Industrial HiVision 以这种冻结状态为基础，识别到数据网络中不请自来
的客人。
激活这项功能后，Industrial HiVision 会保存该拓扑结构的图像。 
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您希望如何处理您数据网络中添加到已有安装程序中的新设备？新设备可
能对您的数据网络造成潜在威胁。“Rogue Device Detection“ （非法设备
识别）功能会对该设备进行特殊的处理。
 刚创建好 Industrial HiVision 之后，请在 Configuration > Preferences > 

Basics > Discover Devices > Discovery Mode 下激活 “Rogue Device 
Detection“ （非法设备识别）功能。
– Industrial HiVision 将新识别到的设备放置在 “Rogue Devices“ （非

法设备）文件夹中。您将手动创建的设备放入特定文件夹
时，Industrial HiVision 会将手动创建的设备保留在相应文件夹。

– 当 Industrial HiVision 将一个新设备放入 “Rogue Devices“ （非法
设备）文件夹中时，Industrial HiVision 除了生成 “ 识别到新设备 ”
事件之外，还会生成一个 “Rogue Device Detection“ （非法设备识
别）事件。

 您可以使用 “Event Actions“(Event Actions)  或 “User defined 
Actions“(User defined Actions) 定义 Industrial HiVision 如何响应 
“Rogue Devices“(Rouge Devices) 文件夹显示的新设备。
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7.2 状态配置

状态配置用于确定为哪些状态分配组件详细设置的值。可能的状态包括：
 “No Status“
 “Not Available“
 “OK“
 “Warning“
 “Error“

举例：
比如，可以为连接中断分配 “OK“ (OK) 、“Warning“ (Warning) 或 “Error“ 
(Error) 等状态。
对于您需要定期关闭的终端设备来说，连接中断 （= 设备关闭）不是一个错
误。
对于不应出现中断的服务器来说，连接中断是一个非常严重的错误，必须进
行监测。

Industrial HiVision 支持在同一设备类别的设备中进行跨设备的组件详细设置
状态配置 ( 参阅页 “Status Configuration” on page 396)。

如果想要改变单个设备的状态配置，可以通过组件详细设置的 “ 属性 ” 窗口
访问状态配置。使用状态配置可以对每个组件详细设置进行单独的状态配置
设置 ( 参阅页 “ 组件详细设置的属性 ” on page 293)。

测定状态的一个先决条件就是组件详细设置的全面监测。 
监测组件详细设置时 Industrial HiVision 将会定期询问值。进行测定
时，Industrial HiVision 将会为此值分配一个状态。

交付状态的状态配置帮助您在安装之后立即对网络进行有效的监测。
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7.3 状态测定

网络管理站需要网络组件的信息来监测您的网络。为了获得这些信息，
 网络管理站将定期询问组件或
 组件主动发送信息 （触发事件）到网络管理站。

提示 :  如果路由器接口与状态检测防火墙结合使用，Industrial HiVision 和 
Classic 设备代理之间无法进行 SNMP 通信。
Classic 代理以临近 Industrial HiVision 管理站的路由器接口的 IP 地址响应 
SNMP 请求。如果指定的 IP 地址与 Industrial HiVision 临近的路由器接口不
符，则 Industrial HiVision SNMP 数据包的 IP 目标地址与源自设备代理的 
SNMP 数据包的 IP 源地址不符。
如果您使用的防火墙没有为此类通信设置正确的规则，防火墙可能会丢弃数
据包。这会导致 Industrial HiVision 和设备代理之间的通信中断。使用 
Industrial HiVision 防火墙的详细信息参见 ( 参阅页 “ 使用带防火墙
的 Industrial HiVision” on page 70)

 循环询问 （轮询）
根据网络的大小和询问的频率，循环询问可能会导致可用带宽明显减小。
例如，短期超载的网络可能会丢失应答或触发事件。定期询问的优点是概
率高，网络管理站在进行下一轮询问时即已得到应答。

 触发事件
一旦设备识别到了状态的变化，就会发送一个报警信息 （触发事件）到
网络管理站。由于设备仅在状态变化时发送触发事件，因此不会对网络负
荷造成明显的影响。但是如果数据包丢失，网络管理站将无法获悉状态变
化。
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7.3.1 触发事件目标地址

设备需要网络管理站的 IP 地址 （= 触发事件目标地址）用于发送警报信息。
通过基于 Web 的界面或 Industrial HiVision 的帮助您可以直接在设备中输入
触发事件目标地址 ( 参阅页 “Trap Destination” on page 409)。

 使用鼠标右键点击设备图标，并在下拉菜单中选择 “Trap 
Destination“(Trap Destination)。打开触发事件配置对话框。 

 选中复选框 “Send Traps“。 
 点击 “Write“ 按键。

7.3.2 更新设备状态

Industrial HiVision 显示设备识别时设备所具有的状态，或其接收触发事件或
询问时的状态。
 使用 “Refresh“ (Refresh) 可以重新读取属性。
218
User Manual Industrial HiVision

Release 8.1 12/19



建立网络监测 7.4 状态转发
7.4 状态转发

状态转发用于规定是否将状态转发到下一个更高层级。

图 47: 向更高层级转发状态
0 - 最低层级 = 组件详细设置
1 - 1. 更高层级
2 - 2. 更高层级
3 - 3. 更高层级
4 - 4. 更高层级
5 - 5. 更高层级
6 - 6. 更高层级
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文件夹采用组件内容所显示的最差状态。评估的顺序如下：
 “Error“ （错误）（最差的状态）
 “Warning“
 “OK“
 “Not Available“
 “No Status“

 您可以在 Configuration > Preferences > Display > Status Colors 下指定所属颜色
的含义。

 可以在相关组件的 “properties” （属性）窗口中指定状态的测定和转发。
该组件也可以是文件夹列表中的一个文件夹。
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7.5 管理操作

除了对网络进行被动检测之外，网络检测还包括对网络事件的主动干预。主
动干预表现为响应网络中的事件或管理行为，例如按照时间表打开和关闭端
口。

7.5.1 事件操作

Industrial HiVision 可以自动响应事件，比如状态更改。

 请选择 Configuration > Preferences > Basics > Event Actions 
(Configuration:Preferences:Basics:Event Actions) 或点击工具栏中的
“Preferences“ (Preferences) 并选择 Basics > Event Actions (Basics:Event 
Actions)。

( 参阅页 “Event Forwarding” on page 337) 可提供以下自动响应选
项 Industrial HiVision：
 “Popup Message Box“
 “Send SMS“
 “Send E-Mail“
 “Run Executable“
 “Play Sound“
 “Push Notification“

在此对话框的第二个框中，Industrial HiVision 支持您为事件分配选定的反
应。

提示 : 如果将 Industrial HiVision 配置为将可执行文件作为事件操作来运行并
推送错误消息，请参阅内核日志中的错误报告来获取更多信息。
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7.5.2 定时操作

Industrial HiVision 可确定某一时间段，在该时间段内 Industrial HiVision 通
过操作对事件做出响应。

 请选择 Configuration > Preferences > Basics > Event Actions 
(Configuration:Preferences:Basics:Event Actions) 或点击工具栏中的
“Preferences“ (Preferences) 并选择 Basics > Event Actions (Basics:Event 
Actions)。

 在 “Alarms“ (Alarms) 框内创建一个新 " 项 "。
可通过 “Alarms“ (Alarms) 对话框中的 “Time“ (Time)" 框 " 定义 " 一个固定
的时间段 （起
止时间固定）。

7.5.3 Industrial HiVision“alive” 动作

Industrial HiVision 可以让您在遥控情况下接收 Industrial HiVision “alive” 动
作。

 请选择 Configuration > Preferences > User defined Actions 
(Configuration:Preferences:Basics:Event Actions) 或点击工具栏中的
“Preferences“ (Preferences) 并选择 Basics > User defined Actions 
(Basics:Event Actions)。

 定义 Industrial HiVision 应作为 “alive” 动作执行的操作，如发送短信息。
( 参阅页 “Event Actions” on page 339)

 定义为执行该操作而由 Industrial HiVision 所触发的警报。
( 参阅页 “Event Actions” on page 339)
222
User Manual Industrial HiVision

Release 8.1 12/19



建立网络监测 7.6 与时间相关的记录
7.6 与时间相关的记录

Industrial HiVision 支持在不同的数据库中记录与时间相关的属性值：
 项目数据库 （历史记录）中
 单独的报告数据库 （报告）中
根据数据库的大小，访问数据库的时间随之改变。
因此 Industrial HiVision 将会限制项目数据库中的历史条目。

7.6.1 历史记录

为了在用户自定义的时间内监测您的网络，Industrial HiVision 可以记录带有
时间信息的状态。 
可以在属性对话框中找到历史记录的记录和显示设置
– “ 连接的属性 ” on page 300 和
– “ 组件详细设置的属性 ” on page 293。

 记录配置
通过组件详细设置 “Properties“(Properties) 对话框和
“Connection“(Connection) 连接对话框可以：
 开始记录历史日志， 
 输入记录 / 询问间隔及 
 记录条目的最大数量。达到最大数量后，Industrial HiVision 将丢弃最

老的记录，记录新的条目。
100 条目 （= 预设置）需要约 5 kB 的存储空间。

 网络负荷
双击连接可以打开历史记录窗口。可以看到每个数据方向上网络负荷的图
形显示。
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图 48: 网络负荷

如果还没有为连接分配端口，通过双击连接打开对话框来分配端口。
如果在连接的 “Properties“(Properties) 对话框中激活了阈值轮询，则图形
显示显示阈值线。

7.6.2 报告

除了用于网络管理系统程序数据库，该报告功能还可用于长期数据统计。
Industrial HiVision 将带有时间信息的属性值保存在特殊的报告数据库中。 
为了对记录值进行评估，此报告功能能以图形和表格的形式导出报告。

提示 : 根据您的设置，Industrial HiVision 可以收集大量的数据并存储在硬盘
上。请确保您的硬盘有足够的使用空间。
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 温度监控的应用示例
您需要监测五天工作日条件下交换机在几周之内的温度波动。Industrial 
HiVision 应每周生成一份报告。第一份报告需要在 2012 年 10 月 7 日
（星期日）生成，之后的每周都应生成一份新报告。
为报告添加温度属性：
 在 “Map“(Map) 选项卡上双击相应设备可以打开属性层级。
 使用鼠标右键点击温度 “Temperature“(Temperature) 属性图标。请选

择 “Add to Reporting...“ (Add to Reporting...)
Industrial HiVision 打开输入报告参数的对话框。

 记录开始时间输入为 2012 年 10 月 1 日 0 点。
请按下输入键，关闭日期对话框。
记录开始时间最晚可设为报告需要第一个条目的时间。
将记录停止时间设为 “Indefinite“ (Indefinite)。
设置轮询间隔，确保足以使 Industrial HiVision 记录预期波动即可。
将 “Polling Interval“ (Polling Interval) 设置为 10 分钟。
点击 “OK“ 按键。

创建报告模板：
您可以使用模板定义待生成报告的外观。在此示例中，假设您所需要的报
告是一个 PDF 文件中的线性图。
 请在菜单栏中选择 Configuration > Reporting。
 在“Reporting“(Reporting) 对话框中选择“Templates“(Scheduling) 选项

卡。
 点击 “New“(New) 为报告创建新的模板。
 请输入模板参数 ( 参阅表格 20)：
 点击 “OK“ 按键。

参数 含义
Report
Name 模板 SW1
Title 交换机 1 中的温度波动
Report Type
Type PDF
Layout Chart
Chart Type Line
Data
Monitored Properties 选择属性并点击向右的箭头。

表格 20: 定义新模板
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创建报告的时间控制：
使用时间控制可以定义 Industrial HiVision 应何时生成报告以及生成报告
的间隔。
 请在菜单栏中选择 Configuration > Reporting (Configuration:Reporting).
 在 “Reporting“(Reporting) 对话框中选择 “Scheduling“(Scheduling) 选

项卡。
 点击 “New“(New) 为报告创建新的时间控制。
 请输入模板参数 ( 参阅表格 21)：
 点击 “OK“ 按键。

参数 含义
Report
Name 模板 SW1
Relative 这种类型的时间控制将导致生成连续的报告。
Duration 5 天
Offset to execution 6 天，报告应包含从星期一至星期五的数据，并须在星期日生成第

一份报告。
First Execution 2012 年 10 月 7 日，星期日，00:00:00 MESZ （中欧夏令时）
Schedule every 1 周

表格 21: 定义新的时间控制
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7.7 自定义属性 (User-defined 
properties)

使用此功能需要高级的 SNMP MIB 知识和设备知识。

7.7.1 自定义属性的说明

在预设置中，Industrial HiVision 已经识别大量的设备及其属性。
Industrial HiVision 提供了 “User defined Properties“ (User defined 
Properties) 功能，允许 SNMP 设备将其 MIB 中的更多属性添加到管理之中。
这样您便可以在 Industrial HiVision 中添加或监测任意 SNMP 设备的属性。
您还可以从 MIB 中为 Industrial HiVision 已识别的设备添加额外的属性，并
监测它们。

7.7.2 自定义属性的应用示例

您希望通过使用 ICMP 数据包监测敏感网络中网络组件的负荷。如果设备在 
5 分钟内接收到了超过 10 个 ICMP 请求，则 Industrial HiVision 应发出警告。
 为了将新属性通知给 Industrial HiVision，请选择 Configuration > User defined 

Properties 对话框。
 添加含新属性的新条目时，在 “User defined Properties“(User defined 

Properties) 对话框中点击 “New“(New) 按键。
 在 “Name“(Name) 栏中为新属性输入一个唯一的名称，比如 

UserDef_ICMP-Message。Industrial HiVision 在此处可接受一个以
“UserDef_” 开头的名称。

 在 “Label“(Label) 栏中输入一个 Industrial HiVision 在用户界面上显示的属
性名称，例如 ICMP-Watch。
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 在 “Parent Property“ 下拉列表中选择 “Agent“。
 在 “MIB Variable/OID“ (MIB Variable/OID）栏中输入新属性的 MIB 变量。 

MIB 管理器还提供了在设备的 MIB 中根据 MIB 变量进行搜索的功能：
– 点击 ”…” 按键打开 MIB 浏览器。
– 点击 “MIB Manager“(MIB Manager) 按键，加载 “MIB Viewer“(MIB 

Viewer)，查看 MIB 概览。
Industrial HiVision 还支持在 MIB 浏览器中加载其他 MIB。请点击
“Load...“(Load...) 按键。在文件系统中选择 MIB。

– 打开对话框 iso:org:dod:internet:mgmt:mib-2:icmp。
– 选择 MIB 变量 icmpInMsgs。
– 点击 “OK“ 按键关闭 “MIB Viewer“(MIB Viewer)。

 在 “Instance“ (Instance) 栏中输入 MIB 变量的实例，在此情况下输入 0。
 在 “Type“ 下拉列表中选择 “Delta“。

图 49: 创建一个新的自定义属性

 点击 “OK“ 结束属性定义。
您现在可以在 “User defined Properties“ (User defined Properties) 窗口中
看到新定义的属性。

 点击 “OK“ 按键关闭 “User defined Properties“(User defined Properties) 窗
口。

 现在切换至列表视图中的详细显示。
 在列表视图中选择需要监测的设备的代理。
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 为了打开 “New Property“ (New property) 窗口，使用鼠标右键点击列表视
图并选择 New > Property (New:Property)。

 若要关闭窗口，请在 “New Property“(New Property) 窗口中选择新定义的
属性 ICMP Watch。

 点击 “OK“ 按键。
现在即已为代理分配了新属性 ICMP Watch。为了监测代理的新属性，请配
置状态 ( 参阅页 216 “ 状态配置 ”) 并测定状态 ( 参阅页 217 “ 循环询问 （轮
询）”)。
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7.8 对系统资源的影响

Industrial HiVision 提供大量管理和检测网络的功能。但这种多样化的选择可
能会耗尽您的系统资源，或使其超载。

本章介绍关于使用系统资源的以下信息： 
 识别 
 影响
 最小化
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7.8.1 识别系统资源的满载

轮询操作和历史记录是影响系统资源的关键因素。
在极端情况下，您可能需要更改相应设置来放慢您的系统。
在其他情况下，您需要客观指标来印证主观看法。指标参见 Help > Kernel 
Info > Polling。

指标 含义
轮询属性的数量 显示已经激活了轮询的属性数量。

这一显示也涉及到由 Industrial HiVision 监测的设备 ( 参阅页 “Manage” 
on page 277) 及其属性。

历史记录中记录的属性
数量

显示已经激活了历史记录的属性数量。 
这一显示也涉及到由 Industrial HiVision 监测的设备 ( 参阅页 “Manage” 
on page 277) 及其属性。

每分钟的轮询操作 Industrial HiVision 汇总已激活了轮询的属性，并使此总和与轮询间隔
相互关联起来。有些轮询间隔大于 1 分钟，则在最后一分钟内轮询操
作的次数将超过这一计算值。
这一显示也涉及到由 Industrial HiVision 监测的设备 ( 参阅页 “Manage” 
on page 277) 及其属性。

最后一分钟内的轮询操
作

显示最后一分钟所进行的轮询操作的数量。
这一显示也涉及到由 Industrial HiVision 监测的设备 ( 参阅页 “Manage” 
on page 277) 及其属性。

设置的历史记录条目的
总和

显示 Industrial HiVision ( 参阅页 223 “ 记录配置 ”) 保存的条目数量。

实际的历史记录条目的
总和

显示 Industrial HiVision 实际保存的条目的数量。

表格 22: 核心信息中的系统资源满载指标
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7.8.2 影响系统资源满载

轮询操作和历史记录的设置对系统资源的满载有很大影响。在 “Monitor“ 
(Monitor) 对话框中可以看到已针对哪些属性激活了轮询或历史记录 ( 参阅
页 “Monitor” on page 313)。

为了尽量降低系统资源的满载程度，请注意下面几点：
 在 Industrial HiVision 中已激活了轮询的每个属性都会造成网络管理站的

负载并增加网络流量。
 请您检查哪些是您确实想要监测的属性。
 请您检查这些监测所需的询问频率。

 每条历史记录都会造成网络管理站的负载，并极大地占用网络管理站中的
存储空间。
 请您检查哪些是您确实想要记录的属性。
 请您检查所需缓存的大小。

 MultiConfig ™功能可以同时在多个设备上创建统计计数器。统计计数器调
整好后即可激活轮询操作和记录操作。
 使用 MultiConfig ™ 功能前请检查，此设置将对系统资源造成哪些影

响。
 过多的事件将增加内存需求、程序开始时间和事件过滤器对话框的启动时

间。

为了确保网络管理站的完美运行 （性能），请注意以下其他影响因素：
 网络扩展
 节点数
 节点管理的复杂性
 网络负荷
 网络管理站的计算能力
 网络管理站的存储空间 （RAM 和硬盘）

7.8.3 轮询最小化

Industrial HiVision 支持逐步根据您的要求调整轮询。可以更改轮询周期以及
定义 Industrial HiVision 应询问的属性。
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 更改多台设备属性的轮询间隔
表格 ( 参阅页 “ 预设置中所监测的属性 ” on page 467) 显示，Industrial 
HiVision 在基本轮询设置中监控哪些属性。
若需在详细显示中通过设备的温度监控降低轮询次数，其操作步骤如下：
 选择详细显示中的 “Properties“ 选项卡。
 在 “Device Class:“ 下拉列表中选择 “All“。
 请在下拉列表 “Property:“ 中选择选项 "Temperature (Device)"。
 使用 ”Ctrl” + ”a” 全选表格中的设备。
 使用鼠标右键点击设备，并选择 MultiConfig ™ .
 在 MultiConfig ™ 对话框的菜单树中选择 “Property Properties“ 

(Property Properties)。
 在 “Polling Interval“(Polling Interval) 文本框中输入 15 分钟。
 为了对修改进行保存，请点击 “Write“ 键。
用同样的方法可以完全停止轮询。

 关闭用于连接属性的轮询
在基本设置中，Industrial HiVision 每 30 秒对网络负荷进行一次轮询。
停止网络负荷轮询的步骤如下：
 选择详细显示中的 “Connections“ 选项卡。
 使用 ”Ctrl” + ”a” 全选表格中连接。
 使用鼠标右键点击连接，并选择 MultiConfig ™。
 在 MultiConfig ™ 对话框的菜单树中选择 “Connection Properties“ 

(Connection Properties)。
 取消选择 #Variable:MultiConfig# 对话框功能区中的复选框 Monitor > 

Polling > Load。
 为了对修改进行保存，请点击 “Write“ 键。
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7.8.4 最小化网络负荷

Industrial HiVision 可以降低由于设备识别所造成的网络负荷。
 请选择 Configuration > Preferences > Advanced > Service Parameters 

(Configuration:Preferences:Advanced:Services)。
 在 “Device Discovery“ (Ping Service) 下选择降低 “Scan Rate 

[devices/min]“ (Scan Rate)。
 在 “Device Discovery“ (Global Settings) 下降低 “Simultaneously 

Discovered Devices“ (Simultaneously Discovered Devices) 的值。
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7.9 过程可视化系统

7.9.1 连接过程可视化系统

作为与过程可视化系统的接口 （SCADA，管理控制和数据采集） Industrial 
HiVision 的 Windows 操作系统包括 OPC 服务和 ActiveX 控制元件。
作为与过程可视化系统的接口 （SCADA，管理控制和数据采集） Industrial 
HiVision 的 Windows 操作系统包括 OPC 服务。

借助 ActiveX 控制元件，过程可视化系统可以图形化显示 Industrial HiVision 
的数据。

如果 Hirschmann Industrial HiVision 08.1.00 Service 已激活，OPC 服务则可
从 Industrial HiVision 中读取数据并供过程可视化系统使用。OPC 服务也可
将数据写入 Industrial HiVision。OPC 服务 OPC Data Access V1 至 V3 和 
OPC Unified Architecture 支持通信。
OPC DA 基于微软的分布式组件对象模型 (DCOM) 协议。DCOM 是多个层面
之上的传输协议，例如 HTTP 互联网协议上。因此 DCOM 能支持局域网内
软件组件之间的直接通信。
Windows 2008 R2, Windows Server 2012 R2 支持 DCOM 更多关于 DCOM 
的信息请参见微软网页。
为实现 OPC 客户端对 OPC 服务器的远程访问需激活网络管理站中的 DCOM 
协议和远程访问。
OPC UA 是基于 XML、独立于操作系统的协议。
Industrial HiVision OPC 服务器服务的默认设置 : OPC UA 服务器被配置为标
准化服务器，并且默认设置为：启用 ( 参阅页 373 “ 服务访问 ”)。

提示 : 如果激活了 Industrial HiVision OPC 服务器服务，则 OPC 客户端可通
过 OPC 服务和 Industrial HiVision 访问由 Industrial HiVision 管理的带有写入
权限的设备。
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为了将写入权限禁用，请打开对话框 Configuration > Preferences > Advanced > 移
动设备 移动设备 。请将框 “OPC Server“ 中控制复选框 “Global Write“ 的勾选
取消。 

图 50: 连接过程可视化系统

h  H h  H h  H h  H h  H
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7.9.2 OPC 的传输数据结构

Industrial HiVision OPC 服务器使用与 Industrial HiVision 在文件夹列表中相
同的树形结构显示待传输的数据。带有值的单个元素即为 “tag”[ 标签 ]。为了
表明层次，Industrial HiVision 将使用前缀，Industrial HiVision 将其置于标签
名称的前面。标签名称对应的 Industrial HiVision 名称为英语。 
在 Industrial HiVision 中更改名称将导致 OPC 客户端无法访问标签。将组件
移到其他文件夹中时也会出现同样的情况。

提示 : 如果您需要经常移动组件，您可以在一个单独的文件夹 （如文件夹
/OPC）内创建组件的快捷方式，并通过 OPC 访问此快捷方式。如果您的过
程可视化系统具有标签名长度限制，这种方法也是极为有用的。

前缀 组件类型
C_ 连接 (Connection)
D_ 设备 （Device）
F_ 文件夹
L_ 连接 (Connection)
P_ 端口
V_ 设备详细信息

表格 23: 用于 OPC 的标签名称
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在设备名称中，Industrial HiVision 用下划线而不是用点来表示 IP 地
址。Industrial HiVision OPC 服务器用下划线代替点和空格。
结构中的每个节点 / 文件夹都由 5 个标签组成，设备、设备详细信息和连接
除外。
设备辅助带有 “Managed” 标签。
设备详细信息辅助带有 “Value” 标签。
连接辅助带有 “ConnectionState”、“Utilization_AB” 和 “Utilization_BA” 标
签。 

标签名称 含义 组件
Label 程序界面中所显示的组件名称。 全部
安全状态 以数值表示的当前状态。

0= 无状态，
1= 不可用，
2= 正常，
3= 警告，
4= 错误

全部

状态 以数值表示的当前状态。
0= 无状态，
1= 不可用，
2= 正常，
3= 警告，
4= 错误

全部

StatusString 当前状态作为可读 （英语）文本，例如：“OK”、“ 错误 ”
（或 “Error”）。

全部

StatusReason 以可读 （英语）文本的形式列出所有有助于改善组件状态
的原因。 

全部

StatusChanged 显示对象状态是否未经确认。
0 = 已确认、
1 = 未确认
通过 OPC，您可将该值设为 “0”。

全部

Managed 显示 Industrial HiVision 是否正在监测设备。 设备
（Device）

Value 组件详细信息的当前值。 设备详细信息
ConnectionState 连接状态，使用线在程序界面上显示：

1= 不可用，
2= 已激活 （实线），
3= 待机 （虚线），
4= 禁用 （点划线）

连接 
(Connection)

Utilization_AB 从第一端点到第二端点的线路负荷 （OPC 树中所显示的顺
序）。

连接 
(Connection)

Utilization_BA 从第二端点到第一端点的线路负荷 （OPC 树中所显示的顺
序）。

连接 
(Connection)

表格 24: 可用的标签
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提示 : Industrial HiVision 的 OPC 服务器最多可询问 3000 个 OPC 标签。

图 51: OPC 树形结构的显示示例

7.9.3 OPC DA 支持的应用程序

Hirschmann 已通过下列应用程序测试了 Industrial HiVision：

软件 版本 制造商
RS View 32 7.20.00 Rockwell Automation
Genesis 32 8.00.138.00 Iconics, Inc
Simatic WinCC 6.0 Siemens AG
Citect SCADA 6.0 Citect Corporation
Softing OPC Demo Client 4.10 Built 512 Softing AG
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7.9.4 OPC UA 支持的应用程序

为将 SCADA- 客户端连接到 Industrial HiVision-OPC-UA- 服务器，SCADA-
客户端需要以下 URL：
opc.tcp://<IP-ADDRESS>:11189/OPCUA/HiVisionUaServer
您可以在对话框 Preferences > Advanced > Services Access 中找到 OPC-UA- 服
务器端口。
Hirschmann 已通过下列应用程序测试了 Industrial HiVision：

7.9.5 OPC-UA 连接示例

OPC UA 服务器默认处于开启状态。为确保 OPC-UA 服务器已激活，请打开
对话框 Preferences > 高级 > 服务访问。此外，“ 服务访问 “ 对话框还显示安装的 
OPC 服务器类型。
如需更改 OPC 服务器类型，请按以下步骤操作：
以下步骤仅适用于版本 6.0 和版本 7.0。
 如果您的电脑上正在运行 Industrial HiVision，停止运行当前该核心服务。
 请打开对话框 Windows Control Panel> Programs and Features。
 请选中 Industrial HiVision 程序，并选择 Change 选项。
 在 Industrial HiVision 的维护对话框中，请选择 Modify 选项，并点击 Next

按键。
 在 Select Components 对话框中选择期望的 OPC service 复选框。
 切记，只能激活一个复选框，之后请点击 Next 按键。
 在 Setup Needs The Next Disk 对话框点击 Browse... 按钮。

软件 版本 制造商
Ignition 7.9.6 Inductive Automation
Prosys 2.3.3-170 Prosys OPC
UaExpert 1.03.0.201 Unified Automation
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 在安装数据载体上导航至包含文件 data2.cab 的文件夹，然后点击 OK 按
键。

 请在 InstallShield Wizard Complete 对话框中，选择期望的复选框并
点击 Finish 按键。

如果您的 Industrial HiVision 版本大于等于 7.1，则 Industrial HiVision 需要进
行重装。
 在开始重装前，备份您数据库。
 卸载 Industrial HiVision。
 在 Attendant question 对话框点击 No 按钮。如果点击 No 按

键，Industrial HiVision 将保留含有您的数据库、PSM 和许可文件的安装
文件夹。

 请重新安装 Industrial HiVision。
 在 Select Components 对话框中选择期望的 OPC service 复选框。
本示例说明，如何连接 Industrial HiVision-OPC-UA- 服务区与 Inductive 
Automation Ignition OPC-UA 客户端。本示例的前提条件是，OPC-UA 
服务器和客户端安装在同一台 PC 上。
 安装并打开 OPC-UA 客户端软件。
 请在 Ignition Gateway Control Utility> Port 栏中输入 8088 的值。
 重启网关。
 在 Ignition Gateway Control Utility 对话框点击 Start the 

Ignition Service 按钮。
 在 Message 对话框点击 OK 按钮。
 在 Ignition Gateway Control Utility 对话框中选择 Go to webpage 

选项。
 在 Ignition localhost 对话框中选择 Configure 选项。
 在 Sign In 对话框中输入默认登录数据。

User name = admin， Password = password
 在 Configuration 对话框中选择 OPC Connections> Servers 选项。
 在 OPC Server Connections 对话框中选择 Create new OPC Server 

Connection... 选项。
 在 Add OPC Server Connection Step 1: Choose Type 对话框中选择 

OPC UA 选项。
 在 Discover OPC-UA Endpoints 对话框中输入以下 URL：

opc.tcp://127.0.0.1:11189/OPCUA/HiVisionUaServer
 在发现过程中，Industrial HiVision 将 Ignition 证书存储在 

services\PKI\CA\rejected. 下的安装目录内。如需使用安全的连接，
请将证书从 rejected 目录中删除，然后将其加入 
services\PKI\CA\cert 目录。

 Discover OPC-UA Endpoints 对话框现在显示多种选项。为使用安全的
连接，请选择 SecurityPolicy: Basic128Rsa15, MessageSecurity: 
SignAndEncrypt 选项。
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 在 New OpcUaConnectionSettings> Main 框架内输入一个有效名称以及
一个有意义的说明。您可以在完成配置后调整参数。

 单击 Create new OPC Server Connection 按键。
 对话框 OPC Server Connections 打开并显示新的服务器及其状态。
现在，您可以配置 Ignition Designer 主控面板。

7.9.6 OPC-UA 服务器用户定制证书

Industrial HiVision OPC-UA 安装是按照 OPC UA 的 2 步服务器身份验证规范
进行工作的。Industrial HiVision 提供了一个 OPC-UA 服务器，其使用了服务
器身份用 CA 证书。这种情况下，OPC-UA 客户端可信任和服务器的连接。
该证书的句法符合 X509 规范。
OPC-UA 服务器使用了以下证书类型进行识别：
 份认证监督 (CA) 证书，其可以将其用于企业环境下的证书签名，例如： 

HirschmannSampleCA。
 份应用程序身份证书，其用于对 OPC-UA 服务器进行识别，例如：

HiVisionUaServer。
 份 HTTPS 证书，其用于对 OPC-UA-HTTPS 服务器进行识别，例如：

HiVisionUaServer。
每份 CA 证书均包含以下文件：
 份 .der 格式的私人密匙
 份 .pem 格式的私人密匙
当 OPC-UA 服务器启动的时候，服务器将检查安装子目录中是否存在证书。
如果缺少证书，则服务器将生成默认证书。

提示 : CA 证书保存在 Industrial HiVision 安装子目录中，该子目录的路径为 
services/PKI/CA/private。CA 证书是高度敏感的数据。请保护子目录，
避免未经授权的读取或写人访问。
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OPC-UA 服务器配置文件 (server.properties.xml) 保存在子目录 
lib/opcua/config/ 中。配置文件包含以下参数，这些参数用于从证书处理
的角度对服务器的行为进行控制：
 OpcUaServer.issuer.name 是 CA 证书的基本文件名。默认情况下，基

本文件名为 HirschmannSampleCA。如果没有 CA 证书，则服务器将生
成具有指定文件名的证书，并将默认文件名用作证书颁发者的名称。

 OpcUaServer.private.password 是服务器用于加密或解密证书私人密
钥的密码。默认密码为 opcua。如果您更改了密码，请对每份证书使用您
创建的新密码。请替换基于已弃用密码的现有证书，或创建新证书。

提示 : 私人密匙用密码是高度敏感的数据。请保护配置文件 
server.properties.xml，避免未经授权的读取或写人访问。

 默认证书
如果没有对证书的特殊要求，则服务器将使用安装包中的默认 CA 证书和
值来创建自签名证书。然后，客户端将导入自签名证书，并将其声明为可
信。

 CA 企业证书
如果一家组织颁发了证书签名用 CA 企业证书，则可以在 OPC-UA 服务
器上使用 CA 企业证书。为了在 OPC-UA 服务器上使用 CA 企业证书，请
按以下步骤操作：
 请将子目录 services/PKI/CA/private 中保存的证书删除。
 请将您的 CA 证书转换为格式 .pem 和 .der。请复制子目录

services/PKI/CA/private 中的证书。
 请打开文件 server.properties。
 请在行 OpcUaServer.issuer.name 中输入 CA 企业证书文件的基本

名称。
 请在行 OpcUaServer.private.password 中输入私人密匙的密码。

– 如果不使用密码，请使用一个空字符串。
如果是第 1 次启动 OPC-UA 服务器，则服务器将基于 CA 企业证书创建
一份应用程序身份证书和一份 HTTPS 证书。
User Manual Industrial HiVision
Release 8.1 12/19 243



建立网络监测 7.9 过程可视化系统
 应用程序身份证书
如果您使用了您的组织或一家可信机构为您创建的证书，则您可以将该证
书用作 HTTPS 服务器用应用程序身份证书。为了在 OPC-UA 服务器上使
用应用程序身份证书，请按以下步骤操作：
 请将子目录 services/PKI/CA/private 中保存的证书删除。
 请将您的 CA 证书转换为格式 .pem 和 .der。请复制子目录

services/PKI/CA/private 中的证书。
– 请针对应用程序身份证书将 HiVisionUaServer 指定为基本名称。
– 请对在 HiVisionUaServer_http 中修改 HTTPS 证书。

 请打开文件 server.properties。
 请在行 OpcUaServer.private.password 中输入私人密匙的密码。

– 如果不使用密码，请使用一个空字符串。
OPC-UA 服务器第 1 次启动时，服务器将创建一个 CA 证书。在这种情况
下，将不使用启动期间创建的 CA 证书。此外，OPC-UA 服务器还将创建
其他缺少的证书。
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7.10 远程访问 Industrial HiVision

7.10.1 网络访问 Industrial HiVision

Industrial HiVision 允许通过 HTTP 或 HTTPS 协议访问 Industrial HiVision 的
网络服务器。建议使用安全的 HTTPS 协议和证书 ( 参阅页 250 “HTTPS 连
接证书 ”)。这样，您可以在任何地方对网络进行监测。
所输入互联网网址的示例：
https://[IP address of your network management station]:11187

您可以借助密码对访问进行限制。为了提供有关访问的信息，可以为每个成
功的访问创建一个事件 Industrial HiVision ( 参阅页 371 “ 高级 ”)。

提示 : 该程序通过 Preferences > Advanced > Services Access 对话框内的 “Web 
Server“ 端口、11187、和 “Project Data Server“ 端口、11188 与服务通信。
可对 7.0 以上版本的 Industrial HiVision 进行配置。“OPC Server“ 端口
在 Industrial HiVision 版本大于 8.0 时可进行配置 Preferences > Advanced > 
Services Access。
请确保这种类型的通讯是可行的。当通过防火墙或端口转发创建连接的时
候，这一点特别重要。
如果使用防火墙，请注意这一事实 ( 参阅页 32 “ 安装 ”)。

Industrial HiVision 的网络服务器提供了以下页面：
 选择不同的网络页面
 图形式用户界面
 事件视图

提示 : 如果您想要对 Industrial HiVision 进行测试，特别是在您想要将应用程
序和真实网络连接的时候，请使用由 Industrial HiVision 将提供的 Demo 网络 
( 参阅页 431 “Demo Network”)。
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 选择不同的网络页面
Industrial HiVision 网络服务器在该页面上提供了由 Industrial HiVision 提
供进行选择的网站。

本网络页面的 URL：
https://[IP address of your network management station]:11187/idx

 图形式用户界面
Industrial HiVision 的网络服务器提供了图形式用户界面，该界面和网络
管理站中所使用的是相同的。对网络进行远程监测和配置与在本地所需执
行的操作相同。

本网络页面的 URL：
https://[IP adresse of your network management station]:11187

 网络页面中的事件
PDA、智能手机和其他移动设备对正日益成为 IT 管理员的重要工具。对
于管理员来说，事件列表是 Industrial HiVision 的重要部分。事件列表包
含了有关被监测网络的集中状态概览 ( 参阅页 “ 事件列表 ” on 
page 119)。
Industrial HiVision 网络服务器提供了 HTML 格式的事件列表。事件列表
已针对便携式设备进行了优化，例如：iPhone、黑莓设备等。

下面将向您介绍 Industrial HiVision 网络服务器的 URL 示例：
https://[IP address of your network management station]:11187/events

可使用事件网页确认事件。Industrial HiVision 对图形式用户界面和移动设
备之间的操作进行同步。
为保证页面清晰，Industrial HiVision 限制以下事件的显示：
– 未确认的事件
– 类型为 “Warning“ (Warning) “Error“ (Error) 的已确认事件。
如果确认了列表中的默认事件，则 Industrial HiVision 将把已确认的默认
事件从列表中删除。

Industrial HiVision 每 5 分钟更新一次页面。
您可在对话框 Configuration > Preferences > Display > Event 中选择不同的更新
周期。
( 参阅页 “Event” on page 354)
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除了根据 “Category“ (Category) 的预定义筛选器，Industrial HiVision 还提
供与 “Source“ (Source) 和 “Component“ （Component）相关的用户自定
义筛选器，这些筛选器将会引发事件。 
 从相应筛选器框的“Source“ (Source)  或“Component“ (Component) 表

格列中复制字符串。为使字符串更具有普遍性，可使用通配符 (Wild-
Card)“*”。

提示 : 通过 HTTP(S) 访问事件列表时，Industrial HiVision 将网络会话中的
过滤器设置保存在 Industrial HiVision 的网络服务器上。
Industrial HiVision 可以在 Configuration > Preferences > Advanced > Services 
(Configuration:Preferences:Advanced:Services) 对话框中更改网络会话
的持续时间。
请使用设置 Industrial HiVision Web Server > Web Server Session Timeout [min] 
(Industrial HiVision Web Server: Web Server Session Timeout [min])。
如果为网络访问设置了密码，则此网页会话到期后密码仍然有效。

图 52: Industrial HiVision 网络页面中的事件
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7.10.2 通过 App 访问 Industrial HiVision

HiMobile 是一种应用于如智能手机和平板电脑等移动设备的移动应用程序 
(App)。 
HiMobile 让您能够在世界上的任何有互联网连接或 Industrial HiVision 网络连
接的地方，通过 VPN 了解您网络的状态。
为此，HiMobile 将作为客户端与 Industrial HiVision 服务相连接，以达到交换
信息的目的。

HiMobile 的功能：
 Industrial HiVision 的文件夹列表显示带有状态信息、连接信息和可能的

子域信息。
 显示 Industrial HiVision 事件列表和过滤功能 
 发生事件时进行通知
 扫描设备 QR 代码，用于识别文件夹列表中的设备和获得更多设备信息以

及访问设备专门网页。 
位置坐标传送到 Industrial HiVision。

 用于设备和连接监控的网络控制面板。

HiMobile App 可在 HiVision 网站上免费下载。

 准备用于访问 Industrial HiVision 的 App
在第 1 次启动 App 或进入 App 菜单之后，您可以找到用于输入连接参数
的对话框。
 请输入网络管理站的 IP 地址或主机名称。IP 地址见 Industrial 

HiVision 中的下列对话框：
Configuration > Preferences > Advanced > Management Station > IP Address 
Management Station
如果您的网络管理站配有多个网卡，则应采用 HiMobile 与 Industrial 
HiVision 通讯时所用的网卡的 IP 地址。
如果您的网络管理站隐藏在具有 NAT 功能的防火墙后面，则应向防火
墙管理员查询相应的 IP 地址。

 输入用于网络服务器的端口。IP 地址见 Industrial HiVision 中的下列对
话框：
Configuration > Preferences > Advanced > 移动设备
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 请输入网络访问的 “User Name“ （用户名）和 “Password“ （密码）。
这些数据见 Industrial HiVision 中的下列对话框：
Configuration > Preferences > Basics > User Management
从 “User Management“ （用户管理）中选择在 “Access Roles“ （用户
角色）中有 “Web Access“ （网络访问）权利的用户。
参考 “User Management” on page 333.

 请输入设备名称。Industrial HiVision 在 Configuration > Preferences > 
Advanced > Mobile Devices 下的 “Mobile Devices“ （移动设备）对话框
中显示移动设备的设备名称。

 使用 App 识别设备
您可以使用 Industrial HiVision 为每一台设备保存一个 QR 代码。请将 QR 
代码打印出来，并将其贴在相应的设备上。 
通过 HiMobile 中的 QR 代码扫描设备，即可现场扫描 QR 代码来识别设
备。若要将这些信息显示在您的移动设备上，请扫描 QR 代码。然后 
HiMobile 将从 Industrial HiVision 网络服务器中调出设备信息，并将这些
信息呈现在您的移动设备上。
 若要生成设备的 QR 代码，则需选中一台设备或属于同一设备类别的

多台设备，并选择打开 MultiConfig ™ 对话框 :Configuration > 
MultiConfig ™ （Configuration:#Variable:MultiConfig#）

 在 MultiConfig™-对话框中选择菜单树中的Device Settings > Diagnostics > 
QR Code Generator(Device Settings:Diagnostics:QR Code 
Generator).
借助 QR 代码生成器对话框，可以通过以下方式保存 QR 代码：
– 更改用于存放 QR 代码文件的预设路径和文件名。
– 确定 QR 代码尺寸 （单位：像素）。
– 将条目保存为预设置。

 如果要将 QR 代码保存到指定目录中，则需点击 "“Write“"(Write) 按
键。

通过对话框 Configuration > Preferences > Advanced > Load/Save 
(Configuration:Preferences:Advanced:Load/Save)，可以将带有文件名
和 Token 的路径作为占位符进行全局设定。

 设备的地理位置显示
使用 Industrial HiVision 可以在网络管理站上的地图，例如谷歌地图中显
示设备的地理位置。
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有 2 种方法输入位置：
 在 Industrial HiVision 的用户界面

 请在详细显示中打开选项卡 “Properties“。
 请在下拉列表 “Property:“ 中选择选项 "Location 

Coordinates (Device)"。
 为了将对话框 “Location Coordinates“ 打开，请双击您想要为其输

入坐标的设备。
 请在 “Value“ 框中的 “Current Value“ 下输入位置坐标，例如：

48.743286,9.320326。
 在 HiMobile

 要进入设备的属性界面，请选择设备。 
 为了输入地理坐标，请点击属性位置坐标的编辑笔。 

通过 “Get My Location” （获得我的位置），您的移动设备将使用可
用的方法来确定您的位置坐标，例如：GPS。如果您携带移动设备
在其他位置，则可以手动输入宽度和长度坐标。 
HiMobile 将这些数据传输到网络管理站。

7.10.3 HTTPS 连接证书

为了最大限度地保护您的移动设备或浏览器与 Industrial HiVision 之间的连
接，您需要一个新证书。为此，您需要一个网络服务器密钥库文件。该网络
服务器密钥库是一个包含有 HTTPS 连接秘钥的文件。
若您使用的是 “/” 而非 “\”，则下列示例也同样适用于 Linux 操作系统。
 在操作系统的命令行解释器中，进入 Industrial HiVision 的安装目录中。
 使用下列命令，在 MS-DOS 微软操作系统的命令行解释器中生成一个 

Industrial HiVision 网络服务器密钥库文件。
lib\java_x86\bin\keytool -genkey -alias hirschmann -keyalg 
RSA -keystore keystore -keysize 2048 -keypass password -
storepass password
请回答您的姓名以及您的网络管理站所连入域的唯一域名。
而对于您所属的组织单位、组织、所在的城市或乡镇以及省份这些问题，
则可以随意作答。
用表示所在国国家代码的两位字母回答国家代码这一问题。
“keystore” 文件位于您刚才所执行命令的目录中。
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 为了能够向安全认证中心申请到一个证书，您需要一个“certificate signing 
request”(*.csr) 文件。
您可以使用下列命令，在操作系统的命令行解释器中生成该文件：
lib\java_x86\bin\keytool -certreq -alias hirschmann -
keystore keystore -file ihivision.csr -storepass password
*.csr 文件位于您刚才所执行命令的目录中。

 使用该 *.csr 文件向安全认证中心 （如 Verisign.de）申请证书。
安全认证中心会以文件或 ASCII 字串符的形式向您提供一份签署证书。
如若您获得的是一个文件，那么请将文件重命名为 ihivision.crt。
如若您获得的是一个 ASCII 字符串，那么请将其完全复制到以 
ihivision.crt 命名的文本文件中。

 使用下列命令，在操作系统的命令行解释器中将该证书导入到网络服务器
密钥库文件中：
lib\java_x86\bin\keytool -import -trustcacerts -alias hirschmann -file 
ihivision.crt -keystore keystore -storepass password

 在将现有文件替换为新创建的文件之前，应将 “keystore” 文件备份到 
Industrial HiVision 安装目录中。

 使用新生成的 “keystore” 文件替换 Industrial HiVision 安装目录中的
“keystore” 文件。

提示 : 这些文件中包含有类似于密码的密钥。请保护好这些文件，防止他人
擅自访问。

您也可以选择自行创建证书，例如参见 www.openssl.org。将所需根证书导
入到移动设备或想要借助其连接 Industrial HiVision 的浏览器中。
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8 参考

前面章节中主要以任务为导向，而参考一章中将以功能为导向介绍单个对话
框和菜单项。主要内容为解决次要基本任务而设置的功能的详细信息。
User Manual Industrial HiVision
Release 8.1 12/19 265



参考 8.1 File
8.1 File

“File“ (File) 菜单中包含与文件操作相关的功能。
Industrial HiVision 将在计算机上执行文件操作，由此 “Hirschmann Industrial 
HiVision 08.1.00 Service” 服务将与界面进行通信。如果您在不同的计算机上
安装了服务和用户界面，那么您将可以通过文件选择对话框选择文件 ( 参阅
图 55)。 
双击表格行，进入文件树形结构的下 1 级。点击 “Up“ (Up)，进入文件树形结
构的上 1 级。
通过表格上方的路径可以知道目前的位置。

图 55: 不同计算机上的文件选择对话框
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8.1.1 New Project

通过这个选项可以创建一个用于存储网络数据的新项目。

提示 : 选择 “New Project“，便可删除当前项目。为了保存当前项目的数据，
请在选择新项目前，请先使用一个不同的名字 ( 参阅页 269 “Save”) 将此项目
的数据导出。

8.1.2 New

请将该选择用于以下功能：
 添加一个新的文件夹
 为所选文件夹添加一个新设备
 为所选文件夹添加一个列表中的新设备
 为所选文件夹添加一个新的子域
 创建一个新连接
 添加具有端口级别属性的计数器，比如用于 “In non Unicast Packets”（在

非单播数据包中）。
 添加一个文本行 
 添加一个符号。您可以在所涉及符号的窗口 “Properties...“ 中对符号进行

修改。

 Devices from List
Industrial HiVision 可以通过文本文件或 Microsoft Excel 文件 （CSV），
对 IP 地址进行扫描。通过对话框 “Create Devices from List“，可以查找文
件并上传至 Industrial HiVision。如果在列表中查找不到某个设
备，Industrial HiVision 则该设备在拓扑图中作为通用设备显示。
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通过对话框 “Create Devices from List“，可以添加文件中所含的表格 IP 地
址 Preferences > Basics > Discover Devices > Network Scan。如果您选中了控制
复选框 “Add IP addresses to 'Preferences - Basics - Discover Devices - 
Network Scan'“，Industrial HiVision 将把文本文件中的 IP 地址范围输入到
表格中。
如果您选中了控制复选框 “Add IP addresses to 'Preferences - Basics - 
Discover Devices - Network Scan'“ 和 “Combine consecutive IP 
addresses into ranges“，Industrial HiVision 将以下述方式把 IP 地址输入
到表格中：
 如果文件中的 IP 地址在表格所含地址的范围之内，则 Industrial 

HiVision 会把该 IP 地址与现有地址范围合并。
 如果 IP 地址范围和另一个范围重叠，或者受到较大的现有地址范围的

限制，则 Industrial HiVision 将使用现有范围的网络掩码。
 如果该函数没有现有范围中的网络掩码，则该函数将自动分配默认网

络掩码值 255.255.255.0。
 该函数将把各个相邻的 IP 地址合并到 IP 地址范围内，该地址范围将

被记录在同一个文件中。
创建 IP 地址文件时使用以下格式：
 192.168.1.10,
 # 这是一个单独的地址。
 192.168.1.11
 # 这同样是一个单独的地址。
 192.168.1.12,192.168.1.15,
 # 这是一个地址范围。
 192.168.1.16,192.168.1.20
 # 这同样是一个地址范围。
 # 这是一个备注行。
 # 192.168.1.1 这同样是一个备注行。

提示 : 为了隔开 IP 地址范围，请使用逗号而不是空格。行尾的逗号是可
选的。插入文本的时候请使用井号 (#)。
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8.1.3 Login

通过这个选项，您可以使用服务与本地计算机 (localhost) （本地主机）或远
程计算机的用户界面进行连接。

8.1.4 Open...

通过这个选项，您可以打开一个以前保存的项目，以进行显示或更改。

 选择相应路径以及文件夹结构中的所需文件。

提示 : 请选择一个具有 Industrial HiVision 服务或您有权访问的路径。

8.1.5 Save

通过这个选项，您可以将 Industrial HiVision 的当前网络数据和配置保存到带
扩展文件 .ihp 的项目文件中。

 请选择 File > Save (File:Save)，以使用 Industrial HiVision 的当前项目和当
前配置覆盖已打开的项目文件。
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8.1.6 Save as...

通过这个选项，您可以将 Industrial HiVision 的当前网络数据和配置保存到一
个当前项目文件中。 

 请选择 File > Save as... (File:Save as...)

 在您的文件夹结构中选择相应的路径，并指定项目名称。

提示 : 请选择一个具有 Industrial HiVision 服务或您有权访问的路径。

 点击 “Save“ (Save)，以将 Industrial HiVision 的当前项目和当前配置保存
在一个新文件中。

8.1.7 Save Backup

通过 Industrial HiVision 可保存恢复 Industrial HiVision 安装所需要的信息。
出于保存备份之目的，Industrial HiVision 在压缩文件中保存下列信息：
 PSM 列表和 PSM
 配置 （服务属性文件）
 项目数据库 
 报告数据库
 许可证文件 
 日志文件
 用户报告
 用户脚本、任务和任务结果
 包含版本信息的 info.txt 文件
调用 “Save Backup“ （恢复备份）后，Industrial HiVision 打开文件选择对话
框。可以在这里选择备份文件的保存位置。

提示 : 加载备份文件时，需要保存备份文件时所使用的相同版本的 Industrial 
HiVision。版本信息见备份压缩文件中的 info.txt 文件。
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8.1.8 加载备份

通过 Industrial HiVision 可恢复损坏的 Industrial HiVision 安装。
出于加载备份之目的，Industrial HiVision 备份压缩文件包含以下信息：
 PSM 列表和 PSM
 配置 （服务属性文件）
 项目数据库 
 报告数据库
 许可证文件 
 日志文件
 用户报告
 用户脚本、任务和任务结果
 包含版本信息的 info.txt 文件
调用 “Load Backup“ （恢复备份）后，Industrial HiVision 打开文件选择对话
框。可以在这里选择备份文件的保存位置。

提示 : 加载备份文件时，需要保存备份文件时所使用的相同版本的 Industrial 
HiVision。版本信息见备份压缩文件中的 info.txt 文件。

8.1.9 Export...

通过这个选项，您可以导出详细显示的内容。
Industrial HiVision 可将图形 （拓扑显示）导出为：
 PDF 文件，
 jpg 文件，
 png 文件，
 bmp 文件。
Industrial HiVision 可将表格导出为：
 PDF 文件
 HTML 文件
 CSV 文件 ( 参阅页 469 “CSV 导出 ”)

 请选择 File > Export...，并随后在窗口 “Save“ 中选择文件类型。
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8.1.10 Export Events...

通过这个选项，您可将整个事件列表导出为：
 PDF 文件
 HTML 文件
 CSV 文件 ( 参阅页 469 “CSV 导出 ”)

 请选择 File > Export Events...，并随后在窗口 “Save“ 中选择文件类型。

8.1.11 Print

通过这个选项，您可以打印详细显示的内容。

 请选择 File > Print。
Industrial HiVision 将生成一个包含列表内容的临时 PDF 文件，并使用安
装在管理站中的 PDF 显示程序 （如 Acrobat Reader）打开 PDF 文件。

8.1.12 Print Events

通过这个选项，您可以打印整个事件列表。

 请选择 File > Print Events。
Industrial HiVision 将生成一个包含列表内容的临时 PDF 文件，并使用安
装在管理站中的 PDF 显示程序 （如 Acrobat Reader）打开 PDF 文件。
272
User Manual Industrial HiVision

Release 8.1 12/19



参考 8.1 File
8.1.13 Exit and Stop Service

该选择在 Windows 操作系统运行时可用。
通过这个选择，您可以退出程序，对本地服务来说则意味着退出服务。退出
服务后，网络监测随之中断。

8.1.14 Exit

通过这个选项，您可以退出程序。该服务在后台仍处于激活状态，并继续监
测您的网络。
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8.2 Edit

“ 编辑 ”“Edit“ （Edit）菜单中包含与编辑操作和设备属性相关的功能。

8.2.1 Undo

通过这个选项，您可以撤消在程序中所作出的最后一次更改。

8.2.2 Redo

通过这个选项，您可以恢复之前在程序中撤消的最后一次更改。

8.2.3 Edit Mode

您可以使用此选择来激活 / 停用 “Edit Mode“
此功能需要相应的访问权限，参见 “Edit Mode” on page 94。
为避免 “Edit Mode“ 写入冲突，Industrial HiVision 阻止同时在多个用户界面
上激活。
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8.2.4 切换为免费版本

在选择之后，您将在免费 30 天的试用时间内在许可版本和免费版本之间进
行切换。
Industrial HiVision 提供了 3 个版本：
 许可版本

只要您输入了一个许可证密匙 Industrial HiVision 便将作为许可版本运行。
作为许可版本，Industrial HiVision 为您提供了全部功能范围。

 30 天试用版 （获许可）
在新安装或升级之后，Industrial HiVision 将以全部功能范围启动，并将持
续免费的 30 天试用时间。
在试用时间的最后 7 天力，将通过一个消息窗口提示您试用时间将要结
束，并且您可以在试用时间结束之前保存项目文件。Industrial HiVision 在
这时候将停止运行，随后 Industrial HiVision 将在下次启动的时候显示该
消息窗口。

 免费版本
作为免费版本，Industrial HiVision 让您可以对 Hirschmann 加以了解，并
对已了解的设备进行升级。

8.2.5 Cut

通过这个选项，您可以将所选的数据 （屏幕元素、组件、设备以及所属的设
置）转移到剪贴板。
数据将被删除，并在需要的时候通过菜单项 “Paste“ 重新添加到其他位置。
您还可以将对象名称复制到其他应用程序中，例如：文本编辑器。

8.2.6 Copy

通过这个选项，您可以将所选择的数据 （屏幕元素、组件、设备和您的设
置）转移到剪贴板。
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数据将被保留，并在需要的时候通过菜单项 “Paste“ 重新添加到其他位置。
您还可以将对象名称复制到其他应用程序中，例如：文本编辑器。

8.2.7 Paste

通过该选择框，您可以将数据 （屏幕元素、组件、设备以及所属的设置）添
加到剪切板中光标当时所处的位置。

8.2.8 Paste As Link

通过该选择框，您可以将数据 （屏幕元素、组件、设备以及所属的设置）作
为快捷方式添加到剪切板中光标当时所处的位置。只是插入数据的引用。数
据本身位于其原始位置 ( 参阅页 149 “ 创建快捷方式 ”)。

8.2.9 Delete

通过该选择框，您可以将所选的数据 （屏幕元素、组件、设备以及所属的设
置）删除。
在删除设备的时候，Industrial HiVision 让您可以在删除设备或者移动至文件
夹 “Unused Devices“ 之间进行选择。
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8.2.10 Rename

通过该选项，您可以对选中的文件夹或一个选中的设备进行改名。

8.2.11 Select All

通过这个选项，您可以选择激活文件夹中的任何对象。

8.2.12 Acknowledge Status Change

通过这个选项，您可以所属子组件被选中组件的状态更改进行确认。

8.2.13 Manage

通过这个选项，您可以激活所选设备的监测 ( 参阅页 278 “Unmanage”)。
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8.2.14 Unmanage

通过这个选项，您可以禁用所选设备的监测 。此外，Industrial HiVision 可将
设备及其配置和当前值保存在数据库中。设备监测处于关闭状态，直到重新
选择了 “Manage“ (Manage) ( 参阅页 277 “Manage”)。Industrial HiVision 将
颁放设备的许可证，并允许您将该许可证用于其他设备。
Industrial HiVision 用灰色和停止符显示状态为 “Unmanage“ (Unmanage) 的
设备。

8.2.15 Set Device and Port Names

通过该选项，您可以指定显示以下元素的详细窗口：
– 所选设备的设备名称和端口名称。
– 所选设备的 IP 地址和端口名称

8.2.16 Set Default Device Icon

通过这个选项，您可以设置用于显示设备类别的图标。如果此设备类别不存
在默认图标，Industrial HiVision 将使用设置中注明的图标作为设备图标 ( 参
阅页 367 “Device Icon”)。
278
User Manual Industrial HiVision

Release 8.1 12/19



参考 8.2 Edit
8.2.17 Device Documentation

通过此选项 Industrial HiVision 将生成一个 PDF 文件，包括：
 “Document Selected Devices“
 “Document All Devices“
PDF 文件中包含设备及其设置的说明。

 作出选择。指定需要 Industrial HiVision 在其中保存 PDF 文件的文件夹。

8.2.18 Drawing Size

您可以借助该选项根据您的要求对详细显示所需标记范围的大小进行调
整。Industrial HiVision 出于该目的提供了 3 个选项：
 “Enlarge“
 “Reduce“
 “Shrink to Fit“
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8.2.19 Background Image

通过这个选项，您可以加载、删除或更改详细显示的背景。可进行以下操
作：
 “Paste As Background“

选择 “Paste As Background“ (Paste As Background) 将剪贴板中的图片设
为详细显示的背景。如果剪贴板是空的，则这个菜单项是灰色标记，不能
选择。

 “Select Background Image...“
选择 “Select Background Image...“ (Select Background Image...) 将来自
文件的图片设为详细显示的背景。选择相应路径以及文件夹结构中的所需
文件。

提示 : 高分辨率的背景图片会增大网络管理站的资源负荷，从而降低系统
性能。

 “Remove Background Image“
选择 “Remove Background Image“ (Remove Background Image) 可以删
除详细显示的背景。

图 56: 编辑：背景
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8.2.20 Find...

使用 “Find“ 对话框可以在该显示中搜索组件、MAC 地址或 IP 地址。

 如果需要搜索 IP 地址，请选择 “Devices by IP Address“ (Devices by IP 
Address) 选项卡。或如果需要搜索设备部件则选择 “Components by 
Name“ (Components by Name)。

 输入
 IP 地址 /MAC 地址或其中一部分
 组件名称或其无需使用通配符的一部分。

 在树形显示左侧选中一台设备，或选择需要 Industrial HiVision 在其中进
行搜索的文件夹。

 点击 “Find“ (Find) 键，开始搜索。

Industrial HiVision 将在搜索对话框的列表中显示搜索结果。双击此列表中的
行，Industrial HiVision 将选择需要在文件夹列表中进行搜索的组件。

图 57: 编辑：搜索
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8.2.21 Auto Topology...

“Auto Topology...“ 功能可以自动创建设备间的连接。为实现拓扑识
别，Industrial HiVision 使用了转发数据库 (Forwarding Data Base (FDB)) 和
设备的 SNMP 功能。
IEEE 802.1AB 描述了链路层发现协议 (Link Layer Discovery 
Protocol,LLDP)。LLDP 实现了用户局域网的自动拓扑识别。
Industrial HiVision 识别冗余机制，例如：RSTP、冗余网络耦合或 HIPER 
环。Industrial HiVision 将每个冗余连接显示为单独连接。
Industrial HiVision 可以识别跨子网的终端设备拓扑，如果子网分隔式路由器
支持 SNMP-ipNetToPhysicalTable。

 请选择 Edit > Auto Topology... (File:Save as...)

 请在自动拓扑识别用对话框中确定 Industrial HiVision 是如何执行功能 
“Auto Topology...“ 的。

选择 操作
Entire Network (Recommended) 识别整个网络的拓扑结构，包括交换机、路由器、无线局域

网和终端设备并从设备中读取大量数据。 
大型网络的拓扑识别可能需要较长时间。
在这种情况下，“ Entire Network （整个网络）” 意味着：连
接到网络管理站网络接口卡的第 2 层网络和所有可达的 
VLAN。

Infrastructure 仅识别以 LLDP 为基础的基础设施设备的拓扑。速度非常
快，但有时有遗漏。

表格 25: “Scope“

选择 操作
Unmanaged Nodes Industrial HiVision 可从已知的邻近设备中推导出没有管理

功能的设备的拓扑信息和没有 Industrial HiVision 许可证的
设备的拓扑信息。Industrial HiVision 将未知设备显示为云。
一朵云可以代表一个或多个未知设备。

表格 26: “Unmanaged Nodes“
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 请点击 “OK“ 按键。

接着 Industrial HiVision 将根据设置询问网络中的所有连接，并在界面中显示
识别到的连接。

提示 : 拓扑识别
 不符合 LLDP 规范或无法通过 SNMP 进行管理的网络组件可能会导致不

正确的自动拓扑识别。
 在识别过程中激活的 DHCP 请求将导致识别结果出现错误。
 VLAN 路由将导致识别结果出现错误。

MACH 3000 M 路由器模块与 VLAN 路由一起工作。
 为了在 1:1-NAT 路由器之后识别子网，请在 “Scope“ (Scope) 下选择

“Infrastructure“ (Infrastructure) ( 参阅表格 25)。

选择 操作
Create New Topology 创建全新的拓扑

删除现有的连接和云朵。接着创建新的拓扑。
Complement Topology 补充现有的拓扑

创建新的连接和云朵。保留现有的连接。
Update Topology 添加缺少的连接，删除与当前拓扑不同的连接。如果符合

当前拓扑，则保留现有的云朵。

表格 27: “Strategy“

选择 操作
Automatic Industrial HiVision 展开拓扑并重新分配对象。
Manual Industrial HiVision 使对象离开当前位置。

表格 28: “Layout“

选择 操作
Current Folder 只在选定的文件夹中执行选择的操作。
Recursive Industrial HiVision 在当前文件夹及其下属文件夹中执

行自动拓扑识别，并在当前文件夹及其下属文件夹中
显示结果。

表格 29: “Range“
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 Industrial HiVision 通过 VRRP 路由器正确识别拓扑的前提是，在相同文
件夹或子文件夹中至少有一个启动了自动拓扑功能的 VRRP 路由器。 

 在无线客户端设备后面识别局域网中的设备：
BAT-Geräte 的 Hirschmann 都配备了 “ client bridge support ”（客户端网
桥支持）功能。
因此 Industrial HiVision 可以在无线客户端设备后面识别局域网中的设
备，激活接入点上无线客户端设备和所属广域网中的 “ client bridge 
support ” （客户端网桥支持）功能。

 冗余连接的终端设备将导致识别结果出现错误。
 拓扑识别可以在拓扑执行时识别拓扑。

拓扑显示更新后，Industrial HiVision 将在网络中显示其他的更改 （比如
漫游）。

 Auto Topology 适用于无法识别的设备
功能 “Auto Topology...“ 隶属于 Industrial HiVision，是专门为平面 2 层拓
扑而设计的。已针对路由拓扑进行了更改。在极少数情况下，识别到的拓
扑结构可能不正确或不完整。以下步骤将帮助您从整个网络中创建拓扑。
这一步骤是根据设备提供的信息通过 SNMP 经由 LLDP 专门提供拓扑。
一个属于此类别设备的示例是 Dragon PTN。
请在根项目文件夹中执行以下步骤。
 请在对话框 “Auto Topology“ 中确定以下数值：

– “Scope“: Infrastructure
– “Unmanaged Nodes“: 按照需要
– “Strategy“: Create New Topology
– “Layout“: 按照需要
– “Range“: Recursive

在 Industrial HiVision 对所选文件夹中的设备进行扫描之后，选项卡 
“Map“ 将显示网络拓扑。该拓扑可能仍然不完整。
通过执行以下步骤，重新扫描网络：
 请在文件夹框中选择所需的文件夹。
 请鼠标右键点击 “Map“ 选项卡上的空白区域。
 在下拉列表中选择 “Auto Topology...“(Schedule Saving Device 

Configuration)。
 请在对话框 “Auto Topology“ 中确定以下数值：

– “Scope“: Entire Network (Recommended)
– “Unmanaged Nodes“: 按照需要
– “Strategy“: Complement Topology
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– “Layout“: 按照需要
– “Range“: Current Folder

8.2.22 Auto Layout

“Auto Layout“ 功能使 Industrial HiVision 不再负责设备的分配。 

 请选择 Edit > Auto Layout。

 为了让 Industrial HiVision 不要在详细显示中重定位对象，请点击 “OK“ 
键。 

8.2.23 文件夹 / 设备的属性

对话框 “Properties...“ 包含了选项卡 
“Properties“、“Subcomponents“、“Status Reason“、“Scan 
Range“、“Protocols“、“IP Address“ 和 “MAC/IP Addresses“。
选项卡 “Protocols“ 和 “MAC/IP Addresses“ 描述了设备属性。

 文件夹 / 设备的属性
选项卡 “Properties“ 显示了组件视图的常规属性。
单击图标 1 次，打开对话框，选择一张 Industrial HiVision 将应用在显示
屏上的图片。Industrial HiVision 自动调整图片尺寸。
状态显示对于网络监测来说是十分重要的。在这里选择 Industrial 
HiVision 是否应测定这一连接的状态，以及 Industrial HiVision 是否应将
测定后的状态转发到更高层级中。在基本设置中，Industrial HiVision 将测
定这一状态并将其转发到更高的层级中。 
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图 58: 文件夹 / 设备的属性

 设备 / 文件夹的子组件
选项卡 “Subcomponents“ 显示了可通过对话框 “Configuration 
Signature“:“Properties“ 打开的组件所有部分的表格。 
除了子组件名称之外，该表还包含了这些子组件各种属性的值。
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图 59: 文件夹 / 设备的子组件

 Status Reason
如果您将鼠标指针移动至文件夹区域或 “Map“ 视图中某个元素的上方，则 
Industrial HiVision 将显示一个状态列表，该列表中含当前已识别的警告
和错误。此外，您可以通过选项卡 View > Properties > Status Reason 显示状
态列表。
选项卡 “Status Reason“ 对以下元素可用：
 文件夹
 设备
 容器 – 设备文件夹的子文件夹
 连接
作为此功能的一个示例，您网络中设备的状态会持续显示识别到的错误。
您想要维护状态列表的历史记录，供以后使用。
为了将状态列表保存为 PDF 文件，请按以下步骤操作：
 选择您要为其保存状态列表的设备。
 请点击工具栏 View > Properties。Industrial HiVision 打开 “Properties“

（多重配置）对话框。
为了打开对话框 “Properties“，您可以点击所选的设备。请在下拉列表
中选择功能 “Properties“。
User Manual Industrial HiVision
Release 8.1 12/19 287



参考 8.2 Edit
 打开选项卡 “Status Reason“。
 如果要将状态列表保存到您的计算机上，则需点击 “Export“ 按键。对

话框 ?? 将自动打开。
 请导航至想要用来保存文件的目录。
 请在文本框 ?? > ??? 中为该文件输入相应的名称。
 请通过下拉列表 ?? > ????? 选择选项 “Adobe Portable Document 

Format“。
 请点击 ?? 键。
 为了将对话框 “Properties“ 关闭，请点击 “OK“ 键。
您可以保存以下格式的状态列表：
 PDF 文件
 HTML 文件
 CSV 文件

提示 : “Print“ 键将以您默认的 PDF 程序打开状态列表。

图 60:  “Status Reason“ 一个文件夹或设备
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 文件夹的扫描范围
通过选项卡 “Scan Range“，您便可以对 IP 地址范围进行定义。Industrial 
HiVision 将在此文件夹中显示此 IP 地址范围中新识别出的设备及其 IP 地
址 ( 参阅页 398 “Scan Ranges”)。

图 61: 文件夹的扫描范围
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 设备协议
选项卡 “Protocols“ 显示了所支持协议及其所属属性的表格。
根据具体设备，Industrial HiVision 支持协议：
 Ping
 SNMP V1
 SNMP V3
 HiDiscovery
 EtherNet/IP
 Modbus/TCP

Industrial HiVision 仅支持 Modbus/TCP 命令 Read Device 
Identification (43 / 14)。

Industrial HiVision 应使用尽可能高级别的协议 （顺序为：SNMP V3、
SNMP V1、Modbus/TCP、Ping）监测设备。

利用 “Reload“ (Reload)，Industrial HiVision 将重新询问设备的协议。

图 62: 设备协议
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 设备的 IP 地址
通过选项卡 “IP Address“，您可以在对话框中对面向 Industrial HiVision 
最新设备的 IP 地址和 SNMP 端口编号进行修改。
重新使用 Industrial HiVision 访问已经直接在设备上更改了 IP 地址的已知
设备时需要用到此功能。
如果您想更改设备的 IP 地址，请选中设备并使用对话框 Configuration > IP 
Configuration ( 参阅页 407 “IP Configuration”) (Configuration:IP 
Configuration)。

图 63: 用于当前设备的 IP 地址
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 设备的 MAC/IP 地址
选项卡 “MAC/IP Addresses“ 显示了设备上现有 IP 地址及其所属 MAC 地
址的列表。列表中包括：

图 64: 设备的 MAC/IP 地址和名称

参数 含义
MAC Address
IP Address
Netmask
Host Name 安装目录 /config/hosts.txt 文件中的主机名称，如果

 此文件存在，
 此条目存在且
 在基本设置中激活了获取设备名称。
否则，该栏保留为空。

DNS Name 域名服务器的名称
Port No 协议的端口编号
Port 设备端口
Management Industrial HiVision 可以通过表格行中的 IP 地址与设备的管理进行通讯。
User Generated 此行中的设备是由用户生成的。Industrial HiVision 还未识别设备。
Router Entry 此行中的 IP 地址来自设备的路由列表。
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8.2.24 组件详细设置的属性

在组件详细设置的属性对话框中，您处于状态测定的最底层。除了更高层级
的属性，此对话框还包括一个有针对性的测定值。如果您想要留意这个值，
则您可以任意的间隔对其进行询问和记录。 
轮询间隔的值域： ≥ 5 秒。

为了配置组件详细设置属性，请如下进行操作：
 请在文件夹框中选择一个设备或一个端口。
 打开选项卡 “List“。
 为了将您想要进行修改的属性的属性对话框打开，请双击该属性。
 请确定数值。
 点击 “Write“ 按键。

图 65: 详细设置的属性
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如果您在设置 ( 参阅页 371 “ 高级 ”) 中取得了重命名的权限则可以编辑属性
名称。

 为了执行记录，请选择 History > Record。
为了在另一个窗口中显示历史记录，请点击 “Show“ 键。通过此窗口中不
同选项卡的选择可以在列表视图及图形视图间进行切换。
属性为计数器 (Counter) 类型时，图形视图可用。 

 通过 “Buffer Size“，您可以注明该报告将缓存多少行。
如果您还想要在上级组件的气泡帮助中显示该数值，则请在下拉列表 ( 参
阅图 65) 中选择组件 “Show Value in Tooltip of“。

在 “Status Config“ (Status Config) 对话框中确定值的更改将如何影响状态的
显示。

除了对您网络的监控外，Industrial HiVision 还让您能够对以下属性进行组件
详细级别的配置，前提是该设备支持该选项：
 端口的 “Name“

为该端口分配了一个任意可读的名称。
 端口状态用 “Admin“

请激活 / 禁用该端口。
 “Autoneg“

请激活 / 禁用该自动协商功能。
 设备的 “Name“

为该设备分配了一个任意可读的名称。
 “Contact“

注明设备的联系人。
 “Location“

注明设备的生产基地。
 “Signaling“

一定设备数量范围内的专用设备必须注明具有相同的生产基地。
294
User Manual Industrial HiVision

Release 8.1 12/19



参考 8.2 Edit
图 66: 配置详细属性
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 指定的值
“Status Config“ 对话框中显示了组件详细设置可能具有的值。
请使用下拉列表，以便为数值分配所需的状态。
操作员为您提供了更多用于定义状态配置的选项。

图 67: 状态显示指定值的示例
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 列表值
“Status Config“ 对话框中显示了组件详细设置当前值的列表。
请使用下拉列表，以便为数值分配所需的状态。 
与 “ 定义的值 ” 相反，这些值是可变的，您可以使用 “ 当前值 ” 读取当前
可用的值，使用 “New“ 按钮在列表中输入您自己的值，然后使用 “Delete“
按钮从列表中删除值。

应用示例：当未经授权的站点登录到一个接入点中时您将收到一个故障信
息。在列表中输入所有符合条件的站点，并将 “ 其他值 ” （Other Value）
设置为 “ 错误 ” （Error）( 参阅图 68)。

图 68: 状态显示的列表值
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 数值
在 “Status Config“ 对话框中以数字形式输入极限值。
请通过下拉列表选择由 Industrial HiVision 分配给设备的状态，前提是未
超过或者低于阈值。 

图 69: 状态显示的数值
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 含有字母和数字的字符串
在 “Status Config“ 对话框中可以为设备详细设置分配一个含有字母和数
字的值。
请通过下拉列表选择由 Industrial HiVision 针对其他字符串分配给设备的
状态。
示例：在一个端口中输入所连接设备的 MAC 地址。如果所连接设备的
MAC 地址正确，请分配状态 “OK“。如果所连接设备的 MAC 地址不同，
请分配状态 “Error“。一旦 MAC 地址更改，您会收到一条故障信息。

图 70: 状态显示的值 （含有字母和数字）

 Generate test events
该 “Generate test events“ 按钮使您可以生成与属性状态更改有关的事
件。然后，您可以为该事件分配一个操作。
单击 “Generate test events“ 按钮后，Industrial HiVision 打开 “Import 
event“ 对话框，以便您可以查看生成的事件。Industrial HiVision 还将测试
事件写入 “Test Events“ 选项卡中。您可以导入 “Test Events“ 选项卡中列
出的已生成事件，然后为该事件分配操作。
Industrial HiVision 不在事件列表中输入测试事件。
在此示例中，您生成测试事件，然后将操作分配给事件。要生成测试事
件，请按照下列步骤操作：
 双击要为其生成测试事件的设备。
 在 “List“ 选项卡中，右键单击要为其生成测试事件的属性。
 在下拉列表中，选择 “Properties...“ 选项。
 在 “Status“ 框架中，选中 “Determine“ 复选框。
 点击按钮 “Status Config“。
 在 “Status Config“ 框架中，配置属性以生成必要的事件。
 点击按钮 “Generate test events“。
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 在 “Import event“ 对话框中，验证表是否显示您要为其分配动作的事
件。

 点击按钮 “Close“。
要将动作分配给事件，请执行以下操作：
 请打开 “Preferences“ 对话框。
 从菜单树中选择 “Event Actions“。
 验证表 “Actions“ 中是否有可用的操作。
 在 “Alarms“ 框架中，点击 “New“ 复选框。
 在 “Filter“ 框架中，点击 “Import...“ 复选框。
 在 “Import event“ 对话框中，选择 “Test Events“ 选项卡。
 选择您要为其分配动作的事件。
 点击按钮 “OK“。

Industrial HiVision 从事件中获取信息并将其输入 “Filter“ 框架中。
 标记 “Actions“ 表中您希望 Industrial HiVision 要执行的操作的复选框。
 点击按钮 “OK“。

8.2.25 连接的属性

一个连接的属性对话框包括了 2 个选项卡：“Connection“ 和 “Properties“。
双击连接访问连接历史记录的第三个属性。
为了调用属性对话框，请鼠标右键双击某个连接，并在下拉列表中选择 
“Properties...“。

 Connection
请在选项卡 “Connection“ 上选择所连接的端口。为了实现更好的概览，
该对话框让您能够对选择视图中所显示的端口进行选择。
速度显示激活时，Industrial HiVision 将随着速度的提高 (10、100、
1000、10000 MB/s) 以每次 2 级字号不断增加线条的粗度。速度显示激
活时，Industrial HiVision 将在气泡帮助中显示当前的连接设置。 
速度显示关闭时，如果您在连接属性对话框中激活了速度显示，Industrial 
HiVision 也将显示当前的速度设置 ( 参阅页 361 “Device”)。
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通过连接末端图标自动显示连接介质时，Industrial HiVision 将选择相应的
图标。Industrial HiVision 允许您自行为连接定义连接末端图标。当给定的
条件阻碍介质的测定时，此选项可为您提供明晰的概览。
如果此连接的监测对您十分重要，则您能以任意的间隔询问下列标准参
数：
 链接状态
 加载 （输入负载）

如果连接的终端设备不提供用于输入负载的值，则 Industrial HiVision 
将会以其他连接终端的输出负载作为此终端的输入负载显示。

 端口冗余
 无线局域网端口属性

Industrial HiVision 可利用 “Record““Load History“ (Record:Load History) 
持续保存已询问的输入负载的值。

 Properties
用于连接的选项卡 “Properties“ 让您能够指定连接的任意名称，以及状态
处理的方式。
状态显示对于网络监测来说是十分重要的。在这里选择 Industrial 
HiVision 是否应测定这一连接的状态，以及 Industrial HiVision 是否应将
测定后的状态转发到更高层级中。一旦您为连接分配了所需连接的端口
（见下文），Industrial HiVision 就将在预设置中测定状态并将其转发到更
高层级中。
在 “Availability“ “Availability”（可用性）中有用于输入 “MTBF“ 和 “MTTR“ 
值的框，Industrial HiVision 可利用其计算可用性 ( 参阅页 432 “Calculate 
Availability”)。

8.2.26 为端口添加组件详细设置

Industrial HiVision 可以为各个组件提供多种组件详细设置的监测。为了明确
起见，Industrial HiVision 将显示这些详细设置的选择。
为了添加另一个组件详细的端口，请如下进行操作：
 请在文件夹框中选择一个端口。
 打开选项卡 “List“。
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 请鼠标右键点击对话框 “List“ 中的空白区域。
 请选择 New > Property。

Industrial HiVision 可提供其他组件详细设置的列表。有类型为 “Delta“ 
(Delta) 和 “Absolute“ (Absolute) 的组件详细设置可供使用。
 “Delta“：监测两次连续询问中值的差异。Delta 属性的图标是一个位于右

上角的三角形。
 “Absolute“：监测每次询问中的绝对数值。

图 71: Delta 属性和绝对属性的图标

 双击某一行选择相应的组件详细设置，并为详细显示中的这一组件详细设
置生成图标。

 请鼠标右键点击图标 。接着，请选择 “Properties“，以便将 “ 组件详细设置
的属性 ” 打开，参考 “ 组件详细设置的属性 ” on page 293.。

8.2.27 添加到报告：

除了用于网络管理系统程序数据库，该报告功能还可用于长期数据统计。
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可为报告功能添加下列元素：
 可轮询的设备详细信息
 两台设备之间的连接，Industrial HiVision 已在其两端识别到了链接状态。

 使用鼠标右键点击设备详细信息或连接，并选择 “Add to Reporting...“ 
(Add to Reporting...)，即可为报告功能添加设备详细信息或连接详细信
息。

 为了添加 1 个以上设备详细信息的报告功能，请如下进行操作：
 打开选项卡 “Properties“。
 请选中您想要添加的元素。
 请鼠标右键点击某个属性 。
 请选择选项 “Add to Reporting...“。

提示 : 如果报告功能以前添加过一个设备详细信息，则 Industrial HiVision 将
显示一条消息，该消息指出对话框 “Add Properties to Reporting“ 中有多少元
素尚未添加。对话框 “Reporting“ 显示了 ( 参阅页 316 “ 报告 ”) 上被监控的元
素。

在此对话框中可以使用 “Record“ (Record) 激活 / 禁用此属性或此连接的报
告。如果禁用了报告，条目将保留在报告功能中 ( 参阅页 316 “ 报告 ”)。针对
报告，您可以选择记录值或记录状态。

使用 “Start“ (Start) 和 “Stop“ (Stop) 可以开始或停止记录。在预设置中，点击
“OK“ (Ok) 后即开始记录，且会在 Industrial HiVision 服务运行期间持续进
行。

如果您事先激活了针对属性或连接的轮询，或改变了轮询间隔，则此设置仍
然保留。否则 Industrial HiVision 将激活轮询，并将轮询间隔最小值设置为 
30 秒。

设置轮询间隔：
 最小值：30 seconds
 允许值：30 的倍数
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图 72: 为报告添加属性

8.2.28 设备和端口信号化

信号化功能让您可以借助设备的 LED 识别一个设备或者一个端口。在创建新
连接的时候，该功能让您能够检查是否使用了相应的设备和正确的端口。 
您可以通过 HiMobile 将该功能激活。

提示 : 该 HiMobile 信号化功能在含以下软件发行版本的设备上可用： 
 设备信号化支持含 09.0.03 以上软件版本的 Classic 设备。
 设备信号化支持含 06.0.01 以上软件版本的 HiOS 设备。
 设备信号化支持含 06.0.01 以上软件版本的 HiOS 设备。
 设备信号化支持含 03.0.01 以上软件版本的 HiSecOS 设备。
 设备信号化支持含 06.0.01 以上软件版本的 HiOS 设备。

 设备和端口的信号化
为了将设备上的信号化功能激活，请按以下步骤操作：
 请确认 Industrial HiVision 处于 “Edit Mode“ 下。
 请双击您想要为其激活信号化功能的设备。
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 打开选项卡 “List“。
 请鼠标右键点击条目 “Signaling“。
 在下拉列表中选择  “Properties“。
 请在 “Value“ 框下拉列表 “Current Value“ 中选择选项 “On“。
 点击 “Write“ 按键。
选项卡 “List“ 上的表格将功能 “Signaling“ 显示为 “On“，并且设备上的 
LED 闪烁 10 秒钟的时长。在 10 秒过后，条目自行改变为 “ 关 ”。
用在某个端口上激活功能 “Signaling“ 的步骤和上述步骤相似。唯一的区
别在于，您选中想要为其将功能 “Signaling“ 激活的端口。

图 73: 信号化属性的对话框

 支持信号化功能
以下列表包含了支持 Industrial HiVision 功能 “ 信号化 ” 的设备和软件版
本：
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设备型号 以上版本 设备信号化 端口 / 连接信号化
Classic 09.0.01 X
HiOS 04.0.00 X X
HiSecOS 03.0.00 X

表格 30: 支持信号化功能的软件
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8.3 View

菜单 “View“ 包含了用于通过详细显示框架的内容历史记录进行导航的功能。

8.3.1 Select VLAN

利用此项功能您可以在彩色显示中识别出已识别设备的 VLAN 从属性和连
接。
 请选择 View > Select VLAN (View:Select VLAN)。

Industrial HiVision 打开一个对话框以选择一个 VLAN。
 请在下拉列表中选择需要显示其 VLAN 从属性的 VLAN 的 VLAN-ID。

Industrial HiVision 以浅灰色显示属于其他 VLAN 的设备和连接。所选 
VLAN 所对应的设备保持彩色或深灰色。

Industrial HiVision 将在文件夹列表上部显示所选的 VLAN。

8.3.2 Refresh VLANs

通过该项功能，可以对 Hirschmann 设备中的 VLAN 信息进行更新。
 为了对 VLAN 信息进行更新，请选择对象框架中的一个节点。
 请在菜单栏 View > Refresh VLANs 中选择。

Industrial HiVision 已经对所选节点的子组件中的信息进行了更新。
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8.3.3 Protocol Statistics

协议统计可以提供与协议通讯有关的带有 Industrial HiVision 的设备响应时间
概览。此概览可以帮助您断定响应时间是否是 Industrial HiVision 无法与单个
设备建立通讯的原因。
您可以注明抽样的数量，该抽样是 Industrial HiVision 计算为 ICMP 和 SNMP 
平均响应时间的基础。
 打开对话框 Configuration > Preferences > Services。
 您可以确定有关 “ICMP Statistics - Moving Average Number of Samples“ 

参数的 ICMP 抽样数量。
 您可以确定有关 “SNMP Statistics - Moving Average Number of Samples“ 

参数的 SNMP 抽样数量。
该对话框将推导得出的平均值显示为 0，直至 Industrial HiVision 计算出第一
个平均值。

Industrial HiVision 可为您提供一部分协议统计作为每台设备的详细信
息。“Avg Resp [ms]“ (Avg Resp [ms])  和 “Std Dev“ (Std Dev) 位于设备的协
议属性中。

参数 含义
Device 本行中条目适用的设备 IP 地址
Protocol Industrial HiVision 通过其与设备进行通讯的相关协议
Requests 自上次复位以来 Industrial HiVision 的询问次数
Responses 自上次复位以来，设备回复的次数
Timeouts 响应设备时间长于设置中所指定时间的次数
Errors 与默认存在偏差的包数量
Msg Loss [%] 点损耗 [%] = 包损耗 [%] = 1- （应答 / 询问）x 100
Avg Resp [ms] 平均响应时间
MAvg Resp [ms] 推导得出的平均响应时间 
Min Resp [ms] 响应的最短等待时间
Max Resp [ms] 响应的最长等待时间
Std Dev 响应时间的默认偏差 = 振动的测量
Try 1 第 1 次询问尝试 （“ 尝试 1”）后收到响应的数量。

根据 Industrial HiVision 中 SNMP 配置的不同设置，Industrial HiVision 
还将创建 “Try“2、“Try“3 列等。
列 “Try“ 2 仅包含了第 2 次询问尝试后收到响应的数量。

表格 31: 协议统计 (Log Stalistics)
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使用报告功能，您可以精确分析单个设备的行为。可以将协议详细信息加入
报告中。

使用 “Export“ (Export) 您可将整个列表另存为：
 PDF 文件
 HTML 文件
 CSV 文件 ( 参阅页 469 “CSV 导出 ”)

使用 “Print“ (Print) 可以打印整个列表。Industrial HiVision 将生成一个包含列
表内容的临时 PDF 文件，并使用安装在管理站中的 PDF 显示程序 （如 
Acrobat Reader）打开 PDF 文件。

使用 “Reload“ (Reload) Industrial HiVision 可以更新本对话框列表中的值。

使用 “Reset“ (Reset) Industrial HiVision 可将列表中的值复位为 “0”。

8.3.4 对象事件筛选 （Filter Events for Object）

通过 “Filter Events for Object“，您将以所选的 GUI 对象为基础对事件列表进
行筛选。您可以对具有以下对象类型的事件进行筛选：
• 设备
• 连接
• 端口
• 设备属性
为了对一个对象的事件进行筛选，请如下进行操作：
 请在选项卡上或者树视图中选择必要对象的数量。如果您至少选择了 1 个

对象，则 “Filter Events for Object“ 键被激活。
 点击 “Filter Events for Object“ 按键。

图 74:  通过 “ 对象事件筛选 (Filter Events for Object)” 功能生成的列表 
User Manual Industrial HiVision
Release 8.1 12/19 309



参考 8.3 View
事件列表显示了基于对象筛选的事件。事件列表信息栏上的 “Filter“ 区域显示
了有关为筛选所使用对象的信息。下面说明了某些可能的场景： 
如果您对基于 2 个设备之间的连接的事件进行筛选，则 “Filter“ 区域显示了信
息：
• 如果所连接设备已改名，则所连接设备的 IP 地址和名称在列 “Source“ 中
• “Component“ 列中的端口编号和名称
• 如果端口是 WLAN 接口或一个模块的一部分，则组件路径在 

“Component“ 列中。
如果您对基于文件夹的事件进行筛选，则 “Filter“ 区域显示了信息：
• 如果设备已改名，则所连接设备的 IP 地址和名称在文件夹的列 “Source“ 

中。

提示 : 如果您对设备的属性进行改名，则 Industrial HiVision 将仅搜索新的名
称。该规则对端口不适用。

8.3.5 返回 （Back）

使用 “Back“ (Back) 回到详细显示区的前一个视图。

8.3.6 前进 （Forward）

使用 “Forward“ (Forward) 进入详细显示区的下一个视图。
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8.3.7 上一级 （Up）

使用 “Up“ (Up) 进入详细显示区的下一更高层级。

8.3.8 Home View

“Home View“ 键让您可以将窗口大小和详细显示参数复位为您通过 “Set 
Home View Settings“ 键定义的设置。
以下参数为永久性预设：
 VLAN “All“(All)
 事件筛选器 “Last 24 Hours Events“
 选项卡视图 “Map“
功能示例的操作步骤如下：
 点击 “Home View“ 按键。
 请记下参数设置和窗口大小。
 请确定 VLAN 将仅对 VLAN 1 进行监控。
 将窗口大小设置为全屏。
 请在菜单树中选择另一个文件夹。
 请在选项卡 “List“ 上选择一个设备。
 请根据 “Unacknowledged Warnings & Errors“ 对事件进行筛选。

Industrial HiVision 现在将以全屏模式显示所选事件的事件。Industrial 
HiVision 还显示了是 VLAN 1 用户的设备，其为每个设备设有了状态颜色。
为了将显示复位为之前保存的配置，则请点击 “Home View“ 键。

8.3.9 Set Home View Settings

“Set Home View Settings“ 功能允许您设置窗口大小和定义显示内容的详细程
度 , 点击 “Home View“ 键，Industrial HiVision 会显示配置结果。
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功能示例的操作步骤如下：
 请确定已经将 “Edit Mode“ 激活。
 请按照需要确定视图。

 Industrial HiVision 支持保存以下设置：
– 请在菜单树中确定另一个文件夹。
– 定义其他的屏幕大小。
– 请确定最大化和普通视图。

 请点击功能 View > Set Home View Settings。
此外，您可以在列表 Configuration > Preferences > Display > Appearance > Home 
View Settings > Home Folder 中确定设置 ( 参阅页 364 “Appearance”)。

8.3.10 地理位置视图

使用 Industrial HiVision 可以在地图上显示设备的位置。
 在详细信息视图中使用鼠标右键点击设备，并选择 “Geographical 

Location View“ （地理位置视图）。 
如果满足了下列前提，则 Industrial HiVision 会在地图上显示设备的位置。
 坐标记录在设备的 “Location Coordinates“ （位置坐标）属性中。

参考 “ 组件详细设置的属性 ” on page 293.
 在 Configuration > Preferences > Advanced > External Applications 中的

“Geographical Location View“ （地理位置视图）下记录了用于地图显示
应用程序的 URL。
参考 “ 服务参数 ” on page 386.

8.3.11 缩放 （Zoom）

使用 “Zoom“ (Zoom) 可以将详细显示区的显示效果每次放大 10%。
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8.4 Configuration

8.4.1 Monitor

“Monitor“ 对话框中以表格形式列出当前监测组件的监测功能：
 属性，
 属性的值，
 接受与属性相关的警报信息 （陷阱）的值，
 由设备定期询问此属性的值，
 询问间隔，
 记录此属性的历史记录，
 历史记录循环存储器的大小 （条目数），
 从属性值中推导出的属性状态，
 将状态转发至下一更高层级。

双击表格行即可编辑属性的状态配置。

提示 : 点击 “Disable Polling“ 按键前，请保存您的项目 （参考 “Save” on 
page 269.）。该按键禁用当前属性的轮询并清除列表。此外，该按键还禁用
对话框 参考 “Save” on page 269. 中的标准轮询功能。
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图 75: Configuration > Monitor
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8.4.2 PSM 管理器

产品专用模块 (PSM) 描述可以读取Industrial HiVision 用于监控或写入该产品
用于配置的设备属性。
通过 PSM 管理器可更新 PSM 或除交货状态下包含的 PSM 之外导入其他 
PSM，并重新删除这些 PSM。
 Industrial HiVision 为 Industrial HiVision 没有为其提供 PSM 的设备分配

设备等级 “Switch”。
 在导入的时候，Industrial HiVision 将会把待导入的 PSM 的版本和可能已

经存在的 PSM 的版本进行对比。如果待导入的 PSM 已经存在，则 
Industrial HiVision 将打开一个对话框。对话框让您可以保留或覆盖已有
的 PSM。

提示 : Industrial HiVision 将在重新启动服务之后应用所作的修改。

图 76: Configuration > PSM Manager
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8.4.3 报告

除了用于网络管理系统程序数据库，该报告功能还可用于长期数据统计。

 监视 （Monitor）
表格中将列出所需监测的属性 ( 参阅页 302 “ 添加到报告：”)。
 更改此列表中的条目时，先选择条目，然后点击 “Edit“(Edit) 按键。
 删除此列表中的一个或多个条目时，先选择条目，然后点击 “Delete“ 

(Delete) 按键。
如果条目包含在模板中，则 Industrial HiVision 会拒绝删除该条目。
请在模板列表中删除条目，这样才可在监控列表中删除条目。

 由于编辑时可能会对该对话框中的条目进行更改，点击
“Refresh“(Refresh) 即可检查条目是否仍有效。

如果 Industrial HiVision 可以访问并询问其组件，则此条目有效。

提示 : 激活 Hirschmann Industrial HiVision 08.1.00 Service 后，Industrial 
HiVision 即可开始记录值。如果 Hirschmann Industrial HiVision 08.1.00 
Service 停止，则记录也将中断，直到 Hirschmann Industrial HiVision 
08.1.00 Service 重新启动。

 Templates
您可利用此对话框定义报告的格式。
 点击 “New“(New) 定义新模板。
 点击 “Edit“(Edit)  编辑新模板。

参数 含义
Record 激活此条目。

如果关闭了此对话框，且在 “ 监测 ”(Monitor) 对话框中点击了 “ 确
定 ”(OK) 或 “ 应用 ”(Apply)，则 Industrial HiVision 将根据下面的设
置开始记录。

Recording > Start > Now 如果关闭了此对话框，且在 “ 监测 ”(Monitor) 对话框中点击了 “ 确
定 ”(OK) 或 “ 应用 ”(Apply)，则 Industrial HiVision 将开始记录。

Recording > Start > Time 如果关闭了此对话框，且在 “ 监测 ”(Monitor) 对话框中点击了 “ 确
定 ”(OK) 或 “ 应用 ”(Apply)，则 Industrial HiVision 将立刻开始记
录。

Recording > Stop > Indefinite 记录开始后，Industrial HiVision 将持续进行记录，直到删除或更
改了此条目。

Polling Interval Industrial HiVision 定期询问设备值的时间间隔。

表格 32: 编辑监测表格中的条目
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 点击 “Delete“ (Delete) 删除一个或多个模板。
 点击 “Display Report“ (Display Report) 检查模板外观。

 为了避免在折线图中出现空缺，只汇总具有相同轮询间隔的属性。
 为了优化图表显示，Industrial HiVision 将不断使用最新数据填充数据

间的空缺。可以在表格报告中识别出为进行填充而插入的值，在 
Excel 文件中以灰色表示。

 Scheduling
通过此对话框，Industrial HiVision 可以为定义的时间段创建报告。
 点击 “New“(New) 定义新时间段。
 点击 “Edit“(Edit)  更改时间段。
 点击 “Delete“ (Delete) 删除一个或多个时间段。

Industrial HiVision 可以区分 3 种不同的时间段类型：
– 绝对的开始和结束时间 （“Absolute“(Absolute)）
– 绝对的开始时间和相对的结束时间 (“Relative Stop“(Relative Stop)）
– 相对的开始和结束时间 （“Relative“(Relative)）
 绝对的开始和结束时间 （“Absolute“(Absolute)）

Industrial HiVision 可以使用开始时间和结束时间之间的数据生成报
告。

参数 含义
Report > Name 以任意名称来标识此模板。
Report > Title Industrial HiVision 标在报告上方的标题。
Report Type > Type 报告的导出格式。

选项：“PDF“，“Excel“
Report Type > Layout 报告的显示。

选项：“Chart“(Chart)，“Table“(Table)
Report Type > Chart Type 图表显示的选项。

选项：“Line“ （Line，用于表示数值），“Bar“(Bar)
Data 选择之前添加到报告中的属性 ( 参阅页 302 “ 添加到报告：”)

表格 33: 定义新模板
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 绝对的开始时间和相对的结束时间 (“Relative Stop“(Relative Stop)）
Industrial HiVision 生成的报告
报告时间段每次均以相同的时间开始。
报告时间段每次均以稍后的时间结束，因此所包括的时间段越来越
长。

 相对的开始和结束时间 （“Relative“(Relative)）
Industrial HiVision 创建多个报告。 
报告均在上一份报告结束后开始。 
该报告包含来自同一长度的连续时间段的数据。 

参数 含义
Name Industrial HiVision 提供已有模板作为选项。
From 首次打开此对话框时，Industrial HiVision 将显示 Industrial HiVision 

开始为所选模板记录数据的时间点。如果报告应使用特定时间起的
数据，请在此处输入时间。
范围：记录开始后，生成报告前的时间点。

Until 报告时间段的结束时间。
范围：开始时间之后的时间点。

表格 34: 绝对开始和结束时间的时间控制

参数 含义
Begin of report period 首次打开此对话框时，Industrial HiVision 将显示 Industrial HiVision 

开始为所选模板记录数据的时间点。如果报告应使用特定时间起的
数据，请在此处输入时间。
范围：记录开始后，生成报告前的时间点。

Offset to execution 指的是数据的相对结束时间包含在报告中。包含在报告中的数据的
相对结束时间涉及到该报告的生成时间。
执行补偿是指包含在报告中的数据的相对结束时间和报告生成时间
之间的时间段。
范围：记录开始后和生成第 1 份报告之间的时间段。

First Execution Industrial HiVision 应生成第 1 份报告的时间点。
Schedule every 生成两份报告之间的时间段。

表格 35: 绝对开始时间和相对结束时间的时间控制
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 生成的报告
此对话框中列出了生成的报告。Industrial HiVision 将在 
\var\report_files 的安装目录中保存生成的报告。
 选中报告点击 “View“ (View) 即可显示报告。
 选中报告点击 “Save“ (Save) 即可保存报告。
 选中报告点击 “Delete“ (Delete) 即可删除一个或多个报告。
 点击 “Refresh“(Refresh) 按键更新列表。更新后，Industrial HiVision 将

把自上次更新以来生成的报告添加到列表中。
Industrial HiVision 将在表格下方显示 Industrial HiVision 保存报告的路
径。远程连接时，指定的路径是运行 Hirschmann Industrial HiVision 
08.1.00 Service 的文件系统。
报告功能所记录的数据将以快照方式显示。代表 Industrial HiVision 在特
定时间保存的属性的值。在此时间点之间对值的推断缺少相应基础。

8.4.4 Scheduler

“Scheduler“(Scheduler) 对话框支持自动执行 Industrial HiVision 的重复任
务。

参数 含义
Duration 通过持续时间可以设置包含在报告中的数据的相对开始时间。

范围：时间段短于连续执行之间的重复间隔负向补偿。
Offset to execution 指的是数据的相对结束时间包含在报告中。包含在报告中的数据的

相对结束时间涉及到该报告的生成时间。
执行补偿是指包含在报告中的数据的相对结束时间和报告生成时间
之间的时间段。
范围：记录开始后和生成第 1 份报告之间的时间段。

First Execution Industrial HiVision 应生成第 1 份报告的时间点。
Schedule every 生成两份报告之间的时间段。

表格 36: 相对开始时间和相对结束时间的时间控制
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 Task
该表列出已定义的任务，Industrial HiVision 按照保存的日程安排执行。
 点击 “New“(New) 定义新任务。
 点击 “Edit“(Edit) 编辑任务。
 点击 “Delete“ (Delete) 删除一个或多个任务。

 Scripts
通过 “Scripts“ (Scripts) 对话框可选择脚本操作以扩展自己的脚本。
 点击 “New“ (New) 定义新脚本。
 点击 “Edit“ (Edit) 更改或导入脚本。

参数 含义
Task Name 以任意名称来标识此任务。
Device 选择 Industrial HiVision 执行任务的设备。
Task Type Industrial HiVision 支持以下任务类型：

 “Standard“
 “Advanced“
 “Save Device Configuration“
 “Save Project“
根据选择更改该对话框的后续部分。

Standard Standard(Standard) 任务类型为 “ SNMP 操作 ”。
作为 SNMP 操作时，Industrial HiVision 提供以下操作：
– 启用 / 停用端口
– 启用 / 停用端口的 PoE 电压
选择操作后，设备端口选择以及相应参数 [ 启用 / 停用 ] 请见下
表。

Advanced Advanced(Advanced) 任务类型为 “ 脚本操作 ”。
作为脚本操作时，Industrial HiVision 提供以下操作：
– Cisco: show running config
– Cisco: show running config all
– HiOS: show running config
– HiOS: show running config all
在程序下可使用集成的远程登录客户端执行操作或选择带有参数传
送的专有程序。

Save Device Configuration 此选项实现存储设备配置的日程安排。可以选择多个设备、路径以
及定义文件的存储规则。

Save Project 使用该选项，以安排任务将项目数据库保存到您选择的位置。
该数据库中包含以下设备信息：
– 设备位置如选项卡 “Map“ 中所示
– “Map“ 选项卡中显示的设备间的数据连接
– 设备登录数据
– Industrial HiVision 设备状态配置

表格 37: 定义新任务
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 点击 “Delete“ (Delete) 删除一个或多个脚本。
 点击 “Duplicate“ (Duplicate) 复制脚本。

提示 : Industrial HiVision 使用 Telnet 或 SSH 会话在设备上运行脚本。成
功登录后，会话等待设备的特定输出。无线设备不发送输出。这会导致超
时 (Timeout)。要解决此问题，您可以设置 Industrial HiVision，使 
Industrial HiVision 打开命令行工具 （例如 Putty），然后运行脚本。

 Schedules
通过 “Schedules“ （Schedules）对话框可定义执行任务的时间安排。
 点击 “New“(New) 定义新任务。
 点击 “Edit“(Edit)  编辑任务。
 点击 “Delete“ (Delete) 删除一个或多个任务。

提示 : 1 个设备只能安排 1 个任务。

 Results
“Results“ (Results) 出了已执行任务的结果。
 点击 “View“ (View) 显示选择的事件。
 点击 “Delete“ (Delete) 删除事件。
 点击 “Refresh“(Refresh) 按键更新事件列表。

参数 含义
Script Name 以任意名称来标识此脚本。
Content 导入脚本或以文本形式输入脚本。

表格 38: 定义新的脚本

参数 含义
Task Name 在 "“Tasks“ (Tasks)" 对话框中的任务列表可供选择。
Execution 执行方式：次和多次任务通过输入的起始时间开始执行 , 实现多次

执行任务则通过输入的重复间隔时间 .。
Repetition 多次执行时输入重复条件：重复次数，结束时间。

表格 39: 定义新的日程安排
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 单个设备的事件日程安排示例
此示例展示保存设备配置事件的日程安排。Industrial HiVision 发现配置保
存过程中的错误时，识别的错误将保存到日志。 
Industrial HiVision 将日志文件保存到以下路径：
\log\services\HiVisionKernelDb.0.stderr.log。

提示 : 如果在设备配置检索期间 “Save Device Configuration“ 任务失败，
请按照以下步骤操作：
 确保 Industrial HiVision 可以访问选择的设备。
 确保设备上的 SNMP 和 HTTP 或 HTTPS 已激活。
 确保 Industrial HiVision 在选择的设备上有 SNMP、HTTP 和 HTTPS 管

理权限。
 确保选择的设备支持 “ 保存到 PC ” 或 “ 导出配置 ” 功能。

在 Industrial HiVision 中进行单个设备的配置文件保存事件的日程安排时，
请如下操作：
 打开 Industrial HiVision。
 验证 “Edit Mode“ 处于活动状态。
 要打开 “Scheduler“ 对话框，请单击 Configuration > Scheduler。
以下工作步骤与 “Tasks“ 选项卡有关：
 要打开 “New Entry“ 对话框，请单击 “New“ 按钮。
 输入描述事件的名称，例如 “Save Device Configuration“。
 从 “Device“ 列表中选择一个设备。
 在 “Task Type“ 字段中，从下拉列表中选择 “Save Device 

Configuration“ 选项。
 当所选设备支持该功能时，“Save Config“ 框架中的字段将处于活动状

态。在 “Save Config“ 框架中的以下字段中输入适当的信息：
– 在 “Destination folder“ 中，输入或浏览到您想要保存配置的位置。
– Industrial HiVision 在该 “File name“ 字段中输入

DeviceConfig_<IP Address>。
– 该 “On multiple task execution“ 字段允许您选择 Industrial HiVision

处理多个文件的方式。要保留配置更改的历史记录，请选择 “Add 
timestamp to target file name“。 

 Industrial HiVision 记录检测到的失败任务。为了配置  功能，请取消控
制复选框 “Suppress report creation for successfully completed task“ 
的选中。

 点击按钮 “OK“。
以下工作步骤与 “Schedules“ 选项卡有关：
 要打开 “New Entry“ 对话框，请单击 “New“ 按钮。
 在 “Task“ 字段中打开 “Name“ 下拉列表。
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 选择在前面的步骤中创建的任务。
 要使 Industrial HiVision 多次保存设备配置，请在 “Execution“ 字段中选

择 “Multiple execution“。
 您可以在 “Start Date“ 字段中保留当前日期和时间 （默认设置）。 
 将 “Interval“ 设置更改为 1 ，将单位更改为 “Days“。
 要使 Industrial HiVision 每天保存设备配置，直到您更改此设置，请在

“Repetition“ 字段中选择 “Repeat indefinitely“ 选项 （默认设置）。
 点击按钮 “OK“。

 多个设备的事件日程安排示例
您也可以设定 1 个事件来保存多个设备的配置。Industrial HiVision 发现配
置保存过程中的错误时，识别的错误将保存到日志。
日志文件保存在以下路径：
\log\services\HiVisionKernelDb.0.stderr.log。

提示 : 设备配置中 “Save Device Configuration“(Save Device 
Configuration) 任务失败时，请如下操作：
 确保 Industrial HiVision 可以访问选择的设备。
 确保设备上的 SNMP 和 HTTP 或 HTTPS 已激活。
 确保 Industrial HiVision 在选择的设备上有 SNMP、HTTP 和 HTTPS 

管理权限。
 确保选择的设备支持 “ 保存到 PC” 或 “ 导出配置 ” 功能。

在 Industrial HiVision 中进行多个设备的配置文件保存事件的日程安排
时，请如下操作：
 打开 Industrial HiVision。
 请确定 “Edit Mode“(Edit Mode) 已激活。
 在 “Map“(Map) 选项卡上选择需要保存配置的设备。您也可以选择

“List“(List)， “Devices“(Devices) 和 “Security“(Security) 选项卡上的设
备。

 右键单击设备。
 在下拉列表中选择 “Schedule Saving Device Configuration“(Schedule 

Saving Device Configuration)。“Schedule Saving Device 
Configuration“(Schedule Saving Device Configuration ) 对话框打
开。Industrial HiVision 在 “Device“(Device) 栏突出显示您在
“Map“(Map) 选项卡上选择的设备。
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 在 “Save Config“(Save Config) 栏的以下字段输入相应信息：
– 在 “Destination folder“(Destination folder) 输入保存配置的位置或

导航到保存位置。
– Industrial HiVision 将 DeviceConfig_<IP Address> 输入 “File 

name“(File name) 字段。
– 在 “On multiple task execution“(On multiple task execution) 栏选择 

Industrial HiVision 如何处理多个文件。选择 “Add timestamp to 
target file name“(Add timestamp to target file)，维护配置变更历史
记录。 

 Industrial HiVision 日志检测到失败的任务。要记录成功任务，请清除
“Suppress report creation for successfully completed task“ 复选框。

 “Reporting“(Reporting) 栏还包含 “Schedule Execution“(Schedule 
Execution) 功能。此功能实现配置文件保存事件的日程安排。功能激
活时，Industrial HiVision 将设备配置保存到各个文件。

 使 Industrial HiVision 多次保存设备配置时，在 “Execution“(Execution) 
栏中选择 “Multiple execution“(Multiple execution)。

 可以保留 “Start Date“(Start Date) 栏中的时间和日期设定（预设置）。 
 将 “Interval“(Interval) 设置更改为 1，单位更改为 “Days“(Days)。
 确定 “1 minute delay between start of tasks“(1 minute delay between 

start of tasks) 功能已激活。借助此功能，Industrial HiVision 可以在设
备配置存储进程之间添加延迟。

 需要 Industrial HiVision 每天保存设备配置，直到您更改这一设定时，
请在 “Repetition“(Repetition) 栏中选择 “Repeat indefinitely“(Repeat 
indefinitely) （预设置）。

 点击 “OK“(EDS File) 按键。

 Save Project(Save Device Configuration) 事件日程安排示例
“Save Project“(Save Device Configuration) 任务让您能够安排项目数据库
的备份。

提示 : 随 “Save Project“(Save Device Configuration) 任务创建的备份文件
视版本而定。

为 Industrial HiVision 中安排事件并保存项目数据库的备份，请如下进行
操作：
 请确定 “Edit Mode“(Edit Mode) 已激活。
 需要打开 “Scheduler“(Scheduler) 对话框时，点击 Configuration > 

Scheduler。
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以下步骤在 “Tasks“(Schedules) 选项卡上操作：
 点击 “New Entry“(New) 按键打开 “New“(New Entry) 对话框。
 输入描述事件的名称，例如 “Save Project“(Save Device 

Configuration)。
 在 “Task Type“(Task Type) 栏的下拉列表中选择 “Save Project“(Save 

Device Configuration)。
 请在 “Save Project File“(Save Project File) 栏中输入以下信息： 

– 请在 “Destination folder“(Destination folder) 栏中输入想要存储文件
的路径。

– 请在 “File name“(File name) 栏中输入能够描述文件的名称。
– 以下步骤导致同一位置出现多个文件。请打开下拉列表 “On 

multiple task execution“ 并选择 “Overwrite target file“ 或 “Add 
timestamp to target file name“。

 Industrial HiVision 采集识别到的失败任务记录。禁用 “Suppress report 
creation for successfully completed task“ (Suppress report creation for 
successfully completed task) 以记录成功任务。

 请点击 “OK“(OK) 按键。
以下步骤在 “Schedules“(Schedules) 选项卡上操作：
 点击 “New Entry“(New) 按键打开 “New“(New Entry) 对话框。
 在 “Task“(task) 栏中打开下拉列表 “Name“(Name)。
 选择在前面的步骤中创建的任务。
 为使 Industrial HiVision 多次保存项目数据库，在

“Execution“(Execution) 栏中选择 “Multiple execution“(Multiple 
execution) 选项。

 可以保留 “Start Date“(Start Date) 栏中的时间和日期设定 （预设置）。
 将 “Interval“(Interval) 设置更改为 1，单位更改为

“Weeks“(Days)。“Save Project“(Save Project) 任务的最小值为 1 小
时。

 为使 Industrial HiVision 每周保存项目数据，直到您更改这一设定为
止，请在 “Repetition“(Repetition) 栏中选择 “Repeat 
indefinitely“(Repeat indefinitely) （预设置）选项。

 请点击 “OK“(OK) 按键。
User Manual Industrial HiVision
Release 8.1 12/19 325



参考 8.4 Configuration
8.4.5 Preferences

在 “Preferences“(Preferences) 窗口可以进行程序的基本设置。这些设置包
括监测功能、管理功能、显示选项、访问权限等。 

图 77: Configuration > Preferences

 点击 “OK“ 可以将更改应用到对话框并关闭窗口。
 为了在切换到其他对话框前将更改应用到对话框，请您点击 “Apply“ 

(Apply) 按键。
 点击 “Cancel“(((Cancel) 按键关闭窗口任何未使用 “Apply“ (Apply) 保存的

更改均将丢失。

 导入和导出用户设置
Industrial HiVision 支持导入和导出用户参数设置。Industrial HiVision 将用
户设置导出为扩展名为 .prefs 的文件。可以将文件用于备份或导入用户设
置到新管理站。导入用户设置后应用重新启动。
出于安全考虑，Industrial HiVision 导出的文件不包含以下参数：
 密码
 密码相关用户设置
 用户管理设置
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 许可证
 设备登录信息
 移动设备登录信息

提示 : Industrial HiVision 显示信息通知，可以选择在导出用户设置文件前
应用这些设置。
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Preferences > Basics

8.4.6 Basics
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Preferences > Basics > Discovering devices

 Discovering devices
可以在对话框中设置 Industrial HiVision 在网络结构中识别设备的方
式。Industrial HiVision 将在已注册的目标文件夹中显示新识别出的设备。
如果您在网络扫描列表 （见下文）中没有注册已激活的目标文件夹，则 
Industrial HiVision 将在 “New Devices“ （新设备）文件夹中显示新识别
出的设备。
工具栏中的搜索功能可以帮助您发现已识别的设备。

Industrial HiVision 为您提供 “Discovery Mode“ （设备识别模式）的以下
几种方式：
 “Standard“

Industrial HiVision 使用您选择的方法用于设备识别。
 “Monitoring Mode“

Industrial HiVision 只评估 “Cold Start Trap“（冷启动陷阱）和 ARP 答
复用于设备识别。

 “Rogue Device Detection“
Industrial HiVision 使用您选择的方法用于设备识别，并将新识别的设
备放入 “Rogue Devices“ （非法设备）文件夹内。

Industrial HiVision 可提供以下设备识别方式：
 通过触发事件识别设备
 借助 HiDiscovery 协议识别设备
 通过定义的 IP 地址范围识别设备 （“Network Scan“(Network Scan)）
 识别新创建的设备
 通过列表识别设备

通过触发事件识别设备。
接通电源后设备将发送一个接通信息到设备内的网络管理站。
Industrial HiVision 将读取设备的属性：
– Industrial HiVision 将像对待新设备一样重新读取设备的所有属性和结

构 （新的 / 已删除的模块或电源）。
– 重新读取属性：Industrial HiVision 重新读取已识别的属性。
示例：维护工作期间关闭有两个电源的设备。如果电源出现故障，且设备
处于接通状态时，Industrial HiVision 将如何操作？
– 通过设置 “Reload Device“ (Reload Device) Industrial HiVision 以绿色

显示带有一部电源的设备。
– 通过设置 “Reload Properties“ (Reload Properties) Industrial HiVision 

显示带有两部电源的设备，其中一部电源以红色显示。
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Industrial HiVision 将在相应文件夹中显示新识别出的设备。
在网络监测运行时使用这种设备识别方法对带宽有着很严格的要求。

借助 HiDiscovery 协议识别设备
HiDiscovery 协议可借助 MAC 地址与子网中 Hirschmann 协议激活的 
Hirschmann 设备进行通信。下列 Hirschmann 系列设备均支持 
HiDiscovery 协议。 
– MACH
– GREYHOUND
– PowerMICE
– MICE
– RS
– RSB
– RSR
– RSP
– GECKO
– OCTOPUS
– EES
– EAGLE
– BAT (without BAT-C)
– RR-EPL
此方法帮助识别网络中尚未分配有效 IP 地址的设备。
Industrial HiVision 将在相应文件夹中显示新识别出的设备。
需要将新安装的网络投入运行，或为新设备分配 IP 地址时可选择这种方
法。选择此方法暂时保护您的网络不会出现不必要的网络负荷。
 在 “Polling Interval“(Polling Interval) 栏中输入需要的轮询时间间隔，在

下拉列表中选择单位：秒、分钟、小时或天。
预设置：5 分钟。
请注意对系统资源的影响 ( 参阅页 230 “ 对系统资源的影响 ”)。

通过定义的 IP 地址范围识别设备 （网络扫描）
通过 “Network Scan“(Network Scan) 功能，Industrial HiVision 定期向 IP 
地址在定义范围内的设备发送 Ping 请求，并在定义的目标文件夹中显示
新响应的设备。 
防火墙拦截 Ping 请求。
点击 “evaluate ARP“(evaluate ARP) 复选框后，Industrial HiVision 可识别
透明防火墙后的设备。透明防火墙传送 ARP 答复 (ARP-Response)。如
果到预定时间仍未有 Ping 答复，Industrial HiVision 将分析 ARP 答复。
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“Network Scan“(Network Scan) 方法适用于监测正在运行的网络。请根据
您的网络带宽调整询问频率。 
 在 “Polling Interval“(Polling Interval) 栏中输入询问的时间间隔，在下拉

列表中选择单位：秒、分钟、小时或天。 
预设置：15 分钟。
请注意对系统资源的影响 ( 参阅页 230 “ 对系统资源的影响 ”)。

 点击 “New“ (New) 键，以输入 IP 地址范围。输入 IP 地址范围时需要的
信息：
– 询问范围的第一个 IP 地址，
– 询问范围的最后一个 IP 地址；
– 所属网络掩码
– 询问时此范围的激活 / 禁用，
– 为此范围输入的任意名称，以及
– Industrial HiVision 用于显示新识别设备的目标文件夹。

您可以输入重叠的 IP 地址范围，Industrial HiVision 将在相关文件
夹中生成此设备的副本。

该表将显示已创建的 IP 地址范围。
 为了对一个 IP 地址范围进行编辑，请选中表格中的行，并点击 “Edit“ 

键。
 为了从表格中将一行删除，请选中表格中的行，并点击 “Delete“ 键。
 为了对一个 IP 地址范围进行复制，并随后对副本进行修改，请选中表

格中的行，并点击 “Duplicate“ 键。

识别新创建的设备
在此设置创建新设备时显示的输入 IP 地址的对话框 ( 参阅页 142 “ 添加新
设备 ”)。
识别 IP 地址列表中的设备
Industrial HiVision 可以通过文本文件或 Microsoft Excel 文件 （CSV），
对 IP 地址进行扫描。通过对话框 “Create Devices from List“，可以查找文
件并上传至 Industrial HiVision。如果在列表中查找不到某个设
备，Industrial HiVision 则该设备在拓扑图中作为通用设备显示。 ( 参阅
页 267 “Devices from List”)
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图 78: Configuration > Preferences > Basics > Discover Devices
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Preferences > Basics > User Management

 User Management
用户管理基于某种角色模型。
在 “Access Roles“(Access Roles) 框中定义角色名称。通过分配访问权限
给这些角色分配角色功能。例如，给管理人员自然要分配可用的权限，而
观察员尽管可以登录，但没有能够进行更改的权限。
Industrial HiVision 支持以下访问角色：
 “Login“
 “Edit Mode“
 “User Management“
 “Web Access“

创建访问角色后，创建用户，并给用户分配一个或多个上面设立的角色。
这种分配取决于 Industrial HiVision 用来审核用户授权的方法。
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Industrial HiVision 使用 3 种 “Policies“ （方法）来审核用户授权。
– “Local Users“ （本地用户），具有角色分配的本地用户名。

Industrial HiVision 将上面创建的角色名称应用到用户列表标题行。这
样就能方便地给用户名分配角色。

– “LDAP Server“ （LDAP 服务器），借助轻型目录访问协议的中央用户
控制。
给您的 LDAP 服务器管理员提供有关 Industrial HiVision 用户及其访问
权利角色的信息。
给您的 LDAP 服务器管理员提供下列网络数据，用于输入到 LDAP 服
务器中：
– “User Name“
– “Password“
– “Access Roles“
(Reporting) Preferences > Basics > User Management > LDAP Server 
Configuration 栏包含 “Use Secure Connection“(Suppress report 
creation for successfully completed task) 复选框。使用 LDAP 服务器
授权 Industrial HiVision 用户时，该复选框允许您在安全连接和不安全
连接之间进行选择。 
 如果选中该框，则用户通过 SSL 连接向服务器进行身份验

证。Industrial HiVision 和 LDAP 服务器之间的数据交换是加密的。
 如果未选中该框，则连接不安全，密码等数据以纯文本形式发送。
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– “RADIUS Server“ （RADIUS 服务器），借助远程认证拨号用户服务的
中央用户控制。
给您的 RADIUS 服务器管理员提供下列网络数据，用于输入到 LDAP 
服务器中：
– “User Name“
– “Password“
– “Access Roles“
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在 “User Management“(User Management) 对话框下部可以定义 
Industrial HiVision 验证用户权限的方法。只要字段 “Selected Order“ （所
选顺序）为空，则可自由访问 Industrial HiVision。
Industrial HiVision 使用此栏中的一个条目验证权限。第一种方法验证失
败后，#Industrial HiVision 通过第二种方法进行验证。如果  Industrial 
HiVision 没有成功进行授权审核，Industrial HiVision 拒绝访问。

为了使 HiMobile 用户能够访问 Industrial HiVision 应用，请如下操作：
 请选择 Industrial HiVision。
 请确定 “Edit Mode“(Edit Mode) 已激活。
 打开对话框 Configuration > Preferences > Basics > User Management。
 点击 “New“(New) 为 HiMobile 用户创建访问角色。
 在 “Role Name“(Role Name) 栏输入 HiMobile。
 在 “Permissions“(Permissions) 框选择 “Login“ 和 “Web Access“(Web 

Access) 复选框。 

提示 : Hirschmann 建议为 HiMobile 用户禁用 “Edit Mode“(Edit Mode) 
和 “User Management“(User Management) 选项。

 点击 “OK“ 按键。
 打开对话框 Configuration > Preferences > Advanced > Services Access。
 确定 “Web Server“(Web Server) 选项已激活。
 创建证书并将此证书导入到您的移动设备 ( 参阅页 250 “HTTPS 连接证

书 ”)。
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Preferences > Basics > Event Forwarding

 Event Forwarding
通过该对话框可以设置向系统日志服务器传送事件。
通过 “Forward events to syslog server“ 启用 / 禁用全局事件转发功能。事
件传送功能启用时， Industrial HiVision 会在事件出现时向在该对话框中
登录的系统日志服务器发送系统日志消息。
通过 “Forward internal events“ 例如，“Industrial HiVision Started“, 
Industrial HiVision 还会发送有关 Industrial HiVision 内部事件的系统日志
消息。
通过 “Forward events of all devices“, Industrial HiVision 每个可用设备的
系统日志消息发送到系统日志服务器。标记 “Forward events of all 
devices“ 复选框时，“Forward events for devices“ 表被隐藏。
使用 “Event Type“，您可以指定事 Industrial HiVision 在什么评估级别上
发送系统日志消息。
在 “Forward events for devices“ 表中，输入其事件应导致系统日志消息的
设备。
在 “Syslog servers“ 表中，输入 Industrial HiVision 向其发送系统日志消息
的系统日志服务器的数据。
Industrial HiVision 通过以下传输协议设置与系统日志服务器的通信：
 用户数据报协议 （UDP）
 传输层安全性 （TLS）
使用 TLS 协议时，Industrial HiVision 将接受系统日志服务器的证书，而
无需其他验证。
在某些情况下，系统日志服务器可能需要两步验证过程，其中包括对客户
端证书的验证。如果系统日志服务器需要两步验证过程，则无法与系统日
志服务器进行通信。
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图 79: Configuration > Preferences > Basics > Event Forwarding
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Preferences > Basics > Event Forwarding

 Event Actions
可以在此对话框中定义出现特定事件时需要 Industrial HiVision 执行的操
作。

图 80: Configuration > Preferences > Basics > Event Actions

该 “Actions“ 框架描述了 Industrial HiVision 可以执行的操作：
 在屏幕上打开消息窗口
 发送短信
 播放声音
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 发送邮件
 执行程序（参见 “ 在 Windows 系统下安装 ” 中的提示）。在下图 ( 参阅

图 81) 中，您将以用户程序 “ siren.exe ” 为例。
 要指定您要分配给事件的操作，请单击 “New“ 按钮。

第 1 次尝试时无法执行操作，例如发送短信时线路占用，Industrial 
HiVision 支持重复操作。
“New Entry“ 对话框包含 “Test Action“ 按钮。“Test Action“ 按钮使您可
以测试配置。

“Send SMS“ 操作的前提条件是
– 将网络管理站通过例如调制解调器连接到电话网并
– 正确配置短信程序。
在 “Recipient“ 下输入收件人的电话号码。
如果您输入调制解调器的电话号码作为 “Sender“，则 Industrial 
HiVision 会将其与消息一起发送。因此您的手机上将显示发件人
为 Industrial HiVision。
作为 “Service Provider“ 您可以输入已在短信程序 （如果可用）中配
置好的可用服务。 

在 Preferences > Advanced > External Applications 下请确保用于所需帮助程
序的条目存在且符合您的要求。

该表将显示已创建的操作。
 要编辑操作，请在表中选择一行，然后单击 “Edit“ 按钮。
 要从表中删除行，请选择表中的行，然后单击 “Delete“ 按钮。
 要复制操作，以便随后可以修改副本，请在表中选择一行，然后单击

“Duplicate“ 按钮。
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图 81: Configuration > Preferences > Basics > Event Actions > Actions，用于应用程序
“ siren.exe ” 的 “ Execute program ” （执行程序）操作的示例

当某些事件发生时或未确认某些事件时，“Alarms“ 框架提供了执行动作的
可能性。
在 “Type“ 下，您指定 Industrial HiVision 执行该操作的时间。
在 “Alarm“ 下方，输入要触发动作的事件的任何名称。
在 “Filter“ 下，您可以定义触发以下所选动作的事件。Industrial HiVision 
可以使用通配符定义筛选器。 

为进行简化，“Import...“ 提供的事件已经包含在了事件框中。
 选中某一行并点击 “OK“ 按钮。

Industrial HiVision 接受了筛选器框中所选事件的属性。

名称 含义
Type 选择状态类型 （错误，警报，...），
Category 特定类别的事件 （状态改善，新设备，...），
User 网络管理站的登录名，
Source 事件原因，
Component 事件原因的组件，
Message 事件的纯文字描述，

表格 40: 筛选标准
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可以在 “Message“ 行中输入用于操作的纯文本信息。为此，您可以输入
带有 $ 前缀的变量作为筛选关键词。请输入大写的关键词。在消息中输入
“ $TIME ”，Industrial HiVision 会将事件发生的时间输入至消息
中。“Message“ 行的气泡帮助中将列出 Industrial HiVision 所能提供的关
键词。

以下列表包含保留给 Industrial HiVision 内部用法的单词。如果您在
“Message“ 字段中键入任何单词，则 Industrial HiVision 会打开错误消息。
禁止单独使用单词或将其作为更长单词的一部分。保留字仅适用于英语和
德语图形用户界面 （GUI）。

保留的英语单词列表：
 Alarm
 alarm
 Alarms
 alarms
 Actions
 actions
 Message
 message
 Critical
 critical
保留的德语单词列表：
 Alarm
 Alarme
 Alarms
 Nachricht
 Kritisch

“Time“ 框架为您提供了设置时间段的机会，在这段时间段内 Industrial 
HiVision 用动作对事件进行响应。 

在 “Actions“ 操作框中可以选择一个或多个之前创建的操作。当发生以上
定义的事件或在 “Type“ 中指定的时间内未确认事件时，Industrial 
HiVision 执行这些操作。
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图 82: Configuration > Preferences > Basics > Event Actions > Alarms > Message

以下示例配置描述了如何配置 Industrial HiVision 以发送事件电子邮件。
在此示例中，您配置以下 Configuration > Preferences 对话框：
 Advanced > 服务参数对话框
 Basics > Event Actions > Actions > New > New Entry 对话框 
 Basics > Event Actions > Alarms > New > New Entry 对话框
User Manual Industrial HiVision
Release 8.1 12/19 343



参考
为了使 Industrial HiVision 发送电子邮件，它连接到电子邮件服务器主机。
从您的电子邮件服务器管理员那里获取以下服务器信息： 
 主机名称
 Industrial HiVision 用于发送电子邮件的电子邮件帐户的名称。使电子

邮件发件人的名称易于识别为 Industrial HiVision。
 Industrial HiVision 是否必须登录到服务器？如果是这样，那么以下信

息是必要的：
– 服务器使用哪种类型的连接。Industrial HiVision 使用以下协议进行

连接：
正常，不安全的通讯 
STARTTLS，开始 TLS 会话
SSL，使用安全套接字层协议

– 服务器使用哪个 TCP 端口。
– 用于认证的用户名和密码。

以下各项可以防止 Industrial HiVision 发送电子邮件：
 防火墙设置
 病毒防护设置
要将 Industrial HiVision 配置为连接到电子邮件服务器，请按照下列步骤
操作：
 请打开 Advanced > 服务参数对话框。
 在 Mail Server > SMTP Mail Host 字段中，输入电子邮件服务器的名称，例

如 smtp2.xxxx.com。
 在 “Sender Address“ 字段中，键入 Industrial HiVision 发送电子邮件的

电子邮件帐户，例如， Industrial HiVision@xxxx.com.。
 点击按钮 “OK“。

要将电子邮件发送给负责该任务的人员，请按照下列步骤操作：
 请打开 Basics > Event Actions 对话框。
 要在 “Actions“ 表中进行输入，请单击 Actions > New 按钮。
 在 Edit > Action > Name 字段中，输入值 Send_email_to_admin。
 在 “Action“ 下拉列表中，选择 “Send E-Mail“ 选项。
 在 “Recipient“ 字段中输入负责该任务的人员的电子邮件地址。
 点击按钮 “OK“。

要配置 Industrial HiVision 发送电子邮件的事件，请执行以下操作：
 请打开 Basics > Event Actions 对话框。
 要在 “Alarms“ 表中进行输入，请单击 Alarms > New 按钮。
 在“Edit“对话框中，输入您希望在“Name“字段的主题行上显示的文本。
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 在 “Filter“ 框架中输入您希望作为电子邮件发送的事件。
当 Industrial HiVision 在 “Event History“ 中有一个事件要发送为电子邮
件时，您可以让 Industrial HiVision 使用 “Import...“ 按钮自动在 “Filter“
框架中输入值。
– 点击按钮 “Import...“。
– 从选项卡中选择事件 “Application Events“。
– 点击按钮 “OK“。
您还可以生成可以作为电子邮件发送的测试事件。 参考 “Generate test 
events” on page 299.

 在 “Message“ 字段中输入您希望显示在电子邮件正文中的消息。
您可以输入自由文本或使用令牌。当您将鼠标悬停在文本字
段 Industrial HiVision 上时，会显示一个气泡帮助，其中包含可以使用
的令牌。标记表示事件日志中显示的列。例如，$TYPE = “Type“ 列， 
$MESSAGE = “Message“ 列。

 在 “Actions“ 表中标记 Send_email_to_admin 复选框。
 点击按钮 “OK“。
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Preferences > Basics > User defined Action

 User defined Action
自定义操作支持通过网络管理站启动其他设备上的操作。

界面示例：“ 调用远程客户端界面 ”
想要通过远程客户端例如 ”Putty” 访问已知设备，例如交换机。
 请在 Industrial HiVision 菜单栏中选择 Configuration > Preferences。
 请在 “Preferences“(Preferences) 对话框中选择 Basics > User defined 

Actions。
 定义用户可以配置的新操作时，点击 “New“(New) 按键。
 在 “Name“(Name) 栏输入验证调用远程客户端的名称，例如 “ 通过远程

管理交换机 ”。
 在 “Available for“(Available for) 行选择启动操作的符号。Industrial 

HiVision 根据下拉列表中的定义设置操作。使用鼠标右键点击
“Actions“ (Actions) 图标即可找到操作。
– 想在之后的特定时间在设备层级调用操作时，请在 “Available 

for“(Available for) 下拉菜单中选择 “Device“(Device)。
 在下拉列表 “Device Type“(Device Type) 中选择 “All“(All)。
 您希望在运行着 Industrial HiVision 用户界面的计算机上启动远程登录

客户端。远程登录客户端等待开关管理员的互动。请选择 “Desktop“ 
(Service) 作为 “Location of Execution“ (Location of Execution) ( 参阅
表格 41)。

Location[ 地点
]

含义

Desktop Industrial HiVision 在运行 Industrial HiVision 界面的计算机上启动应用。服务
可以在另一台计算机上运行。服务可以在另一台计算机上运行。
启动 Industrial HiVision 的应用需要交互时，选择 “Desktop“(Desktop)。
应用示例：启动远程客户端

Service Industrial HiVision 在服务运行的计算机上启动应用。 
使用此选项可以配置仅允许通过网络管理站 IP 地址配置的设备。
应用示例：想从多个界面 （以及小应用程序）调用的配置脚本或执行批处理文
件的配置脚本 （“ 界面示例 ”）。

Browser Industrial HiVision 通过 URL 启动应用。
示例：要在浏览器中打开设备的图形用户界面，请在
“Parameters“(Parameters) 栏输入以下值：  http://10.0.1.13。

表格 41: 自定义操作的执行地点
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 在 “Application“(Application) 文本框中输入应用的路径和名称。您还可
以点击 “...“ 选择应用。
若要选择远程登录客户端应用 “Putty”，请输入例如： 
C:/Data/Software/putty.exe。

 通过 “Parameters“(Parameters) 字段可以向应用传输带 Token 参数。
在示例中，请输入：
– 调用远程登录
– 设备 IP 地址的 Token 参数
$“-telnet $IP_ADDR“

服务示例：“ 激活 / 禁用端口 ”
为访客准备的空间有以太网连接。每个人都可以自由访问这个空间。因
此，您需要只在实际访问时才与以太网端口连接的端口。
 为此，请使用 SNMP 命令编写以下小批处理文件以激活 / 禁用端口：
适用于 Windows 用户：
1. 批处理文件：Port-on.bat
set IP_ADDR=%1%
set IF_INDEX=%2%
"<installation folder>\bin\SnmpSet.cmd.exe" -c private %IP_ADDR% 
1.3.6.1.2.1.2.2.1.7.%IF_INDEX% integer 1

2. 批处理文件：Port-off.bat
set IP_ADDR=%1%
set IF_INDEX=%2%
"<installation folder>\bin\SnmpSet.cmd.exe" -c private %IP_ADDR% 
1.3.6.1.2.1.2.2.1.7.%IF_INDEX% integer 2

适用于 Linux 用户：
1. 批处理文件：Port-on.bat
#!/bin/bash
IP_ADDR=$1
IF_INDEX=$2
"<installation folder>/bin/SnmpSet" -c private $IP_ADDR 
1.3.6.1.2.1.2.2.1.7.$IF_INDEX integer 1

2. 批处理文件：Port-off.bat
#!/bin/bash
set IP_ADDR=%1%
set IF_INDEX=%2%
"<installation folder>/bin/SnmpSet" -c private $IP_ADDR 
1.3.6.1.2.1.2.2.1.7.$IF_INDEX integer 2

使用以下命令将文件标记为 Executable， Exec-Bit：chmod 700 Port-
On.sh。
 将批处理文件保存到您的网络管理站，例如保存到路径 

C:\Data\PortOnOffBatch。
 请在 Industrial HiVision 菜单栏中选择 Configuration > Preferences。
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 请在 “Preferences“(Preferences) 对话框中选择 Basics > User defined 
Actions。

 定义用户可以配置的新操作时，点击 “New“(New) 按键。
 输入第 1 个批处理文件的名称，例如 “ 激活访客端口 ”。
 在 “Available for“(Available for) 行选择启动操作的符号。Industrial 

HiVision 根据下拉列表中的定义设置操作。使用鼠标右键点击
“Actions“ (Actions) 图标即可找到操作。
– 想在之后的特定时间在设备层级调用操作时，请在 “Available 

for“(Available for) 下拉菜单中选择 “Device“(Device)。 
 在此示例中，连接访客空间的端口连接到 RS30 导轨式交换机。在下

拉列表 “Device Type“(Device Type) 中选择  “OpenRail, Mach 4000, 
Octopus“。

 您希望在运行着 Industrial HiVision 服务的计算机上启动批处理文
件。Industrial HiVision 在调用批处理文件时将端口的界面编号作为命
令参数传送。然后批处理文件自行关闭运行。请选择 “Service“ 
(Service) 作为 “Location of Execution“ (Location of Execution) ( 参阅
表格 41)。

 在 “Application“(Application) 文本框中输入应用的路径和名称。您还可
以点击 “...“ 选择应用。
为示例输入以下内容：C:\Data\PortOnOffBatch\Port-on.bat

 通过 “Parameters“(Parameters) 字段可以向应用传输 Token 参数。为
此示例输入以下信息：
– 设备 IP 地址的 Token 参数
– 端口的 Token 参数
$IP_ADDR $USER

在 “Parameters“(Parameters) 文本框中输入 $USER 值时，Industrial 
HiVision 打开 “User Input Prompt“(User Input Prompt) 文本框。

 通过 “User Input Prompt“(User Input Prompt) 文本框可以在 “User 
Input“(User Input) 对话框中输入说明。
在本例中，输入：“ 输入接口号 ”。

“Advanced“ (Advanced) 中包括更多详细功能：
 “Token Language“

Industrial HiVision 将使用这种语言将 Token 参数的内容传输到应用
中。涉及的 Token：“ 状态 （文本）”，“ 值 ” 和 “ 名称 ”。

 调用操作时询问密码
如果从输入密码到下一次调用操作的间隔长于 30 分钟，则 Industrial 
HiVision 将再次询问密码。

 应用事件内容的显示设置
 应用事件显示方式的显示设置

“Only In Case Of Failure“(Only In Case Of Failure)：应用的返回值为
一个非 0 值时，将出现错误。
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图 83: 自定义操作的示例

浏览器示例：“ 调用网络浏览器 ”
您希望访问 Industrial HiVision 服务的网络服务器，以读取事件列表。
 请在 Industrial HiVision 菜单栏中选择 Configuration > Preferences。
 请在 “ 设置 ” 对话框中选择 Basics > User defined Actions。
 定义用户可以配置的新操作时，点击 “New“(New) 按键。
 输入任意名称以调用远程登录客户端，例如 “ 事件列表 ”。
 在 “Available for“(Available for) 行选择启动操作的符号。Industrial 

HiVision 根据下拉列表中的定义设置操作。使用鼠标右键点击
“Actions“ (Actions) 图标即可找到操作。
– 想在之后的特定时间在设备层级调用操作时，请在 “Available 

for“(Available for) 下拉菜单中选择 “Device“(Device)。 
 “Device Type“(Device Type) 选择  “Windows PC“。
 您想在网络浏览器中查看事件列表。请选择 “Browser“ (Service) 作为

“Location of Execution“ (Location of Execution) ( 参阅表格 41)。
 通过 “Parameters“(Parameters) 行，可以向应用传输 Token 参数。在

示例中，请输入：
– 调用网络浏览器
– 计算机 IP 地址的 Token 参数， Industrial HiVision 服务在此运行。
– Industrial HiVision 网络服务器的端口
– 您想查看的网络页面
http://$IP_ADDR:11187/events
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Preferences > Basics > License

 License
运行 Industrial HiVision 需要许可证密钥。可显示设备的数量与许可证密
钥有关。因此您在 Industrial HiVision 上的投资成本可以始终与您的网络
发展相适应。
重装和升级后需要新的许可证密钥。Industrial HiVision 将没有许可证的设
备置为 ”Unmanaged” （未管理）状态。一旦您为此设备输入了许可证密
钥，则可以重新将其状态置为 ”Managed” （管理）状态。
Industrial HiVision 使用印章代表没有有效许可证的设备。

图 84: 没有 Industrial HiVision 许可证密钥的设备。

 点击 “New“(New) 并在输入窗口中输入许可证密钥。如果您拥有电子形
式的许可证密钥，则可以利用复制和粘贴重新输入。
点击 “OK“ 结束输入。
使用同样的方法添加新的许可证密钥和升级许可证。

输入许可证密钥后，Industrial HiVision 将在表格行中显示此许可证密钥。

完整版的许可证允许您在 Industrial HiVision 中监测特定数量的设备。是
否为完整版许可证与购买时 Industrial HiVision 的版本有关。

名称 含义
Key 密钥编号
Version Industrial HiVision 软件版本号
Expires 许可证有效期结束的日期
Type 完整版或升级版
Devices 许可证所包括的设备数量
Hardware Key 需要输入许可证密钥时您所输入的硬件密钥。如果

此许可证密钥的硬件密钥与许可证列表中的硬件密
钥相匹配，则可以将此许可证密钥用于网络管理
站。

License Holder 需要输入许可证密钥时您所输入的名称。
Registration Code 购买完整版本、升级或维护计划时获得的注册代

码。您已使用该注册代码索要许可证密匙。 

表格 42: 许可证表内的项
350
User Manual Industrial HiVision

Release 8.1 12/19



参考
提示 : Industrial HiVision 将会使用网络管理站中的一些硬件组件来确定硬
件密钥。这些硬件组件包括例如网络接口卡。为了能够更换硬件组
件，Industrial HiVision 比较某些硬件组件的组合，以确定硬件密钥。
请求许可证密钥时，网络管理站中安装的网络接口卡只要有一个激
活，Industrial HiVision 就会识别出正确的密钥。在这种情况下，可以在 
Industrial HiVision 中继续安装其他硬件组件。
Industrial HiVision 确定管理站没有激活的接口卡时，“Hardware 
Key“(Hardware Key) 栏显示此消息。“ 硬件密钥无效。未识别任何网络接
口 ”。为显示硬件密钥请添加网络接口。也可以选择激活一个网络接口。

“Leased licenses“
若您拥有分级网络结构，并且已将许可证借用给子域，则
“Licenses“(Licenses) 对话框的下部将包含有一个用于显示已借用许可证
的表格。
此表格有以下几列：
– “Subdomain name“
– “IP Address“
– “Leased licenses“
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Preferences > Display

8.4.7 Display
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Preferences > Display > Language

 Language
可以通过这个对话框选择图形用户界面的语言和日期格式。
预设置：
 语言：计算机的系统语言。
 界面的日期格式：年 - 月 - 日
 服务的日期格式：年 - 月 - 日
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Preferences > Display > Event

 Event
您可利用此对话框预设置事件显示。

Events in the Event List[ 事件列表中的事件 ] ( 参阅图 8)：
 “Max. Number of Events“

可以在下拉列表中选择 Industrial HiVision 在事件列表中显示的事件的
最大数量。出现的事件的数量超出定义的数量时，Industrial HiVision 
放弃显示最早的事件 （根据先进先出原则）。
预设置：1000
值域： ≤ 50000

 “Event Display“
通过 “Show Event List and Summary“(Show Event List and Summary) 
显示 / 隐藏事件列表和主窗口中的事件摘要。
预设置：开

 “Event Log to File“
通过 “Logging Enabled“(Logging Enabled) 可以定义 Industrial 
HiVision 将每个出现的事件写入事件日志文件。Industrial HiVision 以
操作系统所使用的语言将其写入事件日志文件。
事件日志文件 HiVisionEvents0.csv 在 Industrial HiVision 安装目录
的 \log\events 下。
HiVisionEvents0.csv 文件超过 1 MB 时，Industrial HiVision 将 
HiVisionEvents0.csv 文件重命名为 
HiVisionEvents1.csv。Industrial HiVision 将新的事件写入新的 
HiVisionEvents0.csv 文件。
HiVisionEvents0.log 文件再次超出 1 MB 时，Industrial HiVision 重
命名文件：
– HiVisionEvents1.csv 重命名为 HiVisionEvents2.csv
– HiVisionEvents0.csv 重命名为 HiVisionEvents1.csv
– 依次类推。
Industrial HiVision 最多可生成 1000 个日志文件。如果出现了更多事
件，Industrial HiVision 将按照如上所述方式覆盖 
HiVisionEvents999.csv 文件。
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 “Logfile path“
作为安装目录的替代选项，您可以在此行中选择 Industrial HiVision 写
入事件日志文件的任意路径。

提示 : 写入网络驱动器时如果出现延迟或中断，可能会影响 Industrial 
HiVision 服务。

提示 : 网络的延迟或中断可能会导致在事件日志文件内出现空缺。 

提示 : 因为服务写入日志文件时，本地系统帐户需要此目录的写入权
限。

 “Status Change Caused by Status Propagation“
组件或文件夹的属性状态变化时显示事件，Industrial HiVision 可以将
事件显示为事件框中的条目。
在下拉列表中选择 Industrial HiVision 应显示的事件：
– “No Event“(No Event)，当您只需要显示最低层级的状态变化时。

最低层级应向上转发的状态变化均作为事件条目由 Industrial 
HiVision 隐藏起来。

– “Info Event“(Info Event)，当您需要 Industrial HiVision 将状态变化
作为条目在事件列表中进行显示时。由于转发状态变化而出现的事
件条目的类型为 ”Info” （信息）( 参阅页 98 “ 事件数量 ”)。

– “Similar Event“(Similar Event)，当您需要 Industrial HiVision 将状
态变化作为条目在事件列表中进行显示时。
由于转发状态变化而出现的事件条目的类型与此层级转发的状态变
化相对应。
预设置：无事件。

 “Source“
若设备发生事件，则 Industrial HiVision 将会在事件列表中补充设备名
称以及您在 “Location“ (Location) 设备属性中所输入的地点。
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Events on the Industrial HiVision Web Site[#Variable:Produktname kurz# 
网络页面中的事件 ]
( 参阅页 246 “ 网络页面中的事件 ”)
 “Days in event log“

Industrial HiVision 会在事件网络页面中显示所输入过去天数中发生的
全部事件。
预设置：7 天

 “Automatic page refresh every“
Industrial HiVision 会定期更新一次事件网络页面。请在此输入周期时
长 （单位：分钟）。
预设置：5 分钟

“"I'm alive" Event“
( 参阅页 222 “Industrial HiVision“alive” 动作 ”)
 “Send "I'm alive" events“

在激活状态下，Industrial HiVision 会定期发送被定义为 “"I'm alive" 
Event“ ("I am live" Event) 动作的相关事件。
预设置：未激活

 “Send interval“
预设置：1 分钟

 “Send warning events since last "I'm alive" event“
在激活状态下，Industrial HiVision 除了 “alive” 动作外，还会发送自上
次发送 “alive” 动作后 Industrial HiVision 所注册的警告事件。
预设置：未激活
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图 85: Configuration > Preferences > Display > Event
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Preferences > Display > Event Auto-Acknowledge

 Event Auto-Acknowledge
该对话框为您提供了设置 “Status Worse“ 事件的选项， Industrial HiVision 
应用程序可以自动确认是否在指定的时间间隔内发生了相关 “Status 
Better“ 事件。
“Event Auto-Acknowledge“ 列表中的事件：
 “Ping Reachability“

与端口可达性状态更改有关的事件。
 “Port Link“

与端口的链接状态更改有关的事件。
 “Port In Load“

与端口入站流量负载状态更改有关的事件。 
 “Port Out Load“

与端口出站流量负载状态更改有关的事件。
 “Ring Coupling Status“

与冗余环耦合状态改变有关的事件。
 “Ring Status“

与 “Ring Status“ 属性状态更改有关的事件。
 “Rapid Spanning Tree“

与快速生成树协议的状态更改有关的事件。
 “Spanning Tree Status“

与生成树协议状态更改有关的事件。
 “Multiple Spanning Tree Status“

与多生成树协议状态更改有关的事件。
 “Interface Link“

与接口的链接状态更改有关的事件。
 “Interface In Load“

与接口上入站流量负载的状态更改有关的事件。
 “Interface Out Load“

与接口上出站流量负载的状态更改有关的事件。
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要配置事件的自动确认功能，请按照下列步骤操作：
 默认情况下，自动确认功能是禁用的。要启用自动确认功能，请选中

“Event Auto-Acknowledge Global“ 复选框。 
 选择需要启用该功能的事件。在 “Event Auto-Acknowledge“ 列表中标

记相应的复选框。
 要设置时间间隔，请在 “Auto-acknowledge interval“ 字段中输入必要的

值，然后从下拉菜单中选择该值的时间单位。您可以选择秒，分钟，
小时或天。
预设置：3 分钟。
“Auto-acknowledge interval“ 的值范围可以在 1 秒到 2 天之间指定。
为事件配置警报时，还可以选择不显示 “Status Worse“ 事件警报。如
果事件已事先确认，则有可能。 
您可以在 Configuration > Preferences > Basics > Event Actions > Alarms > 
New > New Entry 对话框 ( 参阅图 82) 中为 “Status Worse“ 事件创建新
警报。在 “Type“ 框架中，选中 “If event has not been acknowledged 
after“ 复选框，然后选择一个时间间隔，该时间间隔应超过 “Auto-
acknowledge interval“ 字段中指定的时间间隔。

 要接受更改，请单击 “Apply“ 按钮。
  如果要将值重置为默认参数，请单击 “Reset to Defaults“ 按钮。
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图 86: Configuration > Preferences > Display > Event Auto-Acknowledge
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Preferences > Display > Device

 Device
在此对话框中可以设定如何显示网络中的设备，设备之间的连接以及标
记。
 “Symbol“

点击相应的白色选项钮，选择 Industrial HiVision 显示设备时使用的图
标：
– “Realistic“(Realistic)_ 使用产品图片显示设备
– “Abstract“(Abstract)_ 图标表示的设备功能
预设置：“Realistic“

 “Status Visualisation“
此处可以确定 Industrial HiVision 将如何在屏幕上显示设备状态或状态
变化。
Industrial HiVision 提供以下显示方式：
– “Flash after Status Change“
– “Acknowledged OK with Color“
– “Status Symbol in Icon“
– “Filled Background“
– “Frame“
– “Icon and Text Flash as well“
预设置 “Filled Background“(Filled Background) 和 “Frame“(Frame) 激
活。

 “Font“
输入设备文字说明和设备间连接标记的字号 (pt) 和字体。
基本设置：字号 = 13，字体 = Arial。

 “Device Appearance“
确定图标尺寸和最大宽度 （单位：像素），Industrial HiVision 将依此
在屏幕上显示网络中的设备。基本设置：基本设置：图标尺寸 = 48，
最大宽度 = 150。
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 “Connection Appearance“
– 确定 Industrial HiVision 是否以及如何在屏幕上显示网络中已识别

设备间的连接。
在 “Draw Label“(Draw Label) 下拉列表中选择 Industrial HiVision 何
时标记连接的状态。
选项：“Always“(Always)，“Never“(Never)，“Under Mouse 
Pointer“(Under Mouse Pointer)
预设置：“Never“
通过 “Draw Terminal Labels“(Draw Terminal Labels) 下拉列表选择 
Industrial HiVision 是否标记连接的端点。
选项：“Always“(Always)，“Never“(Never)，“Under Mouse 
Pointer“(Under Mouse Pointer)
预设置：“Always“

– 通过 “Line Thickness“(Line Thickness)，您可以在拓扑视图中对连
接速度和连接状态有一个更加直观的了解。
“Speed“(Speed) 显示激活时，Industrial HiVision 将随着速度的提
高 (10、100、1000、10000 MBit/s) 以每次 2 级字号不断增加线条
的粗度。激活 “Speed“(Speed) 显示时，Industrial HiVision 在气泡
帮助中显示当前的连接设置。 
“Speed“(Speed) 显示禁用时，Industrial HiVision 显示当前的速度
设置，即使 “Speed“(Speed) 显示在连接属性对话框中激活 ( 参阅
页 300 “Connection”)。
激活 “Status“(Status) 显示时，Industrial HiVision 将随着状态权重
的增加以 2 点为增量增加线宽。
预设置：“Status“

– 使用 “Minimum Line Thickness“ (Minimum Line Thickness) 确定 
Industrial HiVision 根据速度增加线条粗度时的线条最小粗度。
选项：1、3、5
预设置：1

 “Preview“
“Preview“(Preview) 框显示设置实现的效果。

显示 含义
OK Acknowledged 状态未更改，一切正常。
OK Status Changed 状态已更改，一切正常。
Warning Acknowledged 状态未更改。显示警告消息。
Warning Status Changed 状态已更改。显示警告消息。
Error Acknowledged 状态未更改。显示错误。
Error Status Changed 状态已更改。出现一个错误。

表格 43: 设备显示和连接线的预览
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 如果点击 “Reset to Defaults“ (Reset to Defaults)，您所做的更改均将恢
复为基本设置。

图 87: Configuration > Preferences > Display > Device
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Preferences > Display > Appearance

 Appearance
可以通过这个对话框改变文本显示和选项卡选择：
 “Toolbars“

工具栏中的文本定位
预设置：“Text Alongside Symbol“

 “Font Size“
预设置：取决于屏幕分辨率。

 “Security“
打开对话框输入密码或查看密码时，用星号 （不可见）显示密码。
预设置：“Hide Passwords“

 “Tab Presets“
根据上下文，Industrial HiVision 可为您提供各种不同的选项卡。
– 选择 “Saved settings“(Saved Settings) 时，打开视图时将显示此视

图中最后打开的选项卡。
– 选择 “Default settings“(Default Settings)，使 Industrial HiVision 选

择设备层级下有列表显示的选项卡。
– 选择 “Don't apply“ (Don't apply) ，Industrial HiVision 将在切换到另

一个设备或组件详细设置时沿用当前的显示方式 （列表显示或拓
扑显示）。

预设置：“Saved settings“
 “Home View Settings“

设定 “Home View“(Home View) 按键的显示预设置。
 Industrial HiVision 支持保存以下设置：
 请在菜单树中确定另一个文件夹。
 定义其他的屏幕大小。
 请确定最大化和普通视图。
以下参数在 Industrial HiVision 中定义为预设置：
  VLAN “All“(All)
 “Last 24 Hours Events“
  “Map“(Map) 视图
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图 88: Configuration > Preferences > Display > Appearance
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Preferences > Display > Status Colors

 Status Colors
使用此对话框可为每种状态分配一种颜色。在这里可以随意为前景和背景
选择颜色。

 如果点击 “Reset to Defaults“ (Reset to Defaults)，您所做的更改均将恢
复为基本设置。

图 89: Configuration > Preferences > Display > Status Colors

状态 前景 背景
OK 黑色 绿色
Warning 黑色 黄色
Error 白色 红色
Not Available 黑色 灰色
No Status 黑色 白色

表格 44: 状态颜色的基本设置
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Preferences > Display > Device Icon

 Device Icon
使用该对话框可以在设备识别时为不同类型的设备分配不同的默认图标。

 点击 “New“(New) 定义新的默认图标分配。选中列表中相应的行，点击
“Edit“(Edit) 按键即可编辑条目。

Industrial HiVision 可以提供下列区分设备类型的方法：

 系统对象标识符 (“SysOID“)

 “EtherNet/IP“
除了在对话框中输入参数，使用 Industrial HiVision 还可以从 EDS 文
件 （Electronic Data Sheet，电子数据表）中下载参数。

 “Modbus/TCP“

 “MAC Address“

Type SysOID
SysOID 制造商 ID
Icon 点击 “？ ”，为您的文件系统寻找一个用于图标的图像文件。

Type EtherNet/IP
Vendor Code 基于 EtherNet/IP 的设备描述中的制造商 ID。
Product Type 基于 EtherNet/IP 的设备描述中的产品类型。此处的 “*” 代表 “ 所有产品类型 ”。
Product Code 基于 EtherNet/IP 的设备描述中的产品标识。此处的 “*” 代表 “ 所有产品 ”。
Icon 点击 “？ ”，为您的文件系统寻找一个用于图标的图像文件。

Type Modbus/TCP
Vendor Name 基于 Modbus/TCP 的设备描述中的制造商 ID。
Product Code 基于 ModbusTCP 的设备描述中的产品标识。此处的 “*” 代表 “ 所有产品 ”。
Icon 点击 “？ ”，为您的文件系统寻找一个用于图标的图像文件。

Type MAC Address
MAC Address 可以使用 MAC 地址分配设备图标的设备 MAC 地址部分。示例：Hirschmann 

地址的 MAC 地址的前 24 位是 00:80:63。
Number of Bits 分配图标时所需使用的 MAC 地址的位数。MAC 地址的前 24 位表示设备制造

商。
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您可以在表格中：
– 添加新条目。
– 编辑现有条目。
– 删除现有条目。
– 复制现有条目。
– 通过 “EDS File“(EDS File) 按键添加新的以太网 / IP 条目。Industrial 

HiVision 将加载选中的 EDS 文件和所属的图标文件。EDS 文件图标文
件
Industrial HiVision 也可以找到供应商特定子文件夹中的图标。
EDS 文件在设备的 CD 上。也可以选择从制造商网页上下载 EDS 文
件。EDS 文件包含 “Vendor Code“(Vendor Code)、“Product 
Type“(Product Type)、“Product Code“(Product Code) 和图标名
称。Industrial HiVision 尝试通过定义的名称打开图标。
Industrial HiVision 未打开新设备图标时，请如下操作：
 通过文本编辑器 （例如 Notepad++）打开设备 EDS 文件。
 确定图标在指定的路径下，例如 “Symbol = "Icon/xxxx.ico";”。
 保存并关闭 EDS 文件。
 点击 “EDS File“ 按键。
 为设备选择 EDS 文件。
 点击 “OK“ 按键。

识别设备和选中设备时，Edit > Set Default Device Icon 可以通过 Industrial 
HiVision (Edit:Set Default Device Icon) 来检查设备类型。Industrial 
HiVision 可将 Industrial HiVision 在表格中找到的第一个图标分配给设备。
选择 “Up“(Up) 和 “Down“(Down) 按键更改条目在列表中的顺序。
Industrial HiVision 中预定义的 Hirschmann 设备的图标隐藏在表格顶部。
因此 Industrial HiVision 可以为 Hirschmann 设备分配正确的图标。

Icon 点击 “？ ”，为您的文件系统寻找一个用于图标的图像文件。
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图 90: 设备图标分配表
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Preferences > 高级

8.4.8 高级
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Preferences > 高级 > 高级

 高级

“Expire Time for Edit Mode“
持续时间可以规定 Industrial HiVision 处于编辑模式的时间，之后再进入
该模式需要申请。持续时间结束后 Industrial HiVision 进入 “ 运行模式 ”。 
可能的设置：5 - 60 分钟或 “Permanent“(Permanent)。

“Web Access“
除了未经授权的访问企图，“Generate an Event for every Successful Web 
Access“ （为每一次成功的网络访问生成一个事件）可以为每一次成功的
网络访问生成一个事件。

“Allow Renaming“(Allow Renaming) 支持重命名组件详细设置的属性。例
如，您可将连接的 “In Load“(In Load) 属性更改为 “ 传入数据量 ”。

通过 “Auto Reload“(Auto Reload) 定义 #Industrial HiVision 执行下列任
务：
– 打开属性对话框时询问此对话框的当前值。
– 在打开文件框时立即询问其内容的值。
“if Value Older than“(If Value Older than) 功能支持根据值存在的时间自动
查询显示的值。
“Include device passwords in documentation“
通过 “Device Documentation“ (Device Documentation) 可以创建带有可读
密码或隐藏密码的设备文件。
预设置：隐藏密码。

提示 : 如果您忘记了密码，关闭 Industrial HiVision。在 Windows 下以 
”administrator” （管理员）身份登录或在 Linux 下 ”root” 登录，并重启 
Industrial HiVision。作为 ”administrator” （管理员）或 ”root” 重启 
Industrial HiVision 后可以避开之前的密码询问创建新条目。

SNMP V1 ******,****** public, private
SNMP V3 admin, MD5: ******, 

DES: ******
admin, MD5: private, 
DES: private

表格 45: 带有可读密码或隐藏密码的设备文件举例
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图 91: Configuration > Preferences > Advanced > Program Access
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Preferences > 高级 > 服务访问

 服务访问
如果要将值重置为默认值，则可以使用 “Services Access“ 对话框激活和
停用从另一台计算机访问网络管理的各种方法。防火墙将 Industrial 
HiVision 服务同客户端断开时，添加防火墙规则，以继续在服务和客户端
之间传输数据。 参考 “ 使用带防火墙的 Industrial HiVision” on page 70.
 “Web Server“

这项服务允许您使用其他计算机通过网络浏览器访问网络管理站。网
络服务器的地址为：
协议：// 网络管理站的 IP 地址：端口编号，比如
http://10.0.1.159:11187
使用 https 设置安全连接时， Industrial HiVision 使用了 Hirschmann 认
证，您的浏览器将标识为无效。如果您想使用这项服务，需要先将这
个连接设置为信任，为您的浏览器添加免责条款。保存免责条款。
如果您希望指定 Industrial HiVision 用于连接 “Web Server“ 的其他值，
请取消选中 “Use Default Values“ 复选框。在 “Port“ 字段中输入所需的
值。选中 “Use Default Values“ 复选框会将 “Port“ 字段中的值重置为默
认值 11187。

 “Project Data Server“
“Remote Access“ 允许您在其他计算机上运行的 Industrial HiVision 接
口可以访问本 Industrial HiVision 服务。
如果指定 Industrial HiVision 用于连接 “Project Data Server“ 的其他
值，请取消选中 “Use Default Values“ 复选框。在 “Port“ 字段中输入所
需的值。如果选中 “Use Default Values“ 复选框，则 Industrial 
HiVision 将 “Port“ 字段中的值重置为默认值，11188。
如果 “Services Access“ 允许，则使用网络连接而不是内部 IP 地址
127.0.0.1 连接本地接口，该接口与外部计算机的接口完全一样。因
此，网络连接中断时，内部界面也将失去与服务的连接。
“Port“ 字段显示在其他计算机上运行的 Industrial HiVision 接口可以访
问本地 Industrial HiVision 服务的端口。
“Subdomain interface“
如果激活 “Subdomain interface“ 功能，则让另一个网络管理站作为超
级域访问本地 Industrial HiVision。
“Password“
使用此管理站作为超域时，可以通过此对话框输入访问超域接口的密
码。 参考 “ 将子域绑定到超级域 ” on page 64.
“Superdomain“
建立安全连接后，Industrial HiVision 允许您选择超域用来处理子域提
供的证书的过程：
 “Accept any subdomain cartificate“
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此方法允许超级域无需验证即可接受子域提供的证书。证书将不会
添加到信任存储中，并且会在邮件中创建带有子域指纹的事件。
默认设置：启用。

 “Accept any subdomain certificate and store as trusted“
此方法允许超级域无需验证即可接受子域提供的证书。证书将被添
加到信任存储中，并用于将来的连接。创建一个事件，该事件记录
子域的指纹已添加到信任存储的事实。

 “Verify subdomain certificate against trusted certificates“
创建一个事件，该事件记录子域的指纹已添加到信任存储的事实。
如果证书不在信任库中，则拒绝连接。并且会在邮件中创建带有子
域指纹的事件。

 “OPC Server“
“OPC Server“ 允许您激活 Industrial HiVisionOPC 服务器 ( 参阅页 237 
“OPC 的传输数据结构 ”)。
通过使用 OPC 写入命令 ( 参阅页 235 “ 连接过程可视化系统
”)，“Global Write“ 可以将对象值写入 Industrial HiVision 中。
使用 CA 证书 ( 参阅页 242 “OPC-UA 服务器用户定制证书 ”) 加密 
OPC UA 服务器和 Industrial HiVision 之间的通信。
使用 HTTP 连接到 Industrial HiVisionOPC UA 服务器时，将 OPC UA
客户端配置为在 “OPC UA Server Port (http)“ 字段中显示的端口上访
问服务器。 
使用 HTTPS 连接到 Industrial HiVisionOPC UA 服务器时，将 OPC 
UA 客户端配置为在 “OPC UA Server Port (https)“ 字段中显示的端口
上访问服务器。
要指定 OPC 客户端用于连接 “OPC Server“ 的其他值，请取消选中
“Use Default Values“ 复选框。在 “OPC UA Server Port (http)“ 字段中
输入要使用的 HTTP 协议的必要值。如果选中 “Use Default Values“
复选框，则 Industrial HiVision 将 “OPC UA Server Port (http)“ 字段中
的值重置为默认值 11189 或 11190。

提示 : 禁用 “OPC Server“ 功能时，重新启动 Industrial HiVision 内核。
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图 92: 配置 C > 选项 P > 高级 > 服务访问
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Preferences > 高级 > 高级

 高级
Industrial HiVision 通过自动密码应用帮助您与 SNMP 设备进行通信。

“Device Credentials“
在与 SNMP 设备建立通信时，Industrial HiVision 将会使用已知的密码和
用户名尝试进行访问。
使用错误密码时，Industrial HiVision 从相关设备收到一个认证触发事件。
使用正确密码时，Industrial HiVision 收到 SNMP 询问的应答，在对话框
上部的表格中输入正确的密码和用户名。

“SNMP Guess List“
与未知 SNMP 设备建立通信时，Industrial HiVision 将尝试通过 “SNMP 
Guess List“(SNMP Guess List) 中的登录数据进行验证。
通过 “New“(New) 按键在列表中创建新的条目。
Industrial HiVision 提供以下列表条目选项：
– 通过 “Edit“(Edit) 按键更改条目
– 通过 “Delete“(Delete) 按键删除条目
– 通过 “Duplicate“(Duplicate) 按键复制条目

“Hide Passwords“
Industrial HiVision 支持用星号等代替密码，保护其不会泄露。 
打开此对话框时，这一区域的设置取决于 Display > Appearance 
(Display:Appearance:Security) 对话框中的设置。
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参考
图 93: Configuration > Preferences > Advanced > Device Credentials

除了自动密码应用，使用 Industrial HiVision 也可以手动为单个 SNMP 设
备进行 SNMP 预配置。
 因配置 SNMP 需要打开 “New Entry“(New Entry) 对话框时，在 “Device 

Credentials“(Device Credentials) 框中点击 “New“(New) 按键。
 输入需要进行 SNMP 预配置的设备 IP 地址。
 选择设备支持的 SNMP 版本。
 根据所选 SNMP 版本输入所需的访问信息：

SNMP 版本 名称 含义
V1 Read Password 可获得设备访问读取权限的密码
V1 Write Password 可获得设备访问写入 / 读取权限的密码。
V3 (easy) Username 用于设备访问的用户名。
V3 (easy) Password 用户名所属的密码。
V3 (complete) Username 用于设备访问的用户名。
V3 (complete) Authentication 用于信息认证的 SHA、MD5 工具
V3 (complete) Password 用于认证的密码
V3 (complete) Encryption DES、AES128、对称加密算法
V3 (complete) Password 用于加密的密码

表格 46: SNMP 配置输入
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“Advanced“ (Advanced) 中包括 SNMP 特定的换算参数。交付状态时的设
置可满足大多数要求。
 使用 “Timeout [s]“ (Timeout [s]) 可以确定 Industrial HiVision SNMP 请

求响应的等待时间。如果没有响应，Industrial HiVision 将重复进行 
SNMP 请求。

 使用 “Retries“ (Retries) 可以确定在没有响应时 Industrial HiVision 重复
进行 SNMP 请求的频率。
在 Industrial HiVision 发送新的请求前，Industrial HiVision 将以双倍的
超时时间进行重试。

 使用 “Port No“ (Port No) 选择 Industrial HiVision 将向其发送 SNMP 请
求的协议端口。

 “Hide Passwords“(Hide Passwords) 支持用星号代替此表格条目的密
码，保护其内容不会泄露。 

图 94: Configuration > Preferences > Advanced > Device Credentials > New
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Preferences > 高级 > Management Station

 Management Station
可以在此对话框中输入 IP 参数的预设置。打开需要 IP 参数的对话框
时，Industrial HiVision 会输入这些预设置，例如 Industrial HiVision 通过 
HiDiscovery 识别到的设备的 IP 配置。

“IP Address Prefix“ (IP Address Prefix):
Industrial HiVision 可在此处输入自身 IP 地址的前缀。

“Default Netmask“ (Default Netmask):
Industrial HiVision 可在此处输入自身 IP 地址的网络掩码。

“Default Gateway“ (Default Gateway):
Industrial HiVision 可在此处输入同时供网络管理站使用的网关前缀。

“IP Address Management Station“ (IP Address Management Station):
如果您的管理站有多个 IP 地址，Industrial HiVision 会将这些 IP 地址输入
下拉列表。
 选择需要作为陷阱目标地址使用的地址。

“Network Card Management Station“ (IP Address Management Station):
如果您的网络管理站有多个网络接口卡，Industrial HiVision 会在下拉列表
中显示这些卡。
 选择需要访问其 HiDiscovery 协议的网络接口卡。
“Management Station Appearance“:
如果 “Do not Change Management Station Icon“ 函数处于活动状态
且 Industrial HiVision 发现运行内核的设备，则 Industrial HiVision 保留设
备的图标。
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图 95: Configuration > Preferences > Advanced > Management Station
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Preferences > 高级 > OPC-SNMP

 OPC-SNMP
使用 Industrial HiVision 的 OPC 服务器您可以通过 OPC 客户端询问测定
设备的 SNMP 值。
在 Advanced > OPC-SNMP (Advanced:OPC-SNMP) 对话框中输入需要测定
其值的 SNMP 属性。在表格中您可以 
– 添加新条目。
– 编辑现有条目。
– 删除现有条目。
– 复制现有条目。
在 “Edit“ (Edit) 和 “New“ (New) 对话框中可以直接输入 SNMP 属性或从 
MIB 中选择属性。
点击 “Select MIB Attribute...“(Select MIB Attribute) 按键，从 MIB 中选择 
SNMP 属性。在 “MIB Viewer“(MIB Viewer) 对话框中选择 SNMP 属性。
点击 “MIB Manager“(MIB Manager) 按键加载其他 MIB。
为此条目输入一个有实际意义的简短名称，在稍后询问 OPC 标签时将会
用到。
如果 OPC 标签中使用了对象标识符 (OID)，请输入完整的 OID，包括可
能存在的实例。
OPC 客户端询问的 OPC 标签，比如：
Industrial_HiVision.snmp.get.10:0:1:159,161,ifAdminState

此时为：
 10:0:1:159 是设备的 IP 地址，冒号代替点号作为分隔符
 161 是 SNMP 端口
 ifAdminState 是在设置中配置的 SNMP 属性的名称
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图 96: Configuration > Preferences > Advanced > OPC-SNMP
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Preferences > 高级 > 服务参数

 服务参数
Industrial HiVision 程序启动了自带的服务。您的 PC 操作系统将显示此 
Industrial HiVision 服务。 
Industrial HiVision 服务由下列服务组成：
 “Device Discovery“

• “Scan Rate [devices/min]“
此服务可进行网络扫描 ( 参阅页 328 “Basics”)。扫描速率单位为 
Ping/Min。 
预设置：600

• “Simultaneously Discovered Devices“
使用此设置可以在识别设备时修正网络负荷。在此处输入识别设备
时需要 Industrial HiVision 同时询问的设备数量。
预设置：20

• “SNMP Guessing Packet Rate [pkts/s]“
利用此设置可以规定 Industrial HiVision 为获得登录数据，每秒钟
最多向未知 SNMP 设备发送多少个数据包。
预设置：100

 “Web Server“
• “Web Server Root Directory“

参数显示 Industrial HiVision 网络服务器的基本目录。
• “Web Server Session Timeout [min]“

通过此参数定义网络服务器会话的最大空闲时间。
预设置：20

 “Device Availability“
使用此设置可以根据设备的 Ping 响应时间调整 Industrial HiVision。
– “Ping Timeout [s]“

如果 ICMP 设备在此时间内对 Ping 请求作出了响应，Industrial 
HiVision 会将设备识别为再次可用的设备，除非它最后没有响应。

– “Max. Ping Response Time [ms]“
如果 ICMP 设备在此时间内对 Ping 请求作出了响应，Industrial 
HiVision 会将设备识别为重新出现的设备，除非它最后没有响应。

较低的值可以提高 Industrial HiVision 的性能。值过低时，Ping 响应可
能出现过晚，Industrial HiVision 会将设备显示为 “ 不可达 ”
（unreachable）。针对可能会有瞬间中断的大型子网，建议使用较小
的值。
较大的值将导致 Industrial HiVision 中状态变化的显示出现延迟。
“Simultaneously Discovered Devices“(Simultaneously Discovered 
Devices)：使用此设置可以在识别设备时调整网络负载。在此处输入
识别设备时需要 Industrial HiVision 同时询问的设备数量。
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 “Reporting“
– “Reliability Polling Intervals“

该询问值的记录时间早于属性询问的轮询间隔 x 轮询间隔 [S] 的最
大数值 ( 参阅页 293 “ 组件详细设置的属性 ”)。

– “Replication Lock for Reporting Events [s]“:
使用重复锁定可以减少在事件列表中对重复事件的记录。
预设置：3600
Industrial HiVision 可以重新记录类型为 “Warning“ (Warning) 和
“Error“ (Error) 的报告事件 （如果最后一次记录的时间远远早于重
复锁定的持续时间）。
程序重启后 Industrial HiVision 可再次进行更改。

 “Statistics“
– “ICMP Statistics - Moving Average Number of Samples“

该条目确定了推导得出的平均值，该平均值是基于响应时间的子集
计算所得的。
预设置：5
推导得出的平均值作为每个设备的属性类型包含在协议属性中，并
且可以向报告工具添加。

– “SNMP Statistics - Moving Average Number of Samples“
该条目确定了推导得出的平均值，该平均值是基于响应时间的子集
计算所得的。
预设置：10
推导得出的平均值作为每个设备的属性类型包含在协议属性中，并
且可以向报告工具添加。
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图 97: Configuration > Preferences > Advanced > Service Parameters
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Preferences > 高级 > 服务参数

 服务参数
Industrial HiVision 可以为下列功能提供额外的帮助程序：
 “Telnet“
 “SSH“
 “Browser“

在 Linux 系统中 Industrial HiVision 将 Mozilla Firefox 作为默认浏览器。
如果您想使用其它的浏览器，请在 “Browser“ 行中输入相应浏览器的
路径。

 “Ping“
 “PDF Viewer“
 “SMS“
 “HiProvision“

如果已在 Industrial HiVision 安装目录中安装了 HiProvision 程序，则
可以选中 “Use Default HiProvision“ 复选框。
如果您在其他位置安装了 HiProvision 程序，请在 “HiProvision“ 文本
字段中键入该位置。
有关 “HiProvision“ 程序的更多信息，请参见 “HiProvision” on 
page 137

 “Mail Server“
进行电子邮件配置。

 “Geographical Location View“
用于调用地理位置显示程序的 URL 输入，例如：谷歌地图。
http://maps.google.de/maps?q=$LATITUDE,$LONGITUDE($NAME)&z=19

参考 “ 地理位置视图 ” on page 312.
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Preferences > 高级 > Device/Port Names

 Device/Port Names
通过此对话框可以在各自的属性对话框中更改设备和端口的名称，并在用
户界面中进行显示。
首先确定 Industrial HiVision 是否应使用预设置的名称显示设备和端口，
或 Industrial HiVision 是否使用设备确定的名称。
向 Industrial HiVision 添加新设备的时候，“Device/Port Names“ 框让您能
够选择 Industrial HiVision 用来显示设备名称的方法。
 功能 “Basics“：“Use default names or entered names“ 让 Industrial 

HiVision 能够显示带 IP 地址的新设备。
 功能 “Basics“：“Set names from device in Industrial HiVision“ 让 

Industrial HiVision 能够显示新设备的名称。

提示 :  “Reset to Defaults“ 键仅将对话框 “Device/Port Names“ 恢复为预设
置。

为了对 Industrial HiVision 显示设备名称的方式进行更改，请如下进行操
作：
 请将设备从 Industrial HiVision 中删除。
 请打开针对所需事件的对话框 “Device/Port Names“。
 请重新扫描设备的网络。

确定设备名称

Industrial HiVision 可将主机名称和 DNS 名称写入 MAC/IP 地址分配表 (
参阅页 404 “MAC/IP 列表 ”)。

“Set Device Name“

Request DNS 在识别新设备时 Industrial HiVision 可以从域名服务器获
取设备名称。

Request Now Industrial HiVision 从域名服务器中为已识别设备确定设备
名称。此过程将持续一段时间。

Use Name of Hosts File Industrial HiVision 从主机文件中为已识别设备读取设备名
称。主机文件 hosts.txt 是文本文件，位于安装目录的 
config （配置）子目录中。 
该主机文件中包含每个设备的 IP 地址和名称，由制表符
进行分隔。

Read Now Industrial HiVision 从主机文件中为已识别设备读取设备名
称。
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在此处可以选择 Industrial HiVision 在设备属性的名称栏中所应用的设备
名称。Industrial HiVision 将在文件夹列表和详细显示中显示此名称。
可能有以下参数：
– “DNS Name“
– “Host Name“
– “System Name“
– “Location“
– “Contact“
选中并点击箭头按钮，在 “Possible Parameters“ (Possible Parameters) 
和 “Used Parameters“ (Used Parameters) 表之间移动备选名
称。Industrial HiVision 应用表格 “Used Parameters“ 最上面的名称。如果
设备的使用参数为空，Industrial HiVision 将接受位于下一位的名称。如果 
Industrial HiVision 未找到用于设备的参数，Industrial HiVision 将应用设备
的管理 IP 地址。

“Port Name“
通过 “Set Port Name“ 功能，只要在设备中输入了端口名称，就可以接受
在设备的端口属性名称栏中输入的端口名称。Industrial HiVision 将在文件
夹列表和详细显示中显示此名称。如果没有此项设置，Industrial HiVision 
将显示用于设备的 IP 地址和用于端口的端口号。

提示 : Industrial HiVision 可以在识别设备 / 端口时应用已设置的名称选
项。稍后对这一选择的更改将在重置设备 / 端口名称后生效。为此请选中
相关设备，并使用鼠标右键选择 “Set Device and Port Names“(Set Device 
and Port Names)。
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图 98: 分配设备和端口名称
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Preferences > 高级 > Load/Save

 Load/Save
该对话框让您可以输入以下参数：
– 一个网络中现有 tftp 服务器的 IP 地址
– 带路径说明的文件名
– URL。 
Industrial HiVision 会自动在执行文件传输的对话框中应用上述内容，例
如：在 MultiConfig ™ 对话框中加载 / 保存配置。
当调用对话框 “MultiConfig ™ ” 的时候可以不用再多次重复输入 URL 和文
件名。

占位符 含义
$INSTALL 网络管理站上的 Industrial HiVision 安装文件夹。
$TFTP_SERVER 在 Configuration > Preferences > Advanced > Load/Save 

(Configuration:Preferences:Advanced:Load/Save) 对话框中输
入的 TFTP 服务器 IP 地址。

$IP_ADDRESS 从 Industrial HiVision 读取配置的设备 IP 地址或由 Industrial 
HiVision 写入配置的设备 IP 地址。Industrial HiVision 应用对象
区表格中的 IP 地址。

$SYSTEM_NAME 从 Industrial HiVision 读取配置的设备 IP 地址或由 Industrial 
HiVision 写入配置的设备 IP 地址。 

$CURRENT_DATE 网络管理站的当前日期。
$CURRENT_TIME 网络管理站的当前时间。
$EXTENSION 文件名 - 扩展：

cfg，针对二进制文件
cli，针对脚本文件
html，针对 HTML 文件

表格 47: 支持的占位符 
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图 99: Configuration > Preferences > Advanced > Load/Save
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Preferences > 高级 > 1:1 NAT Devices

 1:1 NAT Devices
此对话框允许您使用 Industrial HiVision 管理和监测 1:1-NAT 路由器后的
设备。
为了让 Industrial HiVision 能够识别 1:1-NAT- 路由器后面的设备，请将与
网络管理站连接的端口 （1:1-NAT- 路由器的端口）的 MAC 地址输入到
该表格中。
在 “MAC/IP Addresses“ （MAC/IP Addresses）选项卡 1:1NAT 路由器的
属性对话框中可以找到端口 MAC 地址。

图 100: Configuration > Preferences > Advanced > 1:1 NAT Devices
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Preferences > 高级 > Mobile Devices

 Mobile Devices
只要您是第 1 次将 HiMobile 查询发送给 Industrial HiVision，则 Industrial 
HiVision 将会注册您的移动设备。
在 “Push Notification“ (Push Notification) 一栏中，激活 / 禁用向已注册设
备发送推送通知的服务。
预设置：激活。
为了将一个已注册的设备删除，请选中表格中的行，并点击 “Delete“ 键。
若表格中的相应条目处于激活状态，则 Industrial HiVision 将会向设备发
送推送通知。为了发送推送通知， Industrial HiVision 需要接入互联网。
如果 Industrial HiVision 重启或升级后，您的移动设备中的对应条目在列
表中丢失，则应在移动设备上退出 HiMobile。若要在 Industrial HiVision 
上注册移动设备，则需启动 HiMobile。
由 Industrial HiVision 在何时发送何种推送通知，您可以在事件操作中进
行定义。
( 参阅页 339 “Event Actions”)
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Preferences > 高级 > PoE

 PoE
 “Automate Power Limit“

通过 “Automate Power Limit“ 和 “Power Limit“ 功能，设备可以发送触
发事件，并且应用程序可以发送端口级别耗电量方面的警告。 
为了设定 “Automate Power Limit“ 功能，请对附加百分比进行配置，
该百分比会影响视图 “Module / Port“ 中选项卡 “PoE“ 上所显示的值 
“Power Limit“。
该附加百分比是一个可配置的参数，其使用了公式 “Power Limit“ = 
“Max Cons“ + 附加百分比。为了对该附加百分比进行计算，请使用公
式：附加百分比 = “Max Cons“ × “Automate Power Limit“。为 
“Automate Power Limit“ 预设的值为 10。您在对话框 Preferences > 
Advanced > PoE > Automate Power Limit 中配置附加百分比。

为了对以太网供电端口 (POE) 用附加百分比进行配置，请如下进行操作：
 点击 “Preferences“ 按键。
 打开对话框 Advanced > PoE。
 请在 “Automate Power Limit“ 下确定 PoE 附加百分比。
 点击 “OK“ 按键。
有关确定 “Power Limit“ 值方面的信息请参见 “Power Limit” on page 402。

图 101: Preferences > 高级 > PoE
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Configuration > Status Configuration

8.5 Status Configuration

通过该对话框，您可以跨设备极限的对设备类的一个组件属性状态进行配
置，或者同时对每个设备进行配置。

此对话框中可以显示带有相应属性的设备类别的表格。

 为了显示每个设备类的属性，请选中控制复选框 “Combine Entries“。为
了按照设备类显示属性，请选中控制复选框 “Combine Entries“。

 为了确定属性的值，请双击表格中的一行。

Industrial HiVision 打开 “Status Configuration“ （多重配置）对话框。

 为值分配所需的状态，然后点击 “OK“ (Ok) 键。

 为了修改您之前单独配置过的设备的属性，请选中控制复选框 “Overwrite 
all Properties“。

Industrial HiVision 将此 “Status Configuration“ 应用于此类别中的所有设备。

需要在 HIPER 环内部实现最高的可用性时，此功能将提供极大的帮助。这
种情况下，预设置 “Warning“ 对于冗余损失而言过小。在 “Status 
Configuration“ 对话框中，您可以通过一个步骤将同一类别中所有设备的状
态从 “ 无冗余 ” （No redundancy）设置为 “Error“ (Error)。
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图 102: 状态配置 “Status Configuration“* 双击表格行
User Manual Industrial HiVision
Release 8.1 12/19 397



参考
Configuration > Scan Ranges

8.6 Scan Ranges

您可利用此对话框为选中的文件夹确定扫描范围。

 在文件夹列表中选中了文件夹或激活了详细显示之后，请选择 
Configuration > Scan Ranges (Configuration:Scan Ranges) 或使用鼠标右键
在下拉菜单中选择 Scan Ranges (Scan Ranges)。

 点击 “New“ (New) 键，以输入 IP 地址范围。输入的 IP 地址范围包括：
– 询问范围的第一个 IP 地址，
– 询问范围的最后一个 IP 地址，
– 所属网络掩码，
– 询问时此范围的激活 / 禁用，
– 为此范围输入的任意名称。

Industrial HiVision 已将选中的文件夹或激活的详细显示注册为目标文件夹。

该表将显示已创建的 IP 地址范围。

 为了对一个 IP 地址范围进行编辑，请选中表格中的行，并点击 “Edit“ 键。

 为了从表格中将一行删除，请选中表格中的行，并点击 “Delete“ 键。

 为了对一个 IP 地址范围进行复制，并随后对副本进行修改，请选中表格
中的行，并点击 “Duplicate“ 键。
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图 103: 单个文件夹的扫描范围

提示 : 确保此对话框的网络掩码与网络内部的网络掩码一致，保证识别顺利
进行。
如果网络内部的网络掩码大于扫描范围的网络掩码，则 Industrial HiVision 将
在网络扫描时跳过扫描范围的网络掩码中最高的 IP 地址，因为此 IP 地址为
一个广播地址。
如果网络内部的网络掩码小于扫描范围的网络掩码，则 Industrial HiVision 将
在网络扫描时同时扫描网络的网络掩码中最高的 IP 地址。由于此 IP 地址为
一个广播地址，可在此处答复每个设备，Industrial HiVision 将识别不存在的
设备。
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Configuration > User defined Properties

8.7 User defined Properties

在此对话框中可以增强并监测 Industrial HiVision 中任意 SNMP 设备的属性 (
参阅页 227 “ 自定义属性的说明 ”)。
 在菜单栏上选择 Configuration > User defined Properties (Configuration:User 

defined Properties)，打开 “User defined Properties“ （自定义属性）对话
框。

选中自定义属性即可进行编辑、删除或复制。如果此属性已被分配到一个更
高级别的属性中，则当选中此自定义属性时，“Delete“ (Delete) 键仍然显示
为灰色。

8.7.1 创建一个新的自定义属性

请参见 “Setting up the network monitoring” （建立网络监测）( 参阅页 227 “
自定义属性的应用示例 ”) 章节中的应用示例。

名称 含义
Name 以 “UserDef_” 开始的可自由选择的设备唯一名称，比如

“UserDef_ICMP-Message”。
Label Industrial HiVision 在用户界面中所显示的可自由选择的名称。
Icon Industrial HiVision 在用户界面中作为属性图标所显示的像素文

件的选择。
Parent Property 新属性的更高级别属性，例如：属性 “Speed” （速度）属于更

高级别的 “Port” （端口）属性。
MIB Variable/OID MIB 变量 /OID （对象标识），可通过在 MIB 浏览器中点击三

个点进行选择。
Instance 将 Mib 变量分配给一个设备细节，例如：“0” 针对时间。

Industrial HiVision 可选择自己决定类型，例如：“ 模块编号 ”。
Type 自动选择类型 （例如：MAC 地址或一个整数）（如果 

Industrial HiVision 可以测定类型）。

表格 48: 用于新建自定义属性的 “New Entry” （新条目）对话框。
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Mapping 将一个数字值分配给一个含义，例如： 
“0 = false（假）” 或 “1 = true（真）”。Industrial HiVision 可根
据 MIB 确定此值。

Factor 单位转换因数，例如：将摄氏度转换为华氏度。
Offset 单位转换偏移量，例如：将摄氏度转换为华氏度。

名称 含义

表格 48: 用于新建自定义属性的 “New Entry” （新条目）对话框。
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Configuration > MultiConfig ™

8.8 MultiConfig ™

多配置功能 (MultiConfig™) 可帮助您在设备上和 Industrial HiVision 中进行配
置： 
 一台或多台设备
 一种或多种设备属性，可用于所有设备
 一种或多种设备详细设置，可用于所有设备
更多信息及应用示例请参见章节 “ 配置网络 ” on page 171。

8.8.1 Power Limit

为了配置 “PoE“ 端口的功能 “Power Limit“，请如下进行操作：
 请选择您网络中的 PoE 端口，该网络需要同一个阈值。
 请鼠标右键点击所选的端口。一个下拉列表自行打开。
 请选择选项 “MultiConfig ™ “。
 打开对话框 Device Settings > PoE > Automate Power Limit。
 为了配置 “Power Limit“ 功能，请取消控制复选框 “Automate Power Limit“ 

的选中。
 请在 “Power Limit“ 栏中输入需要的值。如果功率高于注明的阈值，则设

备将发送一个触发事件，并且应用程序将发送一个警告。
 为了自动设置 “Power Limit“，请选中控制复选框 “Automate Power 

Limit“。
 点击 “Write“ 按键。
 点击 “Close“ 按键。
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图 104: Configuration > MultiConfig ™ > Device Settings > PoE > Power Limit
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Configuration > MAC/IP 列表

8.9 MAC/IP 列表

8.9.1 MAC/IP 地址

此对话框可以显示由 Industrial HiVision 识别出的所有 IP 地址及其所属 MAC 
地址的列表。列表中包括：

您可以通过 “Export“ 保存以下格式的完整列表：
 PDF 文件
 HTML 文件
 CSV 文件 ( 参阅页 469 “CSV 导出 ”)

名称 含义
MAC Address
IP Address
Netmask
Host Name 安装目录 /config/hosts.txt 文件中的主机名称，如果

– 此文件存在
– 存在一个条目
– 在基本设置中激活了获取设备名称
否则，该栏保留为空。

DNS Name 域名服务器的名称
Port No 协议的端口编号
Port 设备端口
Management Industrial HiVision 可以通过表格行中的 IP 地址与设备的管理进行通讯。
User Generated 此行中的设备是由用户生成的。Industrial HiVision 还未识别设备。
Router Entry 此行中的 IP 地址来自设备的路由列表。
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通过 “Print“ (Print) 可以打印完整列表。Industrial HiVision 将生成一个包含列
表内容的临时 PDF 文件，并使用安装在管理站中的 PDF 显示程序 （如 
Acrobat Reader）打开 PDF 文件。

8.9.2 MAC/IP 地址成对安全性

此对话框可用于分配 MAC 地址，以便监控 IP 地址和识别双重 IP 地址。 
Industrial HiVision 识别以下类型的表格条目：
 “Existent“

该条目源自网络中存在和已识别的设备。如果从拓扑中移除此设备，则 
Industrial HiVision 将把此设备从该列表中删除。
Industrial HiVision 在考虑事件时会将此条目纳入考虑范围内。

 “User Generated“
用户已在此位置创建或编辑了此条目。此条目保留在列表中，直到用户手
动将其从列表中删除。
Industrial HiVision 在考虑事件时会将此条目纳入考虑范围内。

 “Excluded“
用户已在此位置创建或编辑了此条目。此条目保留在列表中，直到用户手
动将其从列表中删除。
Industrial HiVision 在考虑事件时会将此条目排除在外。

利用下拉菜单 “Display“ （显示）中的选项可根据类型过滤表格内容。
 若要激活监控，请选中复选框 “Configure Schedule for Checking“ （监控

的时间计划）。
一旦通过按键退出对话框，Industrial HiVision 打开 “Scheduler“ （时间计
划）对话框。在这里规定监控标准。
参考 “Scheduler” on page 319.
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8.10 Refresh

利用 “Refresh“ (Refresh) 可以使 Industrial HiVision 读取之前选中的设备、文
件夹或属性本身的属性值。Industrial HiVision 读取这些值之后，Industrial 
HiVision 将更新显示。
 在编辑模式下，在设备内更新设备或文件夹时，Industrial HiVision 将仅在

所涉及的设备或文件夹中读取现有的设备属性。
比如您可以在使用模块对硬件进行扩展后，使此模块在 Industrial 
HiVision 中可见。 

 在编辑模式下，在设备内更新设备或文件夹时，Industrial HiVision 将仅在
所涉及的设备或文件夹中读取现有的设备属性。

更新属性时，Industrial HiVision 将读取属性值。
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8.11 IP Configuration

此对话框可用于为由 HiDiscovery 识别的没有 IP 地址的设备配置 IP 参数，
或更改已配置的 IP 参数。

请打开用于 IP 配置的对话框，您只需鼠标右键点击设备并选择 “IP 
Configuration“ 即可。 

此对话框打开时 Industrial HiVision 将通过 HiDiscovery 协议对设备进行询
问。询问完成后 Industrial HiVision 将显示设备参数及 “Signal““Signal” （信
号）键。如果设备未答复 HiDiscovery 请求，则 Industrial HiVision 将通过 
SNMP 对设备进行询问。SNMP 询问完成后，Industrial HiVision 将显示设备
参数。
 请点击 “Signal“ 键，以便为了识别设备将 LED 的闪烁激活。为了重新将

闪烁禁用，请点击 “Signal“ 键。 
此功能的先决条件：
– 已针对设备将 HiDiscovery 激活。
– 您已经在对话框 Configuration > Preferences > Advanced > Management 

Station 中的 “Default Network Card“ (HiDiscovery) 下选择了用于该网络
的网络接口卡。

 您可以为该设备在 “Name“ 栏中输入一个名称。
 您可以通过 “IP 地址 ” 栏为设备分配一个新的 IP 地址。
 您可以通过 “ 网络掩码 ” 栏为设备分配一个新的网络掩码。
 您可以通过 “ 网关 ” 栏为设备分配一个新的网关。
 如果您点击 “Default Values“ 键 1 次，则 Industrial HiVision 将在用于 IP 

配置的栏中输入取自 “Management Station” on page 379 的默认值。

如果您点击 “OK“ 键，则 Industrial HiVision 将把名称和 IP 配置传输给设备。

为了关闭对话框并保留原始条目，请点击 “Cancel“ 键。
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图 105: 设备的 IP 配置
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8.12 Trap Destination

使用鼠标右键点击设备并选择 “Trap Destination“ (Trap Destination) 即可打
开触发事件目标对话框。 

打开此对话框时，Industrial HiVision 将询问设备的触发事件设置，并显示设
备是否已为显示的 IP 地址发送触发事件。
 如果您想要在发生定义的事件后由设备发出触发事件，则请选中控制复选

框 “Send Traps“。
 请选择您网络管理站的 IP 地址，您是通过该网络管理站驱动 Industrial 

HiVision 的，其位于下拉列表 “to IP Address“ 上方。
 如果您想要在设备的永久存储器中保存触发事件配置，请选中控制复选框 

“Save Config on Device“。

图 106: 设备的触发事件目标

提示 : 如果已激活 Windows 防火墙，且未安装 Windows 触发事件服务，则
防火墙将阻止接收触发事件。如果您的确需要接收触发事件，请将 
/services/HiVisionKernelDb.exe 安装目录中的 Industrial HiVision 
文件作为可执行文件添加到防火墙设置中。
Windows- 触发事件 - 服务已安装，前提是可以在 Industrial HiVision 中的 
Help > Kernel Info 下找到 “SNMP- 触发事件 - 连接：触发事件服务 ”。 
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您可以在 “ 开始 > 设置 > 控制面板 > Windows 防火墙 ” 下的选项卡 “ 特殊情
况 ” 上对 Windows 防火墙进行配置。点击 “ 程序 ” （Program），选择 
Industrial HiVision 安装目录中的 /services/HiVisionKernelDb.exe 
文件。
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Tools > Dashboard

8.13 Tools

您可在菜单 “Tools“ 中找打不同的工具，通过这些工具您可以借助 Ping、图
形式用户界面、CLI、SNMP 浏览器或者 HiDiscovery 扫描访问您网络中的设
备。

8.13.1 Dashboard

该 Industrial HiVision-“Dashboard“ 是一种查找错误时有用的工具，通过该工
具可以实时向管理员显示网络统计以及有关网络性能方面有帮助的信息。
Industrial HiVision 让您能够创建含不同信息的多个主控面板，并以幻灯片形
式显示主控面板的预览。此外，该功能还让您能够保存和加载主控面板的布
局。
主窗口包含了一个时间控制器。该时间控制器让您能够调整每页显示幻灯片
的时长。
如果您将应用程序 Industrial HiVision 关闭，则应用程序将保存主控面板的大
小和位置。应用程序还保存其他激活的主控面板选项，例如：全屏模式、时
间控制器状态和 “ 重播 ” 或 “ 暂停 ” 状态。
User Manual Industrial HiVision
Release 8.1 12/19 411



参考
图 107: Industrial HiVision 主控面板

提示 : 如果主控面板未显示 “New“、“Delete“ 和 “Save“ 键，请点击工具栏 
Industrial HiVision 上的 “Edit Mode“ 键。

 小部件的显示和配置
Industrial HiVision 让您可以根据您的要求调整主控面板。通过拖放功能，
您可以确定主控面板所显示小部件的类型和位置。此外，您还可以确定每
个主控面板单元格的行数和列数。
小部件的背景色和小部件中所显示的最差状态是相同的。背景色表示了和 
Industrial HiVision 图形式用户界面 (GUI) 上相同的状态。用户可以指定背
景色 （参见 “Status Colors” on page 366）。
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 小部件大小
主控面板让您可以对小部件进行放大和缩小。
为了放大一个小部件，请确认小部件的右侧或者下方有您想要放大的空单
元格。如果没有空单元格可用，请通过 “Grid“ 键添加所需单元格的数量。
请选中您想要放大的小部件。接着，请通过 “Widget Size“ 键的加号 (“+”) 
将小部件放大。每次点击加号键 (“+”)，则小部件将相应放大 1 个单元格。 

 “ 属性 ” 键
某些小部件让您可以对应该监控哪些参数进行配置。为了确定小部件对哪
些参数进行监控，请点击 “Properties“ 件，并在 “Parameters“ 对话框中输
入值。此外，小部件还让您可以将图形式用户界面或文件夹框的不同选项
卡中的参数拖动到小部件中。
以下小部件让您可以确定待监控的参数：
 “Connection Status“
 “Moving Avg Ping Response Time“
 “Numeric Property“
 “Top 10 Moving Avg Response Time“ （没有拖和放）

 显示模式
Industrial HiVision 让您能够借助以下方法显示主控面板的幻灯片。 
 如果您点击 “ 全屏 ” 键 ，则主控面板将切换到全屏模式，并且幻灯

片将切换到 “ 暂停 ” 模式。
 您还可以通过“重播”键将幻灯片打开 。如果您通过“重播”键打开幻

灯片，则主控面板将切换到全屏模式，并且幻灯片将开始显示当前用
户的页面。

“ 全屏模式 ” 下，主控面板还拥有工具栏，其包含了以下控制功能。
 为了使幻灯片保持在当前页面上，请点击 “ 暂停 ” 键 。 
 为了重新开始幻灯片，请点击 “ 重播 ” 键 。
 如果您想要将某个指定的页面打开，您可以从下拉列表中选择所涉及

的页面。

提示 : 为了显示工具栏，请将鼠标指针移动至上屏幕区域的上方。

为了退出全屏模式，请点击 “ 还原 ” 键  或者键盘上的 “Esc” 键。
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 改名 
主控面板功能让您可以对现有页面的名称进行修改。
为了对一个现有页面的名称进行修改，请如下述步骤进行操作：
 点击 “Rename“ 按键。
 请在 “Dashboard Name“ 栏中输入新名称。
 点击 “OK“ 按键。

 主控面板顺序
如果存在多个主控面板，Industrial HiVision 使您能够以任意顺序显示主控
面板。如果存在多个主控面板或所选主控面板不在列表上方，则激活
“ up ” 按键。“ up ” 按键可将主控面板上移一个位置。

 Device Summary 小部件
小部件显示了构成了整个项目的设备的概览。该概览按照设备状态显示设
备。小部件仅显示受管理 (“managed”) 和获许可的设备。
Industrial HiVision 包含了设备和概览中的设备副本。如果您向 Industrial 
HiVision 添加了一个设备的 1 个副本，则 “ 设备概览 ” 小部件将对该设备
计数 2 次。小部件对设备计数 2 次，因为副本的状态可能会和原件的状态
存在偏差。“Device Summary“ 小部件将连接排除在计数范围之外。
小部件显示设备的状态，无论设备状态是否已经过了确认 （参见 “ 确认
事件 ” on page 101）。
每个栏中每个名称的后面都有一个箭头。该箭头表示了自上次更新以来该
栏的趋势。示例：“Warning“ 栏在之前的扫描中显示 “3”，而当前扫描则
返回了 “2”。这种情况下，该栏显示一个向下的箭头。
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 Connection Summary 小部件
小部件显示了构成了整个项目的连接的概览。该概览按照连接状态显示连
接。
小部件显示连接的状态，无论连接状态是否已经过了确认 （参见 “ 确认
事件 ” on page 101）。
该箭头表示了自上次更新以来该栏的趋势。示例：“Warning“ 栏在之前的
扫描中显示 “3”，而当前扫描则返回了 “2”。这种情况下，该栏显示了一个
向下的箭头。

 Connection Status 小部件
您可以为主控面板添加多个 “Connection Status“ 小部件。“Connection 
Status“ 小部件以图表形式显示链接状态和所选连接的网络负荷。将以专
门的图表显示负荷值和链接状态。小部件框显示了当前连接状态的颜色。
小部件从 Industrial HiVision 数据库中调用连接状态。如果 Industrial 
HiVision 出于某些原因确定了连接方面的错误，则小部件框将显示为指定
错误而确定的颜色。
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图 108: “Connection Status“ 小部件，带激活的 “Top to bottom“ 功能。

在创建一个新小部件的时候，小部件处于未经配置的状态。例如：您尚未
将小部件和某个项目中的连接进行关联。这种情况下，小部件将显示一空
白图表。 
为了对小部件进行配置，请如下进行操作： 
 请通过拖放功能将小部件拖动至主控面板中的一个单元格中。 
 为了将对话框 “Widget Parameters“ 打开，请点击主控面板右侧的 

“Properties“ 键。
 请在 “History Size“ 栏中输入所需的历史记录时长。

用于 “History Size“ 的区域只需 1 分钟至 2 小时便足够了。默认值为 
30 分钟。

 请通过下拉列表中选择度量单位 。
 请为小部件分配一个连接。请在 “Connection“ 栏中选中一个连接。
 点击 “OK“ 按键。

提示 :  如果您选择了一个非连接的元素，则小部件 “Widget 
Configuration Error“ 将显示。

小部件采集有关服务器的 “In Load“ 和 “Out Load“ 的数据，并在历史记录
图表中显示这些数据。历史记录图表让图片慢慢经过小部件上方，并让您
可以读取信息。小部件显示图表，直至您将小部件关闭或者注明了另一个
连接。
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“Widget Parameters“ 对话框让您可以对小部件的可视化方面进行配置。
为了对小部件进行配置，让小部件直接在有关 “In Load“ 上方图表下面直
接显示有关 “Out Load“ 的下方图表，请选中控制复选框 “Top to bottom“。
为了将负荷图表从实心条形图更改为堆栈条形图，请选中控制复选框 
“Stacked“。每个条形按照图表类型显示了数据记录的状态，例如：实心
或者堆栈条形。小部件保存每个数据记录的状态配置，并对其加以显示。

提示 : 该实心条形图通过使用颜色对条形进行标记，该颜色相当于所涉及
时间点的数值的状态。堆栈条形图用不同的颜色显示低于极限值、在极限
值之间或超出极限值的条形部分。这样便可以显示状态配置方面的修改。

小部件使用和图形式用户界面上所配置相同的极限值。 参考 “ 连接的属性
” on page 300.

图 109: “Connection Status“ 小部件，带激活的功能 “Top to bottom“ 和 
“Stacked“。

该小部件试图借助不同的方法对两个方向上的负荷进行确定。该小部件按
照以下顺序从数据库中调用数值：
 连接的两个最终报告有关 “In Load“ 的属性值。图例显示了数据通信的

方向。
 如果一个页面没有提供任何 “In Load“ 类型的属性，则小部件将使用相

对页面的属性 “Out Load“。图例显示了数据通信的方向。
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 如果只有 1 个页面是一个端口的连接，则小部件将使用该端口的属性 
“In Load“ 和 “Out Load“。图例显示了终点的名称，同时该名称上附有 
“In Load“ 或 “Out Load“。

 如果无法确定数据通信的方向，则图表和图例将保持为空。
如果您对和一个小部件关联的连接进行了修改，则小部件将立即反应出该
修改。如果拧删除了连接，则小部件 “Widget Configuration Error“ 将显
示。

 Kernel Status Info 小部件
“Kernel Status Info“ 小部件显示了有关 Industrial HiVision 内核的信息。 
有关 Industrial HiVision 内核的补充信息请参见以下章节中的一章 ( 参
考 “Kernel Info” on page 439.)。
该小部件显示了以下信息：
 “Kernel uptime“

自启动 Industrial HiVision 以来的运行时间。
 “Memory Usage“

服务所使用储存空间的比例。Industrial HiVision 如下计算储存空间的
百分比：
percent = actual memory used/reserved memory

 “Polling Operations per Minute“
所指定内核每分钟可执行过程的数量。

 “Polling Operations last Minute“
上一分钟内核已执行过程的数量。

 “Polling Operations dropped“
上一分钟服务已丢弃过程的数量。您可以通过更改监视的轮询过程或
轮询间隔的数量来影响丢被弃轮询过程的数量。

提示 : 其他有关内核检测参数配置方面的信息，参考 “Monitor” on 
page 313.。
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 Security Summary 小部件
“Security Summary“ 小部件显示了安全相关的参数。
“Vulnerable Devices“ 栏显示了容易受到攻击的设备数量。易于受攻击的
设备至少激活了 1 个根据建议应该被禁用的功能，例如：HTTP- 或 
SNMP-v1/v2 协议。小部件还对其安全功能被禁用的设备进行计数。小部
件中所显示的数字相当于您安全状态比 “OK” 差的项目中的设备的数量。
Industrial HiVision 的图形式用户界面上的选项卡 “Security Status“ 确定了
哪个设备在事件中包括了该小部件，以及设备的安全风险。为了在计数时
将设备的数量降低，并改进网络安全，请将选项卡 “Security Status“ 上确
定的功能进行禁用 / 激活。您还可以使用 MultiConfig ™ -“Security 
Lockdown“ 功能。
“Rogue Devices“ 栏显示了恶意设备拓扑中的设备数量 参考 “ 识别非法设
备 ” on page 214. 如果恶意设备拓扑的数量超过 0，则小部件将显示您为
“ 警告 ” 所指定的颜色。

提示 : 小部件在 “Rogue Devices“ 栏的右边显示一个警告三角形。该三角
形提醒您将功能激活。小部件将 “Rogue Device Detection“ 功能激活之
后，将隐藏三角形。 

“Config. Signature Changes“ 栏显示了有配置修改的设备数量。该栏记录
每次修改，即使该修改已被恢复为原始值。
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为了让小部件能够显示属性，请指定一个基准值，并乳腺对状态计算进行
配置：
 请将 Industrial HiVision 的图形式用户界面 (GUI) 上的选项卡 

“Properties“ 打开。
 请打开下拉列表 “Property:“ 并选择 “Configuration Signature“。
 请选中表格中的设备，该表格没有任何激活 “Configuration Signature“ 

可用。 
具有激活 “Configuration Signature“ 的设备在表格 “Status“ 中用勾选表
示。为了找到需要采取措施的设备，您可以对表格进行过滤。为了对
表格进行过滤，请点击列标题 “Status“，直至表格显示上方的条目。

 请通过 Configuration > MultiConfig ™ > Status Config 打开对话框 “Status 
Config“。

 选中复选框 “Set current to reference“。
 选中复选框 “Value is Reference Value“。 
 请打开下拉列表 “Value is Reference Value“ 并选择 “OK”。 
 选中复选框 “Other Value“。
 请打开下拉列表 “Other Value“，并选择 “Warning“ 或 “Error“。
 为了对修改进行保存，请点击 “Write“ 键。

提示 : 小部件在 “Config. Signature Changes“ 栏的右边显示一个警告三角
形。该三角形提醒您对功能进行配置。在对每个设备的基准进行配置后，
三角形将被隐藏。

“Config. Signature Changes“ 栏的状态要么是针对 “0” 值为 “OK”，要么相
当于所配置 “Configuration Signature“ 属性的最差情况。
箭头表示各个栏的趋势。

 Numeric Property 小部件
“Numeric Property“ 小部件让您能够对具有数字值的参数状态进行跟踪。
小部件让您能够最多对 10 个数字参数进行跟踪。 
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为了输入您想要监控的参数，请通过对话框 “Widget Parameters“ 按如下
步骤进行操作：
 点击 “Widget Parameters“(New) 按键打开 “Properties“(New Entry) 对

话框。
 请在 “History Size“ 栏中输入您想要对设备进行监控的时长。

预设置：30
 请针对您想要监控参数的时间段输入 “History Size“ 度量单位。

预设置：“Minutes“
 请从项目结构中选择最多 10 个参数。
 您可以在 “Title“ 栏中为小部件指定另一个名称。
 点击 “OK“ 按键。
以下列表包含了小部件可以监控的数字参数中的几个：
 “Ports“:

“In Load“
“Out Load“
“Speed“

 代理： 
“Number of Users“

 协议： 
“Moving Avg Response Time“
“Avg Response Time“
“Min Response Time“
“Max Response Time“
“Std. Deviation“
“Message Loss“

提示 : 2 个设备可以针对 1 个参数具有相同的数值，这样，设备 
10.0.1.10、10.0.1.17 和 10.0.1.200 便可以具有 38 °C 和 39 °C 的温度。
这种情况下，一条曲线将覆盖另一条曲线。请参见下方图片 “Numeric 
Property“ 中蓝色、黄色和橙色的曲线。
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 Moving Avg Ping Response Time 小部件
“Moving Avg Ping Response Time“ 小部件让您可以最多对 10 个设备的 
Ping 查询响应时间加以显示。您可以借助拖放功能或者通过 “Widget 
Parameters“ 对话框对设备进行记录。
为了输入您想要监控的设备，请通过对话框 “Widget Parameters“ 按如下
步骤进行操作：
 为了将对话框 “Widget Parameters“ 打开，请点击 “Properties“ 键。
 请在 “History Size“ 栏中输入您想要对设备进行监控的时长。

预设置：30
 请针对您想要监控设备的时间段输入 “History Size“ 度量单位。

预设置：“Minutes“
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 请从项目结构中选择最多 10 个参数。
 点击 “OK“ （写入）。
为了输入您想要监控的设备，请通过拖放功能按如下步骤进行操作：
 请打开选项卡 “GUI Map”。
 请选中您想要监控的设备。
 请将选中的设备拖至 “Moving Avg Ping Response Time“ 小部件中。

提示 : 每次选择您想要监控的新设备的时候，小部件将用新选择的设备替
换现有的设备。 

有关推导得出的 ICMP 平均值的其他信息 参考 “ 服务参数 ” on 
page 383.。

 Top 10 Moving Avg Response Time 小部件
小部件显示最多 10 个设备推导得出的平均响应时间。具有更长推导得出
的平均响应时间的设备将显示在图表上方。
为了对小部件进行配置，请通过 “Properties“ 键将 “Widget Parameters“ 
对话框打开。该对话框让您可以注明小部件显示哪个协议。您可以通过下
拉列表从以下协议中进行选择：
 预设置：Ping
 SMNP V1
 SMNP V3

小部件在每个设备的 IP 地址旁边显示一个趋势箭头。趋势箭头提示某个
设备的位置自从上次轮询以来相对于小部件中所显示的其他设备所作的移
动。
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在您为实现网络最佳性能进行规划的时候，小部件中所提供的信息是非常
有帮助的。例如：小部件显示了哪个设备具有较长的平均响应时间。较长
的平均响应时间可能导致您网络的瓶颈。如果您网络的中心位置有一个响
应时间较长的设备，则该设备可能会影响您网络中的其他设备。更换较慢
的设备，有助于顺利的传输数据流。
以下列表包含了可能导致长响应时间的原因：
 设备由于发送给 CPU 的数据而过载。 

接收和转发数据是网络设备的核心任务。处理管理请求是次要任务。
 通往设备的路径较慢。

– 较慢的连接
– 相邻设备较慢的连接
– 废旧光纤或以太网电缆

提示 : 如果是首次配置小部件，则小部件在必要时将显示较长的响应时
间。这种情况下，请在采取措施之前稍等片刻，直至所显示的值稳定下
来。如果平均响应时间在 1 之后长时间保持不变，则请考虑后续措施。

 PoE Status
“PoE Status“ 小部件让您可以对您网络中的 PoE 设备的状态进行监控。
小部件显示了以下参数的选项卡 “PoE“ 上所找到警告的总数：
 “Class 0 Detected“

显示设备识别到 0 类设备连接的端口总数。
 “Device“

显示其上数值超出 “Device Limit“ 值的设备总数。
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 “Module“
显示其上数值超出 “Module Limit“ 值的模块总数。

 “Port“
显示其上数值超出 “Port Limit“ 值的端口总数。

该箭头表示了自上次更新以来该栏的趋势。示例：“Class 0 Detected“ 栏
在之前的扫描中显示 “3”，而当前扫描则返回了 “2”。这种情况下，该栏显
示了一个向下的箭头。
如果您在 “PoE“ 选项卡上将端口的 “PoE Class 0 Detection“ 功能禁用，则
小部件将在 “Class 0 Detected“ 栏旁显示一个警告三角形。您已将其识别
功能禁用的端口不包含在 “Class 0 Detected“ 栏中所输入的数字内。

提示 : 小部件在一个栏的旁边显示一个警告三角形，必要时所涉及的元素
数量要超过注明的数字。

图 110: “PoE Status“ 小部件

 TSN Schedule 小部件
小部件显示了 TSN 循环时间和一个表格中一个端口的网关控制器。表格
为每个 “Priority“ 类显示 1 行。“Priority“ 类旁边的列显示每个网关的状态。 
网关指的是一个时间段，将在该时间段内将优先级的端口打开或关闭。一
个打开的网关转发优先级的数据通信。一个关闭的网关阻塞优先级的数据
通信。绿色的单元格表示打开的网关，而灰色的单元格表示关闭的网关。
列的宽度表示打开或关闭的网关相对于循环时间的持续时间。
为了对小部件进行配置，请点击 “Properties“ 键。Industrial HiVision 打开
“Widget Parameters“ （多重配置）对话框。该对话框让您可以注明小部
件显示哪个 TSN 兼容端口。
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图 111: “TSN Schedule“ 小部件

8.13.2 Web Interface

“Web Interface“ 工具让您可以通过 Web 浏览器中 Industrial HiVision 界面将
所选设备窗口中基于网络的界面打开。
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8.13.3 Device Configuration

“Device Configuration“ 工具允许您打开在 Industrial HiVision 窗口中所选中的
设备，此设备的图形界面 （GUI）作为 JAVA 应用将在另外一个基于网络界
面的浏览器中打开。此时 Industrial HiVision 将使用 SNMP 配置设置中的登录
名和密码 ( 参阅页 376 “ 高级 ”)。Industrial HiVision 将省去登录步骤并直接跳
转到设备的启动页面。

以下产品系列均支持此功能：
 MACH 4000
 MACH 1000
 MACH 100
 GREYHOUND
 PowerMICE
 MS20/MS30
 MSP
 RS20/RS30/RS40
 RSP/RSPS/RSPL
 RSR20/RSR30
 RED
 EES20/EES25
 OCTOPUS
 EAGLE 20
 Magnum 12KX
 TCSESM
 TCSESM-E
 TCSG
 TCSN
 TCSEFEC
 ESM 801-TG
 ESM 802-TG
 ERT
 AFF650
 AFS650/655
 AFS66x
 AFS670/675
 AFS677
 AFR677
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提示 : Industrial HiVision 让您能够使用 “Device Configuration“ 功能，无论是
否是其他应用程序，例如：一个浏览器或一个安装了 Java 环境的 
Hirschmann 产品图形式用户界面。Hirschmann 已经将 Industrial HiVision 开
发为一种应用程序，其让您能够在一个封闭的网络中以简单的方式通过 
“Device Configuration“ 功能使用图形式用户界面。
如果 Industrial HiVision 和 HTTP 或 SSH 建立了一个安全的连接，则 
Industrial HiVision 不会对用于连接 Industrial HiVision 的设备标识进行检查。
此外，Industrial HiVision 将不会向用户显示设备的标识。网络上的攻击者可
能会利用这一缺失的检查，来获取敏感信息。
建议的做法是在一个封闭的网络中使用 Industrial HiVision。请不要在一个公
共网络中使用功能 “Device Configuration“ 和 MultiConfig ™ 对话框、
HTTPS。请对 Industrial HiVision 执行升级，前提是有一个新版本可用。

8.13.4 CLI

使用 “CLI“ 工具可以通过 Industrial HiVision 界面建立和所选设备的连
接。Industrial HiVision 将会打开一个单独的窗口。
Industrial HiVision 自动检查设备是否允许 SSH 会话或者 Telnet （远程登
录）会话。Industrial HiVision 首选建立一个 SSH 会话。

提示 : 在 Linux 环境下，“CLI“ 工具的前提条件是已经安装了 Telnet （远程登
录）和 SSH 客户端，并且 PATH 环境变量中包含安装了 “xterm” 程序的目录
名称。

8.13.5 SNMP Browser

使用 “SNMP Browser“ （SNMP 浏览器）工具可以读取和写入选中设备的 
MIB。Industrial HiVision 在一个新窗口中使用了 MIB。
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提示 : 该 “SNMP Browser“ 是可以免费使用的附加软件。该 “SNMP Browser“ 
不在系统测试范围内。

8.13.6 Ping

使用 “Ping“ 工具可以向窗口中选中的设备发送 Ping 请求。Industrial HiVision 
打开一个单独的 Ping 窗口。

提示 : 在 Linux 下，“Ping“ 工具需要 PATH 环境变量中包含安装了 “xterm” 程
序的目录名称。

8.13.7 HiDiscovery Scan

“HiDiscovery Scan“ 通过这些工具，您可以发现网络中支持 HiDiscovery 协
议的设备，只要这些设备已激活 HiDiscoveryv1 协议即可。

提示 : 就 HiDiscovery 而言， Industrial HiVision 仅支持 HiDiscoveryv1 协议。

 配置示例
在此示例中，您扫描网络以发现具有 HiDiscovery 协议处于活动状态的设
备。
 请打开 Preferences > Advanced > Management Station 对话框。
 从 Network Card Management Station > Default Network Card (HiDiscovery)

下拉列表中选择连接到要扫描的网络的适配器。
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 要将值保存在 Industrial HiVision 中并关闭对话框，请单击 “OK“ 按钮。
 要扫描网络，请单击 “HiDiscovery Scan“ 按钮。

8.13.8 Scan Network

功能 “Scan Network“(Scan network) 使您能够识别指定网络地址范围内的每
个设备 （参见 “Basics” on page 328）。为了开始搜索新设备，请从下拉列
表中选择 “Scan Network“(Scan network) 选项。
工具 “Scan Network“(Scan network) 具有切换功能。切换功能开始和结束网
络扫描。如果网络扫描已经执行，请点击 “Scan Network“(Scan network) 按
键以暂停当前网络扫描。
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8.13.9 Demo Network

随附的 “Demo Network“ （演示网络）程序让您有机会在您的计算机上模拟
该网络，以帮助您在未连接到网络时熟悉 Industrial HiVision。

 为了开始演示网络的模拟，请选择 Tools > Demo Network (Tools:Demo 
Network)。 

交付状态下设备识别已通过一个触发事件激活，且 Industrial HiVision 已识别
演示设备。Industrial HiVision 显示 “New Devices“ 文件夹中的演示设备。由
于演示网络没有网络连接功能，因此演示网络的模拟是通过 IP 地址为 
127.0.0.1 的本地主机接口进行的，并通过端口编号区分设备：
127.0.0.1:9003、127.0.0.1:9004、127.0.0.1:9005。模拟再现了以下的设备
管理功能：
 基于 LLDP 的拓扑识别
 线路中断
 MRP 中的线路中断
 缺少电源
 设备 9010 设备上的网络负荷
 启用 / 停用信号触点
 更改设备温度
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图 112: 演示网络

8.13.10 Calculate Availability

由于其物理特性，网络中的每个组件都有其有限的寿命。MTBF 代表平均故
障间隔时间。
组件的维修也需要一定的时间。MTTR (Mean Time To Repair) 代表平均维修
间隔时间。
Industrial HiVision 可以根据此路径所涉及的设备的 MTBF 和 MTTR 值计算
路径的可用性。
Industrial HiVision 还会考虑到冗余路径。
所连接设备的类型会影响网络的可用性。冗余连接的交换机 / 路由器与冗余
连接的设备相比会对网络可用性产生更大影响。
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如果计算出的可用性值不符合您的要求，可以采取以下措施提高可用性：
 设置冗余路径
 缩短维修时间，例如使用备用设备

 计算可用性的先决条件
 面向 Windows 操作系统：

计算可用性的时候，Industrial HiVision 使用了 2.0 或以上版本的 
Microsoft .NET Framework。
此程序是 Windows 操作系统的默认安装程序。
在网络管理站上安装此软件是正确计算可用性的前提条件。

 面向 Linux 操作系统：
请安装 MONO 2.0。
请检查此程序是否已安装在您的网络管理站中。

 针对 Debian 6.0 和 Ubuntu 12.04 (LTS) 的注意事项：
请安装 libmono2.0-cil 和 libmono-winforms20-cil。

在计算可用性之前 Industrial HiVision 需执行下列检查：
– 是否每个连接的 “MTBF“/“MTTR“ 值都大于 0？
– 每个对象 （设备、云端）都拥有 “MTBF“ 和 “MTTR“ 属性，并且其值

均大于 0？
如果 Industrial HiVision 发现了缺少信息的对象，那么 Industrial HiVision 
将在窗口中显示这些对象。一旦输入了所需信息，就可以重新开始计算
了。
如果尽管缺少信息您仍想要继续计算，请点击 “Use Default Values“ 键。
这种情况下 Industrial HiVision 将为所缺少的信息提供默认值以进行计
算。
当缺少这些对象时，可以通过点击 “Use Default Values“ （使用默认值）
开始可用性计算。接着，Industrial HiVision 将使用每个为计算所输入的 
“MTBF“/“MTTR“ 值，否则将输入指定的 “MTBF“/“MTTR“ 默认值。

可用性级别 名称 可用性 （单位：%） 每年的停机时间
1 (AEC-0) 稳固 99.0 3.7 天
2 (AEC-1) 可用 99.9 8.8 小时
3 (AEC-2) 高可用 99.99 52.2 分钟
4 (AEC-3) 对故障不敏感 99.999 5.3 分钟
5 (AEC-4) 容错 99.9999 32 秒
6 (AEC-5) 容灾 99.99999 3 秒

表格 49: 可用性级别 （根据 ACE 划分）
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“MTBF“ = 30,000 小时 （针对设备），100,000 小时 （针对连接）
“MTTR“ = 24 小时，针对设备和连接
该设备 / 连接的实际值与默认值有偏差。
例如：计算 2 个替代路由的可用性偏差时可以使用该默认值。

 准备计算可用性
下面的例子介绍了如何准备计算两个设备之间的连接可用性。
可以在以下文件的 Hirschmann 安装目录中找到 Industrial HiVision 设备
的 MTBF 值：
/data/doc/MTBF-Products.PDF。
 请打开设备界面上的选项卡 “Map“。
 为了输入一个连接的 “MTBF“/“MTTR“ 值，请如下进行操作：

– 使用鼠标右键点击连接，并选择 “Properties...“ （属性）。
– 请在对话框中打开选项卡 “Properties“。
– 请在框 “Availability“ 中输入 “MTBF“/“MTTR“ 值。
– 点击 “OK“ 按键。

 为设备属性添加自定义属性 “MTBF“、“MTTR“ 和 “Node Type“。
– 请双击连接的 2 个设备中的 1 个，以便进入详细显示中更深的 1 个

界面。
– 使用鼠标右键点击详细显示的空白区域，以添加自定义属性 

“MTBF“ 和 “MTTR“。
– 请选择 New > Property。
– 在 “New Property“ （新属性）对话框中按住 “Ctrl” 键选择 “MTBF“ 

和 “MTTR“。
– 点击 “OK“ 按键。
– 双击属性 “MTBF“ 打开 “Properties“ 对话框，以输入 “MTBF“ 的值。
– 请在 “Current Value“ 栏中输入数值，并点击 “Write“ 键。
– 点击 “OK“ 按键。
– 请以相同方式输入 “MTTR“ 值。

 同样为其他相关设备添加设备属性。
如果其中一个设备是冗余连接的设备，则请以相同方式 （参见上
文：“MTBF“ 和 “MTTR“）为其属性 “Node Type“ 分配 “End Device“ 值。
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作为单独设备配置的替换方案，Industrial HiVision 还提供了 
MultiConfig ™ 选项。其优点在于，可以同时对 2 个设备进行 
“MTBF“/“MTTR“ 属性的配置。
 请打开设备界面上的选项卡 “Map“。
 为了输入一个连接的 “MTBF“/“MTTR“ 值，请如下进行操作：

– 使用鼠标右键点击连接，并选择 MultiConfig ™。
– 在 MultiConfig ™ - 对话框中选择菜单树中的 (Container 

Properties)。
然后，您将在对象框中发现相关连接的列表，并会在功能框中出现
属性表格。

– 请在框 “Availability“ 中输入 “MTBF“/“MTTR“ 值。
– 点击 “Write“ 按键。

 用于将用户自定义属性 “MTBF“ 和 “MTTR“ 添加到设备属性中。
– 按住 “Ctrl” 键点击连接端部的设备以选中这两台设备。
– 使用鼠标右键点击选中的设备，并选择 “MultiConfig ™ ” 打开 

MultiConfig ™ 对话框。
– 在 MultiConfig ™ - 对话框中选择菜单树中的 Program Settings > New 

Property (Device Settings:Diagnostics:Status Config:Trap 
Destinations)。
然后，您将在对象框中发现相关设备的列表，并会在功能框中出现
属性表格。

– 为了为表格中的 “MTBF“ 值创建一个新的条目，请点击 “New“ 键。
– 请选中 “MTBF“ 属性，并点击 “OK“ 键。
– 为了为表格中的 “MTTR“ 值创建一个新的条目，请点击 “New“ 键。
– 请选中 “MTTR“ 属性，并点击 “OK“ 键。
– 点击 “Write“ 按键。

 为了将用于输入 “MTBF“ 值的对话框打开，请在详细显示中打开选项
卡 “Properties“。
– 请在下拉列表 “Property“ 中选择属性 "MTBF (Device)"。
– 选中相关设备。
– 使用鼠标右键点击选中的设备，并选择 “MultiConfig ™ ” 打开 

MultiConfig ™ 对话框。
– 为了输入 “MTBF“ 值，请在对话框 MultiConfig ™ 的菜单树中将对

话框 “Property Value“ 打开。
– 请在 “Value“ 栏中输入 “MTBF“ 值。
– 点击 “Write“ 按键。

 为了将用于输入 “MTTR“ 值的对话框打开，请在详细显示中打开选项
卡 “Properties“。
– 请在下拉列表 “Property“ 中选择属性 "MTTR (Device)"。
– 选中相关设备。
– 使用鼠标右键点击选中的设备，并选择 “MultiConfig ™ ” 打开 

MultiConfig ™ 对话框。
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– 为了输入 “MTTR“ 值，请在对话框 MultiConfig ™ 的菜单树中将对
话框 “Property Value“ 打开。

– 请在 “Value“ 栏中输入 “MTTR“ 值。
– 点击 “Write“ 按键。

 Calculate Availability
下面的例子介绍了在完成上述准备工作之后如何进行可用性的计算。
 请打开设备界面上的选项卡 “Map“。
 按住 “Ctrl” 键点击连接端部的 2 台设备以选中这 2 台设备间的连接。
 在菜单栏中选择 Tools > Calculate Availability (Tools:Calculate 

Availability) 打开可用性计算对话框。
– 如果对特定对象而言缺少了属性 “MTBF“/“MTTR“，则 Industrial 

HiVision 将打开对话框 “Availability“，该对话框含缺少该属性的设
备的列表。表格中还包括此类属性值为 0 的设备。 
检查是否缺少需要计算可用性的对象 （例如：设备或连接）。

– 如果为每个对象都在选项卡 “Map“ 上指定了属性 “MTBF“ 和 
“MTTR“，则 Industrial HiVision 将执行计算，并在对话框 
“Availability“ 中显示结果。
Industrial HiVision 将在对话框的 “ 详细设置区 ” （Detail frame）中
显示需由 Industrial HiVision 计算可用性的路径。为了显示详细信
息，请选中控制复选框 “Details“。

Industrial HiVision 在计算时将可用性计算的详细信息写在日志文件中。
您可以在文本区 <Installation path>/log/availability 找到指纹。
日志文件名由加载项目文件名和时间戳的名字组成。

提示 : 可用性计算
Industrial HiVision 将在假设条件下进行可用性计算，网络中的设备将在
每个端口上进行传送。冗余连接的设备、路由和虚拟局域网可能会导致结
果出错。作为冗余连接设备的补救措施，请在设备中创建 “Node Type“ 属
性，并将值设为 “ 设备 ”。

提示 : 并行连接
Industrial HiVision 总结出 2 台设备之间的并行连接以便优化 1 个路径的
计算。路径出现在对话框中的路径列表中，并作为一个单一路径出现在日
志文件中。 
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8.14 Help

您将在 “Help“ 菜单中找到 “Online Help“ 以及该程序的版本信息。

8.14.1 Online Help F1

您可以通过您键盘上的 “F1” 键或点击 Help > Online Help 来调用 “Online 
Help“。
“Online Help“ 涵盖了手册的全部内容，其中包括目录、内容选项卡、搜索功
能和导航帮助。
在各对话框中，您可点击 “ 帮助 ”( Help) 直接进入手册中与对话框相关的页
面。

8.14.2 Readme

请使用 Help > Readme 将 “Readme“ 文件打开。它包括了 Industrial HiVision 
的安装信息。 

8.14.3 Release Notes

请使用 Help > Release Notes 将 “Release Notes“ 文件打开。您可以获得 
Industrial HiVision 安装版本的信息。 
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8.14.4 Tutorial

在首次开始学习使用 Help > Tutorial 时可以使用 Industrial HiVision 
(Help:Tutorial) 在浏览器中打开带有准则规范的练习。这种练习可以帮助您
熟悉 Industrial HiVision 最重要和最新的功能。

8.14.5 Online

更多信息请参见 Help > Online。 
您可以选择：
 Hirschmann

用于打开 Hirschmann 网站。
 Hirschmann 技术中心

用于打开 Hirschmann 技术中心网站。
 Industrial HiVision

用于打开 Hirschmann 网站上的 Industrial HiVision 产品页面。
 申请许可证

用于在浏览器中将用于在线申请 Industrial HiVision 许可证的订购表。 
订购许可证密钥时需要：
– 产品认证证书的注册代码 （包含在供货范围内）
– 硬件密钥 （请参见对话框 Configuration > Preferences > Basics > License 

(Configuration:Preferences:Basics:License)。
如果您调出了订购页面，Industrial HiVision 将自动发送给您硬件密
钥。
438
User Manual Industrial HiVision

Release 8.1 12/19



参考
8.14.6 Kernel Info

Help > Kernel Info (Help:Kernel Info) 包含服务模式中技术服务人员所必需的信
息。
Industrial HiVision 应用程序的核心是内核。内核的目的在于从网络设备和用
户界面收集信息。内核将信息保存在一个数据库中。用户界面向内核发送一
个请求，例如：有关设备状态的请求。内核从数据库中调用信息，并对请求
作出回复。

图 113: Industrial HiVision 内核结构 （Kernel Info）

User interfaceServices

read/write

Configuration
data

Display
data

Database

Kernel

Remote 
User interface
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8.14.7 About

 Program Info
有关程序版本以及发行方的信息请参见 Help > About > Program Info。

 EULA
有关许可证协议的信息请参见 Help > About > EULA。

 License
Industrial HiVision 许可证的相关信息，请参见 Help > About > License。
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A.1 常见问题

对常见问题的回答请参见 Hirschmann Industrial HiVision 网站：

www.hivision.de
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A.2 监测的属性

A.2.1 预设置中所监测的属性

下列表格中包括 Industrial HiVision 在基本设置中通过陷阱或轮询所监测的属
性。

Industrial HiVision 在事件列表中列出了陷阱。 

提示 : 请注意对系统资源的影响 ( 参阅页 “ 对系统资源的影响 ” on 
page 230)。

属性 陷阱 轮询 轮询间歇
AutoConfiguration Adapter 状态 X
风扇状态 X
电源状态 X
继电器状态 X
端口连接 X * 30 秒
端口输入负载 * 30 秒
端口输出负载 * 30 秒
端口管理 X
端口运行状态 X
无线局域网站点 X ** 30 秒
WLAN 接入点 X ** 30 秒
Signal to Noise Ratio （信噪比） x** 30 秒
生成树状态 X * 30 秒
快速生成树状态 X * 30 秒

表格 50: 监测的属性
* 在基本设置中为与 Industrial HiVision 进行电缆连接的端口激活轮询。
** 在基本设置中为与 Industrial HiVision 进行无线连接的端口激活轮询。
*** 设备所支持的较高协议
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多种生成树状态 X * 30 秒
Ping 可达性协议 X 30 秒
SNMPv1 可达性协议 x*** 2 小时
SNMPv3 可达性协议 x*** 2 小时
HIPER 环状态 X * 30 秒
HIPER 环耦合状态 X * 30 秒
双归属状态 X * 30 秒
环耦合启用 X
环管理启用 X
双归属启用 X
路由器冗余模式 X
路由器冗余状态 X
温度 X X 5 分钟
Configuration Status X X 5 分钟
Configuration Signature X 1 小时
Configuration File X X 24 小时
Http X 24 小时
Telnet X 24 小时
SNMP V1/V2 X 24 小时
Tftp X 24 小时
IEC61850 X 24 小时
Profinet IO X 24 小时
EtherNet/IP X 24 小时
Unused Active Ports X 24 小时
802.1X Port Access Control Enabled X 24 小时
Outbound ANY Rule X 24 小时
Inbound ANY Rule X 24 小时

属性 陷阱 轮询 轮询间歇

表格 50: 监测的属性
* 在基本设置中为与 Industrial HiVision 进行电缆连接的端口激活轮询。
** 在基本设置中为与 Industrial HiVision 进行无线连接的端口激活轮询。
*** 设备所支持的较高协议
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A.3 CSV 导出

如果您需要使用不同的语言编辑 CSV 文件，则必须有相应的字符
集。Industrial HiVision 在导出 CSV 文件的数据时将使用以下代码： 

A.3.1 2010 年以前的 Microsoft Excel

导入到 Microsoft Excel 时请选择：
 请在 Excel 中选择菜单项 

Data:Import External Data:Import Data
 请选择文件并点击 “Open” 打开。 
 在文本导入向导 - 步骤 1 中选择原始数据类型 “Separate” （独立）。
 在文本导入向导 - 步骤 1 中选择原始数据类型 “Separate” （独立）。
 在文本导入向导 - 步骤 2 中选择 “Tab stop” （制表）和 “Semicolon” （分

号）作为分隔符。

语言 字符集
德语、英语、法语、西班牙语、意
大利语、葡萄牙语、印尼语

Latin-8859-1

希腊语 Windows-1253
韩语 Johab
日语 Shift-JIS
汉语 GB2312
俄语 Kyrillisch-8859-5

表格 51: 用于 CSV 导出的字符集
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附录 A.3  CSV 导出
A.3.2 Microsoft Excel 2010

导入到 Microsoft Excel 时请选择：
 请在 Excel 中选择菜单项 Data:From Text
 请选择文件并点击 “ 导入 ”。 
 在文本导入向导 - 步骤 1 中选择原始数据类型 “Separate” （独立）。
 在文本导入向导 - 步骤 2 中选择 “Tab stop” （制表）和 “Semicolon” （分

号）作为分隔符。
 请在文本转换向导 - 步骤 3 中，为列的数据格式选择 “ 标准 ”。
 请点击 “ 完成 ”。
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附录 A.4  语言支持
A.4 语言支持

语言 用户界面 在线帮助 手册
（PDF 文
件）

手册 （印
刷版）

Tutorial
（指南）

readme

德语 X X X X X X
英语 X X X X X X
西班牙语 X X X
法语 X X X
意大利语 X X X
俄语 X
汉语 X X X
韩语 X
日语 X
希腊语 X
葡萄牙语 X
印尼语 X

表格 52: 语言支持
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附录 A.5  使用的端口
A.5 使用的端口

Industrial HiVision 用于在特定协议端口网络中的用户界面和服务之间进行通
信。下面的表格中介绍了这些端口及其用法。
防火墙将 Industrial HiVision 服务同客户端断开时，添加防火墙规则，以继续
在服务和客户端之间传输数据。 参考 “ 添加新设备 ” on page 142.

使用的端口 应用
11185 CORBA 命名服务
11186 Industrial HiVision 服务的演示代理陷阱
11187 HTTP/HTTPS 服务器
11188 接口和服务之间的通信。Industrial HiVision 将这些端口用于服务和子域之间

的通信。
11191 与 OPC-DA 服务器的通信
11189 与 OPC-UA-HTTP 服务器的通信
11190 与 OPC-UA-HTTPS 服务器的通信

表格 53: 使用的端口
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附录 A.6  维护
A.6 维护

Hirschmann 不断致力于软件的完善和开发。请定期检查软件更新是否能为
您带来更多益处。您可以在 Hirschmann 网站的产品页面中找到软件的信息
和下载。
www.hirschmann.com
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附录 A.7  参考文献
A.7 参考文献

 《Optische Übertragungstechnik
in industrieller Praxis》
Christoph Wrobel (Hrsg.)
Hüthig Buch Verlag Heidelberg
ISBN 3-7785-2262-0

 Hirschmann 手册
“Basics of Industrial ETHERNET and TCP/IP”
280 710-834

 “TCP/IP Illustrated”，卷 1
W.R. Stevens
Addison Wesley 1994
ISBN 0-201-63346-9

 Hirschmann 用户手册 “ 安装 ”

 Hirschmann 用户手册 “ 基本配置 ”

 Hirschmann 用户手册 “ 冗余配置 ”

 Hirschmann 用户手册 “ 路由配置 ”

 Hirschmann“ 图形式用户界面 (GUI)” 参考手册

 #Variable:Firmenname# 参考手册 “ 命令行界面 ”

 Hirschmann 用户手册 “ 工业协议 ”

 Hirschmann 手册 “ 网络管理系统 HiVision”

 Hirschmann 手册 《HiOPC 服务器界面》
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附录 A.8  集成软件的版权
A.8 集成软件的版权

Industrial HiVision 包含了一系列开源组件。
这些组件的设计者为这些组件发布了各种不同的许可证。
这些许可证位于 Industrial HiVision 安装目录中 data\doc\FOSS-
BOM.html
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附录 A.8  集成软件的版权
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Index
B Index

程
.NET 2.0  433
“Audit Log” （审计日志） 57
“Audit Trail” （审计跟踪） 57
产品专用模块 88, 315
产品图片 361
位置显示 249
位置视图 312
免费版本 68, 275
创建一个文件夹。 147
删除 （Delete） 276
前景 366
前缀 379
协议 290
协议端口 378
协议统计 (Log Stalistics) 308
历史记录 294, 300, 313
发送邮件 343
另存为 ... （Save as... ） 270
名称 144, 388
在线帮助 92, 437
域 58, 62
域名服务器 145
培训计划 485
声音 221, 339
字体 361
字体大小 364
对象标识符 381
对齐 144
导入 341
导出 271
导航区 82
导航帮助 437
属性 (Properties) 285, 293, 300
平板电脑 248
手册 437
打印 (Print) 272
打开 269
扫描速度 234, 383
技术服务人员 439
技术问题 485
抽象 361
授权 55
排列 144
推送通知 221, 394
搜索功能 437
操作 341, 346
数值 286, 293

文件选择对话框 266
文本显示 364
日志文件 355
日期 100
日期格式 353
智能手机 248
更改 OPC 服务器类型 240
更新 （Update） 218
权利角色 56, 333
极限值 298
标识 407
样版示例配置 147
模块号 144
模板符号 148
气泡 294, 300, 362
注册代码 350
测试时间 68, 275
添加规则 182
漫游 150, 150
版本 437
状态 216, 361, 366
状态变化 361
状态图标 173
状态测定 143
状态转发 143, 219, 285, 301
状态配置 145, 150, 216
监视 （Monitor） 313, 316
短信 339
私人网络 75
租用许可证 64, 65
移动应用程序 248
移动设备 248, 394
程序 36
筛选器 341
签名 53
管理 IP 地址 144
线条粗细 362
组件详细信息 106, 238, 296, 297
绝对 302
缓存大小 294
缩放 （Zoom） 104, 312
背景 361, 366
背景 （Background Image） 280
菜单栏 82, 88
触发事件 217
触发事件目标 409
许可证 58, 62, 68, 275
许可证密钥 350
许可证文件 270, 271
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Index
许可证条款 440
证书 53, 55
询问间隔 331
询问频率 136, 331
语言 353
超时 378
超级域 64, 373, 373
超级域许可证 65
轻型目录访问协议 56
速度 362
防火墙规则 182
隐藏列 105
非法设备 214
项目数据库 270, 271
默认图标 140, 367
默认设备图标 69

0-9
1
1 NAT Router （1
1 NAT 路由器） 283, 393

A
ActivX 控件 235
APP 248
安全 52, 71, 204
安全状态 115, 238
安全状态显示 207
安全锁定 212
安全隐患 36, 53, 54

B
保存备份 270
保存 (Save) 160, 269
报告 88, 224, 302, 316

C
CA 证书 242
Ctrl+E 89
重复 (Repetition) 378
重复锁定 384
重新启动 179
重要安全提示 208

D
Data Access V1 至 V3 235
DCOM 235
Debian 6.0 433
Delta 302
DNS 145
带宽 136, 331
登录名 55
地图 312

地理位置 312
地理位置视图 312, 386
地理位置显示 249
电子数据表 367
电子邮件配置 386
端口安全 212, 213
端口号 144, 378
端口名称 144, 389

E
Edit Mode ( 编辑模式 ) 55, 94, 274
EDS 367
EDS 文件 （电子数据表） 368
EtherNet/IP 140, 290
EULA 440
Event 356
E-Mail 386
340

F
FAQ 485
FDB 282
访问权限 58
分布式组件对象模型 235
复制 （Copy） 145
服务 35, 100, 266, 273, 373, 383
服务器 43
服务器 IP 地址 43
符号 173, 174

G
GPS 250
GREYHOUND 330
工具 411
工具栏 82, 89
过程可视化系统 235

H
HiDiscovery 290, 330
HiMobile 访问 Industrial HiVision 336
HiProvision 386
HiProvision 激活 137

I
ICMP 227
IP 地址 135, 142, 156, 330, 407
IP 地址前缀 379
IP 地址范围 136
IP 配置 58, 156, 407
I'm alive 356

J
基本设置 174, 285, 361, 366
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Index
加载备份 271
简单网络管理协议 (SNMP) 282, 290, 400
交付状态 216
接入点 150
接入站点 150
接通信息 135, 329
禁用 OPC 服务器 374
警报 313

L
LDAP 56
Linux 系统日志服务器 38
LLDP 282
连接 (Connection) 149, 150, 151, 223, 276, 
300, 362
连接属性 154
连接状态 362
连接线 154
浏览器 386
轮询 231, 232, 303, 467
轮询间隔 233, 330, 331

M
MAC 地址 135, 140, 330, 367
MIB 227, 428
MIB 浏览器 228, 381
MIB 变量 /OID 228
MIB 管理器 228, 381
Modbus/TCP 140, 290, 367
MONO 2.0 433
MTBF 301, 432
MTTR 301, 432
密码 55, 187, 204, 364, 371, 376, 377
密钥 212
目录 437
目标文件夹 329

N
NAT 393
内容选项卡 437

O
OID 228
OPC 59
OPC 服务 235
OPC 服务器 381
OPC 写入命令 374
OPC-UA 安全 242
OPC-UA- 客户端 240

P
PDF 浏览器 386
Ping 290, 386

Ping 服务器 383
PSM 88, 315
PSM 管理器 88, 315
配置网络 157
配置签名 211

Q
QR 代码 249

R
RADIUS 56
Remote Authentification Dial-In User Service 

56
冗余网络管理系统 54
软件备份 41

S
SCADA 235
SNMP 浏览器 428
SNMP 密码同步 186
SNMP 配置 377
SNMP 请求 378
SNMP 用户 376
SNMP 版本 377
SNMP-MIB 227
Software-Backup 40
SSH 386
SysOID 140, 367
设备连接。 150
设备密码 371
设备配置 427
设备信号化 304
设备信息 248
设备名称 144, 156, 388
设备文件 (Device Documentation) 162, 279, 
371
设备证书 212
设备识别 140, 218, 367
设备识别方法 135
升级 42
事件 339, 341, 354, 409
事件列表 82, 248, 272, 354, 384
事件日志 101
事件日志文件 120, 354
事件显示 354
事件行 82, 98
时间安排 88, 319
时间 （Time） 100
双向 113

T
TSN-Beispielkonfiguration 195
TSN-Zeitberechnung 191
User Manual Industrial HiVision
Release 8.1 12/19 479



Index
图形 144
图形式用户界面 411
图标 140
图标尺寸 361
图标文件 368
退出 273, 273
拓扑 106
拓扑识别 150, 282

U
Ubuntu 12.04 433

V
VLAN 从属性 307
VLAN 更新 307
VRRP 284

W
Web Interface 426
WLAN 150
网关 379, 407
网关 IP 地址 156
网络访问 245
网络负荷 223, 233, 234
网络接口卡 379
网络扫描 (Scan Network) 136, 329, 330, 430
网络掩码 156, 331, 379, 398, 407
网络管理界面 133
网络规划 141
温度 233
温度监控 233
无法识别的设备 284
无线设备脚本 321
无线客户端 284
无线局域网 150

X
系统对象标识符 140, 367
系统控制 36
系统要求 30
系统语言 353
系统资源 230
陷阱 67, 135, 313, 329, 467
陷阱目标地址 67, 379
写实 361
信号 407

Y
以太网供电 115
用户名 376
用户权限 55, 59
用户管理 333
预设置 182, 379

远程登录 386, 428
远程访问 43, 373
运行模式 94

Z
指纹 211
主机文件 145
主窗口 82
转发数据库 (Forwarding Data Base) 282
自动拓扑 (Auto Topology) 282
自动布局 144, 285
自定义属性 227
自定义属性 (User-defined properties) 400
自定义操作 346
子域 58, 62, 64, 65, 373
子域接口 373
子域密码 373
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更多支持
C 更多支持

技术问题
如有技术问题，请联系您所在地区的 Hirschmann 代理商，或直接垂询 
Hirschmann。
我们的代理商地址请查询网站 http://www.hirschmann.com。
由 Hirschmann 直接提供的技术支持电话号码和电子邮件地址的列表请参见 
https://hirschmann-support.belden.com。
此外，您还可以找到免费数据库和软件下载区。

Hirschmann Competence Center
Hirschmann Competence Center 凭借完善的创新服务同时在三方面遥遥领
先于各路竞争对手：
 咨询服务涵盖了从系统评估到网络规划再到项目实施的全面技术支持。
 为客户提供了基础理论传授、产品入门指导以及用户训练等培训服务，并

且可提供相应的认证。
技术与产品方面的最新培训计划请查阅 http://www.hicomcenter.com。

 客户支持囊括了从调试到急救服务再到维护方案的所有方面，一应俱全。
借助于 Hirschmann Competence Center，您在任何情况下都无需妥协。为
客户量身定制的产品服务方案可让您自由选择所需的服务组件。
网址：
http://www.hicomcenter.com
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读者意见
D 读者意见

您对本手册有何想法？我们一直致力于在我们的手册中全面描述所有要点、
介绍重要的背景知识，以便在您使用我们产品时提供帮助。您的意见和建议
将能够帮助我们继续提高文件的质量和信息层次。

对本手册的评价：

您认为本手册有何不足之处吗？
体现在哪些方面呢？请举例说明。

非常好 好 满意 一般 糟糕
描述精准 O O O O O
可读性 O O O O O
理解性 O O O O O
示例 O O O O O
结构 O O O O O
完整性 O O O O O
图形 O O O O O
图纸 O O O O O
表格 O O O O O
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读者意见
提议、改进建议、补充建议：

综合评价：

发件人：

尊敬的用户，
请将本页填写完整并发回 
 传真至 +49 (0)7127 14-1600 或
 邮寄至 

Hirschmann Automation and Control GmbH
01RD-NT 部门
Stuttgarter Str. 45-51
72654 Neckartenzlingen

公司 / 部门： 

姓名 / 电话： 

街道： 

邮编 / 地区： 

E-Mail：

日期 / 签名： 
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